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 Sea urchins and other marine invertebrates have contributed fundamentally to our knowledge 
of cell, molecular, and developmental biology. These contributions, ranging from the dis-
covery of cyclins in the sea urchin, to cellular immunity in the starfi sh, to transmission of 
nerve cell signals in the squid giant axon, arise from the incredible diversity of these organ-
isms, the ease with which samples can be prepared, and the availability of suffi cient num-
bers of samples. With sea urchins, for example, you can relatively rapidly obtain large 
quantities of eggs all of which are arrested at the same stage of the cell cycle. This natural 
synchronization of these cells has proven useful for understanding the regulation and con-
trol of the cell cycle. 

 One of the most famous contributions of marine invertebrates to cell and molecular 
biology is the discovery of cyclins [1]. Over several summers at the Marine Biology 
Laboratory in Woods Hole, MA, Tim Hunt and colleagues demonstrated a protein band 
that disappeared in fertilized or activated sea urchin eggs, while the other proteins contin-
ued to be synthesized [2]. Further analysis showed that this protein band was continuously 
synthesized before being destroyed about 10 min before each cell division. Following this 
initial discovery, a similar behavior was discovered in cycling clam eggs and, as we now 
know, is universally responsible for regulating the cell cycle [3]. 

 These interesting organisms have also contributed basic knowledge that leads directly 
to discoveries in human physiology with direct relevance to human health. For example, 
Ilya Mechnikoff and Paul Ehrlich shared the Nobel Prize in Physiology and Medicine in 
1908 for their discoveries in immunity. In his Nobel lecture, Mechnikoff describes his 
work on comparative embryology as being crucial for the ultimate discovery of phagocy-
tosis [4]. Enabling his discovery was the fact that many of the “lower animals” (his words) 
are transparent and thus allow visualization of cells within the living organism. He 
observed cells within the body cavity of bipinnaria larvae from the starfi sh and it occurred 
to him that these might be like blood cells from vertebrate organisms and that they may 
play a role in the individual’s defense against microorganisms. He tested his idea by 
inserting a thorn (different sources say a rose thorn or a thorn from a tangerine tree) into 
the larva and observing that it was surrounded by mobile cells the following morning. In 
later studies, he observed similar behavior in “water fl eas” ( Daphnia ) infected with 
microbes and then transferred his theories to humans and the infection-fi ghting role 
played by phagocytes [4, 5]. 

 With the development of genome projects for many different phyla, the potential for 
these organisms to contribute more to our understanding of basic cell and molecular pro-
cesses increases. This Method in Molecular Biology volume addresses the use of sea urchins 
and other marine invertebrates in the cell and molecular biology laboratory. It covers all 
aspects of the process beginning with caring for the animals, obtaining gametes, and pro-
ducing embryos for a variety of organisms in the fi rst chapters. We move on to describing 
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methods for imaging and other useful experimental tools for cell and developmental biol-
ogy research. The fi nal portion of the book will present a variety of molecular biological 
methods and strategies for utilizing the sea urchin genome. 

 Chapters   1    –  5     present methods for culturing and caring for a variety of marine inverte-
brate organisms. Hopefully, these chapters will inspire you to try a new model system in 
your own research program. In Chapter   1    , Richard Strathmann describes techniques for 
the culture of marine invertebrates. These methods are streamlined and adaptable to the 
larvae of diverse animals. Many labs would like to give these fantastic animals a try and this 
chapter is just what you are looking for to get started. The provided methods are suffi cient 
for taking your cultures from fertilization, through embryogenesis and up to metamorpho-
sis. Chapter   2     is a very special chapter, written by Charles Lambert just before his passing 
in 2011. With great thanks to Gretchen Lambert, his chapter was completed and edited for 
inclusion in this volume. This chapter focuses on obtaining gametes, performing in vitro 
fertilization, and culturing embryos from the three different orders of ascidians. Because of 
their special place as basal chordates, understanding maturation, fertilization, and early 
development in this important group of animals has been very informative. The Drs. 
Lambert worked on these intriguing animals throughout their productive careers and have 
inspired many scientists along the way. Chapter   3     by Anthony Pires describes the culture of 
the widespread limpet  Crepidula fornicata  from spawning to metamorphosis. This mollusc 
has emerged as a very useful model system for the study of embryonic and larval life histo-
ries because of the development of useful tools including a well-resolved fate map, develop-
ment of loss- and gain-of-function strategies, and an emerging genomics resource [6]. The 
culture of the mysterious placozoan  Trichoplax adhaerens  is described by Andreas Heyland 
and colleagues in Chapter   4    . These basal metazoans have interested scientists since their 
discovery in 1883 because they were diffi cult to classify, appearing perhaps as cnidarians or 
sponges [7]. They have also generated recent interest since the publication of their 98 mil-
lion base pair genome because they show great promise for understanding the evolution of 
the basic animal body plan [8]. A method for culturing bryozoan larvae and colonies is 
presented by Michael Temkin in Chapter   5    . The Bryozoa are a phylum of diverse aquatic 
invertebrates that are found in fresh and salt water. There are over 4,000 living species 
known! Bryozoans are found in the fossil record, but their relationship to other organisms 
is not certain, making them an interesting group to study for evolutionary reasons. 

 The fi eld of cell biology developed in response to advances in technology, particularly 
along with advances in microscopy. The light microscope allowed direct visualization of 
cells and some subcellular structure, which continued to advance following the introduc-
tion of electron microscopy that allowed for visualization of subcellular detail and even to 
the level of individual proteins. In Chapters   6    –  9    , methods are described for acquiring and 
analyzing visual information in cell and molecular biology. George von Dassow details 
methods for processing of images from confocal microscopes in Chapter   6    . This is a very 
practical and useful chapter written in an engaging style. Among many other things, readers 
will learn how to process 3D images, how to use the free ImageJ software, and how to deal 
with background noise. In Chapter   7    , George Shinn details methods for imaging chaeto-
gnatha internal anatomy by light and transmission electron microscopy. The detailed meth-
ods described are applicable to most any marine invertebrate organism. There is a particularly 
extensive and useful  Note  section in this chapter, which will allow the novice to avoid the 
common pitfalls encountered when learning how to process embedded and sectioned spec-
imens for light and electron microscopy. John Buckland-Nicks gives an excellent descrip-
tion of scanning electron microscopy in Chapter   8     with a focus on visualization of marine 
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invertebrate gametes. The chapter describes some background theory before giving detailed 
steps that could be replicated for any organism. Particular attention is paid to the delicate 
nature of gametes, particularly oocytes. Again, the extensive use of the  Notes  section pro-
vides the reader with suffi cient advice for successfully adopting these methods in their own 
laboratory. In Chapter   9    , Robert Burke and colleagues give a detailed description of several 
techniques useful for imaging neural developing in sea urchins. They consider many topics 
that will be of interest to anyone using light microscopy to study cell and molecular biology 
(which is probably all cell and molecular biologists). Some items covered include a compari-
son between the use of paraformaldehyde and methanol as fi xatives. What is compatible 
with in situ hybridization techniques? Can this be combined with immunolabeling of a 
specifi c protein antigen. Even if you’ve done these methods before, you will learn some-
thing new in this chapter. 

 Chapter   10     by Anthony Morgan and Antony Galione describes the preparation of sea 
urchin egg homogenates that preserve biological function. These preparations have been 
invaluable for the study of signal transduction in these cells, particularly the regulation of 
calcium release in response to a variety of agonists. The homogenates allow for visualization 
of both calcium release from internal stores and the study of the uptake of calcium as the 
signal is completed. Using homogenates also removes the necessity of microinjection for 
introducing molecules or proteins into the system. However, microinjection remains a use-
ful method for studying cell biology in these systems, as detailed in Chapter   11     by Alex 
McDougall, Karen Wing-man Lee, and Remi Dumollard. They describe methods for the 
microinjection of mRNA expressing fl uorescently tagged proteins and for following the 
expression of these proteins from the egg to the tadpole in the ascidian. As they mention, 
this method could be combined with a variety of gene knockdown methods to give a very 
comprehensive picture of specifi c developmental processes. While described for the ascid-
ian, these methods will also certainly be applicable and useful and most any system that 
allows for microinjection (basically every egg)! Methods for isolating specifi c cell types from 
the sea urchin are described by Celina Juliano, S. Zachary Swartz, and Gary Wessel in 
Chapter   12    . The sea urchin model system has been extraordinarily useful for understanding 
gene expression in the early embryo and during cell specifi cation. This chapter details meth-
ods for isolating these different types of cells, based upon gene expression patterns, which 
will allow for downstream analysis of specifi c cell lineages that would not otherwise be pos-
sible. This lab thinks outside the box, so you don’t know what ideas may be generated by 
reading their protocol. Chapter   13     by Samantha Cihal and David Carroll describes a method 
for labeling cell surface proteins in living starfi sh oocytes and methods for the further analy-
sis of these proteins and, perhaps, their interaction with intracellular signaling molecules. It 
is hoped that this procedure would be generally useful to most cell types. 

 The Hedgehog signaling pathway is an important regulator in many different develop-
mental processes and in a wide variety of organisms. It represents a fundamental decision- 
making pathway. Methods to study the contribution of this pathway to development in the 
sea urchin by microinjection of morpholino oligos or with small molecule inhibitors are 
described in Chapter   14     by Jacob Warner and David McClay. Sea urchins have been useful 
model systems for the study of fertilization and also for the early developmental events that 
occur following fertilization. In Chapter   15    , Jolanta Kisielewska and Michael Whitaker 
report a clever method for using fl uorescence to monitor DNA replication in living cells, 
along with methods for introducing other fl uorescently labeled proteins into these embryos. 

 Protein phosphorylation regulates the activity of many signaling molecules, in both a 
positive and negative fashion. As more is learned about developmental mechanisms, it is 
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becoming clear that the phosphorylation state of these signaling proteins is critical for their 
function. In Chapter   16    , Jose Escalona and Stephen Stricker detail methods for an 
 immunoblotting method to quantifi ably analyze protein phosphorylation changes in 
nemertean oocytes during maturation. These methods can be easily adapted for use in 
other oocytes or cell types. One big advantage to the method described is that it is fi lm 
based and, as such, will be useful in a wide variety of situations, including when working at 
marine laboratories. 

 In Chapter   17    , Aditya Sethi, Robert Angerer, and Lynne Angerer detail methods for 
the analysis of gene regulatory networks during development in the sea urchin using mul-
ticolor fl uorescent in situ hybridization ( FISH ) combined with immunohistochemistry. 
These techniques will allow spatial and temporal resolution of gene expression changes in 
whole embryos. Julio Harvey outlines a very practical application of a DNA hybridization 
assay in Chapter   18     to identify specifi c organisms from environmental water samples. This 
protocol, called the sandwich hybridization method, makes use of two different DNA 
probes—one to capture the target and the other for identifi cation. This separation allows 
for an increased signal-to-noise ratio and it also allows for quantifi cation in the described 
microarray format. 

 As mentioned above, the sea urchin has proven to be a perfect model system for the 
study of fertilization. In recent years, tremendous progress has been made in identifying 
components of the fertilization pathway and to understand the mechanism of the initial 
activation event. Chapter   19     by Michelle Roux and Kathy Foltz takes this analysis to the 
next level by describing methods for the analysis of either individual signaling molecules or 
global signaling pathways at fertilization in the sea urchin system. Because of the develop-
ment of the sea urchin genome project ( see  Chapter   20     in this volume), modern genomic 
and proteomic methods can be applied to this fundamental biological problem. This chap-
ter does a fantastic job introducing the promise and the potential problems that can be 
encountered when beginning such a research program. Chapter   20     details bioinformatic 
methods for effi cient use of the sea urchin genome data. Andrew Cameron takes us through 
SpBase, the home of the Sea Urchin Genome Database. From this starting point, the pro-
teins, genes, and genome data can be analyzed using a variety of publicly available software 
programs. The possibilities are tremendous and available for all to take advantage. 

 The super-versatile starfi sh oocyte system is utilized in Chapter   21     by Eiichi Okumura, 
Masatoshi Hara, and Takeo Kishimoto. They describe methods for the preparation of anti-
bodies for use as specifi c inhibitors in the oocyte (and even in the nucleus). The protocol 
details each step of the way, from designing and producing the antigen, to immunizing the 
animals and purifying the antibodies by affi nity chromatography to the microinjection pro-
cess. This is a remarkably comprehensive chapter and will prove very useful for labs looking 
to design a project from start to fi nish to understand the function of a specifi c protein. In 
our fi nal chapter, Tetsuo Kida, Shinjiro Matsuda, Atsushi Kuyama, and Tetsuo Toraya 
describe a method for identifying the 1-methyladenine receptor using photoaffi nity label-
ing. The chapter also details their progress in the identifi cation of a promising target for the 
long-sought-after 1-MA receptor. 

    Melbourne ,  FL ,  USA       David J.     Carroll      
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    Chapter 1   

 Culturing Larvae of Marine Invertebrates 

           Richard     R.     Strathmann    

    Abstract 

   Larvae of marine invertebrates cultured in the laboratory experience conditions that they do not encounter 
in nature, but development and survival to metamorphic competence can be obtained in such cultures. 
This protocol emphasizes simple methods suitable for a wide variety of larvae. Culturing larvae requires 
seawater of adequate quality and temperature within the tolerated range. Beyond that, feeding larvae 
require appropriate food, but a few kinds of algae and animals are suffi cient as food for diverse larvae. 
Nontoxic materials include glass, many plastics, hot-melt glue, and some solvents, once evaporated. 
Cleaners that do not leave toxic residues after rinsing include dilute hydrochloric or acetic acid, sodium 
hypochlorite (commercial bleach), and ethanol. Materials that can leave toxic residues, such as formalde-
hyde, glutaraldehyde, detergents, and hand lotions, should be avoided, especially with batch cultures that 
lack continuously renewed water. Reverse fi ltration can be used to change water gently at varying frequen-
cies, depending on temperature and the kinds of food that are provided. Bacterial growth can be limited 
by antibiotics, but antibiotics are often unnecessary. Survival and growth are increased by low concentra-
tions of larvae and stirring of large or dense cultures. One method of stirring large numbers of containers 
is a rack of motor-driven paddles. Most of the methods and materials are inexpensive and portable. 
If necessary, a room within a few hours of the sea could be temporarily equipped for larval culture.  

  Key words     Algal medium  ,   Antibiotics  ,   Culture  ,   Food  ,   Larvae  ,   Seawater  ,   Stirring  ,   Temperature  , 
  Toxic  ,   Vital stain  

1      Introduction 

 A great variety of marine animals can be reared from embryo to 
metamorphic competence if the seawater (SW) is of suffi cient qual-
ity and the temperature within the tolerated range. Different foods 
are best for different larvae, but a few species of easily cultured 
algae suffi ce for larvae of many taxa. Much is learned from larvae 
reared in the laboratory, but conditions in laboratory cultures are 
unlike conditions in the sea. The embryos and larvae in laboratory 
culture are at much greater densities than in nature [ 1 ], without 
the usual complement of other plankton and with differing dis-
solved organic compounds, light, and motion of water. Food, 
sometimes interacting with temperature, is known to affect the 
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form, size, and organic composition of larvae and the postlarval 
juveniles subsequently formed [ 2 – 6 ]. Absence of predators in cul-
tures can also limit the range of forms because predators affect 
form or size of some larvae [ 7 ]. Natural and artifi cial seawaters 
differ in dissolved materials, which can affect larval development. 
Thus, larvae and postlarval juveniles reared in the laboratory can 
differ from those encountered in nature. Whether the differences 
are trivial or important for interpretation of results depends on the 
question being asked. 

 This protocol emphasizes simple methods suitable for a wide 
variety of marine invertebrate larvae that are heavier than SW and 
either eat phytoplankton or do not require food. The methods are 
adequate for rearing hundreds to a few thousands of individuals to 
metamorphic competence. Some variations for rearing one or a 
few larvae per container and for rearing larvae that are buoyant, 
hydrophobic, or eat larger prey are also described. Access to SW of 
good quality (from a location within a few hours of the sea) is 
assumed, though artifi cial seawaters have been adequate for some 
larvae. Materials and Methods are listed for several different pur-
poses so that subsets can be chosen for particular needs. 

 Almost all described methods are for batch cultures with peri-
odic water changes. Marine larvae and the reasons for culturing 
them are much too diverse for a single protocol to cover all useful 
methods. Additional information is in guides and protocols that 
focus on culture of diverse larvae [ 8 ], echinoids [ 9 ], and algae 
[ 10 ]. The web provides useful information on both methods and 
supplies. A literature search often uncovers methods best suited to 
a particular kind of larva. Although some general suggestions for 
inducing metamorphosis are offered, methods for starting cultures 
from gametes and fertilization [ 8 ] and for inducing metamorpho-
sis of competent larvae differ greatly among taxa and are both 
beyond the scope of this protocol and described elsewhere.  

2    Materials 

 Solutions should be made with deionized or glass distilled water. 
Water deionized by reverse osmosis (RO water) does not need to 
be at the highest level of purity. If these are lacking, other freshwa-
ter of high quality can be tried. Rinsing containers and stirrers with 
distilled or RO water avoids residues from tap water. 

 Some tools, such as saw, drill, and hot-melt glue gun, will be 
needed to construct a stirring frame or container for hatching 
 Artemia . A glass scoring tool (stylus tipped with a substance harder 
than glass) is useful for breaking glass tubes. Some common labo-
ratory supplies are not specifi ed separately as materials. 

Richard R. Strathmann
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  Choice among the following depends on total volume of SW, 
number of replicate containers, and whether there are numerous or 
single larvae per container ( see   Notes 1 – 3 ).

    1.    Glass jars of 3–4-liter (~1 gal) volume.   
   2.    Glass dishes of a bit more than 100 ml volume with sloping 

sides (such as custard dishes from Corning or others).   
   3.    Shot glasses.   
   4.    Plastic multiwell culture plates (Falcon™) with 6, 12, or 24 

wells, petri dishes, or (as a substitute) plastic ice cube trays.   
   5.    125- and 500-ml Erlenmeyer fl asks for algal cultures ( see   Note 4 ).   
   6.    Aluminum foil or (if using a microwave oven) glass beakers, 

paper, or heat-resistant plastic as caps for fl asks.    

    Although it is possible to change the water frequently and rear 
sparsely populated cultures without a stirrer, many cultures require 
stirring. Described below are three possible methods of stirring—
paddle stirring, aeration, and shaking.

    1.    Paddle stirrer for up to 18 large jars: components for a paddle 
stirrer are listed in 1a–e; assembly instructions are given in 1f 
(a smaller stirrer is depicted in Fig.  1 ) ( see   Note 5 ).
     (a)    Fixed frame: ~5.2 m (~17 ft) of pipe of ~25-mm (~1 in.) 

outer diameter (OD) for a frame of outer dimensions 
~100 cm long, 60 cm wide, and 46 cm height 
(~40 × 23 × 18 in.) with a pipe ~15 cm (6 in.) long to hold 
the motor; 5 T-joints and 4 corner joints that fi t the pipe; 
4 screws longer than the pipe OD to prevent rotation of 
the T-joint and pipe at the end of the frame that supports 
the motor.   

   (b)    Swinging frame: ~3 m (~10 ft) of pipe of ≤22-mm 
(≤7/8 in.) OD for a frame of ~94 × 50 cm (37 × 19.75 in.), 
four corner joints that fi t the pipe.   

   (c)    String: ~9 m (30 ft) (for six rows of string on the fi xed 
frame to support paddles and six rows of string on the 
swinging frame to push paddles, with enough extra string 
to tie ends through holes in the frames); also string to 
hang the swinging frame below the fi xed frame with dis-
tance of ~15 cm (~6 in.) at each corner.   

   (d)    A small electric stirring motor, 6–10 rpm, with holes in its 
casing for mounting; two bolts with nuts of the diameter 
and length needed to mount the motor; acrylic sheet (or 
any rigid durable light material that can be drilled and 
sawed) of ~6 × 10 cm and ~0.3 cm (~1/8 in.) thickness for 
mounting the motor; two bolts with nuts for attaching 

2.1  Culture 
Containers

2.2  Stirrers 
for Cultures

Culture of Marine Invertebrate Larvae
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  Fig. 1    Frame, motor, and paddles for stirring numerous cultures:  ec  arm for eccen-
tric attachment for string that pulls the moving frame,  ff  fi xed frame,  sf  swinging 
frame,  m  motor,  mm  motor mount,  pb  paddle blade,  ph  paddle handle,  s  string       

 

Richard R. Strathmann
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acrylic sheet to PVC pipe; pieces of acrylic for constructing 
an arm of ~3 × 8 cm mounted to the motor’s shaft for 
eccentric attachment of the string that pulls the swinging 
frame; one bolt as a set screw for attaching the eccentric 
arm to the motor shaft.   

   (e)    Paddles: an acrylic sheet (Plexiglass) ~0.3 cm (~1/8 in.) 
thick with an area of about 1,000 cm 2  (0.12 yd 2 ) for 20 
paddle blades, each ~8 × 6 cm (~3 × 2 in.), and an acrylic 
sheet ~0.7 cm (~0.25 in.) thick and ~1,700 cm 2  (~0.2 yd 2 ) 
for 20 paddle shafts, each ~48 cm (~19 in.) long and 
~1.6 × 0.7 cm (~5/8 × 1/4 in.) in cross section.   

   (f)    Assembly instructions for paddle stirrer: drill holes along 
the pipes for each side of the fi xed frame for strings for 
hanging paddles. Spaces between holes (and strings) 
should allow room for rows of culture containers along the 
strings, though if jars are offset, the space between strings 
can be less than the diameter of the jars. Drill holes in the 
pipes for each side of the swinging frame for strings at the 
same interval. These strings push the paddles. Friction is 
suffi cient for all joints of the assembled frames except for 
the end of the fi xed frame that holds the motor mount. 
At the end of the fi xed frame at which the motor is 
mounted, drill holes through each end of the T-connector 
and pipes at the middle and through the two connectors 
and the pipes at each corner for four screws that prevent 
rotation of the T-connector and end pipes under the 
weight of the motor. Tie strings taut across the fi xed frame 
and the swinging frame. Tie four strings to hang the swing-
ing frame from the fi xed frame, near the ends on each side. 

 After cutting shafts and blades, fasten the blade to 
shaft with chloroform, which dissolves and fuses the 
acrylic and then evaporates. Make blades small enough to 
traverse most of the width of the culture vessel without 
hitting the sides but large enough for stirring. A large 
volume of water should move slowly near the bottom of 
the culture vessel. Cut a series of notches for suspension of 
each paddle from the string on the fi xed frame. Several 
notches will allow adjustment of height of the paddle 
blade above the bottom of the vessel. 

 Drill holes for mounting the motor near one end of 
the small sheet of acrylic plastic or other rigid material. 
The drilled holes should match the holes in the motor 
housing and also include a hole for the shaft of the motor. 
Insert the other end of the sheet into a slot cut in the PVC 
pipe extending from the T-connector and fi x it in place 
with bolts through two holes drilled through pipe and 
acrylic sheet. Fix the motor to the acrylic sheet by bolts 

Culture of Marine Invertebrate Larvae
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through the drilled holes. From pieces of acrylic, fashion a 
rotating arm that at one end is fi xed to the motor’s shaft 
by a setscrew (possibly reinforced with glue but not hot-
melt glue) and that at the other end has a place for a loop 
of string. Form a loose loop at the end of the string at the 
rotating arm and tie the other end of the string to the end 
of the swinging frame. Tape the string at the swinging 
frame to prevent the loop from slipping along the pipe. 

 When the frame is assembled, adjust the distance that 
paddles swing by adjusting the length of the string 
connecting the rotating arm to the swinging frame and by 
adjusting the lengths of the strings connecting the 
swinging frame to the fi xed frame.    

      2.    Stirring with air bubbles: aquarium air pump, fl exible tubing, 
gang valves to adjust airfl ow, cotton for a fi lter in the tube 
between pump and gang valves, and glass tubes or pipettes for 
ends in the cultures.   

   3.    Stirring by shaking of multiwell plates: shaker table for rotation 
at 40–60 rpm [ 9 ]. If the shaker becomes warm, use a sheet of 
insulating polystyrene foam plastic between the cultures and 
shaker.      

       1.    If possible, obtain SW that is at least as clean as the water 
where the larvae are found in nature. SW from bays with ports, 
marinas, or city or industrial runoff may be contaminated with 
toxic materials ( see   Note 6 ).   

   2.    Large plastic containers with plastic screw caps for collecting SW.   
   3.    Thermometer, for checking adequacy of temperature control 

and for estimates of development rates ( see   Note 7 ).   
   4.    Refractometer for approximate estimates of salinity with units 

for salinity (ppt). Needed if salinity of the source SW varies 
and is sometimes lower than that tolerated by the larvae.   

   5.    Artifi cial seawaters have been used to rear larvae with varying 
success, usually less successfully than with natural SW. 
Commercially available artifi cial seawaters include Crystal Sea 
Marinemix, Instant Ocean, Coralife, and Tropic Marin, Petco. 
Alternatively MBL general purpose artifi cial SW with trace 
metals can be mixed as follows with distilled or RO water for 
all solutions ([ 11 ],  see   Note 8 ): 24.72 g NaCl, 9 ml of 1 M 
KCl, 9.27 ml of 1 M CaCl 2 ⋅2H 2 O, 22.94 ml of 1 M 
MgCl 2 ⋅6H 2 O, 25.5 ml of 1 M MgSO 4 ⋅7H 2 O, 2.15 ml of 1 M 
NaHCO 3  in a 1-l fl ask. Add the NaHCO 3  after the solution is 
almost to the liter volume and, if sterilizing, after autoclaving. 
Bring solution to fi nal 1 l volume. For larval culture, include 
trace metals [ 9 ], as in the MBL trace solution SW formula 
[ 11 ]: use same recipe as above but with only 8.27 ml of the 

2.3  Seawater 
Solutions

Richard R. Strathmann
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1 M KCl and 0.089 g KBr per liter; 0.003 g NaF per liter; 
0.037 g SrCl 2 ⋅6H 2 O per liter; and 0.024 g H 3 BO 3  per liter. 
The MBL artifi cial SW can be adjusted to pH 8. TRIS buffer 
is commonly used but may harm some larvae.      

   Choice of fi lters is a matter of need, cost, and convenience. Coarse 
fi ltration is often suffi cient, but removal of small particles is useful 
when one must increase consistency in food supply by minimizing 
contaminating organisms or when one is culturing larvae removed 
from capsules at early stages.

    1.    Micropore membrane fi lters of cellulose nitrate/acetate, com-
monly 0.22- or 0.45-μm nominal pore size and 47 mm diam-
eter (as from Corning, Gelman, Millipore). 

 Use an in-line fi lter holder if there is suffi cient upstream 
pressure from a SW system. If system pressure is low or if one 
is using stored SW, then use a suction fi lter apparatus: a vac-
uum pump, vacuum hose, and trap between fi lter apparatus 
and vacuum pump. The trap can be a fl ask with two-hole stop-
per with inlet and outlet tubes. Glycerin is a nontoxic lubricant 
for inserting glass tubes into rubber stoppers.   

   2.    Bag fi lters: polyester felt fi lters with nonmetal rings are avail-
able in nominal 1- to 10-μm pore sizes, though particles larger 
than that can pass (from McMaster Carr or other suppliers).   

   3.    Paper fi lters and funnel: many paper fi lters are adequate, 
including coffee fi lters.   

   4.    Mesh fi lters: nylon screens (Nitex mesh, as used for plankton 
nets) with 30–200-μm mesh openings. Remove the bottoms 
from plastic beakers or other containers and attach mesh with 
hot-melt glue. A 30-μm mesh excludes most multicellular ani-
mals and transmits organisms of sizes eaten by many larvae. 
Larger meshes that are still substantially smaller than the larvae 
allow water changes by reverse fi ltration ( see  Subheading  2.10 ). 
Use a beaker of ≥400 ml for fi ltering SW for cultures. Use a 
beaker that fi ts within the culture vessel for reverse fi ltration: a 
beaker of ~50 ml fi ts into 100 ml in a custard dish, of ~150 ml 
can be lowered into a large jar.   

   5.    Flexible tubing as a siphon for removing large volumes in 
reverse fi ltration.   

   6.    A turkey baster for removing volumes of a few hundred ml 
( see   Note 9 ).      

      1.    Plastic fi ber scrubbing pad (without detergent) for glass cul-
ture containers and paddles.   

   2.    Bottle brush for Erlenmeyer fl asks.   
   3.    RO or distilled water for rinse following tap water and before 

air drying and storage ( see   Note s  1 ,  2 , and  10 ).      

2.4  Seawater Filters

2.5  Glassware 
Cleaners

Culture of Marine Invertebrate Larvae
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      1.    Autoclave.   
   2.    If an autoclave is unavailable or inconvenient, then a hot plate, 

stove top, or microwave oven can be used ( see   Note 11 ).      

  Antibiotics are usually unnecessary but are helpful when embryos 
or larvae are removed from egg capsules at early stages. Streptomycin 
and penicillin are often used in combination.

    1.    Streptomycin (dihydrostreptomycin) at 50 mg/l [ 9 ] or 
50–200 mg/l [ 8 ].   

   2.    Penicillin at 50 mg/l or ~100 U/ml [ 9 ] or 25–150 mg/l [ 8 ].   
   3.    Gentamicin at 40 mg/l [ 12 ].      

        1.    Algal species commonly used for larvae that capture small par-
ticles include  Isochrysis galbana, Pavlova lutheri, Rhodomonas 
lens, Skeletonema costatum, Chaetoceros gracilis ,  Dunaliella 
tertiolecta, and Nannochloropsis oculata  ( see   Note 12 ).   

   2.    f/2 enrichment medium for algal cultures ( see   Note 13 ): to 
make the f/2 enrichment from one’s own stock solutions 
[ 10 ], add to 950 ml of fi ltered SW the following components 
using specifi ed stock solutions dissolved in distilled or RO 
water: 1 ml of 75 g/l stock solution of NaNO 3 , 1 ml of 5 g/l 
stock solution of NaH 2 PO 4 ⋅H 2 O, 1 ml of 30 g/l stock solu-
tion of Na 2 SiO 3 ⋅9H 2 O, 1 ml of trace metal solution [into 
950 ml of distilled or RO water, dissolve the following compo-
nents: 3.15 g FeCl 3 ⋅H 2 O, 4.36 g Na 2 EDTA⋅2H 2 O, 1 ml of 
180 g/l stock solution of MnCl 2 ⋅4H 2 O, 1 ml of 22 g/l stock 
solution of ZnSO 4 ⋅7H 2 O, 1 ml of 10 g/l stock solution of 
CoCl 2 ⋅7H 2 O, 1 ml of 9.8 g/l stock solution of CuSO 4 ⋅5H 2 O, 
1 ml of 6.3 g/l stock solution of Na 2 MoO 4 ⋅2H 2 O; bring total 
volume to 1 l], 0.5 ml of a vitamin solution [into 950 ml of 
distilled or RO water, dissolve the 200 mg thiamine⋅HCl, 1 ml 
of 1 g/l stock solution of biotin (vitamin H), 1 ml 1 g/l stock 
solution of cyanocobalamin (vitamin B 12 ); bring to 1 l volume 
with distilled or RO water and store frozen in quantities con-
venient for thawing and use]. Bring total volume of f/2 
medium to 1 l with more fi ltered SW and sterilize. Omit the 
silica for algae that do not require it for their skeletons or when 
growing algae with SW rich in silica.   

   3.    Centrifuge capable of up to ~3,000 ×  g : for separating algal 
cells from their culture medium.   

   4.    Hemacytometer with Neubauer rulings: for cell counting.   
   5.    Lugol’s fi xative for fi xing algal cells: dissolve 2 g potassium 

iodide and 1 g iodine in 100 ml distilled water. Other recipes 
maintain this ratio of solutes but with greater or less concen-
tration in water. Some add acetic acid or sodium acetate. 
Presumably all are suffi cient to fi x algal cells for counting.      

2.6  Sterilization 
of Solutions

2.7  Antibiotics

2.8  Food for Larvae 
That Eat Algae

Richard R. Strathmann



9

      1.     Artemia  cysts (from aquarium shop, mariculture supply, or 
biological supply). To hatch  Artemia  cysts, use the following: 
aquarium pump with tubing, container with tube entering 
bottom for air bubbling, and aquarium heater (or warm 
room). An inverted plastic jug with stopper with tube for air 
hose inlet at the narrow bottom (formerly the top) and its 
former bottom removed is cheap; a separatory funnel with air 
entering the bottom outlet is convenient; an air stone in any 
nontoxic container with narrow bottom is suffi cient. To sepa-
rate hatched  Artemia  nauplii from debris: a fi ber-optic or 
other light that can be directed at a small area. Alternatively, 
an opaque container with hole drilled in its side, placed inside 
an outer transparent container. The opaque container can be 
constructed from any completely opaque nontoxic material 
that can be drilled. Because the  Artemia  nauplii are hardy, the 
inner container can also be made opaque by covering it with 
black tape. Algae (cultured as described above) can be used for 
feeding  Artemia  nauplii, if daily hatching is inconvenient.   

   2.    The rotifer  Brachionus plicatilis  has been used to feed those 
zoea larvae of crustaceans and fi sh larvae that need smaller 
prey. Obtain from aquarium or mariculture supplier.  I. gal-
bana ,  N. oculata , or other algae rich in appropriate highly 
unsaturated fatty acids can be used to feed the rotifers.   

   3.    Natural plankton: use a plastic bucket or large plastic bottle in 
conjunction with nylon (Nitex) mesh fi lters of mesh sizes that 
retain desired plankton and eliminate others. Cut away the 
bottom of ≥200-ml plastic beakers and replace it with Nitex 
attached with hot-melt glue.   

   4.    Other foods: suppliers for mariculture and aquarists sell foods 
like Instant Algae ®  (killed algae of several species) that are 
appropriate for rotifers,  Artemia , and possibly some marine 
larvae.      

       1.    For changing seawater in 3 l jars by reverse fi ltration, construct 
Nitex fi lters on a beaker of ~400 ml as described in 
Subheading  2.4 ,  item 4 , and attach a cable tie or other plastic 
handle for lowering the fi lter into the jar; use in conjunction 
with Tygon ®  or other nontoxic tubing for siphoning.   

   2.    For changing smaller volumes (e.g., custard dishes) by reverse 
fi ltration, use a Nitex fi lter on a beaker of ~50 ml in conjunc-
tion with a turkey baster.   

   3.    For removing individual larvae: Pasteur pipettes with latex or 
other bulbs ( see   Note 14 ). A Bogorov tray can aid the search 
for larvae ( see  Fig.  2 ).

2.9  Food for Larvae 
That Eat Small 
Animals

2.10  Changing 
Seawater in Larval 
Cultures

Culture of Marine Invertebrate Larvae
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             1.    Microscope slides, cover glasses, and Plasticine (modeling clay).   
   2.    If it is necessary to break microscope slides, pipettes, or glass 

tubing, use a tool for scoring the glass prior to breaking 
( see   Note 14 ).       

3    Methods 

  Stir cultures by swinging paddles, rotating paddles, aeration, or 
placing cultures on a rotating platform ( see   Note 5 ). Low densities 
of larvae permit fast and normal development with fewer failures, 
with densities depending on the size of the larvae. For sea urchin 
larvae, densities of ~1 ml −1  are suffi ciently low at early stages; densi-
ties of ~0.1 ml −1  are better and suffi ciently low at advanced stages. 
Larval body volume, biomass, metabolic rate, and maximum clear-
ance rate (volume of water cleared of food per time) are indications 
of suitable larval densities.  

2.11  Handling 
and Observing 
Individual Larvae

3.1  Stirring Cultures

  Fig. 2    Bogorov tray in two views. Ruler for scale is in cm and mm       

 

Richard R. Strathmann
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      1.    With few exceptions (e.g., multiwell tissue culture plates and 
disposable pipette tips), rinse new containers, paddles, and 
 fi lters with RO water or fi ltered SW.   

   2.    After use, scrub culture vessels, paddles, or other materials 
with a plastic fi ber scrubber (without detergent) in tap water. 
Then rinse twice with RO (reverse osmosis) or distilled water 
before air drying. Unless there is contamination from dust, 
materials rinsed and air dried in this way can be used directly 
without more rinsing ( see   Note 10 ). If distilled or RO water is 
unavailable, materials can be rinsed with fi ltered SW before 
use. Also, some tap water is an adequate rinse for some larvae.      

      1.    SW of high quality from a non-contaminated source ( see   Note 6 ) 
may change as it passes through the pipes of a SW system. Low 
pH of SW exiting from a system of pipes is expected, has not 
been reported as a problem for larval culture, and can be rem-
edied by aeration or other stirring. A change in suspended 
particles is expected and can be remedied by fi ltration.   

   2.    Water can be collected from the ocean and stored. If possible, 
collect away from shore. If possible, collect from below the sea 
surface to minimize material from surface slicks. Remove large 
particles with a bag or paper fi lter and store in a refrigerator.   

   3.    If using a commercial artifi cial SW, mix the dry product thor-
oughly before mixing a subsample with water. Check that 
adequate trace metals are included in the artifi cial SW. 
Artifi cial SW lacking adequate trace metals can be supple-
mented with f/2 trace elements, which include the chelator 
EDTA [ 9 ] ( see  Subheading  2.8 ,  item 2  and  Note 13 ). 
For the MBL artifi cial SW, use the version with trace metals 
( see  Subheading  2.3 ,  item 5 ).      

      1.    Remove unwanted particles by fi ltration. Coarse fi lters are 
often adequate. A 30- or 50-μm nylon mesh is suffi cient to 
remove predators and most animal eggs, while passing a vari-
ety of edible particles, but such coarse fi ltration may also 
necessitate more labor in cleaning cultures. A bag fi lter 
removes most particles greater than 10 μm. A paper fi lter is 
slower than a bag fi lter but satisfactory.   

   2.    Membrane fi lters help remove smaller particles and greatly 
reduce introduction of other organisms. Micropore fi lters with 
a 0.45-μm pore size are commonly used. Prefi lter SW with a 
fi ber prefi lter if the membrane fi lter clogs rapidly. With a SW 
system of suffi cient pressure, in-line fi lter holders for fi lters of 
47-mm diameter are convenient. Otherwise suction fi ltration 
is required. The low pressure associated with suction removes 
dissolved gases from solution, which then re-equilibrates. 

3.2  Cleaning 
Containers and 
Stirrers

3.3  Collecting 
Seawater

3.4  Filtering 
Seawater
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Because membrane fi lters may contain materials to enhance 
wetting, it is prudent to discard the fi rst water through the 
fi lter, especially when fi ltering a small total volume. Filtration 
removes most organisms but does not provide sterile SW.   

   3.    If culturing larvae that have been removed from capsules at 
early stages, fi lter SW with a 0.22-μm or 0.45-μm membrane 
fi lter and then sterilize or pasteurize. Sterilize in an autoclave at 
~120 °C for ~15 min or pasteurize by heating SW to 60 °C for 
20 min on a hot plate or stove top or heat in a microwave oven 
just to initiate boiling ( see   Note 11 ). Antibiotics may be needed.     

 For algal cultures, sterilize SW as above, after adding the 
enrichment medium. Autoclave fl asks containing the enriched SW 
medium at ~120 °C for ~15 min or microwave just to the point of 
boiling ( see   Notes 11  and  13 ).  

      1.    Control temperature if room temperature is not within the tol-
erated range of the larva or if development rates are needed. If 
available, an aquarium with a continuous fl ow from a SW sys-
tem can be used as a water bath, but comparisons of develop-
ment rates require more accurate temperatures, as with a cold 
room or a temperature-controlled water bath ( see   Note 7 ).   

   2.    If the source of SW for cultures is an estuary with varying 
salinity, use the refractometer to compare salinities to the 
salinities where the larvae occur ( see   Note 6 ).   

   3.    Ordinary room light of a wide range of intensities, spectra, 
and light/dark durations is usually adequate for the larvae. 
Light affects the behavior of some larvae and affects the 
growth of contaminating organisms and algae introduced as 
food. Alas, observations of larval development seldom include 
data on light.      

      1.    Change water more frequently at higher temperatures and at 
greater concentrations of larvae. A water change every 2 days 
at high temperatures (>20 °C) and less often (~twice a week) at 
low temperatures (~10–15 °C) is usually suffi cient. The balance 
between the desire for less variable culture conditions and aver-
sion to repetitive work decides the frequency of water changes. 
If growth at particular concentrations or kinds of food is being 
compared, frequent changes with renewed food may be neces-
sary even when larvae are at low density because algal concen-
trations change from causes other than larval grazing.   

   2.    Reverse fi ltration is rapid and suffi ciently gentle for most lar-
vae. Use a fi lter screen with mesh size substantially smaller 
than the larva but large enough to pass much of the debris. 
Use a siphon for cultures of large volume and a turkey baster 
for small ones.   

3.5  Adjusting 
Temperature, Salinity, 
and Light Regimes

3.6  Changing 
Seawater in Cultures
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   3.    Many mollusk veligers and some other larvae are unharmed if 
the culture is poured through a fi lter that is submersed in a bowl.   

   4.    Larvae that swim to light, swim upwards, or sink concentrate 
themselves, aiding transfers.   

   5.    In cultures maintained for weeks, aggregates of material larger 
than the mesh size will accumulate. If larvae do not separate 
themselves from debris by their swimming, concentrate the 
larvae by reverse fi ltration and then transfer them to clean SW 
with a pipette with an orifi ce larger than a larva ( see   Note 14 ). 
To remove all larvae from a volume of water without repeated 
searches of a dish, pour water into a Bogorov tray (Fig.  2 ) and 
scan along the troughs, taking care not to miss larvae under 
the meniscus at the edges of troughs.   

   6.    Change containers and paddles when they are visibly fouled or 
more often.      

      1.    A convenient medium for growing algae is f/2 in SW. It is 
easier to purchase the medium than to make it but useful to 
know what is in it ( see  Subheading  2.8 ,  item 2  and  Note 13 ). 
Filter SW. Add the enrichment to the SW before sterilization. 
The listed algae will grow well even after vitamins in the 
enrichment are lost from heating. Mix well, divide into 
Erlenmeyer fl asks, and cap each fl ask with a double layer of 
aluminum foil that extends a few cm down the neck of the 
fl ask. Autoclave enriched SW at ~120 °C for ~15 min. After 
capped fl asks are autoclaved, they can be stored for months at 
room temperature. If an autoclave is unavailable, heat in a 
microwave oven ( see   Note 11 ). For microwave heating, cover 
each fl ask with a glass beaker, paper, or heat-resistant plastic 
cap instead of aluminum foil.   

   2.    All of the algae listed in Materials grow at room temperatures 
(~17–22 °C). A window without intense sunlight is usually 
adequate. A fl uorescent light tube suspended about 20 cm 
from the algal cultures is more consistent. For slower growth, 
maintain stock cultures with fewer daily hours of light, at lower 
temperatures, or both. Culturing the cells on agar, with trans-
fers by a fl ame-sterilized metal inoculation loop, is also possible 
[ 10 ]. To promote algal growth, swirl fl asks every 1 or 2 days. 
Grow more food than needed and discard excess algal cultures 
rather than being caught short of food. Feed larvae with algae 
that are still growing. Algae that have depleted nutrients and 
slowed or ceased growth change composition. More frequent 
transfers of smaller food cultures provide food of more uni-
form quality than when feeding larvae from an aging algal cul-
ture of large volume. Look at change in color of algal cultures 
to see if they are still growing, nearly constant, or in decline. 
When  transferring algae to a new fl ask of medium, handle caps 

3.7  Providing Algae 
as Food for Larvae
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so that fi ngers do not touch the cap where it touches the fl ask’s 
opening or the fl ask near its opening. For faster growth, air 
bubble algal cultures with an aquarium air pump, a cotton 
plug as a fi lter in the air line, and a gang valve to distribute air 
to fl asks through multiple tubes. Do not air bubble stock cul-
tures because it increases risk of contamination.   

   3.    Add enough algae that the larvae have some algal cells in their 
guts, but do not overfeed. The SW should have little or no 
discernible color from the algae ( see   Note 15 ). 

 For a known ration, count algal cells per volume of sus-
pension and then add a volume of the suspension that gives 
the desired number of cells ml −1  in the larval culture. To avoid 
contamination from pipetting from the culture fl asks, pour 
some of the algal culture into a separate container. Mix by 
swirling, decant a subsample of a few ml into a vial, and add a 
drop of Lugol’s fi xative. (Killing is necessary before counting 
if the algae are motile.) Place the cover glass on the clean and 
dry hemacytometer, mix the vial with a Pasteur pipette, touch 
the tip of the pipette to the groove of the hemacytometer 
chamber, and release the liquid, immediately removing the 
pipette so that the chamber fi lls evenly with no overfl ow. Add 
fl uid to the chamber only once and do not overfi ll. The thick 
cover glass supplied with a Neubauer hemacytometer main-
tains a constant depth of the chamber of 0.1 mm. Each cham-
ber of a hemacytometer with Neubauer ruling is divided into 
nine squares, 1 mm on each side (Fig.  3 ). A count of one of 
the nine squares gives number of algal cells per 0.1 mm 3 . (Each 
of the 1-mm 2  squares is subdivided in a different way.) 

  Fig. 3    Neubauer ruling on hemacytometer, with 1-mm × 1-mm square indicated       
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Variation in counts for different fi llings of the chamber is high. 
Count from at least two separately fi lled chambers. A total of 
≥200 cells gives an approximate estimate of concentration. 
Count enough of the 1-mm 2  squares for an adequate count. 
Clean the hemacytometer with alcohol and wipe dry.

       4.    Because organic content of small algal cells is nearly in propor-
tion to volume, adjust numbers of cells added to cultures 
according to approximate volume. As examples, maximum 
ingestion for echinoid larvae with  R. lens  or  D. tertiolecta  
occurs at about 5,000–10,000 cells/ml [ 13 ]. For feeding with 
 R. lens  alone, 5,000 cells/ml should provide near maximal 
growth if the larvae are at low concentrations.  D. tertiolecta  is 
smaller than  R. lens , and  I. galbana  is about half the diameter 
of  D. tertiolecta . About 5,000 cells of  D. tertiolecta  ml −1  and 
40,000 cells of  I galbana  ml −1  should provide near maximal 
ingestion rates for many kinds of echinoderm larvae. Maximum 
ingestion for bivalve larvae with  I. galbana  occurs at about 
100,000–150,000 cells/ml [ 14 ]. For feeding with  I. galbana  
alone, that concentration is about right for many mollusk veli-
gers, or it could be offered as a 1:1 mix of  I. galbana  and other 
small algae, such as  C. gracilis ,  N. oculata , or  P. lutheri . For 
approximate estimates of algal density, determine the relation 
between optical density and cell concentrations for suspen-
sions of cells of each species used. The relationship does not 
give an accurate estimate of cell numbers because optical den-
sity changes with the state of the algae. When using two algal 
species as food, additions of similar total cell volumes from 
each species can be based on comparison of optical density by 
eye. It is often unnecessary to increase concentrations of food 
during larval growth and development ( see   Note 16 ).   

   5.    Examples of successful feeding: different larvae grow best with 
different foods. The algae listed in Materials are in common use, 
but other algal species are also good foods. Check the literature 
for foods that have been successfully used for the larvae being 
reared. Here are some suggestions. Although the maximum 
sizes of algal cells captured commonly increase as larvae grow, 
the minimum size changes little for many echinoderm and 
mollusk larvae. Thus, one size, adequate for the earliest stages, 
can be used throughout their development [ 15 ,  16 ].     

 Numerous algae have been suffi cient in combinations and sev-
eral when added as single species, though reported diets may have 
had different supplements from unknown contaminant organisms. 
For echinoderm larvae, try  R. lens  alone [ 17 ] or in combination 
with another alga or try a mixture of  D. tertiolecta  and  I. galbana  
(T-ISO) [ 3 ,  18 ,  19 ].  C. gracilis  [ 20 ] and  D. tertiolecta  have each 
been used alone, although  D. tertiolecta  is a poor single species diet 
for some larvae. Development of sand dollar larvae was faster with 
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a mixed diet of  I. galbana  and  D. tertiolecta  than with either alga 
alone [ 3 ,  18 ,  19 ]. 

 Molluscan veligers have been reared with  I. galbana  (usually 
T-ISO) alone or in combination with  C. gracilis ,  P. lutheri , or 
 N. oculata . Molluscan veligers capture small particles and small 
veligers do not ingest large particles. Large gastropod veligers have 
been reared with the larger cells of  Rhodomonas  sp. [ 21 ]. 

 A nemertean pilidium has been reared through metamorphosis 
with a  Rhodomonas  sp. alone. 

 Barnacle nauplii have been reared with  S. costatum  alone [ 4 ].  

  Larvae of some decapod crustaceans can be reared on  Artemia  
nauplii as their sole food; others require small prey [ 22 ] or require 
smaller prey at early stages and grow better with larger prey at later 
stages [ 23 ,  24 ]. Many small animals can serve as food. Rotifers are 
a small prey and  Artemia  nauplii a larger prey that are widely avail-
able from aquarium shops and mariculture suppliers ( see   Note 17 ).

    1.    Store  Artemia  cysts cool and dry in a tightly capped container. 
Wash cysts in fi ltered SW before use. Hatch at a density of 
~5 g of cysts per liter of water with illumination with a tem-
perature of ~20–30 °C (best at ~28 °C) in water heavily aer-
ated from below. The water can be SW of full salinity or SW 
somewhat reduced in salinity. Aerated SW should have a pH 
near the desired pH 8. Hatching is in ~2 days at 20 °C. 

 Attract hatched nauplii to light in a small part of the 
hatching chamber (after stopping aeration) to harvest them 
separately from unhatched cysts and hulls. If nested opaque 
and clear chambers are available for harvesting, shine the light 
at the hole in the inner opaque container so that the nauplii 
swim out into the surrounding container to be harvested as 
food. Because hatched nauplii rapidly deplete their nutrient 
reserves, they should be used within the day of hatching or be 
fed ( see   Note 17 ).   

   2.    The rotifer  Brachionus plicatilis  has been used as a smaller prey 
for some zoea larvae of decapod crustaceans and fi sh larvae [ 8 , 
 25 ]. Obtain from an aquarium store or mariculture supplier. 
Feed rotifers with    algae such as  I. galbana  and  N. oculata,  and 
transfer a portion of the culture to new water and containers 
at intervals ( see   Note 17 ). The rotifers can be reared in dense 
cultures. For harvesting, separate rotifers from algae and debris 
and concentrate them by fi ltration, or they can be settled by 
adding distilled or RO water for 5–15 min and then resus-
pended in fi ltered SW before use as food.   

   3.    Natural plankton as food: for algal cells, collect SW in a large 
bottle, held beneath the water’s surface. Pour the water through 
a mesh of ~30 μm and use it as the SW for larval culture. Collect 
zooplankton with a plankton net. After collection, resuspend 

3.8  Providing 
Animals and Natural 
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the concentrated plankton in a larger volume of SW to reduce 
mortality. Large plankton can be eliminated by pouring the 
sample through a mesh that passes desired prey. If necessary, 
smaller plankton can be eliminated by reverse fi ltration.    

        1.    Larvae that fl oat at the surface are often fragile. Ruptured 
embryos or larvae produce a slick of decaying material, and 
the fl oating larvae must be provided with clean SW. Although 
culture in still water has succeeded, improvements are 
 mesh- bottomed beakers suspended in a SW aquarium with con-
tinuously renewed water [ 26 ,  27 ] or in similar  bottomless bea-
kers and aquarium with a drip of fi ltered SW from above [ 28 ].   

   2.    Hydrophobic larvae, such as opisthobranch veligers and 
 rhizocephalan nauplii, become caught in the surface fi lm. 
One remedy is sprinkling fl akes of cetyl alcohol on the surface 
of the culture [ 8 ,  29 ]. Another remedy is a drip to the surface 
of a culture [ 27 ], which can be achieved with air bubbled to 
one arm of a Y-tube that lifts water from an outer beaker 
and drips it onto the surface of a culture in an inner mesh-
bottomed beaker [ 8 ]. Yet another remedy is to eliminate the 
air-water interface by sealing larvae and their food within 
bottles that are then rotated on a roller; continuous light was 
provided and oxygen did not decline [ 30 ]. A plankton wheel, 
to which capped containers are strapped and then rotated at 
~1–2 rpm around the wheel’s axis, might also suffi ce to keep 
larvae and algae suspended in containers without an air-water 
interface.      

      1.    Keep track of development by removing a sample of larvae. 
Observing larvae in a dish under a dissecting microscope mini-
mizes stress but precludes close observation ( see   Note 18 ). For 
observations with a compound microscope, avoid crushing lar-
vae under the cover glass by supporting the cover glasses with 
a small quantity of Plasticine (modeling clay) at each corner. 
Some larvae can be entrapped by compression of the Plasticine 
supports until the larvae are touched by cover glass and slide.   

   2.    To aid observations of living larvae, the following anesthetics 
can be used for reversibly reducing larval motility [ 8 ]: isos-
motic MgCl 2  (0.33 M) mixed ~1:1 with SW relaxes muscles of 
many kinds of larvae without permanent damage but does not 
prevent swimming of some ciliated larvae; chloretone, a few 
drops of 1 part saturated aqueous solution and 2 parts SW 
added to the water; MS-222, fi nal concentration of ~0.5 mg/ml 
in SW (store the stock solution in the dark; ineffective if it 
turns yellow); propylene phenoxytol, stock solution 1.5 % in 
distilled or RO water, refrigerated, >100× dilution in SW to 
anesthetize larvae.   

3.9  Culturing 
Buoyant or 
Hydrophobic Larvae

3.10  Observing 
Larval Condition 
During Rearing
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   3.    If sampling is to be done without returning larvae to the cul-
ture, larvae can be slowed with polyethylene oxide of ~5 × 10 6  
molecular weight, added as a powder to the microscope slide, 
or killed by ethanol or a fi xative, but replacement of the larvae 
following observation is often necessary when checking sparse 
cultures of larvae. Some larvae can be immobilized by very 
slight compression from the supported cover glass or entrapped 
in a cul-de-sac formed by slivers of glass or other materials 
under the cover glass.   

   4.    Vital stains can be used to distinguish between larvae sub-
jected to different initial treatments and then reared in the 
same container [ 8 ,  31 ]. For echinoderm larvae and some oth-
ers, incubate 5–20 min in SW with 5 ppm of neutral red; Nile 
blue sulfate can be used similarly if two stains are needed [ 32 ]. 
Extent of adverse effects has varied. To control for staining 
effects, reverse staining between treatments, with replicates for 
each stain-treatment combination. Alternatively, calcium car-
bonate shells and skeletons can be marked with fl uorescent 
stains (tetracycline or calcein) that also mark a growth line at 
the time of staining. Bivalve larvae were stained with calcein at 
50 and 100 ppm for 2 and 3 days [ 33 ].      

  Stimuli differ among species and include materials from conspecif-
ics, prey, and substrata [ 34 ].

    1.    Because bacterial exopolymers stimulate settlement of many 
larvae [ 35 ], a dish left in an aquarium can acquire a biofi lm 
that may induce settlement.   

   2.    Water fl ow and surface topography also affect settlement [ 36 ].   
   3.    An elevated concentration of potassium ions induces meta-

morphosis of larvae of several phyla, but the effective concen-
trations (between ~10 and 30 mM excess K + ) differ among 
species [ 37 ].    

4       Notes 

     1.    Many materials are generally nontoxic when used in larval cul-
ture :  polyethylene and Tygon ®  tubing, polyethylene contain-
ers (and many other plastic containers), acrylic plastic 
(including acrylic plastic joined by chloroform as solvent, after 
the chloroform evaporates), PVC (as in SW systems, after con-
tinuous fl ow has removed solvents or catalysts), hot-melt glue, 
clear silicone glue (after the acetic acid evaporates), nylon 
plankton netting, bag fi lters, membrane fi lters, glass fi lters, 
most paper fi lters (including coffee fi lters), membrane fi lters, 
parafi lm, and plastic wrap as covers. 

3.11  Stimuli That 
Induce Metamorphosis
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 Advantages of glass containers include weight-related sta-
bility, durability with repeated scrubbing, and high melting 
point (if heat sterilization is necessary). Advantages of plastic 
are low cost and light weight for transport. 

 Rinse most new containers, tubing, and fi lters before use 
because of the possibility of toxic residues from the factory or 
storage. Exceptions are materials like disposable pipette tips 
and multiwell culture plates. 

 Glassware and other materials for cultures can be specially 
labeled (as with an “E” for embryological). If glassware is con-
taminated, special cleaning is required, or the “E” should be 
removed and it should placed with non-“E” stock.   

   2.    Many materials are often toxic, especially if residing in batch 
cultures: latex tubing, black rubber tubing, black rubber stop-
pers, some heavy metals in solution, and some metal objects. 
Also, potentially toxic are containers with a residue of forma-
lin, glutaraldehyde, osmium tetroxide, or detergents from pre-
vious uses. 

 Where most materials are for culture of embryos, glass-
ware that may have toxic residues because of exposure to toxic 
materials can be specially marked (as with an “X”). Avoidance 
of other potential sources of toxicity: 

 When in doubt and especially when fi ltering a small volume 
of water, discard the fi rst water through a fi lter. 

 Clothespins with a piece of labeled tape attached are con-
venient for labeling cultures, but check that metal parts are not 
corroded. Corroded metal could be shed into the culture. 

 Avoid hand lotions. 
 An air stream used for stirring can introduce noxious mate-

rials with dust. A cotton plug should be inserted in air lines 
between the aquarium air pump and the cultures. A strong air 
stream from room ventilation may blow noxious materials into 
open cultures. If that appears to be a problem, cover cultures 
with a sheet of clean plastic.   

   3.    Large jars permit automated stirring of ~2 l of water by a pad-
dle, with 100 or more larvae per jar. Searching for larvae cul-
tured as single individuals is aided by rearing them in dishes 
with sloping sides that fi t under a dissecting microscope. 
Custard dishes containing ≥100 ml of SW are large enough 
for automated stirring by a paddle. Shot glasses are useful for 
individual larvae but not large enough for paddle stirring. 
Multiwell culture plates (Falcon™) are convenient for single 
larvae. They are usually used without stirring, though  multiwell 
plates can be rotated on a shaker at 40–60 rpm [ 9 ].   

   4.    A 125-ml Erlenmeyer fl ask is convenient for continuing stock 
cultures in ~50 ml of water. A 500-ml fl ask is convenient for 
growing food for larvae in ~200 ml of water. The low water 
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level gives a greater surface for gas exchange. Flasks for food 
can contain a greater volume of water if aerated. 

 Aluminum foil is a convenient cap when sterilization is by 
autoclave or by pasteurization with a hot plate but cannot be 
used with a microwave oven.   

   5.    The protocol gives dimensions of a stirring frame and paddles 
of dimensions for large jars, but dimensions can be altered to 
fi t the space and containers used for culture. In contrast, the 
smaller stirrer in Fig.  1  (with PVC pipe of smaller diameter) 
was made for custard dishes holding 100 ml of water and one 
or few larvae per dish. 

 PVC plumbing pipe and joints make a frame that can be 
disassembled for transport. Cut legs of the fi xed frame long 
enough and hang the swinging frame low enough that the 
swinging frame pushes each paddle across the width of a cul-
ture container. The swinging frame must clear the legs of the 
fi xed frame and clear the top of culture jars. 

 The motor can be quite lightweight because little force is 
required. Supporting the motor on an extension from the stir-
ring rack makes positioning of the motor relative to the stir-
ring frame easier. String is the lightest and most convenient 
way to support and push paddles, support the swinging frame, 
and join the eccentric attachment on the motor to the stirring 
frame. The motor pulls the frame forward and gravity moves 
the frame and paddles back. 

 Acrylic plastic sheets (Plexiglass) are a good material for 
paddles because they can be cut with a power saw and joined 
with chloroform, which dissolves the plastic, then evaporates 
without a residue. Hot-melt glue might substitute for chloro-
form but has not been tried. Other materials may provide 
easier construction of paddles, but I know of no reports on 
successful alternatives. 

 Stirring distributes larvae and food more evenly. An advan-
tage of the frame and paddles is that a large volume of water is 
moved with low shear. Another is that a rack with one motor 
can stir at least 20 jars for a total of 40 l of SW. That permits 
culture of 4,000 larvae at a low density of 1 larva per 10 ml. 
With stirring, many kinds of small larvae, such as those at early 
stages, can be reared at higher densities, ~1 ml −1 , if necessary. 
Multiple jars also provide replication. Each jar provides one 
replicate for a statistical test without pseudoreplication; 
numerous jars provide more replication per treatment (e.g., 
20 jars allow 5 replicates of 4 treatments). When a paddle 
 stirrer is scaled down for 100 ml volumes in custard dishes, 
individual larvae develop in a large volume of moving water. 

 A disadvantage of paddle stirrers is that cultures are open 
to the air, which can introduce other organisms from SW spray 
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if an aquarium is used as a water bath. In rooms with a strong 
airfl ow, dust may contaminate cultures, necessitating a dust 
cover. Rotating paddles, with a motor on a plastic cover for 
each jar, is one alternative, but many motors are required. 
Magnets mounted on the shaft from a motor can drive rotat-
ing paddles in numerous jars [ 17 ], but the water volume is 
more limited than with the stirring frame.   

   6.    Source of SW is important, whether it is piped to the lab or 
collected in a bucket. SW from bays with ports, marinas, or 
urban or industrial runoff is often contaminated with toxic 
materials. SW in recirculating systems that serve several aquaria 
is usually of poor quality for larval culture. 

 Common salinities along open coasts are 32–35.5 ppt. 
Many larvae, though from open coasts, tolerate salinities down 
to 30 ppt or lower.   

   7.    An indication of tolerated temperatures is the range where the 
larvae develop in nature. Within a species, temperature toler-
ances for development can change with season or differ 
between regions [ 38 ,  39 ]. Temperature control for cultures is 
often needed in laboratories heated or cooled for human com-
fort. A heating-cooling circulating bath (e.g., Thermo 
Scientifi c [formerly Haake] or Lauda-Brinkmann) can pump 
freshwater to a higher external bath for cultures, with the 
water returned by gravity. Prevent corrosion of the circulating 
heater-cooler by using RO or distilled water and avoiding SW 
spills into the bath. Water level in unstirred containers should 
be near the level of water in a cold bath to avoid heating above 
the bath’s waterline. If relying on a temperature-controlled 
room, decrease short-term variation in temperature by placing 
containers in a large water bath.   

   8.    SW is nearly 1 osM. To maintain osmolarity when substituting 
ions, one can add salts in a solution of ~1 mol of ions, as in 
0.5 M KCl or 0.33 M MgCl 2 , although solutions isosmotic with 
SW of 35 ppt would be 0.53 M KCl and 0.37 M MgCl 2  [ 11 ].   

   9.    Alternatively a fi lter can be connected to a siphon. One method 
is to cut off the fl at part of the screw cap for a 50-ml polypro-
pylene centrifuge tube (Falcon™), screw the cap over Nitex 
mesh, trim off excess mesh material, cut off the pointed end, 
and seal a tube into the hole in the pointed end with hot-melt 
glue [ 9 ]. A smaller fi lter can be made by attaching the Nitex 
over the large end of the disposable plastic tip for a 1,000-μl 
automatic pipette; fasten the Nitex mesh with a short band cut 
from Tygon ®  tubing that fi ts snuggly; then insert the small 
end of the pipette into the fl exible tubing.   

   10.    “E” containers for cultures can be exposed to SW, tap 
water, distilled water, or RO water. Plastic fi ber scrubbers 
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(without detergent, sold for household use) and a bottlebrush 
can be used to remove organic material from glassware with-
out solvents. If additional cleaning is considered necessary, 
dilute sodium hypochlorite (household bleach), dilute acetic 
acid, and dilute HCl can be used without compromising “E” 
ware by a toxic residue if rinsing is thorough. Also, substances 
that are metabolized, such as ethanol and acetic acid, are ade-
quately removed by rinsing.   

   11.    With usual culture methods, neither larval nor algal cultures are 
free of bacteria. Although contamination with bacteria harmful 
to larvae has occurred in aquaculture [ 40 ], cultures with bacte-
ria but without other eukaryotes are usually suffi cient for algae 
used to feed larvae. Nevertheless, sterilization is needed to 
minimize contamination of algal cultures and to protect larvae 
that have been removed early from egg capsules. 

 The duration of microwave sterilization depends on the 
volume of fl uid and the power of the microwave. With a 
700-W microwave and 1.5 l of SW, bacteria were eliminated in 
5–8 min [ 41 ].   

   12.    Obtain starter algal cultures from UTEX the Culture 
Collections of Algae at the University of Texas at Austin, the 
Provasoli-Guillard National Center for Culture of Marine 
Phytoplankton, Carolina Biological Supply, or other suppliers 
of algal cultures. Reports of value of algae added as foods do 
not preclude presence of other material in the diet. Algal cul-
tures designated as the same species but from different isolates 
may differ in quality. Cultures of algae are designated by codes, 
such as the T-ISO strain of  I. galbana . Noting the culture 
code is good practice, though as algal cultures are passed 
around, this information is often lost and thus unreported. 
Algae with the same culture number may diverge in quality 
and cell size during repeated growth and transfers. Without 
extraordinary precautions, algae maintained as food are rarely 
if ever free of bacteria. Larval cultures become contaminated 
with other organisms introduced with the starting embryos or 
larvae or later. Dissolved and particulate organic material 
accompanies the SW. Of the listed algae,  Rhodomonas  spp. 
grows more slowly in culture and more commonly fails as a 
culture, but it is convenient as an adequate sole food for many 
echinoderm larvae.   

   13.    Buying Guillard’s medium f/2 for addition to SW is more 
convenient than making it from reagent grade ingredients. It 
can be obtained from Fritz Pet Products (500 Sam Houston 
Rd. Building F, Mesquite, Texas, 75149-2789). Component 
A, with the vitamins, should be refrigerated for storage and 
both components (A and B) can be stored refrigerated and 
used for years.   
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   14.    To adjust a pipette to larval sizes, enlarge a Pasteur pipette by 
scoring and breaking it or pull the pipette to a fi ner tip after 
heating it in a gas fl ame. 

 If fi ner control is needed, construct a braking pipette by 
pulling a capillary tube until there is a narrow constriction at 
one end, then cementing it into a glass tube so that the con-
striction is at the inner end, restricting airfl ow. Attach a fl exible 
tube to the pipette instead of a bulb. Suck or blow on the tube 
to control airfl ow and thus water fl ow. Consistent constric-
tions in the capillary tube can be achieved with an automatic 
pipette puller, as used for microelectrodes [ 42 ]. For a braking 
pipette with larger capacity, pull a portion of a Pasteur pipette 
to the desired tip diameter for the outer end and a very small 
diameter for the inner, braking end.   

   15.    For many kinds of larvae, algal medium need not be removed 
from algal cells used as food, but some larvae are sensitive to 
materials dissolved in algal cultures. Also, comparisons of 
effects of different kinds or concentrations of algae are best 
made without confounding effects of different quantities of 
enrichment solution and algal exudates. Medium can be 
removed from the algal cells by centrifugation and resuspen-
sion of algal cells in seawater. A few trials will indicate the time 
and speed necessary to pellet the algae; 1 min at ~2,300 rpm 
(~3,000 ×  g ) is a recommended centrifugation from a protocol 
that lists the same algae as this one [ 9 ]. Discard the superna-
tant and resuspend the pelleted cells in a volume of fi ltered SW 
that gives a cell concentration convenient for counting. After 
the fi rst trial centrifugation, inspect algal cells for damage. 

 If undesired effects from algal medium are suspected, 
algae used for feeding (as distinct from stock cultures of algae) 
can be grown in simplifi ed nutrient enrichment with inorganic 
nitrate and phosphate added to SW at the same concentration 
as in the usual enrichment medium.   

   16.    Some protocols recommend increased concentrations of algae 
as larvae grow. Larger larvae can clear a larger volume of water 
of food per time, but for many ciliary-feeding larvae, the sati-
ating concentration of food changes little during their growth 
and development [ 13 ,  14 ]. If larvae are not so concentrated 
that they clear much of the SW of food between water changes, 
then the same concentration of algae can be used throughout 
their development.   

   17.    The quality of  Artemia  nauplii as food varies among popula-
tions, from maternal effects, and from their diet. The quality of 
rotifers ( B. plicatilis ) as food varies similarly.     B. plicatilis  sup-
ported the development of crab zoeae to the megalops stage 
when the rotifers were fed with  I. galbana  but not when they 
were fed with  D. tertiolecta  [ 25 ]. There is an extensive literature 
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   18.    No single measure fully represents the stage of development 
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measurements, use a microscope equipped with an ocular 
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    Chapter 2   

 Obtaining Gametes and Embryos of Ascidians 

           Charles     C.     Lambert    

    Abstract 

   Ascidians are basal chordates that have become increasingly important for understanding chordate evolution. 
They comprise three orders. In the orders Phlebobranchia and Stolidobranchia, most species freely spawn 
eggs and sperm, whereas members of the order Aplousobranchia form colonies that brood their eggs and 
broadcast sperm. In the two free spawning orders, eggs and sperm are easily obtained for in vitro fertiliza-
tions. In the third order, slices of colonies yield gametes and embryos of all stages. Methods are described 
for obtaining gametes, performing fertilizations, and culturing embryos. Also included are methods for 
removing follicle cells and vitelline coats from oocytes.  

  Key words     Ascidian  ,   Tunicate  ,   Aplousobranchia  ,   Phlebobranchia  ,   Stolidobranchia  ,   Demembranation  , 
  Defolliculation  

1      Introduction 

 The phylum Chordata includes the subphyla Vertebrata, Tunicata, 
and Cephalochordata. Tunicates are currently considered to be the 
sister group of the vertebrates [ 1 ]; they include the class Ascidiacea 
which are all sessile as adults and the pelagic Appendicularia and 
Thaliacea. Ascidians include both solitary and colonial forms. All 
tunicates are marine and require a salinity of at least 20 parts per 
thousand for development. All ascidians are hermaphroditic; some 
are protandric, but most are simultaneous hermaphrodites. Self- 
fertilization is possible in some species, but many are self-sterile 
[ 2 ]. The ascidians include three orders: Aplousobranchia, 
Phlebobranchia, and Stolidobranchia [ 3 ]. Aplousobranchs are all 
colonial with small zooids only a few mm in length embedded in a 
common tunic matrix. Each zooid in the colony is cloned from 
buds. Because of the small size of the zooids, only a few eggs are 
produced per zooid. The eggs are generally large and may take 
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weeks to develop fully. Aplousobranchs spawn large complex sperm 
which fertilize brooded eggs. This type of reproduction has been 
termed spermcast reproduction [ 4 ]. Aplousobranch embryos are 
diffi cult to culture outside the colony, so most studies of their 
development come from embryos dissected from colonies. The 
location of embryos within the colony varies from family to family. 
Embryos may be within the zooid atrium, in brood pouches, or in 
the basal tunic of the colony. 

 Phlebobranch and stolidobranch ascidians are mostly solitary 
free spawners with eggs from 100 to 300 μm. Thousands of eggs 
are released at each spawning with fertilization occurring in the 
sea. These eggs are small compared to those of aplousobranchs, 
and the sperm is also much smaller and less complex than that of 
aplousobranchs. In the Stolidobranchia, the family Styelidae 
includes a number of colonial species.  Botrylloides violaceus  pro-
duces small eggs with a true placenta forming very large and com-
plex larvae which may take several zooid generations to develop 
[ 5 ]. Only a few phlebobranchs are colonial.  Ciona intestinalis  is a 
large solitary ascidian that has been classifi ed as either aplouso-
branch or phlebobranch in various publications. It has some prop-
erties of both groups. Based upon its    small and simple sperm, its 
egg and tadpole larva, as well as its large size and solitary nature, it 
is considered a phlebobranch here.  

2    Materials 

 Traces of detergents, soap, fi xatives, and metal salts are toxic to 
gametes and embryos. Thus, it is best to use new glassware and 
plasticware whenever possible. Glassware can be washed with 
Micro cleaner and rinsed several times with very hot tap water fol-
lowed by distilled water rinses; all glassware and instruments must 
be free of contaminants. If in doubt, wash. 

      1.    Buffer A: 0.56 M NaCl 1 % EDTA (tetrasodium) pH 4.2.   
   2.    pH 6 SW: with a pH meter measure pH and add 1 N HCl 

dropwise to clean SW to pH 6.   
   3.    pH 9 Tris SW: with a pH meter add dropwise 1 N Tris to pH 9.      

      1.    Treat eggs with 0.1 % trypsin solution in SW for 2 h. Pipette 
to remove membranes. Wash thoroughly.   

   2.    Buffer B: to 20 ml seawater (SW), add 0.15 g dithiothreitol, 
0.72 g CHES, and 0.02 g pronase E = Sigma P6911 or P5147 
pH 9.2 (make fresh).       

2.1  Buffers and 
Seawater Solutions

2.2  Solutions 
for Removing Vitelline 
Envelopes
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3    Methods 

  Colonies are invariably asynchronous with regard to blastogenic 
and embryonic stages, making it necessary to collect and dissect 
several colonies to be assured of obtaining the required stages. 
Since aplousobranch eggs are brooded for extended periods and 
diffi cult to culture in the laboratory, it is usual to dissect colonies 
and isolate the required stages [ 6 ,  7 ]. Place the colony in a 60 mm 
Petri dish and slice it into 1–3 mm slices. Under a dissecting micro-
scope, remove the required embryos. In  Distaplia  (family 
Polycitoridae), the embryos are embedded in the colony within a 
brood sac that may be independent of the zooids. In  Aplidium  [ 7 ] 
and other species from the family Polyclinidae, as well as other 
polycitorids, zooids brood their embryos in enlarged thoracic atria. 
Didemnid embryos are brooded in the tunic at the base of the 
colony below the zooids. Thus, it is important that the basal tunic 
is included when colonies are collected. This is also true for the 
colonial botryllid stolidobranch  B. violaceus , though in other bot-
ryllids, the embryos are brooded in the zooids. Swimming tad-
poles can be collected with a tadpole collector in response to light 
following darkness [ 8 ].  

  Store adults under continuous light to prevent light-induced 
spawning [ 9 ].  Ciona     and  Corella  spawn when exposed to light for 
about 30 min after a 1 h dark period [ 9 – 11 ].  Ciona  is self-sterile, 
so be sure to spawn or dissect at least two if you want fertilization 
[ 12 ]. Dissection is necessary for other phlebobranchs.

    1.    In the family Ascidiidae which includes  Ascidia ,  Ascidiella,  
and  Phallusia , remove the tunic to expose the gonoducts 
which are easy to see when full of gametes ( see   Note 1 ).   

   2.    Dry the animal thoroughly with a Kimwipe, being especially 
thorough in the region of the gonoducts.   

   3.    The oviduct overlies the sperm duct. Using a needle held par-
allel to the oviduct, carefully make an opening, and the eggs 
will stream out. The eggs are held together by a viscous mucus 
coating. Pick up the eggs on the  outside  of a dry Pasteur 
pipette. The mucus will stick the eggs to the outside of the dry 
pipette. Keeping the operating area dry prevents the eggs from 
streaming away ( see   Note 2 ).   

   4.    Remove the tunic from  Ciona , and open the atrium with fi ne 
scissors to expose the gonoducts. Dry the animal and remove 
eggs as for other phlebobranchs. After the eggs are removed, 
the sperm can be collected “dry” (i.e., in a concentrated mass) 
with a dry Pasteur pipette or a positive displacement pipette if 
sperm are scarce. Store sperm in an iced Eppendorf tube. Dry 
sperm may be stored up to a week in the refrigerator.    

3.1  Obtaining 
Gametes and Embryos 
from Aplousobranchs

3.2  Obtaining 
Gametes and Embryos 
from Phlebobranchs
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    Store animals under continuous light to prevent unscheduled 
spawning [ 13 ] and to accumulate gametes. As is the case for  Ciona  
and  Corella ,  Molgula  will spawn in response to a short light cycle 
[ 11 ]. Many species of  Styela  and sometimes other stolidobranchs 
will spawn if stored in the dark for 12 h or so and then exposed to 
light for 12 h. Many stolidobranchs are self-sterile, so it is neces-
sary to use two or more animals to start a culture. If you wish to 
experimentally fertilize a culture, it is necessary to use a self-sterile 
species so that fertilization does not occur while dissecting eggs 
( see   Note 3 ). 

 Many but not all species of the stolidobranchs including 
 Boltenia ,  Herdmania ,  Pyura ,  Styela,  and  Halocynthia  are self- 
sterile.  Molgula  spp. are generally self-fertile [ 2 ]. A few solitary 
stolidobranch and phlebobranch species are ovoviviparous. In this 
case, opening the atrium will release the brood.

    1.    To obtain gametes, clean epibionts from the tunic and bisect 
with a razor blade through the siphons. Remove from tunic 
and lay out the isolated half animals in a 60 mm Petri dish 
covered with SW. With forceps, remove and discard the bran-
chial basket to expose the ovary and testis in the body wall. 
Oocytes with intact germinal vesicles are stored in the ovary. 
Germinal vesicle breakdown occurs within 30 min of dissec-
tion in pH 8 SW. If you want oocytes with intact germinal 
vesicles, dissect in low pH SW [ 14 ].   

   2.    Remove the gonads and place in 35 mm Petri dish, chop with 
fi ne scissors, then pipette in and out of a Pasteur pipette. Be 
sure the scissors are clean and not contaminated with formal-
dehyde or detergents.   

   3.    Pour through coarse (300 μm) Nytex. Squirt SW through tis-
sue remaining on fi lter to remove more eggs and sperm. Pour 
egg/sperm suspension into 100 ml beaker with SW. Use a 
larger beaker if necessary.   

   4.    Wash oocytes in a beaker by placing a 100 μm fi lter which is 
attached to the bottom end of a 38 mm Plexiglas tube 70 mm 
long into the beaker. Withdraw supernatant SW from the 
Plexiglas tube with a large-volume syringe or pipette to remove 
the supernatant. The fi lter allows removal of supernatant with-
out loss of mature oocytes. Wash until supernatant is clear of 
sperm, adding more SW to the beaker as needed. This method 
also removes small immature oocytes that pass through the 
Nytex mesh. The Nytex screen prevents eggs from entering 
the interior of the tube where the supernatant is collected 
( see   Note 4 ).   

   5.    Eggs from colonial styelids are obtained by dissection as 
described for aplousobranchs. Embryos of  B. violaceus  are in 
the base of the colony. Thus, be sure to collect the whole 

3.3  Obtaining 
Gametes and Embryos 
from Stolidobranchs
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 colony and not just the surface layers. The embryos of  Botryllus  
spp., other  Botrylloides  spp., and other colonial styelids are 
brooded inside the atrial cavity of the individual zooids.    

4       Fertilizations and Culture Methods 

     1.    To insure synchronous fertilization, soak eggs for an hour in 
pH 6 SW. Wash 4× with normal pH 8 SW.   

   2.    Dilute dry sperm 1:1,000 with clean normal SW or pH 9 Tris 
SW ( see   Note 5 ).   

   3.    Add 10 ml diluted sperm to 100 ml of egg suspension. Most 
ascidians do not have a fertilization membrane. Thus, it can be 
diffi cult to know if fertilization has occurred before cleavage. 
However, if you examine the eggs with a 100× microscope 
5 min and 15 min after fertilization, you will see that fertilized 
eggs are now quite elongate or pear shape [ 15 ]. About 10 min 
after fertilization wash off exogenous sperm with clean SW 
( see   Note 6 ).   

   4.    For short-term culture, you can leave the embryos in a mono-
layer in the bottom of the beaker where they will develop well 
to hatching without any aeration or agitation. Swimming tad-
poles can be collected from the upper levels of the beaker; they 
are photopositive when fi rst hatched but become photonega-
tive when ready to settle.   

   5.    For large cultures, place the embryo suspension in a 1 gallon 
jar and agitate with a plastic propeller at 30–60 RPM. Large 
quantities of tadpoles and newly metamorphosed tadpoles 
may be cultured in this manner.     

      1.    To remove follicle cells of phlebobranch eggs, place eggs in 
Ca 2+ -free SW containing EGTA and agitate vigorously [ 16 ]. 
Alternatively, rapidly squirt eggs in and out of a syringe with a 
26 gauge needle ( see   Note 7 ).   

   2.    For stolidobranchs like  Boltenia  and  Halocynthia , removal of 
follicle cells is accomplished by a modifi cation of a method by 
Fuke [ 17 ]. Oocytes are placed in a 15 ml centrifuge tube of 
Buffer A and shaken periodically for 30 min followed by 20 
passages through a 163 μm Nytex fi lter. Follicle cells can then 
be separated from oocytes by passage through a 100 μm Nytex 
fi lter and pelleted in a clinical centrifuge at    Ravg 1600 
(Rmax 2683; 4,000 RPM) for 10 min and then re-suspended 
in SW [ 18 ].      

  Originally vitelline coats were removed with needles, and this 
method is still in use when it is desirable to avoid the use of enzymes 

4.1  Follicle Cell 
Removal and Isolation

4.2  Removal 
of Vitelline Coats
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[ 19 ]. To remove the vitelline coat, follicle cells, and test cells of 
 Phallusia , agitate eggs in trypsin [ 20 ] ( see   Note 8 ). 

 The following method works on  Ascidia ,  Ciona,  and 
 Boltenia  eggs.

    1.    Add oocytes to freshly made Buffer B.   
   2.    Rock gently 1.5–2 h (Nutator or other device that gently 

agitates gametes).   
   3.    Place in tube, and shake fairly vigorously.   
   4.    Wash by settling in clean SW.    

5       Notes 

     1.    Wear gloves when dissecting ascidiid tunicates as blood will 
leave a green stain on your fi ngers.   

   2.    Do not suck up the eggs as they will stick to the inside of the 
pipette and are diffi cult to recover.   

   3.    To avoid self-fertilization in self-fertile species, dissect eggs into 
pH 6 SW and wash the eggs with pH 6 SW until free of sperm. 
Return the eggs to pH 8 SW and observe at expected time of 
cleavage to be sure that no self-fertilization occurred [ 10 ].   

   4.    Be sure to aspirate supernatant slowly enough that eggs are 
not forced through Nytex. Check with microscope to be cer-
tain that no eggs are being lost.   

   5.    Check motility of diluted sperm without a coverslip using 
dark-fi eld illumination and 40–100× magnifi cation. To obtain 
dark-fi eld illumination, shift the phase rings of a phase contrast 
microscope slightly off center. If sperm do not show vigorous 
translocational swimming, use pH 9.2 (Tris) SW to make 
another sperm preparation.   

   6.    Left over sperm will rot and bacteria tend to kill embryos.   
   7.    Be careful to examine  Ciona  eggs with a compound microscope 

as many treatments break the elongated  Ciona  follicle cells leav-
ing the base of the cells still attached to the vitelline coat.   

   8.    Another demembranation method utilizes higher pH and 
thioglycolic acid [ 21 ]. Demembranated eggs and embryos 
stick and lyse when they contact glass or plastic. To prevent 
this, coat glassware, plasticware, and cover slips with 1–2 % 
agar or as follows: soak briefl y all glassware, plasticware, etc., 
in 0.1 % gelatin, 0.1 % formaldehyde in distilled H 2 O. Rinse in 
tap then distilled water, drain thoroughly, air dry, and store 
until needed [ 22 ].         
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    Chapter 3   

 Artifi cial Seawater Culture of the Gastropod 
 Crepidula fornicata  for Studies of Larval Settlement 
and Metamorphosis 

           Anthony     Pires    

    Abstract 

   The slipper limpet,  Crepidula fornicata , is a gastropod mollusc of growing importance as a research model 
in developmental biology and as an invasive organism. The large (>1 mm) veliger larvae of this species are 
well suited for neuroethological investigations of settlement and metamorphosis. In this chapter, methods 
are described for conditioning adult broodstock, growing microalgal food for larvae, and culturing larvae 
to metamorphic competence in artifi cial seawater. A protocol is also presented for obtaining electrophysi-
ological recordings of ciliary arrest spikes from intact, behaving larvae, as putative neural correlates of 
larval settlement.  

  Key words     Gastropod  ,   Veliger  ,   Larva  ,   Settlement  ,   Metamorphosis  ,   Neuroethology  ,   Ciliary arrest  

1      Introduction 

 The calyptraeid gastropod,  Crepidula fornicata , is a cosmopolitan 
species of unusual importance. Although historically signifi cant in 
classical studies of embryogenesis [ 1 ], it is only in the last decade 
that  C. fornicata  has re-emerged as a valuable model system for 
lophotrochozoan development (comprehensively reviewed in 
ref. [ 2 ]). In addition to its new utility for cellular, molecular, and 
genomic studies of early development, this species has been the 
subject of numerous studies of growth, energetics, and life history 
[ 3 – 9 ]. Regulation of larval metamorphosis, a key developmental 
and  ecological transition, has been studied with respect to environ-
mental cues and constraints [ 10 – 12 ] as well as internal signaling 
 mechanisms [ 13 – 16 ]. 

 Native to eastern North America,  C. fornicata  (“slipper limpet”) 
is an invasive species that has become established in the American 
Pacifi c Northwest, Europe, and Japan [ 17 ,  18 ]. Its superabundance 
in some European locales has raised concerns about ecological 
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impacts (reviewed in ref.  19 ). This range expansion has increased its 
availability as an object of research and added to the value of under-
standing all aspects of its biology. However, despite the substantial 
volume of literature dealing with post- hatching larval biology of 
 C. fornicata , a complete protocol for rearing larvae to metamorphic 
competence has not been published. 

 The goal of the present contribution is to facilitate the use of 
 C. fornicata  in mechanistic studies of larval settlement and meta-
morphosis, by providing simple culture protocols that are adapted 
for inland laboratories without ready access to natural seawater. As 
reproductive adults are prerequisite for larval culture, the fi rst pro-
tocol given is for conditioning adult broodstock. Adults of  C. for-
nicata  are suspension-feeding protandric hermaphrodites that live 
in “stacks” of 2–15 individuals; females brood eggs that hatch as 
veliger larvae [ 3 ,  7 ]. Few rigorous studies exist of the seasonal tim-
ing of gametogenesis, oviposition, and larval release by  C. forni-
cata  in nature [ 19 ,  20 ]. In the Bay of Brest, France, adults produce 
three or four broods per season with peak hatching periods occur-
ring between March and August [ 19 ]. Adults collected from popu-
lations near Woods Hole, MA, and in the southern Puget Sound, 
WA, USA, yield larvae within a few days of collection during June 
and July; Woods Hole adults appear to be mostly spawned out in 
August ([ 21 ], personal observation). The protocol given here for 
conditioning broodstock out of season reliably produces high- 
quality naturally hatching larvae when used with adults obtained 
from Woods Hole between December and May. This protocol uses 
small volumes of artifi cial seawater and a commercially prepared 
concentrated food source and does not require permanently estab-
lished aquaria. Alternative methods for obtaining embryos out of 
season have recently been published [ 22 ]. 

 The larval rearing protocol presented here is derived from 
methods described by Pechenik [ 4 ], modifi ed with respect to larval 
density, food ration, and use of an artifi cial seawater medium. Under 
the rearing conditions described below, brooded embryos hatch as 
planktotrophic veligers at about 450 μm and grow 35–40 μm/day, 
usually becoming competent for metamorphosis at 10–11 days at 
800–900 μm. If cues for metamorphosis [ 23 ] are withheld, compe-
tent larvae of 1,200–1,500 μm may be easily obtained before spon-
taneous metamorphosis occurs between 3 and 4 weeks post-hatch. 
I also present a simple protocol for culturing the larval food source, 
the fl agellate  Isochrysis galbana , using artifi cial seawater and a 
 minimal amount of natural seawater (no more than 1 L/week for 
a typical small-scale laboratory culture operation). 

 The large size of larvae of  C. fornicata  is a distinct advantage 
for neuroethological studies of settlement and metamorphosis. As 
an example of the types of manipulations that are possible with 
large veligers, I present a protocol for electrophysiological 
 recording of ciliary arrest spikes from intact larvae. The recording 
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electrode is a tether of fi ne platinum wire [ 24 ,  25 ] that allows lar-
vae to swim in the water column or interact with a substrate. The 
ciliary arrest spike is an action potential in the preoral ciliated cells 
that provide the propulsive force for swimming [ 26 – 29 ] and may 
be a neural correlate of larval settlement behavior [ 30 – 32 ].  

2    Materials 

 Adult broodstock conditioning, algal food culture for larvae, and 
larval culture utilize Instant Ocean artifi cial seawater (ASW) 
(United Pet Group, Cincinnati, OH, USA). Dissolve 800 g ASW 
salts in 20 L deionized, distilled, or reverse osmosis-purifi ed water. 
Adjust fi nal salinity to 32 ppt with a refractometer or a hygrometer. 
If the water source does not incorporate a purifi cation stage that 
removes organics, it is advisable to pass the water through a bed of 
activated carbon media (e.g., using a canister-type aquarium fi lter) 
before dissolving the salts. Use this preparation of ASW without 
further fi ltration for adult conditioning and larval cultures. 
Filtration for algal medium is described below in Subheading  2.3 . 

      1.    Adults of  C. fornicata  may be fi eld collected or purchased 
from the Marine Resources Center at the Marine Biological 
Laboratory, Woods Hole, MA, USA. Keep adults cool 
(≤10 °C) and damp during transport from collecting site 
( see   Note 1 ).   

   2.    Shellfi sh Diet 1800 (Reed Mariculture, Campbell, CA, USA): 
This is a mixed-species microalgal concentrate. Store at 4 °C 
according to the supplier’s instructions. Use within 12 weeks 
of purchase.      

      1.    Sieves: Larvae are collected and transferred on sieves made 
from Nitex mesh (Sefar AG, Heiden, Switzerland). Cut the 
bottom off of a 400 mL tri-corner disposable plastic beaker, 
and use hot-melt glue to apply a panel of mesh to form the 
bottom of the sieve. 150 and 236 μm sizes are most useful.      

       1.    Starter cultures of  Isochrysis galbana  (strain T-ISO) are avail-
able from UTEX (The Culture Collection of Algae, University 
of Texas, Austin, TX, USA), CCMP (The Provasoli-Guillard 
National Center for Culture of Marine Phytoplankton, 
Bigelow Laboratory for Ocean Sciences, Boothbay Harbor, 
ME, USA), and Mariculture Technologies International (Oak 
Hill, FL, USA).   

   2.    Guillard’s f/2 medium: This is a half-strength formulation of 
the “f medium” originally given by Guillard and Rhyther [ 33 ]. 
F/2 medium is available as a two-part concentrate from Kent 
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Marine (Franklin, WI, USA). Add 130 μL each of Part A and 
Part B to each liter of a 1:1 mixture of ASW and natural sea-
water and sterile-fi lter at 0.45 μm. Transfer to sterile 1 L 
screw-top stock bottles. Store at 4 °C ( see   Note 2 ).   

   3.    Cotton plugs sized to fi t mouths of 500 mL Erlenmeyer cul-
ture fl asks. Fallout of fi bers into media will be minimized by 
wrapping cotton plugs in cheesecloth. Flasks are plugged, 
capped with aluminum foil, and autoclaved empty ( see   Note 3 ).   

   4.    22 cm lengths of 5 mm (O.D.) glass tubing, fi re polished to 
reduce sharp edges. These provide aeration for algal culture 
fl asks.   

   5.    A hemacytometer for counting algal cell density.      

  Ciliary arrest spikes may be recorded with standard instrumenta-
tion for extracellular electrophysiology, i.e., a differential AC 
amplifi er of 1,000×–10,000× gain, interfaced with appropriate 
data acquisition software. Standard input cables are terminated 
with fi ne-wire electrodes that require the following:

    1.    Electrodes are prepared from 25 μm coated platinum wire 
(7690 from A-M Systems, Carlsborg, WA, USA). Cut a 10 cm 
length of wire, and remove insulation from 1 cm at the proxi-
mal (cable terminal) end by passing through a fold of 600-grit 
aluminum oxide sandpaper ( see   Note 4 ).   

   2.    Terminals to connect electrodes to input cables: Copper 
 fl at-tip micro alligator clips (BU-34C from Mueller Electric, 
Akron, OH, USA).       

3    Methods 

      1.    Set a lighted incubator to the ambient seawater temperature of 
collecting site, or 5 °C (whichever is higher), and 14-h:10-h 
light:dark cycle. Chill ASW to this temperature ( see   Note 5 ).   

   2.    Open shipping container of adult  C. fornicata , remove any 
cold packs, and equilibrate temperature 1 h in an incubator set 
as in  step 1 .   

   3.    Transfer each “stack” of adults to 2 L chilled ASW in a 1-gal 
glass jar. If stacks are small (4–5 adults), 2 stacks may be 
housed together in a single jar. Provide moderate aeration 
through a piece of 5 mm (O.D.) glass tubing.   

   4.    Let animals acclimate overnight without feeding.   
   5.    Raise the incubator temperature by 1 °C/day. Change the 

water every other day.   
   6.    Begin feeding on the fi rst day when the temperature is equal 

to or greater than    10 °C. On the fi rst feeding day, add a single 
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feeding of 300 μL Shellfi sh Diet to each jar. Animals should 
completely clear the water within 3–4 h. On subsequent days, 
feed 300 μL Shellfi sh Diet twice daily. Do not add second daily 
feeding until the fi rst has cleared.   

   7.    Continue to raise the temperature by 1 °C/day, until tempera-
ture in the incubator reaches 20 °C. Continue to feed twice 
daily, changing water every other day. Maintain incubator 
at 20 °C.   

   8.    First releases of larvae should occur within 2–3 weeks after the 
temperature passes 15 °C. Most releases occur in the late after-
noon. A second peak of releases should occur about 2 weeks 
after the fi rst. Subsequent releases are smaller and less reliable; 
it is advisable to terminate adults after the second peak of 
releases and replace with freshly conditioned broodstock.      

      1.    Remove aeration from an adult jar in which a release of larvae 
has occurred. Let stand for 30 min for debris to settle. Larvae 
are strongly geonegative immediately after release and will 
accumulate near the top of the jar.   

   2.    Collect larvae by siphoning into a 150 μm sieve suspended in 
a beaker of ASW. Avoid siphoning near the bottom of the jar.   

   3.    Lift the sieve to drain and momentarily strand the larvae on 
the mesh surface, and then gently rinse larvae into a fi nger 
bowl of ASW using a squirt bottle of ASW.   

   4.    Collect larvae with a Pasteur pipet ( see   Note 6 ). Count 500 
larvae ( see   Note 7 ) into a glass jar containing 2 L ASW at 
20 °C ( see   Note 8 ).   

   5.    Feed with T-ISO, adding enough to achieve 10 × 10 4  cells/mL 
fi nal density in the 2 L culture volume ( see   Note 9 ). Cultures 
are static—do not aerate or stir.   

   6.    Change water every other day. Pour the contents of the cul-
ture jar into a 236 μm sieve suspended in a beaker, such that 
waste water overfl ows the beaker while larvae are retained 
within the sieve. Transfer larvae to a clean culture jar contain-
ing 2 L ASW, as in  step 3  above, and feed with T-ISO as in 
 step 5  ( see   Note 10 ).      

  Comprehensive methods for culturing marine algae are given in 
ref. [ 34 ].

    1.    Set incubator to 27 °C, with continuous light cycle ( see   Note 11 ).   
   2.    Pour 330 mL f/2 medium into a sterile, cotton-plugged 

500 mL Erlenmeyer fl ask.   
   3.    Insert a sterile glass aeration tube between the plug and the 

neck of the fl ask. Connect to air pump, and bubble gently in 
incubator for 30 min to warm the cold medium.   
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   4.    Inoculate culture fl ask with 8–10 ml of a dense culture of 
T-ISO, using a sterile pipet ( see   Note 12 ). Continue gentle 
aeration (2–3 bubbles/s) while in growth period.   

   5.    Use T-ISO for feeding while in log-phase growth (typically at 
a cell density of 4–7 × 10 6  cells/ml, after 4–6 days).    

        1.    Pipet a larva in a minimum volume of ASW onto a sheet of 
weighing paper on a dissecting microscope stage.   

   2.    Blot or pipet away excess ASW, leaving larva immobilized in 
an amount of ASW no larger than its own body volume.   

   3.    Gently blot larval shell with a twisted bit of laboratory tissue.   
   4.    Apply a minimal amount of cyanoacrylate glue to apical area of 

larval shell, using a sharpened toothpick.   
   5.    Lay electrode obliquely across shell, so that the tip of 

electrode extends beyond the margin of shell by about 1 mm 
( see   Note 13 ).   

   6.    Lift the electrode, with larva tethered at the end, and quickly 
transfer larva to recording chamber fi lled with ASW.   

   7.    Attach proximal end of electrode to micro alligator clip terminal 
on amplifi er input cable. It is convenient to clamp the terminal 
end of the cable in an XYZ manipulator to facilitate position-
ing of the larva within the recording chamber.   

   8.    Form distal end of recording electrode into a hook using fi ne 
forceps (Dumont #5 Biologie or equivalent) so that the distal 
end of the electrode is near the base of one velar lobe, without 
interfering with retraction/protrusion of the velum (Fig.  1 ).

       9.    Position larva in water column, in a perfusion stream, and/or 
to enable crawling on a substrate, using the manipulator that 
secures the end of the input cable. Bend the distal portion of 
the electrode as needed to bring the larva into an appropriate 
posture with respect to perfusion fl ow or orientation of the 
substrate.   

   10.    A typical recording is shown in Fig.  1 . As in many electro-
physiological applications, the quality of the recording depends 
on proper shielding, grounding, and noise reduction tech-
niques ( see   Note 14 ).       

4    Notes 

     1.    There is no need to ship animals in seawater; they remain in 
good condition in damp packing material in a foam cooler for 
24–36 h after collection.   

   2.    Sterile fi ltration is easily accomplished with an autoclaved vac-
uum fi ltration fl ask and funnel/fi lter support that uses 
47 mm × 0.45 μm membrane fi lters (09-719-2E from Fisher 
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Scientifi c, Pittsburgh, PA, USA, or similar). Filtration is much 
more effi cient if the 0.45 μm membrane fi lter is topped with a 
2.7 μm glass-fi ber prefi lter (Whatman GF/D or similar, 
Whatman International, Maidstone, England). Prepared f/2 
medium may be stored at 4 °C for several months.   

   3.    I have followed the common marine laboratory practice of 
avoiding the use of fi xatives, soaps, and detergents in glassware 
to be used for cultures. Glass jars used to culture adults and 
larvae  C. fornicata  are cleaned by rinsing with hot tap water and 
scouring with an aqueous paste of food-grade baking soda on a 
nylon scrub pad, rinsing in tap and deionized water, and air-
drying. Erlenmeyer fl asks used to culture T-ISO are similarly 
cleaned with a brush and baking soda and are occasionally acid-
washed in 1 N HCl as needed to remove mineral deposits.   

   4.    It is not necessary or desirable to remove insulation from the 
distal (larval) end of the electrode; the cut cross section of 
exposed platinum provides suffi cient electrical contact.   

   5.    This protocol has been used to condition adults of  C. forni-
cata  that have been collected at Woods Hole, MA, USA, 
between December and May. It should be applicable to winter 
and spring spawning of adults from other populations as well. 
Its purpose is to achieve an appropriate temperature for 
predictable oviposition and rapid development of brooded 

  Fig. 1    Correlated electrophysiological ( a ) and video ( b ) recording of spontaneous ciliary arrests in a 14-day 
(post-hatch) competent veliger of  Crepidula fornicata. Numerals  in ( a ) correspond to  numbered video frames  
in ( b ). 1. Several minutes of swimming without ciliary arrests preceded the fi rst ciliary arrest spike. E, elec-
trode; f, foot; s, shell; v, velar lobes. 2. A momentary ciliary arrest followed the fi rst spike.  Asterisks  indicate 
interruption of metachronal wave of ciliary beating. 3. Complete ciliary arrest and partial collapse of the velar 
lobes followed a sustained burst of arrest spiking. 4. Normal ciliary beating gradually recovered over a period 
of 5 s after the last spike. Scale bars, 1 s ( a ) and 200 μm ( b )       
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embryos while avoiding temperature shocks that can cause 
premature oviposition or mortality of adults. Real-time and 
historic surface seawater temperatures at Woods Hole are 
available [ 35 ] and may range between 1 and 15 °C during the 
indicated months.   

   6.    It is easy to damage larvae with the shearing forces and sharp 
glass apertures of Pasteur pipets. Pipet gently. For handling 
larger larvae Pasteur pipets should be broken back and fi re- 
polished to relieve sharp edges, so that apertures are at least 
1.5× the larval shell diameter.   

   7.    It is essential to count larvae into cultures, rather than attempt 
to estimate numbers in pipetfuls of larvae. “Eyeball” estimates 
nearly always undercount numbers of larvae and lead to 
density- dependent problems of poor growth, shell fouling, 
and mortality.   

   8.    Larvae and conditioned adults may be kept in an incubator at 
20 °C on a 14:10 light:dark cycle but also do well on a labora-
tory benchtop, away from direct sunlight, at 18–24 °C room 
temperatures and ambient room lighting. Temperature effects 
on growth rates and larval duration have been described [ 5 ].   

   9.    Higher larval growth rates have been reported by feeding with 
T-ISO at cell densities of 15–18 × 10 4  cells/ml [ 5 ]. My experi-
ence has been that the lower food cell density given in this 
protocol minimizes problems of shell fouling, clumping, and 
mortality while still supporting vigorous growth at the larval 
density indicated.   

   10.    Larvae should begin to become competent for metamorphosis 
at 10–11 days post-hatch. Metamorphosis consists of loss of 
the larval velum and may be assayed by exposing larvae to a 
conspecifi c adult, ASW conditioned by a conspecifi c adult, or 
ASW in which the concentration of K +  has been elevated by 
15 mM by the addition of KCl [ 13 ,  23 ].   

   11.    Good results will usually be achieved in typical lighted incuba-
tors designed to support plant growth. If growth lights are not 
permanently installed in the incubator, use a pair of 457 mm, 
15 W full-spectrum “plant and aquarium” fl uorescent tubes 
(F15 from General Electric, Cleveland, OH, USA, or similar), 
positioned 10–15 cm from culture fl asks. These tubes fi t 
 standard household 18″ fl uorescent fi xtures.   

   12.    In order to avoid contamination it is good practice to subcul-
ture only from cultures that have not yet been opened and 
used for feeding.   

   13.    Attaching the electrode to the shell and forming the hook at 
the end of the electrode are critical steps, because the quality 
of the recording depends on the proximity of the electrode tip 
to the velar lobe. Practice is required. It is best to err on the 
side of allowing excess length of electrode wire to protrude 
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past the margin of the shell in  step 5 ; any excess can be 
trimmed with fi ne scissors in  step 8 .   

   14.    The recording chamber should be set up on a grounded steel 
plate within a Faraday cage. The monopolar recording elec-
trode occupies one terminal of a differential amplifi er’s input 
cable; for best common-mode noise rejection the second ter-
minal should be connected to a silver wire immersed in the 
recording bath near the tethered larva. The recording bath 
should be grounded.         
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    Chapter 4   

  Trichoplax adhaerens , an Enigmatic Basal Metazoan 
with Potential 

           Andreas     Heyland     ,     Roger     Croll    ,     Sophie     Goodall    ,     Jeff     Kranyak    , 
and     Russell     Wyeth   

    Abstract 

    Trichoplax adhaerens  is an enigmatic basal animal with an extraordinarily simple morphological organization 
and surprisingly complex behaviors. Basic morphological, molecular and behavioral work is essential to 
better understand the unique and curious life style of these organisms. We provide basic instructions on 
how  Trichoplax  can be cultured and studied in the laboratory emphasizing behavioral and cellular aspects.  

  Key words     Placozoa  ,   Behavior  ,   Immunohistochemistry  ,   In situ hybridizations  ,   Cloning  ,   Chemotaxis    

1     Introduction 

  Trichoplax adhaerens  is a species from the phylum Placozoa that 
has been the subject of considerable investigation in recent years. 
The newly emerged interest in this enigmatic creature arose from 
its basal position within the animal kingdom as well as its extraor-
dinarily simple morphological organization ( for recent reviews see  
refs. [ 1 ,  2 ]). Superfi cially one might believe that  Trichoplax  is an 
amoeba ( for general overview of Trichoplax morphology see  Fig.  1  
and ref. [ 3 ]). Instead  Trichoplax  is reported to have 4–5 cell types 
and several thousand cells. More importantly, it shows a remark-
able array of behavioral responses to its environment, reproduces 
both sexually [ 4 ,  5 ] and asexually [ 4 ] and defends itself chemically 
against predators [ 6 ]. It also relies on a broad array of developmen-
tal and physiological signaling pathways for essential cellular and 
molecular functions [ 7 ].

 “It is a riddle, wrapped in a mystery, inside an enigma” 
 Winston Churchill,  cited in  Miller and Ball 2008 
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    Trichoplax  occurs abundantly in tropical and subtropical 
marine habitats around the globe, including coral reefs and man-
grove habitats [ 8 ]. Based on this wide distribution and the lack of 
any meaningful morphological characters that could be used to 
distinguish putative species, it seems unlikely that placozoans are a 
phylum of a single species ( T. adhaerens) . Indeed, several newer 
molecular studies document a signifi cant divergence of individuals 
between geographically separated populations [ 7 ,  9 ]. 

 The phylogenetic relationship of placozoans within the animal 
kingdom and especially in relation to other basal groups such as 
the cnidarians, ctenophores, and sponges remains controversial, 
despite increasing genomic information from a diversity of organ-
isms ( for discussion see  refs. [ 7 ,  10 ,  11 ]). Still, this issue is highly 
relevant for the evolutionary interpretation of future morphologi-
cal and molecular questions. For example, if  Trichoplax  species are 
more basal than sponges, the last common ancestor of all metazo-
ans could have been comparable to  Trichoplax , i.e., morphologi-
cally simple with a small genome and a large mitochondrial genome. 
However, if placozoans are more derived than sponges the simple 
morphology of  Trichoplax  could be a secondary simplifi cation. 

  Fig. 1    Photograph of  Trichoplax  under DIC illumination. Notice the uneven folding pattern of the outer rim of 
the animal (F: folds). Dark spots seen along the rim as well as in the center are shiny spheres (SS). Recent 
research suggests that these cells contain toxins that are used as predator defense mechanisms [ 6 ]. The 
isolated spots visible in the culture dish are unicellular algae ( Cryptomonas  sp.) that are added to the  Trichoplax  
cultures. After dying, they help build a biofi lm on which  Trichoplax  can feed. Scale bar: 200 μm       
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 Intriguingly, many genes with essential biological functions 
related to development, the nervous system and metabolism can 
be identifi ed in the  Trichoplax  genome [ 7 ]. This is remarkable as 
no research has so far produced evidence for any  bona fi de  neurons 
or developmental processes such as gastrulation and neurulation. 

 The cellular organization of  Trichoplax  is simple but it provides 
all essential functions for a free-living lifestyle, thus almost certainly 
excluding the possibility that  Trichoplax  is a parasitic form. 
Individuals are characterized by a dorsal and ventral ciliated epithe-
lium. They incorporate food through specialized digestive cells in 
the ventral epithelium which secret digestive enzymes and can 
phagocytose digested food particles. The cell arrangement between 
the two ciliated epithelia is relatively loose;  Trichoplax  does not have 
coeloms and the only specialized cell type in this region is the fi ber 
cell which may be used for a diversity of functions, including loco-
motion and cell communication. Studies suggest that these fi ber 
cells can produce cytoplasmic extensions in isolation [ 12 ] and it is 
possible that these differentiated cells fulfi ll functions analogous to 
those of neurons and/or muscles.  Trichoplax  also has regular cell–
cell junctions between epithelial cells. However, the basal lamina 
appears to be missing and so far nobody has been able to identify a 
true extracellular matrix (ECM), although the genome reveals 
genes that are coding for proteins that are known to interact with 
the ECM [ 3 ,  7 ]. Finally a function for an additional structure was 
recently identifi ed. The shiny spheres (Fig.  1 ) have been shown to 
be effective in deterring predators by inducing paralysis [ 6 ]. 

 The methods outlined in this chapter provide a basis for mor-
phological, molecular, and behavioral work on  Trichoplax . Linking 
these three aspects will contribute to our understanding of repro-
duction, growth, and metabolism. Therefore, this chapter is 
intended for researchers who are starting work on  Trichoplax  and 
who require information on how to culture and experimentally 
manipulate these organisms.  

2    Materials 

     1.     Cryptomonas  sp. (from UTEX at the University of Texas at 
Austin, stock number LB 2423—  http://web.biosci.utexas.
edu/utex/    ).   

   2.    f/2 growth medium (commercially available or   http://www.
sbs.utexas.edu/utex/media.aspx     for protocol).   

   3.    Pyrex ®  90 mm × 50 mm evaporating dishes (part # 3140).   
   4.    Low-melting point agarose (Fisher Scientifi c # BP165-25 or 

comparable product).   
   5.    Disposable borosilicate glass Pasteur pipets.   
   6.    6-Well culture plates (Corning Costar part # 3527).   

 Trichoplax adhaerens , an Enigmatic Basal Metazoan with Potential
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   7.    Phosphate buffer with Triton (PBT): 0.1 M sodium phosphate 
buffer, pH 7.2, 0.15 M NaCl, 0.2 % Triton X-100.   

   8.    DABCO mounting medium: 1 % DABCO in 90 % glycerol 
and 10 % PBS (pH: 8.0–9.0).      

3    Methods 

   Several colonies of  Trichoplax  can be maintained with approxi-
mately 1 h of time investment per week ( see   Note 1 ). Seawater can 
be natural or artifi cial, ideally with salinity between 30 and 35 ppt 
( see   Note 2 ); specimens generally appear to tolerate higher salini-
ties (>35 ppt) better than lower salinities (<30 ppt). 

 There are two components to maintaining a  Trichoplax  colony: 
fi rst, establishing the algal foodstock (unicellular pyrenomonas 
algae), and second, setting up and maintaining the  Trichoplax  
dishes. The long-term maintenance of colonies requires healthy 
algae cultures which should be prepared at least 7–10 days before 
the fi rst  Tricholplax  culture is established ( see   Note 3 ). It is also 
essential that embryologically clean glassware is used for all pro-
cesses related to  Trichoplax  cultures ( see   Note 4 ). 

  Trichoplax  can be collected in tropical and subtropical regions 
around the globe ( see  ref. [ 8 ] and  Note 5 ).  

  Culturing  Trichoplax  requires the maintenance of axenic algae 
 cultures as well as a working stock.

    1.    A commonly used unicellular algal species for  Trichoplax  cul-
tures is  Cryptomonas  sp. ( see   Note 6 ) which can be cultured at 
room temperature with a 12:12 light:dark cycle. If faster 
growth is required they can be kept under continuous light 
and supplemented with CO 2  ( see   Note 7 ).   

   2.    Axenic algal cultures are maintained separately from the work-
ing stocks. In order to keep the algae culture axenic, sterile 
techniques should be used at all times ( see   Note 8 ).   

   3.    Working stock solutions are inoculated with 5 ml of axenic 
stock solution. Depending on the conditions (i.e., light, CO 2  
temperature), these cultures will take 1–2 weeks to grow to a 
usable density ( see   Note 9 ).   

   4.    Working stock cultures are maintained in sterile 1 l bottles 
fi lled with 500 ml of f/2 (250 μl of f/2 component A and 
250 μl component B in 500 ml of FSW). Use a small aquarium 
pump connected to a 5 ml plastic transfer pipette to aerate 
(air and CO 2 ;  see   Note 7 ) the cultures. Also make sure that 
the cultures are covered with aluminum foil or Parafi lm™ to 
avoid contamination.    

3.1  Collection 
and Maintenance

3.2  Algal Cultures

Andreas Heyland et al.
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    Maintaining  Trichoplax  cultures requires very little space, water, and 
time. The instructions below outline a simple protocol for the suc-
cessful maintenance of a healthy  Trichoplax  population in the lab.

    1.     Trichoplax  cultures are maintained in covered Pyrex 
90 mm × 50 mm evaporating dishes fi lled approximately 90 % 
with fi ltered seawater (FSW: 0.2–0.45 μm;  see   Note 10 ), 
allowing suffi cient air exchange between the culture and the 
environment.   

   2.    Water should be changed every 2 weeks, but the culture will 
survive up to several more weeks without a water change. 
When changing the water of the cultures carefully pour off 
70 % of the water in the container without exposing the 
 Trichoplax  to air. Gently add autoclaved FSW with the proper 
salinity until the dish is 90 % full and add 2 ml of algal feeding 
solution (densities can vary but the algae culture should be in 
a healthy part of its growth and not overly dense;  see   Note 9  
on algae culture for details).   

   3.    When starting a new culture of  Trichoplax , begin with an 
autoclaved dish and add the water. After adding the water 
place 10–15  Trichoplax  into the dish then add 2 ml of the algal 
feeding solution and place a lid loosely on the new culture 
( see   Note 11 ).   

   4.    Start two new cultures per month and discard cultures after 
6–12 months.    

     While  Trichoplax  has a distinct upper and lower ciliated epithelium, 
it lacks an anterior–posterior polarity. When  Trichoplax  is observed 
under a microscope, their net directional movements are so slow 
that they are almost imperceptible. Slightly more rapid indications 
of activity include changes in folding and invagination patterns of 
the organism (Fig.  1 , Online Supplement 1). These folds can occur 
towards the center or the perimeter of the organism and are usually 
visible as subtle color changes under the microscope. 

 Time lapse photography, however, reveals a richer array of 
behavioral patterns in  Trichoplax . Specimens can be observed 
under a microscope with a capture frequency of one frame per 
5–10 s. This will result in continuous movements in the fi nal video 
and allow tracking as well as qualitative and quantitative analyses of 
these behaviors.  

  In order to setup simple time lapse recordings, specimen are trans-
ferred into small petri-dishes (35 mm diameter) with glass inserts 
and placed on a dissecting microscope with transmitted light or an 
inverted microscope ( see   Note 12 ). Videos can be captured for 
up to 4 h without any major water evaporation. This is based on 

3.3   Trichoplax  
Cultures

3.4  Behavioral 
Analysis

3.5  Recording 
Behaviors
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a total water volume of 4 ml/dish ( see   Note 13 ). Following is a 
summary of behaviors that can be observed using time lapse 
recordings. Note that various folding patterns, invaginations and 
fl ipping can be observed under real time conditions, while all other 
patterns require time lapse recording.  

      1.    Folding:  Trichoplax  shows distinct folding patterns of the dor-
sal and ventral epithelium. A part of the dorsal and ventral 
epithelium is elevated away from the substrate while the sides 
of the fold move closer towards each other. These folds gener-
ally occur along the outer edge of the organism and are critical 
components of fl ipping behavior ( see  below).   

   2.    Invagination: Invaginations are similar to folding ( see  above) 
in that the perimeter of the organism is changing shape. In 
contrast to folding they do not involve a signifi cant elevation 
of the epithelium away from the substrate.   

   3.    Rippling: Animals create folds ( see   step 1 ) along the outer 
edge but there are more and smaller folds in comparison to 
the folding pattern described above.   

   4.    Rotating: The animal rotates without any major displacement 
in a specifi c direction.   

   5.    Flattening: The outer edge of an individual moves outwards. 
Distinct movements in the center can occur ( see  Online 
Supplement 2). This generally co-occurs with reduced dis-
placement per time ( see  also description of feeding behavior 
below).   

   6.    Flipping/Turning: Since  Trichoplax  can distinguish between 
up and down (or as others have referred to as dorsal and ven-
tral) they show distinct behavioral patterns when they are 
placed upside-down. The sequence begins with the even fold-
ing of the outer edge into a cup like shape ( see  also  step 1 ). 
The raised borders of the epithelium then move in opposite 
directions until the down-facing epithelium faces upwards and 
the animal unfolds.   

   7.    Feeding: As noted by others (i.e., [ 13 ]) feeding is accompa-
nied by a specifi c set of behavioral patterns that can be clearly 
and repeatedly seen in time lapse recordings (Online 
Supplement 2). To further characterize feeding behavior, we 
compared the activity patterns of the same individual on dishes 
with and without naturally grown biofi lm. During exposure to 
biofi lm,  Trichoplax  displayed specifi c and recognizable behav-
ioral patterns. This behavior consisted of noticeable fl attening, 
resulting in increased surface area, sometimes to almost dou-
ble their original surface area ( see  Fig.  2  and  Note 14) .

3.6  Identifying 
Specifi c Behavioral 
Elements

Andreas Heyland et al.
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             1.    Touching: Two individuals are making contact with each other 
without any folding occurring.   

   2.    Brushing: Folds are created along the outer edge of animals in 
response to direct contact between two individuals. In an 
extreme case, this can result in an extensive contact zone 
between the individuals on their ventral epithelia.   

   3.    Aggregation: Multiple individuals in a dish form large aggre-
gates that are all connected with each other, potentially form-
ing a syncytium. We observed such aggregates in apparently 
healthy cultures with abundant biofi lm growth. Online 
Supplement 3 shows a time lapse video analysis over 12–24 h 
of such aggregates. Individuals are budded off or fuse together 
with the aggregate on a regular basis.      

3.7  Identifying 
Social Behaviors

  Fig. 2     Trichoplax  response to light and biofi lm. Under dark conditions,  Trichoplax  
moves signifi cantly less then under light conditions ( a ). This difference can be 
quantifi ed using video analysis ( b )— y -axis is in pixels/frame. We also compared 
the surface area and displacement of  Trichoplax  and response to biofi lm and found 
that animals move signifi cantly slower on biofi lm while increasing their surface 
area ( c  and  d )— y  axis in ( c ) is in pixels in ( d )— y -axis is in pixels/frame. For more 
details on feeding behavior and video analysis  see  text and Fig.  4 . Scale bars: 4 mm       
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  Experiments can be used to analyze behavioral patterns in response 
to neurotransmitters, putative chemoattractants, biological 
extracts, or other chemicals. Compounds can be diluted in seawa-
ter or presented as a local source within the experimental arena 
(Fig.  3 ). We discuss two complementary types of assays that can 
provide novel insights into the behavior of  Trichoplax. 

   The goal of these trials is to test the physiological activity of a 
chemical. The basic design consists of four phases. Standard condi-
tions for behavioral recording include 30–60 min trials using time 
lapse with 1 frame every 5–10 s.

3.8  Pharmacological 
Trials: Dissolved 
Chemicals

  Fig. 3    Summary of experimental designs for behavioral analysis in response to 
chemicals. ( a )  Trichoplax  is placed in the experimental arena and the petri dish is 
fi lled with 4 ml of fi ltered seawater. Washes can be done without having to remove 
 Trichoplax  from the arena. Point-source experiments ( b ) can be done with chemi-
cals mixed into small agarose blocks which are then placed into the experimental 
arena. The relative distance of  Trichoplax  to any of these point sources can be 
plotted as a function of time ( c ). In this experiment one agarose block contained 
a 10 −3  M Glycine (a + g), while the other block only contained agarose and solvent 
vehicle. Four out of fi ve trials showed a clear tendency to move towards the gly-
cine source relative to the control source. Note that the measurement shown on 
the  y -axis is relative to the control and therefore does not have any units       
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    1.    One or multiple  Trichoplax  are placed in the experimental 
arena (Fig.  3 ) and allowed to settle for 30 min. It is important 
that individuals are only exposed to ambient light during this 
time and that vibration and other disturbances are avoided 
( see   Note 15 ).   

   2.    Recording can then be started for 30–60 min using standard 
conditions ( see  above).   

   3.    The water is carefully removed from the dish with a glass or 
plastic pipette, ensuring that  Trichoplax  remains submerged in 
a small pool of water inside the experimental arena ( see   Note 12 ). 
The dish is then refi lled with experimental solution. Recording 
should be started immediately after the addition of solution in 
order to capture fast behavioral responses.   

   4.    The chemical solution is removed and the dish is refi lled with 
fi ltered seawater. It is important to rinse the dish at least three 
times before starting to record in order to dilute chemicals 
( see   Note 16 ).      

  The goal of these trials is to test the response of  Trichoplax  to a 
local chemical source. In contrast to the dissolved chemical trials 
outline above, point-source trials can be used to analyze chemoat-
tractants or repellent responses.

    1.    In preparation for a trial, one needs to prepare low-melting 
point agarose with and without the inclusion of a known con-
centration of a specifi c chemical or extract (controls will con-
tain water or the specifi c solvent that was used to dissolve 
chemical). If the compound is relatively heat stable, regular 
agarose can be used. Mix 0.1 g of agarose with 10 ml of FSW 
and warm up in a water bath or microwave oven until agarose 
dissolves. Next, aliquot liquid agarose into 1.5 ml Eppendorf™ 
tubes and add the dissolved chemical. Mix well before gelling 
occurs. Tubes can be kept in the refrigerator or freezer until 
they are used for the experiment ( see   Note 17 ).   

   2.    Before an experimental trial, bring the agar to room tempera-
ture and stab it with a disposable borosilicate glass Pasteur 
pipette to remove a small cylinder from the tube that can be 
easily pushed out of the pipette into a plastic dish. Use a fi ne 
scalpel to cut a small slice of this cone under a dissecting scope. 
Transfer experimental and control slices carefully to opposite 
sides of the experimental arena fi lled with FSW using forceps. 
In addition to these replicated experimental trials, two types of 
replicated control trials have to be performed where chemical 
versus chemical and control versus control blocks are pre-
sented ( see   Notes 18  and  19 ).    

3.9  Pharmacological 
Trials: Point- Source 
Trials
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    Time lapse videos can be imported into ImageJ [ 14 ] using the 
Bioformats LOCI plugin (  http://www.loci.wisc.edu/software/
bio-formats    ) and be transformed into .avi videos using JPEG 
 compression as well as variable frame rates to keep fi le size small. 

 For both qualitative and quantitative analyses of videos, ImageJ 
[ 14 ] can be used to create summary videograms [ 15 ], track either 
single or multiple individuals, and acquire morphological mea-
sures. Below are point by point instructions on how to setup and 
perform a video analysis (Fig.  4 ).

3.10  Video Analyses

  Fig. 4    Video analyses of  Trichoplax  behaviors include tracking either single or multiple individuals as well as 
quantifi cation of morphological characteristics associated with different behaviors. ( a ) Videogram [ 15 ] showing 
the activity pattern over a 76 min video by a single  Trichoplax  crawling, pausing, and then continuing to crawl; 
Scale bar: 800 μm. ( b ) Several particle analysis measurements (ImageJ) show changes that correlate with the 
change in behavior. Mean gray value decreases as the animal becomes slightly darker, while the standard 
deviation (StDev) of the gray value increases as rippling occurs during the pause. In addition, the more circular 
morphology is apparent in a number of measures, including increased circularity, roundness, and solidity, and 
decreased aspect ratio, feret diameter, and perimeter. ( c ) Locomotory track of the  Trichoplax  shown in ( a ) and 
( b ), based on coordinates acquired using the Analyze Particles command in ImageJ ( arrow  indicates start loca-
tion). ( d ) Locomotory paths of fi ve  Trichoplax  monitored simultaneously in a different video (duration: 3 h). 
Seven tracks are visible since two  Trichoplax  crawled out and then back into frame (start/return points indi-
cated by the different symbols). Tracks were generated automatically using the MTrack2 plugin in ImageJ       
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     1.    Contrast: The critical step in automating behavioral analyses is 
ensuring adequate contrast between the  Trichoplax  and the 
background. This can be achieved either by: (1) ensuring all 
portions of every  Trichoplax  in the video are consistently darker 
(or lighter) than the background, or (2) using background 
image subtraction to enhance contrast of moving objects 
[ 15 ,  16 ]. Briefl y, either a blank frame without any  Trichoplax  
in view or a mean frame, averaged across the entire video 
(which blurs the moving  Trichoplax  into the background), can 
be subtracted from every frame in the video, generating a video 
with just the moving  Trichoplax  in view. Once adequate 
 contrast is achieved, selection of an appropriate threshold will 
isolate the  Trichoplax  in a stack of binary images correspond-
ing to each frame of the source video ( see   Note 20 ).   

   2.    Videograms: Videograms provide a quantitative activity sum-
mary of a video clip [ 15 ]. To generate these, the binary image 
stack is simply summed, generating a single image with pixel 
values proportionate to the number of frames a  Trichoplax  was 
active in that pixel location. These can be used for both quali-
tative comparisons of different treatments or quantitative anal-
yses of activity levels (based on the pixel gray values).   

   3.    Tracking: To track individual  Trichoplax  in the binary image 
stack, the “Analyze Particles” command in ImageJ [ 14 ] gen-
erates  x  and  y  coordinates that indicate the centroid of an 
ellipse fi t to the  Trichoplax  shape. When all frames are pro-
cessed, these then provide a two-dimensional locomotory 
track for the  Trichoplax  in the video. Semiautomated tracking 
of multiple individuals can also be achieved using the MTrack2 
plugin (downloadable from   http://valelab.ucsf.edu/~nico/
IJplugins/MTrack2.html    ) ( see   Note 21 ).   

   4.    Morphological Measurements: In addition to tracking object 
locations, the “Analyze Particles” command in ImageJ [ 14 ] 
provides access to a range of morphological measurements 
(both pixel values and shapes) that can aid quantitative analy-
ses of  Trichoplax  videos. Any of these can be gathered at the 
same time as tracking by using the “Set Measurements” com-
mand, selecting the appropriate measures and choosing 
“Redirect To” the original source video stack (this allows cal-
culations based on the video pixel values).   

   5.    Example Analysis: As an example of the outlined method we 
present a behavioral analysis of  Trichoplax  to light. For these 
analyses, source videos of single  Trichoplax  at 1 frame per 30 s 
were used. To enhance contrast, a mean frame was calculated, 
and this was then subtracted from every frame in the source 
video. The video was then cropped to exclude areas outside 
the area where  Trichoplax  behavior occurred. The resulting 
cropped and motion enhanced video was converted to a binary 
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image stack, with the threshold set to ensure the entire 
 Trichoplax  shape was present in the binary image. The parti-
cles were analyzed to fi nd the  Trichoplax  locations, with three 
important settings: (1) Since the chosen threshold introduced 
some spurious smaller noise particles due to contrast fl uctua-
tions, the minimum particle area was set to fi lter out the noise, 
leaving just the  Trichoplax  as part of the analysis. (2) The mea-
surements were redirected to the original video to allow pixel 
gray values to be part of the measurements. (3) A noise-less 
binary image stack including just the  Trichoplax  was generated 
using the Show Masks option. Videograms were generated by 
summing the resulting binary image stacks (after removing the 
inverted LUT that is applied by default and interferes with the 
summation). The measurements table including the  x  and  y  
coordinates was saved, and Excel (Microsoft Corp.) was used 
to calculate frame-by- frame displacements which we then 
summed over each trial and compared between treatments 
(Fig.  2 ;  see   Note 22 ).    

    In recent years more research on  Trichoplax  has began to focus on 
molecular and cellular processes. Although still rudimentary, some 
useful protocols exist for basic methodologies such as immunohis-
tochemistry (IHC), in situ hybridizations (ISH) and even some 
transient knockdown techniques have been employed. 

 Standard IHC can be used for  Trichoplax . We tested the IHC 
method outlined below using antibodies raised against serotonin, 
alpha- and beta-tubulin and histone H3. Other authors [ 17 ] also 
presented IHC data based on an RFamide antibody using this 
method. Figure  5a  shows ciliary stain of  Trichoplax  using alpha- 
tubulin antibody (monoclonal anti-α-tubulin antibody, clone 
DM1A; Sigma Chem. Co.). Note that live and fi xed  Trichoplax  
have a broad range of autofl ourescence. Figure  5b–d  shows images 
of live  Trichoplax  at three commonly used wavelengths (used for 
the visualization of FITC, TRITC, and Cy5). Fixation generally 
quenches autofl ourescence slightly.

     1.    Fixation overnight at 4 °C. 4 % paraformaldehyde in seawater 
can be used for the fi xation, but specimens have often been 
observed to disintegrate during subsequent processing 
( see   Note 23 ). The addition of 0.25 % of glutaraldehyde 
enhances tissue preservation ( see   Note 24 ).   

   2.    Five washes in PBT 10 min each at room temperature (RT).   
   3.    Two washes in blocking solution (PBT, 10 % goat serum), fi rst 

wash 5 min, second wash for 1 h at RT.   
   4.    1° Antibody incubation (Blocking solution, 1° antibody 

1:200–1:5,000) overnight at 4 °C.   
   5.    Five washes in PBT, 10 min each at RT.   

3.11  Immunohisto-
chemistry Methods

Andreas Heyland et al.
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   6.    2° Antibody incubation (PBT, 2° antibody 1:400–1:1,000), 
3 h at RT or overnight at 4 °C.   

   7.    Five washes in PBT, 10 min each.   
   8.    Mount on poly- L -lysine coated slides with DABCO mounting 

medium ( see   Note 25 ).    

    Over the past years, several molecular methods have been success-
fully applied to  Trichoplax . For example, several groups have suc-
cessfully employed ISH with  Trichoplax  [ 18 – 23 ]. While the 
protocols differ slightly from group to group, the most important 
steps are comparable. In our experience,  Trichoplax  can be fi xed in 
4 % paraformaldehyde and post-fi xed in ice cold 100 % methanol 
for 10 min. We also noted that proteinase K treatment is generally 
not necessary. Finally, hybridizations in heating ovens give the 
best results. 

 Two types of transient knockdown techniques have been 
applied to  Trichoplax : double-stranded RNA and morpholino anti-
sense oligonucleotides. Both techniques have resulted in successful 
knockdown effects as documented by [ 19 ]. 

3.12  Molecular 
Methods

  Fig. 5    Alpha-tubulin staining of  Trichoplax  using immunohistochemistry protocol further explained in the text 
( a ). Scale bar equals 150 μm.  Trichoplax  produces signifi cant amounts of autofl uorescence in all three 
 commonly used channels: FITC, TRITC, and Cy5 ( b – d ). Scale bars on  panels  ( b – d ) are 90 μm       
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 DNA and RNA extraction methods have been successfully 
applied to  Trichoplax  and do not require special techniques. 
Protocols for DNA extractions can be found in Pearse [ 8 ]. In our 
experience, one requires at least 30 specimen to successfully isolate 
>20 ng/μl high-quality RNA using RNAqueous ® -Micro Kit 
(Ambion).   

4    Notes 

     1.    The amount of time needed to maintain  Trichoplax  largely 
depends on whether fi ltered seawater is readily available and 
whether the cultures are fed with live algae or rice ( see  
Subheading  3.1 ).   

   2.    The salinity can be measured with a handheld salinity meter or 
refractometer.   

   3.     Trichoplax  cultures can be easily maintained for several months 
using uncooked rice. Add 2–3 rice grains to the culture at each 
waterchange and remove the old ones. If cultures should be 
maintained longer however it is recommended to use live 
algae.   

   4.    All glassware that is used for  Trichoplax  or algae cultures need 
to be embryologically clean. This means that it must be auto-
claved and not exposed to any soap, detergent, or bleach at 
any time. It is generally recommended that a separate area 
with dedicated tools is set aside in the lab for cleaning.   

   5.     Trichoplax  can be shipped in 50 ml Falcon tubes. Rinse the 
tube with deionized water then fi ll it with FSW. Place the 
desired number of  Trichoplax  inside the tube and wait 10 min 
for the  Trichoplax  to attach themselves. Gently add more water 
until the tube starts to overfl ow, at this point stretch Parafi lm™ 
over the top of the tube and tighten the lid on the tube.   

   6.    We tested different algae species and the best results were 
achieved with  Cryptomonas  sp. (stock number LB 2423 from 
UTEX): The Culture Collection of Algae; The University of 
Texas at Austin; 1 University Station A6700, Austin, TX 
78712-0183, USA; (ph) 512-471-4109; (fax) 512-471-0354.   

   7.    If cultures are supplemented with CO 2  it is recommended to 
keep it at a concentration of approximately 1 % which can be 
achieved by gently bubbling CO 2  into the algae cultures. This 
cannot be done with the axenic stocks.   

   8.    Recommended protocol for maintaining axenic algae cultures: 
First, open the sterile algae culture immediately after arrival 
and transfer 1 ml of culture into two autoclaved tall disposable 
borosilicate glass test tubes with either a breathable plastic lid 
or a sterile cotton plug. To the same tubes add 4 ml of sterile 
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FSW containing 0.05 % f/2 components A and B (i.e., 2 μl 
component A and 2 μl component B; note that this stock can 
also be prepared in larger quantities and kept at 4 °C). Care 
should be taken not to cross-contaminate components A and 
B (use different pipette tips). This and all subsequent transfers 
should be done under a laminar fl ow hood using sterile pipette 
tips and glassware. The axenic culture needs to be changed 
once every 2 weeks by transferring 1 ml of the original culture 
into a new tube with 4 ml f/2. One such culture (5 ml total 
volume) can also be used to setup a new working stock culture 
( see  below) after at least 1 week of growth.   

   9.    To estimate algal density take a small sample from these cul-
tures and count the number of cells every 2 days using a 
hemocytometer. Do not use the culture to feed  Trichoplax  
once the growth curve reaches a plateau (the maximum cell 
density ranges from 1,000 cells/μl under low light conditions 
to 3,000 cell/μl under high light conditions). Once the work-
ing stock culture has reached this point, transfer 100 ml into 
500 ml growth medium (250 μl of f/2 component A and 
250 μl component B in 500 ml of FSW) to setup a new cul-
ture. Note that this transfer should be done maximally four 
times before a new axenic culture sample is used to inoculate 
the working stock culture.   

   10.    While cultures can be maintained in plastic dishes we had bet-
ter success with glass dishes.   

   11.    Alternatively, cultures can be inoculated with algae up to a 
week before adding  Trichoplax  so that a biofi lm can grow.   

   12.    Differential Interference Contrast (DIC) illumination is pre-
ferred for time lapse recordings but regular brightfi eld illumi-
nation can be used as well. We have also had success using 
agarose plates (prepared with seawater) as a suitable substrate 
for behavioral experiments.   

   13.    In a 4 h trial the salinity will likely increase. One strategy to 
avoid excessive evaporation and perform longer trials is to 
cover the dishes. With this setup, water condensation on the 
lid can obscure observations if the room temperature is higher 
than the initial water temperature. This problem can be par-
tially solved by using an inverted microscope.   

   14.    During feeding the animal crawled noticeably more slowly 
across the substrate compared to when it was in the dish with-
out biofi lm.  Trichoplax  also appeared to thicken around the 
periphery while fl attened. The inner fl attened portion became 
thicker in some parts, moving outward towards the periphery 
in a wave-like motion, almost as if the  Trichoplax  was “kneed-
ing” the surface of the arena. While on the biofi lm,  Trichoplax  
seemed to exhibit this behavior several times, and each time 
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was followed by a short bout of movement to a slightly 
 different position before fl attening again. After the  Trichoplax  
moved to a new location, it was apparent that biofi lm had 
been removed from the bottom of the arena.   

   15.    The conditions during this adjustment phase should be identi-
cal to those used during the experimental trial.   

   16.    Removing too much water can lead to immediate disassocia-
tion of  Trichoplax  due to surface tension.   

   17.    Make sure to always use the same agarose stock for the experi-
mental and control trials.   

   18.    Agarose will become almost transparent under water and it is 
therefore advisable to mark the position of the experimental 
and control blocks. Furthermore the relative position of these 
blocks should be randomized between trials ( see  Fig.  3  for 
details). Behavioral patterns as well as directional data can be 
extracted from these assays (Fig.  3  and    Subheading  3.4 ).   

   19.    Point-source trials can be performed with multiple individuals 
with and without video recording. For example, multiple rep-
licates can be run simultaneously without recording in 6-well 
culture plates. At the end of each trial the positions of indi-
viduals can be recorded and travel distance relative to the 
chemical source calculated.   

   20.    Contrast fl uctuations that result in spurious objects in the 
binary images can be removed, provided they are found in 
consistent locations, are consistently smaller than  Trichoplax , 
or have consistently higher aspect ratios than  Trichoplax .   

   21.    This method can automatically provide tracks for  Trichoplax  
that do not touch each other; however manual intervention is 
necessary to separately identify two or more individuals that 
contact each other, and thus will be counted as one particle by 
the software.   

   22.    Note that the light environment needs to be kept constant 
when performing behavioral trials.   

   23.    Because  Trichoplax  specimens tend to disintegrate during his-
tological processing, they can also be pre-mounted on poly- 
lysine coated slides and all steps can be performed on slides. 
See also additional notes on fi xations above.   

   24.    Addition of 0.5 % glutaraldehyde noticeably increases back-
ground fl uorescence, while specimens fi xed in 4 % paraformal-
dehyde with the addition of only 0.1 % glutaraldehyde often 
fell apart.   

   25.    DABCO mounting medium can be prepared using a 10× PBS 
or TBS buffer solution that has the correct amount of DABCO 
dissolved in it. Add 1 ml of that solution to 9 ml of glycerol 
(check for autofl ourescence) and prepare 1 ml aliquot that can 
be frozen at −20 °C.         

Andreas Heyland et al.
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    Chapter 5   

 Rearing Gymnolaemate Bryozoan Larvae for Cellular 
and Molecular Analyses 

           Michael     H.     Temkin    

    Abstract 

   Gymnolaemates represent the largest group of extant bryozoans, having more than 3,000 described 
 species. Gymnolaemates display a diverse array of reproductive and developmental patterns including 
planktotrophy, lecithotrophy, and matrotrophy. The larvae of gymnolaemates have been broadly grouped 
into three types, cyphonautes (shelled, feeding), pseudocyphonautes (shelled, nonfeeding), and coronate 
(unshelled, nonfeeding), although each group is heterogeneous and probably includes various morpholo-
gies that are largely undescribed. Here, methods for rearing bryozoan colonies and larvae are presented.  

  Key words     Bryozoan  ,   Larvae  ,   Coronate  ,   Cyphonautes  

1      Introduction 

 Gymnolaemate bryozoans have either a feeding (cyphonautes) or a 
nonfeeding (pseudocyphonautes or coronate) larval form [ 1 – 3 ]. 
In the majority of gymnolaemates, fertilized eggs are retained by 
maternal individuals and may be brooded in one of several differ-
ent ways for about 2–3 weeks until a fully developed nonfeeding 
larva is released [ 1 ,  2 ,  4 – 9 ]. The bulk of the nutrients to support 
the development of nonfeeding larvae is supplied by the maternal 
individual either to the egg during vitellogenesis before ovulation 
or to the embryo via a placental-like system after spawning [ 1 ,  2 , 
 5 ]. In some species of the genera  Alcyonidium ,  Bifl ustra ,  Conopeum , 
 Electra ,  Hislopia , and  Membranipora , fertilized eggs are not 
retained by maternal individuals and embryos develop into plank-
totrophic, cyphonautes larvae [ 1 – 3 ,  10 – 12 ]. 

 Gymnolaemate larvae usually spend some amount of time 
swimming in the water column before settling and undergoing 
metamorphosis to form an “ancestrula” (i.e., the fi rst member of a 
new bryozoan colony) [ 1 ,  2 ,  13 ,  14 ]. Nonfeeding larvae swim 
from several hours up to 2 days after release, although shorter 
times are more typical if a suitable substrate is present [ 13 ,  15 ,  16 ]. 
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Extending the swimming period by preventing coronate larvae 
from undergoing metamorphosis can signifi cantly increase the 
time it takes to complete metamorphosis, reduce the overall size of 
the ancestrula including the lophophore, and decrease the survi-
vorship of ancestrulae [ 16 – 18 ]. In comparison to nonfeeding lar-
vae, cyphonautes larvae may swim for a month or more in the 
water column before becoming competent to undergo metamor-
phosis depending on the supply of food. For example, cyphonautes 
of  Membranipora  sp. have been estimated to spend at least 4 weeks 
in the water column before metamorphosis [ 19 ,  20 ]. Cyphonautes 
can extend their developmental period when food is scarce by 
resorbing portions of the juvenile rudiment, which regrow and 
become functional when food becomes available again [ 21 ]. 

 As larvae approach metamorphosis, their responses to environ-
mental cues change. In particular larvae become negatively or neu-
trally phototaxic and positively geotaxic ( see  refs.  1 ,  2 ,  13 ,  22 ) 
which causes them to swim toward benthic substrates. 
Gymnolaemate larvae explore potential settlement sites with the 
pyriform organ, a composite sensory and glandular structure [ 1 – 3 , 
 13 ]. Gymnolaemate larvae have been demonstrated to choose set-
tlement sites based on the presence of biofi lms ( see  refs.  1 ,  2 ), the 
presence of congeners or conspecifi cs (e.g., [ 23 ,  24 ]), or the age 
and species of kelp (e.g., [ 25 ,  26 ]). Gymnolaemate larvae may 
temporarily attach to a substrate using secretions of the pyriform 
organ, but permanent attachment occurs during metamorphosis 
through the eversion of the internal sac which becomes cemented 
to the substrate by mucopolysaccharide adhesive secretions [ 1 ,  2 ]. 
The reorganization of the larva into the ancestrula during meta-
morphosis is extensive and may take from one to several days to 
complete depending on the species [ 1 ,  2 ,  14 ,  16 ]. 

 The method used for rearing larvae of any particular gym-
nolaemate bryozoan depends on the reproductive pattern of the 
species. For example, rearing cyphonautes larvae involves collect-
ing and caring for embryos and larval stages [ 21 ]. In contrast, rear-
ing nonfeeding larvae involves the care and maintenance of adult 
colonies until larvae are released [ 27 – 35 ]. Here, methods for the 
general rearing and maintenance of gymnolaemate bryozoans, 
obtaining nonfeeding and cyphonautes larvae, and obtaining 
ancestrulae and rearing young colonies are presented.  

2    Materials 

     Cultures of  Rhodomonas  sp. (catalog number CCMP757, 
CCMP, Bigelow Laboratory for Ocean Sciences, West 
Boothbay Harbor, ME, USA) prepared accordingly as 
described elsewhere [ 36 ].  

  Containers to hold colonies ( see   Note 1 ).  

2.1  General Care 
and Maintenance 
of Bryozoan Colonies

Michael H. Temkin
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  100 and 1,000 mL Tri-Pour ®  polypropylene, disposable beakers.  
  10 and 20 μm Tri-Pour ®  fi lter baskets. These fi lter baskets are made 

by modifying polypropylene Tri-Pour ®  polypropylene beakers 
( see   Note 1 ).  

  Small paintbrushes.     

      1.    Black or opaque plastic box.   
   2.    Fiber-optic light source or gooseneck lamp.      

     500 mM Ethylenediaminetetraacetic acid (EDTA), pH 8: Add 
350 mL of deionized water to a 1-L beaker containing a stir bar. 
Weigh 93.06 g disodium EDTA and 9.5 g NaOH ( see   Note 2 ). 
While monitoring with a pH meter, slowly add the disodium 
EDTA to water in beaker with stirring. In order for the EDTA 
to completely dissolve, adjust the pH to near 8 with NaOH. 
Once all the EDTA is dissolved adjust the fi nal pH to 8 with 
NaOH and bring the volume up to 500 mL with deionized 
water. Alternatively, 500 mM disodium EDTA can be pur-
chased from many suppliers, including Promega, Madison, 
WI, USA (catalog numbers V4231 and V4233).  

  0.1 mM EDTA in 10 μm fi ltered seawater: Filter seawater through 
a 10 μm fi lter basket and add 200 μL of 500 mM EDTA per 
liter of seawater. Make sure that the solution is mixed well.  

  20 mL plastic syringes.  
  Sterile 0.22 μm Fisherbrand ®  syringe fi lter disks (Fisher Scientifi c, 

Dallas, TX, USA).  
  35 × 10 mm Fisherbrand ®  Media-Miser Disposable Petri Dishes (cat-

alog number 08-757-11YZ, Fisher Scientifi c, Dallas, TX, USA).  
  Swinging paddles on a rack stirring mechanism constructed 

according to Strathmann ( see  Chapter   1    ).  
  Cultures of  Rhodomonas  sp. and  Isochrysis galbana  (catalog num-

ber CCMP1323, CCMP, Bigelow Laboratory for Ocean 
Sciences, West Boothbay Harbor, ME, USA) prepared 
 according to [ 36 ].     

      1.    Glass or plastic containers.   
   2.    Depending on the species, either artifi cial substrates including 

glass, plastic, acetate, and ACLAR ®  (Ted Pella Inc., Redding, 
CA, USA) or natural substrates such as shell, wood, macroal-
gae, or chicken egg inner shell membrane can be used.   

   3.    Seawater with 10 mM excess KCl: Dissolve 0.745 g of KCl per 
liter of 0.22 μm fi ltered seawater.       

2.2  Obtaining 
Nonfeeding Coronate 
Larvae from 
Gymnolaemate 
Bryozoans

2.3  Rearing 
Cyphonautes Larvae 
of  Membranipora 
membranacea 

2.4  Obtaining 
Ancestrulae and 
Growing Colonies

Rearing Gymnolaemate Bryozoan Larvae for Cellular and Molecular Analyses
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3    Methods 

      1.    Gently clean bryozoans of sediment and organisms that are 
adhering or growing on the surface of colonies ( see   Note 3 ). 
Try to remove as much sediment and as many organisms as 
you can, recognizing that colonies will likely not be pristine 
after you have fi nished cleaning them. Depending on the 
growth form (e.g., encrusting sheets, creeping or erect sto-
lons, or arborescent), colonies may be cleaned using a small 
paintbrush, a forceps, and/or your fi ngers. Rinsing colonies in 
fl owing seawater is also helpful.   

   2.    Place cleaned colonies into containers fi lled with seawater at 
the appropriate temperature and salinity. Since gymnolaemate 
colonies have many different shapes or sizes, and can grow on 
a wide variety of substrates (e.g., rock, wood, shell, algal 
fronds, sea grass, barnacles, ascidians, and other bryozoans), 
the choice of container will depend on the species, the pres-
ence and type of substrate, how much material was collected, 
and whether colonies are being maintained in a fl owing seawa-
ter system or static containers (e.g., bowls or jars). Bryozoans 
can be sensitive to anoxia, and overcrowding should be 
avoided, especially when colonies are kept in static containers 
( see   Note 4 ). Colonies may be hung or fl oated upside down to 
reduce the accumulation of sediment and fecal material on the 
colony surface.   

   3.    Gymnolaemates can be fed  Rhodomonas  sp. (10,000 cells/mL) 
as a supplement or as a replacement for food in natural seawa-
ter [ 29 – 31 ,  33 – 35 ,  37 ] ( see   Note 5 ).   

   4.    Reproductive colonies in many gymnolaemates can be distin-
guished by the presence of embryos developing in specialized 
brood structures such as ovicells or embryo sacs ( see   Note 6 ). 
Embryos are often yellow, orange, purple, or red in color. In 
some cases, brooding embryos can be easily observed by using 
dark-fi eld microscopy (Fig.  1 ). In species that do not brood 
embryos, such as  Membranipora membranacea , reproductive 
individuals have pale pink or tan disk-shaped eggs located 
within maternal coeloms and intertentacular organs (ITO) 
(egg- spawning organs) formed between the basal portions of 
the distomedial tentacles (Fig.  2 ).

              1.    Place colonies that are brooding larvae in the dark ( see   Note 7 ).   
   2.    After at least 5–8 h, expose the colonies to light.   
   3.    If possible dim the room lights, and place a light at the side of 

the container. A fi ber-optic light source works well here.   
   4.    Gymnolaemate coronate larvae from many species are posi-

tively phototactic after release and swim toward the light source 
[ 2 ,  13 ,  22 ,  28 ,  38 ]. After a short time, larvae accumulate on 

3.1  General Care 
and Maintenance 
of Bryozoan Colonies

3.2  Obtaining 
Nonfeeding Coronate 
Larvae from 
Gymnolaemate 
Bryozoans
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the side of the container near the light source. If the species 
you are working with releases larvae that are photoneutral, 
then larvae can be made more apparent by illuminating the 
container from the side. Larvae will appear as small refractile, 
spherical objects swimming in spiraling trajectories.   

  Fig. 1    Individuals of a colony of  Cribrilina  sp. viewed through a dissecting microscopy using epi-illumination 
with a fi ber-optic light source ( a ) or dark-fi eld microscopy ( b ). In the dark-fi eld image ( b ), dark spheres are 
embryos in ovicells except for the one marked with an  asterisk  which represents a primary oocyte within an 
ovary. Scare bar = 250 μm       

  Fig. 2    The lophophore of a reproductive individual from a colony of  Membranipora 
membranacea  possessing an intertentacular organ (ITO) and coelomic oocytes 
( arrowheads ). One disk-shaped primary oocyte (O) has just been spawned 
through the ITO while a second primary oocyte ( arrow ) is entering the ITO from 
the maternal coelom. Scare bar = 100 μm       
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   5.    Larvae can be transferred to tubes or other containers using 
glass or plastic pipettes.   

   6.    Larvae will typically swim for several hours before beginning 
to settle and undergo metamorphosis (see Note 8).      

      1. Place colonies of  M. membranipora  [ 39 ] on algal substrate in 
a glass dish containing 0.1 mM EDTA in 10 μm fi ltered sea-
water, cooled to ambient seawater temperature ( see   Note 9 ).  

   2. Allow  M. membranacea  colonies to spawn fertilized eggs for 
about 2 h (Fig.  2 ) ( see   Notes 10  and  11 ). Colonies may be 
kept at room temperature during this time. A slight increase in 
water temperature may increase spawning. Fertilized eggs are 
disk shaped but will become spherical after egg activation 
( see   Note 6 ).  

   3. After about 2 h, transfer colonies to a new bowl of 0.1 mM 
EDTA in 10 μm fi ltered seawater or return to normal seawater.  

   4. Fill a 35 × 10 mm Petri dish approximately halfway with 0.22 μm 
fi ltered seawater using a 20 mL syringe fi tted with a fi lter disk.  

   5. Use either a mouth pipettor fi tted with a glass pipette pulled 
from a glass tube ( see   Note 12 ) or a 200 μl micropipettor 
fi tted with a plastic tip to transfer embryos ( see  Fig.  3 ) from 
the bottom of the dish to the small Petri dish containing 
0.2 μm fi ltered seawater ( see   Notes 13  and  14 ). Do not trans-
fer more than between 100 and 200 embryos per dish to 
avoid overcrowding.

      6. Once embryos begin to swim (usually between 24 and 30 h 
depending on temperature), provide them with  Rhodomonas  
sp. (5,000 cells/mL) and  Isochrysis galbana  (40,000 cells/
mL) [ 21 ] ( see   Note 15 ).  

3.3  Rearing Feeding 
Cyphonautes Larvae 
of  Membranipora 
membranacea 

  Fig. 3    Differential interference contrast microscopy images of ( a ) zygote and ( b ) two-cell stage of  Membranipora 
membranacea . Polar bodies (pb) can be seen at the animal pole of each stage contained within the wrinkled 
fertilization envelope (FE)       
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   7. For long-term rearing, transfer larvae to larger containers that 
are stirred at about 8 rpm with a swinging paddle stirring appa-
ratus ( see  Chapter   1    ).  

   8. Change water and food at least weekly.  
   9. At about 12 °C, larvae may be competent to undergo meta-

morphosis in about 4–5 weeks [ 20 ].     

      1. Rinse substrates in seawater overnight. Many gymnolaemate 
species will settle on plastic, acetate, and  ACLAR  ®  in addition 
to natural substrates such as macroalgae, wood, shell, and 
chicken egg shell membranes ( see   Notes 16  and  17 ).  

   2. Fill bowls, dishes, or multiwell plates with 0.22 μm fi ltered 
seawater. To reduce variability in when larvae settle, metamor-
phosis can be induced using 0.22 μm fi ltered seawater con-
taining a 10 mM excess of KCl [ 40 ,  41 ].  

   3. Place appropriate substrates into the containers. Polystyrene 
weighing dishes can serve as both a container and substrate [ 35 ].  

   4. Transfer larvae competent to undergo settlement and meta-
morphosis into containers. An individual larva or a small 
 number of larvae can be added to a well of a multiwell plate 
( see   Notes 18 and 19 ).  

   5. Following the initial phases of metamorphosis, transfer sub-
strates with ancestrulae into containers with fresh seawater.  

   6. Once ancestrulae evert lophophores, feed them  Rhodomonas  
sp. at a concentration of 10,000 cells/mL.  

   7. Colonies can be grown in the lab or moved to the fi eld 
( see   Note 20 ).  

   8. As encrusting colonies increase in size, initial substrates can be 
glued to larger substrates using a cyanoacrylate adhesive to 
provide for more surface area for growth [ 34 ].      

4    Notes 

        1.    Depending on the species, we often use a variety of clear Pyrex 
glass bakeware to hold colonies. We fi nd 10 oz Pyrex custard 
cups, 4.8 quart oblong baking dishes, and 8-in. square baking 
dishes to be readily available and the most convenient for use 
with a dissecting microscope. A system that works well in run-
ning sea tables can be constructed out of modifi ed Tri-Pour ®  
polypropylene beakers and PVC pipe. We cut the bottoms 
from the Tri-Pour ®  beakers with a band saw and cover the 
open bottoms with Nitex mesh (150–500 μm), using either 
hot glue or silicon glue to hold the Nitex in place. The more 
open the mesh the easier it is to transfer water between the 
basket and the sea table. Modifi ed Tri-Pour ®  beakers are 

3.4  Obtaining 
Ancestrulae and 
Growing Colonies
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 suspended in the sea table by placing them in a rack built from 
2.5 cm rings of PVC pipe that are glued together along their 
sides at points of contact. The diameter of rings depends on 
the size of the Tri-Pour ®  beakers. For example, 1 L beaker 
baskets can be used for holding large colonies or many colo-
nies, whereas individual small colonies or young colonies can 
be kept in 100 mL Tri-Pour ®  beaker baskets. The height of the 
rack can be set by using nylon screws and nuts to mount the 
rack on to a set of legs consisting of ¾ in. PVC pipe. In this 
system water can be changed in the Tri-Pour ®  baskets by rais-
ing and lowering the basket in the rack. Also  see  refs.  27 ,  28 .   

   2.    NaOH is hydroscopic and will quickly pick up water from the air 
if left exposed in an uncovered weigh boat. We keep some NaOH 
in a capped 15 mL plastic centrifuge tube and briefl y open tube 
when we are adjusting the pH of the EDTA solution.   

   3.    Bryozoan colonies are a habitat for many organisms, including 
nudibranchs, ascidians, pycnogonids, turbellarians, poly-
chaetes, small arthropods, and nematodes. Many of these 
organisms eat either adult tissue or larvae [ 42 ]. Removing as 
many of these organisms from colonies will reduce the risk of 
adult and larval mortality due to predation.   

   4.    It is important to consider the oxygen consumption of living 
substrates, such as algal fronds or ascidians, when choosing con-
tainers or transporting colonies. In closed systems large algal 
biomass can cause anoxic conditions very quickly in the dark.   

   5.    Many types of food have been used to feed bryozoans [ 37 ]. 
I have tried to use commercial preparations of algal mixtures 
for bivalve aquaculture to replace  Rhodomonas  sp.; however, 
these algal mixtures alone did not support the long-term 
growth of colonies in the lab.   

   6.    Gymnolaemates spawn sperm (or sperm aggregates) through 
the tips of the tentacles. Spawned sperm enter maternal coe-
loms and fertilize either ovarian or coelomic primary oocytes. 
Although sperm–egg fusion occurs internally, eggs typically 
do not begin to develop until they are spawned from the 
maternal coelom ( see  refs.  4 ,  10 ).   

   7.    Depending on facilities, it is often convenient to place colonies 
in a dark box. A dark box can be constructed out of a black or 
an opaque plastic box or tote. The size of the box will be 
determined by the containers holding your colonies. Boxes 
can be adapted with ports to attach hoses for a fl ow-through 
system in a sea table.   

   8.    Bright fl uorescent illumination (130–170 μE/m 2  s) has been 
used to inhibit larvae of four species of  Bugula  ( B. neritina , 
 B. simplex ,  B. stolonifera , and  B. turrita ) from initiating meta-
morphosis and thus prolonging the length of the larval phase 
of development for more than 2 days [ 16 – 18 ].   
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   9.    The reason why 0.1 mM EDTA enhances developmental suc-
cess of  M. membranacea  is uncertain. EDTA chelates divalent 
cations. However, the low concentration of EDTA used to 
increase developmental success of  M. membranacea  embryos 
would not alter the concentrations of Ca 2+  or Mg 2+  in seawa-
ter. The addition of disodium EDTA to seawater does decrease 
the pH of the seawater by 0.4 U, but this pH change alone 
does not stimulate  M. membranacea  oocytes to undergo egg 
activation [ 10 ].   

   10.    In  M. membranacea  sperm aggregates of 32 or 64 sperm called 
spermatozeugmata are spawned through the two distomedial 
tentacles [ 10 ,  43 ]. Spawned spermatozeugmata are collected 
by the feeding currents of zooids and can enter maternal indi-
viduals through the ITO. Sperm aggregates disassociate and 
sperm–egg fusion occurs at ovulation, but egg activation does 
not occur until eggs are spawned through the ITO [ 10 ].   

   11.    This protocol will generate a batch of embryos that all begin 
to develop within the same 2-h window. Consequently, there 
will be a range of cleavage stages present among the embryos 
during the fi rst few hours after development has been initi-
ated. Once the early larval stage is achieved, individuals in a 
batch are indistinguishable from one another. An alternative 
to natural spawning to achieve greater synchrony within a 
batch of embryos is to cut open reproductive individuals, 
releasing eggs into 0.1 mM EDTA in 0.2 μm fi ltered seawater, 
cooled to ambient seawater temperature. Even though eggs 
have not been spawned through the ITO, eggs will undergo 
activation and develop normally [ 10 ].   

   12.    We make mouth pipettors from borosilicate glass tubing 
(3–5 mm outer diameter), latex rubber tubing (inner diameter 
should match outer diameter of glass tubing—1/8 in. will 
often work), and a tip for a 1 mL pipette. Cut glass tubing to 
lengths of approximately 3.5 in. Make glass pipettes by heating 
the center of the glass tubing over the fl ame of a Bunsen burner 
until it begins to soften. Pull the tubing until the diameter of 
the center of the tube is about 0.5 mm but the space inside the 
tube is not closed. After the tubing has cooled, break the tub-
ing to separate the two glass pipettes. If you pull until the 
lumen of the tubing has closed, you can sometimes still obtain 
a useful pipette by breaking the glass back to where the tubing 
is open. Fit the wide end of glass pipette into one end of the 
latex tubing and the narrow end of 1 mL pipette tip into the 
other end to use as a mouthpiece. Finer control of the pipette 
can be obtained by inserting a 1 in. piece of capillary tubing 
(5 mm outer diameter, 0.25–1 mm inner diameter) into the 
latex tubing between the glass tip and the mouthpiece.   

   13.    Embryos should be transferred into 0.22 μm fi ltered seawater 
as early cleavage stages. Embryos grown in seawater containing 
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0.1 mM EDTA through late cleavage stages usually do not 
develop correctly.   

   14.     M. membranacea  eggs and embryos are very sticky and will 
adhere very readily to the sides of pipette tips and dish bot-
toms. Try to gently expel embryos from pipettes into dishes. 
Embryos that tightly adhere to surfaces may not develop cor-
rectly or may remain stuck to the surface as larvae.   

   15.    Larvae seem to do better if food is available as soon as they 
become competent to feed. If you are only interested in early 
larval stages, then larvae can be fed a diet of  Rhodomonas  sp. 
or natural seawater fi ltered through a 20 μm Nitex mesh 
fi lter basket.   

   16.    Observations of metamorphic events and colony growth are 
often easier to make with transparent substrates such as clear 
or translucent plastic, acetate, and ACLAR ® .   

   17.    Cyphonautes of  M. membranacea  settle preferentially on kelp 
(e.g.,  Laminaria ) (e.g., [ 25 ,  26 ,  40 ]). Punches of kelp fronds 
can be prepared using a cork borer. In response to being cut, 
macroalgae like  Laminaria  produce extensive amount of 
mucus and should be rinsed overnight in seawater before 
being used as a substrate.   

   18.    Conspecifi c larvae may settle gregariously [ 23 ,  24 ].   
   19.    A multiwell plate with 24 or 48 wells works well. The construc-

tion of 96-well plates makes observations of events inside the 
well diffi cult with a dissecting microscopy. In most instances, 
you will probably want to use untreated multiwell plates as 
containers for larval settlement. There are a variety of multiwell 
plates used for tissue culture that are coated with substances 
such as poly- L -lysine, laminin, gelatin, and collagen.   

   20.    Mating colonies has been most often achieved by growing two 
or more colonies in the same container or in close proximity to 
one another (e.g., [ 31 – 33 ,  35 ]) rather than by collecting and 
distributing sperm between different colonies [ 34 ]. 
Fertilization events are not easy to manipulate in gymnolae-
mates for a variety of reasons. First, sperm spawned into the 
external seawater enter maternal individuals and sperm–egg 
fusion occurs internally. Second, sperm fuse with primary 
oocytes while they are still at a very early vitellogenic stage in 
many cheilostome species that brood their embryos. In these 
species, a primary oocyte containing a sperm nucleus may not 
begin developing for weeks, depending on how many primary 
oocytes are present within a particular ovary. Consequently, it 
is diffi cult to determine when an egg was fertilized. Third, 
colonies usually contain both functional male and female indi-
viduals, so some level of self-fertilization is almost always a 
possibility. Lastly, males do not spawn dense aggregates of 
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sperm. Thus, sperm are not easy to collect in large numbers, 
although  C. hyalina  may be an exception [ 34 ]. Recent studies 
of self-fertility in  C. hyalina  [ 33 ] and  B. stolonifera  [ 35 ] indi-
cate that selfi ng may produce high levels of sterile offspring. 
These results suggest the potential importance of sperm 
behavior and sperm–egg interactions in the fertilization pro-
cess to avoid selfi ng [ 43 ,  44 ].         
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    Chapter 6   

 An Invertebrate Embryologist’s Guide to Routine 
Processing of Confocal Images 

           George     von     Dassow    

    Abstract 

   It is almost impossible to use a confocal microscope without encountering the need to transform the raw 
data through image processing. Adherence to a set of straightforward guidelines will help ensure that 
image manipulations are both credible and repeatable. Meanwhile, attention to optimal data collection 
parameters will greatly simplify image processing, not only for convenience but for quality and credibility 
as well. Here I describe how to conduct routine confocal image processing tasks, including creating 3D 
animations or stereo images, false coloring or merging channels, background suppression, and compress-
ing movie fi les for display.  

  Key words     Confocal microscope  ,   ImageJ  ,   Stereo images  ,   False coloring  ,   Kymographs  ,   Image processing  

1      Introduction 

 This chapter describes strategies to display and present data generated 
by a confocal microscope—image series collected over focal height 
or time or both—using primarily the free image processing pro-
gram ImageJ (  http://rsbweb.nih.gov/ij/    ). This is neither the fast-
est nor the most sophisticated image processing program, but it 
runs on essentially any computer platform; it is readily extended 
using macros or easy-to-program plug-ins; and, because the code 
is freely available, a user modestly fl uent in Java can determine 
exactly what the program is doing to images. Therefore many of us 
are content with ImageJ for all of our image processing and analy-
sis. Virtually all commercial image processing software offer similar 
functions at some level. When such a package does not seem to do 
what you want, ImageJ is a helpful adjunct. In this chapter I also 
make use of PhotoShop and QuickTime, which are both widely 
available and by no means unique in their functions. 
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 I omit discussion of sophisticated methods for dealing with 
challenging or extensive datasets, such as deconvolution, auto-
mated segmentation, or volume rendering and 3D measurement. 
Available software for such techniques changes rapidly. 
Furthermore, at present relatively few embryological applications 
truly require advanced image processing: careful sample prepara-
tion and data collection will usually obviate the need for image 
manipulation beyond what is outlined here. 

 Before discussing  how  to manipulate images it is worth consid-
ering  whether  to do so. The short answer is that there is simply no 
avoiding it. However, the complete displacement of fi lm photogra-
phy by digital imaging, in science as well as everywhere else, and 
the widespread availability of image manipulation tools, naturally 
makes people suspicious about the credibility of published fi gures. 

 This is not quite so new a problem as it seems: the journals of 
a century ago were fi lled not with photos but with pen-and-ink 
drawings. These are no more nor less credible than the confocal 
micrographs of today, even though clearly the interpretation of a 
stained tissue section into a drawing on the page involves a deep 
act of manipulation. Compared to drawing, however, digital image 
processing is both easier to do and harder to detect. The issue is 
not so much outright fakery or deception but rather that we 
humans fi nd recognizable color images so compelling and there-
fore intrinsically credible. Poor choices of enhancements, color 
combination, or rendering can deceive unintentionally. 

 Few journals yet provide detailed guidelines for image manipu-
lation. The most extensive and well-thought-out set, to my knowl-
edge, has been prepared by the Journal of Cell Biology, which now 
also makes it easy for authors to deposit original raw data alongside 
fi gures. Hopefully other journals will follow the JCB’s lead. Their 
advice, drafted by Mike Rossner and Kenneth Yamada [ 1 ], boils 
down to this: a few straightforward steps are always acceptable and 
need not be mentioned; a few obvious deceits are universally unac-
ceptable; everything else needs to be disclosed to the reader. This 
is simple, commonsensical, and costs nothing whatsoever. 

 For the specifi c purpose of this chapter, I have adapted their 
advice, with a few additions, to a list of Ten Commandments:

    1.    “ God made crop and the contrast stretch; all else is the work of 
man ,” paraphrasing the mathematician Leopold Kronecker, 
who actually said this about the counting integers. He did not 
mean that one should not do computations involving irrational 
numbers. By analogy, in scientifi c image processing, it is always 
appropriate to crop to a region of interest. It is also universally 
desirable to set, judiciously, the white and black point, as long 
as nothing is thereby obliterated. Everything else—from 
gamma adjustment to convolution fi ltering—deviates from 
obviousness and should be disclosed upon publication.   
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   2.     Honor thy original data, and keep track of what you did to it . 
Hard disks are so cheap that no one should hesitate to keep a 
copy of the originally collected fi les. All image processing 
should be judged according to whether the chain of manipula-
tions preserves the essence of these original data.   

   3.     Thou shalt not blot out specifi c parts of images , i.e., to remove 
dirt or extraneous structures or “nonspecifi c staining.” Image 
quality intuitively implies something about the depth of inves-
tigation, and touch-up undermines this relationship. To quote 
Rossner and Yamada [ 1 ], “If you would have redone an exper-
iment to generate a presentation-quality image in the days 
before the digital age, you should probably redo it now.” This 
does not proscribe masking to systematically extract specifi c 
features, but obviously the use of masks is among the “all else” 
that should be explained.   

   4.     Thou shalt not montage together pieces of different images , unless 
the boundaries remain obvious to any viewer. Otherwise, to 
montage different specimens together risks misleading the 
viewer about the number, context, or independence of 
observations.   

   5.     All color is false color ; therefore, use it only when it is required, 
i.e., to show two labels together, or for highlighting zones of 
intensity within an image with a single label. When color is 
required, color tables should be selected to optimize either for 
the fi nal medium of reproduction (i.e., print or screen) or for 
human visual perception, hopefully both.   

   6.     Rotate images by 90 °  or 180 °  if at all possible ; this preserves 
original pixel values. If it is necessary to rotate images by inter-
mediate angles—e.g., so that all of a set have the anterior of 
the animal to the left—then do so as few times as possible, 
because this operation involves resampling of the original 
intensity values in which new pixel values are interpolated 
between original ones.   

   7.     Scale images by integer multiples  to avoid interpolation as much 
as possible. This is for a similar reason to #6: if an image must 
be enlarged, e.g., for print purposes alongside others, or to 
show a blown-up inset, then stretching it by integer multiples 
 without interpolation  amounts to the least alteration of original 
data. Likewise for image reduction. However, I disagree with 
Rossner and Yamada [ 1 ] that nearest-neighbor “interpola-
tion” should be preferred for arbitrary scaling. For non- integer 
multiples, this method’s only virtue is that it so obviously suf-
fers for its sins: the new pixel values are just as invented as in 
better interpolation methods, but they are  less accurate . If 
images must be scaled by non-integer values, use good inter-
polation  precisely because  it better matches the  original data.   
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   8.     Save compression for last . Useful data is easily ruined by blithe 
use of “lossy” image compression before measurement, ren-
dering, or construction of fi gures. The approximations made 
by the compression algorithms used for JPEGs or QuickTime 
and AVI movies can ruin subsequent efforts to create detailed 
renderings or extract believable measurements.   

   9.     Whatever you do, do it to the whole image . To change the inten-
sity in one portion but not the other is potentially misleading. 
I can think of only one exception, which itself proves the rule: 
background subtraction, either by subtraction of a reference 
image or by Fourier fi ltering, changes intensities (and other 
features) more or less in various parts of the image, but in 
either method the entire image participates. Of course, both 
methods of background subtraction should be disclosed.   

   10.     Always present your best image . Say what? Is it not a problem 
that people show only the singularly remarkable, most com-
pelling pictures? Not if you have reason to believe that they are 
realistic. As Rossner and Yamada [ 1 ] point out, “the quality of 
an image has implications about the care with which it was 
obtained.” All kinds of factors make it diffi cult to achieve the 
perfect image: the specimen was not oriented quite conve-
niently, the labeling was weak this time, the laser was fl icker-
ing, etc. Anyone who has any experience with microscopy (or 
even ordinary photography) knows that to have one great pic-
ture required taking many mediocre ones. No amount of 
(honest) PhotoShoppery will change this. Yes, one can get 
lucky; yes, the best picture might not always be representative; 
and yes, someone might choose exceptional data to display 
because of preconceptions about the ideal results. But on aver-
age, the best picture will also be the most representative one. 
That is usually why it is the best.      

2    Materials 

 Most embryological experiments yield specimens or image sets 
that do not quite meet the ideals described in standard handbooks 
of confocal microscopy. With fi xed material there are two principle 
reasons. The fi rst encompasses the problems of labeling a suffi -
ciently clear embryo or larva with suffi cient brightness to enable 
collection of enough sections at high enough signal-to-noise to 
capture the desired structures. 

 The second reason is an optical constraint: most invertebrate 
embryos used in research today are small enough that high magni-
fi cation objectives with a high numerical aperture (NA) are essen-
tial; yet these objectives suffer from a shorter working distance, 
and the fall-off in signal intensity and resolution as one travels from 
near the coverslip deeper into the specimen can be severe. 
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 Live imaging over time adds a third major deviation from ideal 
conditions. The feature of interest is often likely to remain in a 
single focal plane only by luck, therefore mandating collection of at 
least a short focal series at each time point. But embryos change 
rapidly, necessitating frequent time points. Even for the nearly 
unbleachable sea urchin embryo expressing a GFP fusion protein, 
serious trade-offs against image quality and sampling density are 
often unavoidable. 

 Thus, embryologists simply cannot always achieve theoretically 
optimal resolution or signal-to-noise. Even so, it is useful to keep 
certain targets in mind: 

      1.     At 40 ×  and above, or beyond 0.75 NA, one should usually choose 
any immersion lens over even the best dry lens . Even with a good 
instrument and the best lens, ideal coverslips, etc., the dry 
lenses suffer the greatest loss of intensity and resolution with 
depth. Even at 20×, an immersion lens, if available, and even 
at the same NA as a dry lens, can dramatically improve results.   

   2.     Minimize the differences in refractive index between the immer-
sion medium and the mounting medium and the coverslip . 
Commonly used mounting media such as VectaShield or other 
buffered glycerol preparations have refractive indices signifi -
cantly different from glass, immersion oil, or water. They are 
convenient and clear some specimens (like early sea urchin 
embryos) quite well, but even apparently clear specimens will 
suffer from spherical aberration due to the refractive index dif-
ference to the extent that the far side of the embryo may be 
severalfold darker than the near side and far less detailed both 
laterally and axially. 

 For exceptionally clear specimens, if a water-immersion 
objective is available, it may be preferable to mount specimens 
in aqueous buffer. This has the additional virtue that the speci-
men is likely to suffer little distortion if it remains in water. 
A water-immersion lens might be the best choice for live 
embryos as well. 

 The best resolution and brightness, however, will usually 
be obtained using oil-immersion objectives and a mounting 
medium with a refractive index close to that of glass. Despite 
its many drawbacks, Murray Clear (2:1 mix of benzyl benzo-
ate and benzyl alcohol) remains the most rewarding mounting 
medium for even those invertebrate embryos that are relatively 
clear ( see  ref. [ 2 ], section IV, for method).   

   3.     Oversample about twofold  … Most modern confocal micro-
scopes will happily estimate  Z -axis section thickness as well as 
report lateral resolution. Such estimates assume somewhat 
more favorable conditions than pertain at the far side of a yolk-
rich embryo. Even so, it usually behooves one to sample more 
densely than the estimated resolution. The estimated section 

2.1  Optical Issues
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thickness is based on the ability to clearly resolve objects along 
the  Z -axis, not the ability to reconstruct a continuous edge 
without striations. If one samples too sparsely, intensity gaps 
will make any reconstruction look like a pile of tortillas.   

   4.    …  but match Z-axis sampling to XY pixel size  if practical. If it is 
 not  practical to match  Z -sampling to  XY  pixel size—sectioning 
an entire embryo at 0.1 μm steps is both tedious and pointless—
then choose a  Z -step that is an integer multiple of the pixel 
width. This can reduce the need for interpolation in later 
processing.      

      1.     Choose good modern fl uorophores . This is the only general advice 
on offer. Most dyes in the Alexa, BODIPY, or Cy families are 
both bright and highly photostable, and for all but very scarce 
labels these should tolerate collection of a well-sampled focal 
series of well over a 100 sections. Shun fl uorescein but not 
rhodamine; the latter is especially useful if you are stuck with 
only a 543 HeNe laser.      

      1.     Prefer many noisy time points over fewer, cleaner images . This 
only applies when one fi nds oneself pushing the constraints of 
the instrument. If something moves between frames, too bad. 
If things turn out not to move much from frame to frame, 
then one can, if necessary, average successive frames to reduce 
noise. After all, this is approximately what one would do to 
collect a cleaner frame initially.   

   2.     Sacrifi ce axial resolution before lateral resolution, and lateral 
resolution before time resolution . If pressed, that is, either by 
instrument constraints or by tolerance of the embryo or the 
label. Since the fate of most “4D” series is to be maximum 
projected and played back as a 2D movie, smooth motion is 
usually more important than absolute detail.   

   3.     Extensive photobleaching is harder to deal with than noisy images . 
This is especially true if the goal is to measure intensity changes. 
One can “correct” photobleaching by measuring the average 
 intensity fall-off and multiplying successive time points 
accordingly, but this can be hard to untangle from other 
reasons that brightness might change. Besides, however well 
one can estimate bleaching, brightening the bleached images 
at the end of the series inevitably yields a far noisier image than 
those at the beginning of the series.     

 Because ImageJ has excellent documentation, the procedures 
here assume that users have installed the standard distribution of 
ImageJ and familiarized themselves with basic operations. Certain 
plug-ins that can be downloaded from the ImageJ website (  http://
rsbweb.nih.gov/ij/plugins/index.html    ) are mentioned as needed. 
The most important of these is to install whichever one allows 

2.2  Labeling Issues

2.3  Considerations 
for Time-Lapse 
Sequences
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ImageJ to read your instrument’s native fi le format. For some 
commonly available confocals, like the BioRads, ImageJ may be 
able to open the native fi les without additional plug-ins, but for 
others the LOCI BioFormats package (  http://www.loci.wisc.edu/
software/bio-formats    ) or some more specifi c equivalent is required. 
Note that although many confocal operating programs will export 
data in a generic format (i.e., TIFF), this usually abandons essential 
metadata (e.g., spatial resolution and interval between time points) 
which the native fi les would provide.   

3    Methods 

       A suitable focal series will consist of a stack of at least a few dozen 
sections.

    1.    Set white and black points before rendering, and reduce the 
data to 8-bit (choose the menu command  Image → Type → 
8-bit ) or RGB ( see   Note 1 ).   

   2.    Choose  Image → Stacks → 3D Project… , select “Brightest 
Point” for the projection method, and choose  Y -axis rotation. 
If ImageJ accurately reads the metadata, or you fi lled in spatial 
calibration information (using the menu command 
 Image → Properties… ), the slice spacing should be set already. 
Otherwise, fi ll in the appropriate number. Use an initial angle 
of −15°, a total rotation of 30°, and 1° increments. Ignore the 
transparency bounds (but  see   Note 2 ), leave the opacity at 0 %, 
and set both depth-cuing aspects to 0. Interpolation may 
improve results with stacks whose  Z -steps are far apart.   

   3.    This creates a new stack of 31 frames; the 16th frame is the 
straight-on view. Immediately rename it ( Image → Rename… ) 
to something which identifi es it as the  Y -axis rotation, such as 
“Y forward” ( see   Note 3 ).   

   4.    Click in the window corresponding to the original stack to 
make it active, and again choose  Image → Stacks → 3D 
Project… ; leave all other settings the same, but choose  X -axis 
rotation. Immediately rename the resulting stack accordingly.   

   5.    For each of these new stacks, use  Image → Duplicate…  to 
create a copy of the entire stack minus the fi rst and last frame: 
click the “Duplicate stack” checkbox, and type “2–30,” taking 
the opportunity to assign a helpful name (e.g., “Y reverse”). 
Then use the menu command  Image → Transform → Flip Z  
on each duplicate. Next, choose  Image → Stacks → 
Concatenate…  to join each series to its reversed copy, making 
sure that the reversed and trimmed version of each comes sec-
ond. Again, take the opportunity to assign names (“Y swing”). 
There is no reason to retain the source stacks.   

3.1  Creating 
a “Rocking” 3D 
Animation from 
a Focal Series
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   6.    Now we wish to join the  Y -axis stack to the  X -axis stack. But 
to do so they must each start playing at the straight-on view, 
which is presently the 16th frame. To do this, for each ren-
dered stack, use  Image → Duplicate…  to create a copy of 
frames 1–15, giving it a helpful name (“Y head”). Then delete 
those same 15 frames from each of “Y swing” and “X swing.” 
Use  Image → Stacks → Concatenate…  to join “Y swing” to 
“Y head” in that order, likewise for the  X -axis stacks; there is 
no reason to retain the source stacks.   

   7.    The reordered “Y swing” and “X swing” stacks cannot be 
immediately concatenated because they are of different sizes. 
This is because the ImageJ projection function pads the win-
dow to make room for edges as the stack turns. If these are 
even numbers one can simply trim the edges (if they are, in 
fact, blank) or expand the canvas using  Image → Adjust → 
Canvas Size…  (choose “Center” positioning) so that both 
stacks are of the same size and can be concatenated directly. If, 
however, the numbers were not even, then the two stacks 
might end up misaligned by a single pixel after the canvas size 
is adjusted. To check this, set the Y and X swing stacks to the 
fi rst frame—the straight-on view—and choose Process → Image 
Calculator…; instruct it to compute a difference between “Y 
swing” and “X swing,” creating a new window, and click “No” 
when asked whether to process the whole stack. If the stacks 
are aligned, the resulting image will be black. The quickest 
way to fi gure out who needs to be nudged in which direction 
is to create a new window with two slices and the same dimen-
sions as the swing stacks and then paste the fi rst frame from 
each into each of the two new slices. Flip between to assess the 
shift, then execute the appropriate nudge on one of the swing 
stacks using  Image → Transform → Translate… , and then 
concatenate them.   

   8.    Choose  Image → Stacks → Animation Options… , and select 
a frame rate between 15 and 30. Pressing the backslash key 
with the resulting stack active should play a smooth movie 
without jumps or pauses in which, starting from the straight-
on view, the object swings fi rst toward the left, then toward 
the right, then up, then down, and repeat. To add a pirouette 
after the rocking tour, create another  Y -axis rotation from 0° 
to 360°, with 4° or 5° steps, delete the fi rst frame of this new 
stack, and concatenate it to the end of the rocking stack.      

    One cannot print the pseudo-3D animation created by the previ-
ous procedure. Only stereo images allow one to put a 3D view on 
a page. They work almost as well on screen, although they are 
limited by the number of pixels available. Most people with two 
not-too-different eyes can learn one or the other trick of seeing 

3.2  Creating and 
Viewing Stereo Images
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stereo images; for those who cannot, they are no worse off than if 
you were to present a single projected rendering. If you can learn 
the trick, the view is far more compellingly three dimensional than 
any animation. 

 First I explain how to create a stereo triplet using ImageJ; 
afterwards I explain how to learn to see them and why a triplet. 
Suitable starting material is the same as for creating a 3D rocking 
animation (Subheading  3.1  above).

    1.    Choose  Image → Stacks → 3D Project… , and select 
“Brightest Point” projection and  Y -axis rotation. Make sure 
that the slice spacing is accurate. Use an initial angle of −3°, a 
total rotation of 6°, and 6° increments ( see   Note 4 ). Again, 
ignore the transparency bounds and opacity, and set both 
depth-cuing aspects to 0.   

   2.    This creates a new stack of just two frames; one is destined for 
your left eye, and the other for your right. Move to the second 
frame, and choose  Image → Stacks → Add Slice  to create a 
blank frame at the end.   

   3.    Move to the fi rst frame, select the entire area 
( Edit → Selection → Select All , or press the A key), copy it 
( Edit → Copy  or C), move to the new blank frame, and paste 
( Edit → Paste  or V).   

   4.    Choose  Image → Stacks → Make Montage… , and specify 3 
columns, 1 row, scale factor 1.0, and no borders. 

 The resulting image is a stereo triplet, and it is used like 
this: by either of two tricks, one can “fuse” two adjacent 
images, each of which corresponds to the view angles appro-
priate for each eye, into a simulated 3D view. One pair of the 
triplet gives the view from the front, and the other pair gives 
the view from the back. By presenting triplets, viewers 
acquainted with either of the two viewing tricks will be equally 
able to see your data in 3D.  See  examples in Fig.  1  and  Note 5 .

   The two stereo viewing tricks are nearly the same: one has 
to make one eye look at one of the images, while the other eye 
looks at the other image ( see   Note 6 ). This means either let-
ting your eyes diverge, or crossing them. This sounds easy, but 
the next step involves defeating a refl ex that everyone has been 
honing since birth: the eyes must focus at a different distance 
than they converge. Most people can learn to do one or the 
other. Since I am naturally inclined toward the divergent 
method, I offer the following steps:   

   5.    Display the triplet on screen, reducing to fi t if necessary, and 
orient the screen as close as possible to be perpendicular to 
your line of sight. Keep your head level with the screen. For 
beginners it helps to place the screen somewhat further away 
or to make the images to be fused small enough that their 
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centers are not much further apart than the viewer’s eyes. 
(With practice, one can fuse larger and larger images, but 
eventually it becomes diffi cult to swing one’s eyes far enough 
apart.) Try with simple geometric shapes fi rst, like the cubes in 
Fig.  2a  (fi rst row).

       6.    Pay attention, at fi rst, to either the left and middle images or 
the middle and right images. Fusing these will also fuse the 
others. Gaze at a point between the two images, and simply … 
space out.   

   7.    As you space out ( step 7 ), your eyes will wander. 
Correspondingly, the two images will wander as you lose focus 
on them (Fig.  2a , middle row). The key is  never to try to focus 
on them . The moment you try to focus on the wandering 
images, your refl exes will take over and snap your eyes back to 

  Fig. 1    Stereo triplets. ( a ) Cleaving sand dollar zygote, labeled with Hoechst to stain DNA and antibody to 
 Ser-19- phosphorylated myosin II regulatory light chain. ( b ) Metaphase spindle in a single blastomere of an 
early embryo of the clam  Acila . ( c ) Projection through 16-cell embryo of the clam  Acila        
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the “right” convergence distance. As the images wander farther 
apart, still out of focus, they will overlap. The goal is to get 
them to overlap completely (Fig.  2a , third row). If they start 
to separate, relax. If they are at the same longitude but differ-
ent latitudes, tilt your head a little.   

   8.    Once the out-of-focus images are right on top of each other, 
 do not do anything . By some miracle, your eyes will discover 
that there is something to focus on there, and eventually it will 
just happen. The effect is usually transient at fi rst, but gets bet-
ter quickly with practice.   

   9.    The cross-eyed viewing method is more or less the same, but 
instead of “spacing out,” use a pencil or a fi ngertip in the 
 foreground to make your eyes cross far in front of the screen 
or the page. Keep focusing on the fi ngertip, and move it closer 
or further from you, until you can perceive, fuzzy in the back-
ground, that the out-of-focus images have aligned on top of 

  Fig. 2    Stereo viewing. ( a ) Simple geometric shapes, and the appearance at 
intermediate steps of fusion. ( b ) A somewhat more complex geometric shape       
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one another. Again, do not  try  to do anything. Just gradually 
lose interest in your fi ngertip, and your brain might discover 
something else of interest in the background.   

   10.    It sometimes happens that the forward and reverse images, 
once fused, do not seem to be at the same focal level. Nudging 
the center image one way or the other (select it, cut it, and 
paste it, and then use the arrow keys to nudge) while viewing 
“in stereo” will fi x it.    

     Simply projecting an entire focal series often obscures numerous 
features, especially those in the interior or on the far (that is, the 
inevitably dimmer) side. To retain the impression of sectioning 
while making use of three-dimensional data, one can animate a 
projected slab fl ying through the stack by repeated calls to 
 Image → Stacks → Z Project… , which is exactly what is done by 
Nico Stuurman’s “Running Z Projector” plug-in (available at 
  http://valelab.ucsf.edu/~nico/IJplugins/    ; a slightly improved 
version of Stuurman’s plug-in is available from my website,   www.
gvondassow.com/Research_Site/Methods.html    ). For many speci-
mens, 5–10 sections give signifi cantly greater feel for the whole 
compared to a single section. Usually the “Max Intensity” option 
is preferable. 

 To create an animation in which a single section or slab fl ies 
through against a background image of the projected data:

    1.    Create a single straight-on projection of the entire stack using 
 Image → Stacks → Z Project…  with the Max Intensity option. 
It is not necessary in this case to reduce the dynamic range to 
8-bit.   

   2.    This projection will be the background for each frame in the 
animation, so one needs as many copies of it as slices in the 
original stack. First choose  Image → Stacks → Add Slice  to 
create a second blank frame. Then select the entire fi rst frame, 
copy, and paste it into the new blank frame. Finally, choose 
 Image → Stacks → Scale… ; leaving X and Y dimensions 
unchanged, choose “None” for the interpolation method, and 
for “Depth” enter the number of slices in the original stack.   

   3.    The result is a stack of identical images. To serve as a back-
ground image, they must be dimmed substantially. Choose 
 Process → Math → Multiply… ; a factor of 0.3 is often 
effective.   

   4a.    To overlay the original slices, use  Process → Image 
Calculator…  and request the maximum of the original stack 
and the stack of background images.   

   4b.    To overlay a projected slab instead of a single slice, use my ver-
sion of the Running ZProjector plug-in to create a stack with 
as many frames as the original stack and then do as in 4a.   

3.3  Animating 
a Projected Slab
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   5.    To make the slice or the slab move in both directions through 
the stack, use  Image → Duplicate… , then delete the fi rst and 
last frame from the copy, run the menu command 
 Image → Transform → Flip Z , and concatenate the forward 
and reverse frames.     

 Instead of using a dimmed, monochrome background, the 
projection can be shown in one color and the moving slice in 
another color. To do this, either skip  step 3  above, or use a milder 
dimming factor, and  step 4  should be to make a color merge 
between the stack of repeated projections and the series of slices or 
slabs.  

  First I describe how to highlight a subset of sections (a horizontal 
slab); alternate steps below explain how to highlight a vertical slab 
instead.

    1.    Since this recipe uses the 3D projection function, one must set 
the white and black point and reduce the stack to 8-bit before 
starting.   

   2.    Decide which slice, or contiguous set of slices, you wish high-
lighted, and use  Image → Duplicate…  to extract them from 
the original stack.   

   3.    The duplicated subset needs to be padded with blank frames 
on either side. For example, if you chose to highlight frame 35 
out of a 100-frame stack, you will need to add 34 blank frames 
in front of it and 65 behind it. Use  File → New → Image…  to 
create stacks of blank frames of the appropriate size, and then 
use  Image → Stacks → Concatenate…  to assemble them with 
the slice or the slices to be highlighted.   

   4.    The original stack needs to be dimmed out somewhat: make a 
duplicate of it, and then use  Process → Math → Multiply…  
with a factor of 0.2–0.6.   

   5.    Combine the result of  step 4  with the result of  step 3  using 
 Process → Image Calculator…  to compute the maximum of 
these two stacks.   

   6.    With the resulting stack, proceed with Subheading  3.1  (or 
Subheading  3.2 ) using  Image → Stacks → 3D Project…  to 
create the desired rendering.     

 As in Subheading  3.3 , one can use color, rather than bright-
ness, for highlighting. Instead of  steps 4  and  5  above, do this:

    4.    Use  Process → Image Calculator…  to subtract the result of 
 step 3  from the original stack. This deletes the chosen slices 
from the original so that they have a more distinct color.   

   5.    Combine the result of  step 4  with the result of  step 3  using 
 Image → Color → Merge Channels… ; choose colors such 

3.4  Highlight a 
Horizontal or a Vertical 
Slab Within a Rocking 
Projection
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that the highlighted slices are stronger than the background, 
check “Keep Source Images” so you can try again, and uncheck 
“Make Composite” so that an RGB stack (which can be used 
by the 3D projector) results. A suggestion, for a stack with 
fairly bold but sparse labeling (e.g., muscles), is to put the 
highlighted frames in the red channel, the original stack in 
the green channel, and the original minus the highlighted in the 
blue channel. This results in a yellow highlight on a cyan 
background. It may still be desirable to dim slightly the non-
highlight frames.    

  To create a rocking projection with a vertical slab highlighted, 
the method is the same except that instead of blotting out selected 
entire frames for the highlight stack, one must blot out portions of 
all frames. Replace  steps 2  and  3  above:

    2.    Duplicate the original stack.   
   3.    Decide which latitude or longitude to highlight: use the 

rectangular selection tool to pick out an entire band (from 
edge to edge), and then choose  Edit → Clear Outside  to 
delete the margins.    

  Proceed with  step 4 . The same series of steps can be applied 
with arbitrary combination of selected regions; the common theme 
is to blend the entire dataset, either dimmed or in a different color, 
with a masked version.  

  The main use of color for confocal microscopy is to blend two or 
more distinct labels for display. In this process of  color combination  
or  merging  there is no meaningful notion of “true” color: although 
the detected light had a wavelength, and we distinguish different 
labels from each other by separating wavelength ranges, the col-
lected data is monochromatic. Applying color is thus an instance of 
what is inauspiciously called “false coloring.” Accordingly, one 
should feel no compulsion to, say, show rhodamine in red or fl uo-
rescein in green. The original wavelength does not matter at all. 
Instead, one should choose colors according to the nature of the 
data and human visual psychology [ 3 ]. 

 If one has only a single channel to display, it is usually best to 
present it in grayscale. Even when one has several channels, dis-
playing side-by-side grayscale images provides the maximum detail, 
the minimum obscurance of one channel by another, and makes 
the best use of the typical viewer’s retina. In some applications, 
 color coding —replacing the grayscale with a color table in which 
hue varies with intensity—can make images more informative, for 
example to co-display both low- and high-intensity portions of the 
image in the same panel or to highlight particular intensity bands. 
Color coding will be dealt with below. 

 For color combination, it is most convenient to work with 
images consisting of red, green, and blue channels. It makes 

3.5  Color Merges 
and Color Coding
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merging two or three channels trivial: in ImageJ, choose 
 Image → Color → Merge Channels…  and select appropriately; in 
Photoshop, create a new RGB-mode image of appropriate size; use 
the Channels palette to select red, green, and blue layers; and paste 
into them as needed. 

 This is rarely an ideal use of color, however. Pure red, pure 
green, and pure blue do not always print well, depending on the 
device. Moreover, for most people these primaries do not make 
optimal use of their color vision. This is not just about the color- 
blind, although this consideration too mitigates against a simple 
red–green merge. 

 It may seem like an odd claim: If our photoreceptors respond 
maximally to these primary colors, should not these be the best 
display channels? No: fi rst, many people see very little dynamic 
range in pure blue, considerably more in pure green, and somewhat 
intermediate in pure red. This is because our blue light receptor is 
less sensitive than the others [ 3 ]. Second, any pure primary strongly 
excites only one-third of the available sensors, whereas mixed col-
ors (like yellow) excite two-thirds, and therefore we can see mixed 
colors with higher resolution. The truth is a little more subtle than 
that, because the response spectra overlap substantially—and that is 
why we see the most detail in green—but nevertheless these rules 
are true enough that they have been extensively used to short-cut 
image encoding in video (both analog and digital) and in image 
sensors themselves (e.g., through the Bayer mask). 

 For these reasons, the ideal situation would be to present both 
the separate channels as monochrome images and a color merge 
that uses intermediate colors. If pure colors must be used for 
some reason, use green for the channel in which detail is most 
important. 

 The simplest two-channel color merge which satisfi es all 
requirements—resolution, dynamic range, and accessibility for the 
commonest type of color blindness—is green and magenta. To 
make such a merge in ImageJ, use one raw image for green and put 
the other in both the red and blue channels. This combination 
requires no alteration of the original data, but if your neighbors 
were to paint their house green and magenta, you would likely con-
sider moving. The next best combination is cyan and red, with the 
less detail-intensive channel red. The only other two-channel merge 
which leaves the data unaltered is yellow on pure blue. This is color-
blind friendly but is usually suboptimal because humans differenti-
ate intensities poorly in blue (also, blue prints worst of all). 

 Every other color merge requires that at least one of the red, 
green, or blue display channels contain information from multiple 
data channels. There are three ways to do this. First, one channel 
could be overlaid upon another, blotting out the underlying image 
except where the overlay is transparent. This requires some artistic 
control and does not often seem like it adequately preserves the 
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positive relationship between original data and displayed rendering. 
Second, the two original channels could be added or averaged, or 
third, the resulting channel could be computed from the maxi-
mum of the two originals at each point. For instance, to make a 
yellow/cyan merge, the blue and red channels consist of unaltered 
original data, whereas green is a blend. In ImageJ, with two data 
channels:

    1.    Optimize brightness and contrast, and any other adjustments, 
on the grayscale images alone, and then reduce them to 8-bit 
before merging. ImageJ (and PhotoShop) handles 16-bit/
channel color just fi ne, but some surprises may occur.   

   2.    Choose  Process → Image Calculator… , and select the two 
original data channels; either add them or compute the maxi-
mum. Because it is not always obvious which of these is most 
useful, create and compare both candidates. If the two labels 
do not overlap extensively, the results are very similar. The 
Image Calculator will give the same name to each successive 
combination, so rename its products immediately to keep track.   

   3.    Choose  Image → Color → Merge Channels… ; use the blend 
for green, one original for red, and the other for blue. Check 
“Keep Source Images” so that you may …   

   4.    … try the opposite combination. Yellow and cyan are similarly 
perceived as both bright and detailed, but I often fi nd that large 
areas of cyan make an image seem dark. This is likely because 
the eye can tell the difference between true cyan, i.e., 490 nm 
light, and the mixture created by a blend of blue and green 
light in a computer screen; most people, however, cannot tell 
true yellow light (580 nm) from a blend of red and green [ 2 ].     

 In ImageJ this works for stacks just like single images. For 
three channels the recipe is the same, except that  every  RGB chan-
nel gets a blend of two original data channels. There is one poten-
tially signifi cant diffi culty: with the steps given above for two 
channels, the original grayscale data can be recovered from the red 
and blue channels of the resulting image. This is not possible if 
three channels are blended according to these instructions; only by 
using ImageJ’s composite image format (or equivalent tools in 
PhotoShop) is it possible to apply intermediate colors without los-
ing the independence of the original channels. 

 It is much easier to control colors and proportions using 
PhotoShop, although one cannot always fi gure out what, exactly, 
has been done, and PhotoShop does not handle stacks as naturally 
as ImageJ. To combine three data channels in PhotoShop:

    1.    Create a new RGB image of the appropriate size, and, by 
selecting the appropriate icon in the “Channels” palette, paste 
original grayscale images into each channel.   
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   2.    PhotoShop uses adjustment layers to accomplish certain image 
manipulations nondestructively. Choose  Layer → New 
Adjustment Layer → Channel Mixer… ; the controls are ini-
tially counterintuitive, but they ask,  for each fi nal  display red, 
green, and blue,  how much the original  red, green, and blue 
will contribute. Start by turning everything monochrome: 
click the “Monochrome” button at the bottom, and then un-
click it immediately. Everything turns dimly gray.   

   3.    Now that all those distracting “original” colors are gone, 
choose “Red,” for example, from the Output Channel menu. 
Using the sliders or the boxes in the Source Channels list, 
specify a positive contribution (try 50–80 % for each) from 
whichever original label should end up yellow, and from 
whichever one should end up magenta, and 0 % for whichever 
one is supposed to end up cyan. Do likewise for green and blue 
output channels; for exact intermediate colors (like yellow or 
cyan), assign the red and green output channels the same per-
centage from the yellow-to-be, and so on, but obviously to 
produce other colors (orange, say) one can make whatever mix 
one wants. To make one of the original channels appear in 
grayscale, assign the same percentage to all output channels.   

   4.    Once fi nished, this channel mixer appears in the list of layers 
above the original RGB image. Double-click it to revise.   

   5.    To alter the relative brightness of the original data channels, 
create another adjustment layer between the original image 
and the channel mixer. Click on the layer holding the original 
image, and choose  Layer → New Adjustment Layer → 
Levels… ; the Levels panel shows a histogram along which one 
can drag white and black points for each RGB channel.     

 If you have to blend more than three original data channels, 
you can in principle combine up to six by computing blends in 
ImageJ, but it is cumbersome: one must arrange that the green 
image contain all three of the intended green, cyan, and yellow 
components, likewise for the red and blue image … six calls to the 
Image Calculator and much trouble keeping track of components, 
but if you really need to do it, you can. 

 Up to now each channel remains monochromatic. This is vir-
tuously simple, but a chronic problem is that the lower end of the 
dynamic range is almost inevitably obscured in color merges like 
these. What is the point of avoiding image distortion—sticking to 
linear adjustments, avoiding careless background subtraction, 
etc.—only to end up blotting things out through the back door? 

 Color coding can ameliorate this problem by exploiting our 
sensitivity to hue. So-called pseudocolor tables are widely used in 
certain applications (FRET or calcium imaging, for example) to 
bring out subtle variations in intensity. The color table (or LUT, 
for “look-up table” in ImageJ) specifi es which RGB color 
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corresponds to each of 256 intensity levels in an 8-bit image. The 
color table may be arbitrarily specifi ed, but for this purpose the 
most useful recipes are continuous transitions from one hue to a 
neighboring hue while increasing in intensity. 

 How, in color coding, to preserve the essential relationship 
between original intensity values and fi nal perceptual intensity? 
With some effort and considerable theoretical ambiguity, one can 
calculate color tables which, according to various models of rela-
tive luminosity, best preserve this trait. Or one can tuck a calibra-
tion bar—a band that smoothly varies from black to white—into 
the original grayscale image. Whatever happens to the original 
intensity range will also happen to the calibration bar. In ImageJ 
choose  Analyze → Tools → Calibration Bar… , and choose 
options appropriately. Problem solved. 

 I fi nd most useful a particular color coding scheme which 
skews low intensities red and higher intensities progressively more 
yellow. This is easy to create and comes very close to preserving 
relative luminosity. To do so in ImageJ:

    1.    Starting with 8- or 16-bit grayscale image, apply white and 
black point adjustment, carefully trimming off any background 
peak; even a slight non-zero background will become visible. 
If working with 16-bit data, do not convert to 8-bit at this 
step (unless a calibration bar is needed— step 2 —which will 
force this conversion).   

   2.    If a calibration bar is desired choose  Analyze → Tools → 
Calibration Bar…  and apply desired options. This creates an 
RGB copy of the image; convert it to 8-bit by choosing 
 Image → Type → 8-bit .   

   3.    Duplicate the image twice by choosing  Image → Duplicate… , 
giving the copies distinct names, e.g., “red” and “green.” 
(Keep the original to revise gamma adjustments in  step 4 .)   

   4.    For the “red” image, choose  Process → Math → Gamma…  
and try a value of 0.6; for the “green” image, use the same 
command with a value of 1.5. (For the meaning of gamma,  see  
 Note 7 .) Once you have applied the gamma adjustment, do 
not further adjust black and white points.   

   5.    To combine these as red and green channels in a color image, 
choose  Image → Color → Merge Channels…  and choose the 
“red” image for the red channel, “green” for the green chan-
nel, and nothing for blue and gray; un-check “Create 
Composite,” but check “Keep Source Images.”   

   6.    If the result is not pleasing, go back to  step 3  and try different 
numbers in  step 4 .     

 One must experiment with different pairs of gamma values for 
each dataset. The range 0.5–0.75 works well for red, and a comple-
mentary range 1.7–1.3 for the green. In the resultant color image, 
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for all pixels, the average of the red value and the green value 
should be as close as possible to the original grayscale value. 

 This makes it quick and easy to color-code a single mono-
chrome image, but it becomes cumbersome to composite several 
color-coded images within ImageJ ( see   Note 8 ). The same color 
code is trivial to apply in PhotoShop:

    1.    Open the grayscale image in PhotoShop, whether in 8- or 
16-bit mode, and choose  Image → Mode → RGB Color . This 
copies the grayscale information into each of three color 
 channels which can be independently altered.   

   2.    Choose  Layer → New Adjustment Layer → Levels… , and 
check the box for “Use Previous Layer to Create Clipping 
Mask.” This makes the adjustment layer apply only to the cur-
rently selected layer.   

   3.    Suppress the blue channel: choose “Blue” from the “Channel” 
menu in the Levels dialogue box, and on the slider labeled 
“Output Levels,” drag the white point arrowhead all the way 
to black.   

   4.    Now adjust the gamma for red and green channels: under the 
“Input Levels” histogram, pull the midpoint arrowhead to the 
left for the red channel and to the right for the green channel, 
until you achieve the desired effect. Better, type a number in 
the middle box, noting that PhotoShop’s gamma is the recip-
rocal of what you would use in ImageJ.   

   5.    To revise the adjustment layer, double-click its icon in the 
Layers palette.    

  Any other layers to be merged can be similarly treated. For a 
single channel, the blue-to-cyan equivalent of the red-to-yellow 
gradient is far less effective, but it is the best choice for a comple-
mentary color scheme to apply to a second channel. The channel 
for which detail is most important should get the yellow. Blending 
a third channel imposes new complexities, and there is no good 
rule of thumb. Whatever color scheme is chosen, layer blending in 
PhotoShop goes like so:

    1.    Open individual grayscale images containing distinct  data  
channels.   

   2.    Create a new RGB image, and paste the fi rst image as an entire 
layer (that is, not into a particular  display  channel of a layer); 
create and apply whatever adjustment layer is desired, if any, 
with a clipping mask as above.   

   3.    Paste additional grayscale channels as entire layers above the 
fi rst one, and create adjustment layers as needed.   

   4.    In the “Layers” palette, the topmost item is a menu which 
allows one to specify the blending mode for the selected layer. 
For the bottom layer and all adjustment layers this should be 
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“Normal.” For each data channel to be overlaid, choose either 
“Linear Dodge” to add intensities or “Screen” to simulate 
transparent overlay.      

  To depict directed motion in time-lapse sequences, the methods 
used for three-dimensional  spatial  data are often useful. Where 
moving objects are bright and relatively sparse, a single maximum 
projection can be surprisingly effective. When moving objects are 
densely packed, or when the entire medium fl ows, the most useful 
way to display and quantify motion is to create a kymograph—as in 
Fig.  3 —a two-dimensional image in which one spatial axis is plot-
ted against time.

   If the time-lapse sequence has many frames (more than 100), 
and if the time resolution is good enough that each object moves 
less than its own diameter per frame, then the best way to make a 
kymograph is to reslice the image stack vertically along the domi-
nant axis of motion and then project a subset of the resliced stack 
which contains the objects of interest (Fig.  4a ):

     1.    Use the angle measurement tool in the ImageJ toolbar to 
determine the angle along which the predominant motion of 
the objects of interest takes place (or the angle of the axis 
along which motion is to be measured, e.g., the spindle or the 
anterior–posterior axis of an embryo).   

3.6  Kymographs

  Fig. 3    Kymographs. The  left-hand side  of the fi gure shows three frames from a time-lapse sequence of a 
 C. elegans  zygote expressing both GFP–histone and GFP–gamma-tubulin; anterior is to the left. The  right-hand 
side  shows a kymograph with the anterior–posterior axis horizontal and time vertical. This kymograph was 
made by reslicing the image stack and maximum-projecting all the frames containing signal from centro-
somes or chromatin       
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   2.    Select the entire rectangular region of interest from which a 
kymograph might possibly be useful. Use the menu command 
 Image → Transform → Rotate… , and choose bicubic inter-
polation. A new rotated and cropped substack results.   

   3.    Select a rectangular region of interest again, and choose 
 Image → Stacks → Reslice… ; specify that the reslicing should 
start from the top or from the left side (depending on whether 
the axis of motion is horizontal or vertical), and check “Avoid 
Interpolation (use 1.0 for spacings)” ( see   Note 9 ).   

   4.    The stack resulting from  step 3  should have exactly the same 
dimensions as the region of interest within the input stack but 
with either width or height swapped with depth. For example, 

  Fig. 4    Fine and coarse kymographs. ( a ) Kymograph produced by the fi rst method described, from a time- lapse 
sequence of a  C. elegans  zygote expressing GFP–moesin to reveal actin fi laments. The frame to the left shows 
the region covered by the kymograph. The top portion of the kymograph, which starts shortly after meiosis, 
illustrates active ruffl ing and anterior-directed fl ow; the middle portion exhibits little or no fl ow but static accu-
mulations of actin in the anterior half of the cell; the bottom portion shows actin fi laments fl owing into the 
cleavage furrow. ( b ) Kymograph produced by the second method described, from a time-lapse sequence of a 
 C. elegans  zygote expressing GFP–NMY2 (non-muscle myosin II). The frame to the left shows the region used 
to make the kymograph, which covers the period immediately before and during cleavage furrow ingression 
(corresponds to approximately the bottom fourth of  panel  ( a ))       
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if you started  step 3  with a 360 × 180 pixel region in a stack of 
240 time points, and the reslicing went from the top, you 
should end  step 3  with a 360 × 240 stack with 180 frames. In 
each of those frames, time runs vertically and the original hori-
zontal axis remains the same. Each is a kymograph along the 
horizontal axis, and you can choose the one you need. 
However …   

   5.    … in most cases, a single-pixel-wide slice does not capture clear 
trails because small objects stray from frame to frame if they 
deviate even slightly from straight paths. Therefore, on the 
resliced stack run the “Running ZProjector” plug-in, with either 
average or maximum projection and an experimentally deter-
mined group size (try 5–20 frames). From the resulting stack, 
choose the one which best captures the motion of interest.   

   6.    Velocities can be measured directly from kymographs. First, 
choose  Image → Properties…  and set the pixel width and 
height in the kymograph to correspond to the original pixel 
width (in microns) and frame spacing (in seconds; ignore the 
units here). Next, draw a rectangular selection box around the 
trail of interest. The toolbar will report the run (distance) per 
rise (time).   

   7.    This is useful if objects move primarily along one axis. If they 
take complicated paths or move in diverse directions, the trails 
may be misleading, but the stack created in  step 3  can still be 
useful: following instructions in Subheading  3.1  or  3.2 , one 
can render the resliced stack either as a 3D animation or as a 
stereo pair, which may help to visualize complicated trails ( see  
Fig.  5 ). This helps with visualization but not quantitation, for 
which, in such cases, one must usually resort to particle 
tracking (but  see   Note 10 ).

       For time sequences of fewer than 100 frames, and in which the 
individual objects move more than their own diameter from frame 
to frame, the method above will not work well. Instead, as long as 
the individual objects are more or less recognizable, one can make 
a kymograph by cutting out strips and laying them side by side 
(Fig.  4b ):

    1.    Again, determine the predominant axis of motion using the 
angle tool, and rotate the stack appropriately.   

   2.    Select a thin rectangular region of interest which contains the 
objects to be followed. On one axis, this strip should span 
more than the range over which motion might take place; 
on the other axis, the strip should be about the width of an 
individual object.   

   3.    Use  Image → Duplicate… , clicking the checkbox to copy the 
entire stack, to excise the strip at all time points.   
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   4.    Next use  Image → Stacks → Make Montage…  to lay out each 
strip in either a single row (vertical strips) or a single column. 
Specify 1.0 for the Scale Factor.    

    Many embryos exhibit some autofl uorescence, and certain prepara-
tion methods also suffer from nonspecifi c binding by probes, espe-
cially when targets are rare. It is sometimes possible to eliminate 
this kind of background signal by subtracting a clean, scaled image 
of the autofl uorescence or the nonspecifi c binding ( see   Note 11 ). 
There are a couple of simple possibilities:

 –    If autofl uorescence has a different spectrum than the label, one 
may be able to collect a reference image by activating a detection 
channel in which there is no specifi c label. For example, many 
batches of purple urchin embryos contain subcortical granules 
that are bright enough to pollute low-level GFP fl uorescence. 

3.7  Suppressing 
Background with 
a Reference Image

  Fig. 5    Kymocube, stereo pair. The  top row  shows three frames from a movie, cropped to a single cell within a 
32-cell sand dollar embryo injected with GFP–MCAK, which tracks microtubule tips and binds to kinetochores. 
In the stereo pair, in which time runs down the page, one can visualize the trails of kinetochores congregating 
to the metaphase plate and then disappearing as they separate in anaphase       
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These granules emit almost as much orange as green, so one can 
collect a second channel along with the GFP signal, scale the 
image so that it is slightly dimmer than the GFP channel, and 
subtract.  

 –   Nonspecifi c binding by antibodies is often shared by variants of 
the same type; therefore, adding a different color of secondary 
antibody to the labeling mix may allow one to collect a refer-
ence channel (for example, if labeling with goat-anti-mouse 
alone gives diffuse nonspecifi c binding, goat-anti-rabbit from 
the same supplier is likely to do so also).    

 Both depend on having an empty channel to spare. For back-
ground subtraction to work well, both the image and reference 
should be as close to noise-free as possible. To subtract the refer-
ence image:

    1.    Both signal and reference images (or image stacks) should be 
open as separate windows. The black points must be set com-
parably, and any signifi cant detector background (non-zero 
values outside the specimen) should be trimmed off. For 
16-bit images, adjusting the displayed brightness and contrast 
do not alter the numerical values of pixels. Instead, for each 
image choose  Analyze → Histogram ; locate the lowest inten-
sity peak, and determine its center by hovering the pointer 
over that part of the histogram. Then for each image use 
 Process → Math → Subtract…  to set the black point to equiv-
alent levels.   

   2.    Select a small region within the signal image where you believe 
there is only autofl uorescence or nonspecifi c binding, and no 
specifi c signal. Select the same region in the reference image 
by choosing  Edit → Selection → Restore Selection . Measure 
the average intensity in both selected areas using  Analyze → 
Measure  (if necessary, call  Analyze → Set Measurements…  
to specify that the mean intensity is among the desired 
measurements).   

   3.    The intensities in the reference image must be scaled by these 
measurements using  Process → Math → Multiply… . The 
appropriate factor is ~0.8 times the ratio of the measurements 
made on signal and reference images; the factor of 0.8 means 
that, in the next step, only 80 % of the estimated background 
will be subtracted; adjust as needed.   

   4.    Compute the subtracted image by choosing  Process → Image 
Calculator…  and making the obvious choices.     

 If autofl uorescence is shared by two channels containing spe-
cifi c labels, it may be possible to compute an approximate back-
ground image from them. This only works if the two channels 
co-localize very little, but this is not as unusual as it seems: for 
example, if Hoechst or DAPI is used as a counterstain, and if the 
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other label is not present in the nucleus, then true co-localization 
should be virtually nonexistent. In such a case, the background is, 
approximately, everything that the two images have in common. If 
the images are relatively low-noise, then the common background 
can be computed and subtracted like so:

    1.    Open both images (or image stacks) in separate windows, and, 
as above, make sure that the black points are set equivalently.   

   2.    Multiply the two images together using  Process → Image 
Calculator… ; make sure to check the box “32-bit (fl oat) 
result.” This creates an image which is dominated by features 
that the two images share.   

   3.    Now use  Process → Math → Square Root  to return the com-
mon image to the same range as the originals.   

   4.    As in the previous recipe, the background image needs to be 
scaled before applying it to the originals, but it has to be scaled 
differently for each channel, so use  Image → Duplicate…  to 
make a second copy of the common image with a name that 
associates it to a target channel.   

   5.    For each signal image and one of the copies of the common 
image, select the same small region of interest that you believe 
to contain no specifi c signal, only background; as before, 
choose an area in one image, and copy the selection to the 
other window by activating and choosing  Edit → Selection → 
Restore Selection . Use  Analyze → Measure  to measure mean 
intensity in each one.   

   6.    One of the copies of the common image needs to be multi-
plied, using  Process → Math → Multiply… , by 0.8 times the 
ratio of the measured value in channel #1 to the common 
image and the other copy by the analogous formula involving 
channel #2.   

   7.    Subtract each background image from the corresponding 
signal image using  Process → Image Calculator… .     

 See the example in Fig.  6 . This is not foolproof and genuinely 
risks losing signifi cant specifi c signal. It is probably only appropri-
ate when no quantitative information will be extracted from inten-
sity values.

     Since noise is the highest frequency—most rapidly varying— 
component in the image, one can suppress it (along with the fi nest 
details) by replacing each pixel value by some function in which 
values of the pixels within some radius contribute positively 
( see   Note 11 ). Some suggestions include the following:

    1.     Median instead of mean : Because detector noise usually creates 
pixels with outlier values, the standard simplest possible func-
tion is not to compute the arithmetic  mean  of pixel values in 
the neighborhood, but rather the  median . In ImageJ the 

3.8  Noise Reduction 
Using “Averaging” 
and Blurring
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menu command  Process → Filters → Median…  has a single 
parameter, somewhat euphemistically called the radius; a value 
of 1.0 means that it uses a 3 × 3 block of pixels, 2.0 means a 
5 × 5 block, and a value less than one means that it uses the 
center pixel and its four neighbors.  Process → Noise → 
Despeckle  is a median fi lter using radius 1;  Process → Noise → 
Remove Outliers…  is a median fi lter which allows one to 
set a threshold so that only things which deviate greatly 
are replaced.   

  Fig. 6    Background subtraction. A shared background image is computed by multiplying channels together, 
taking the square root, and then scaling the result before subtracting from each channel. The images used in 
this demonstration come from a hatchling larva of the polychaete  Owenia collaris  stained with Hoechst (DNA) 
and phalloidin (actin fi laments)       
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   2.     Gaussian blur : The mean and median fi lters are pretty harsh 
because each pixel within the specifi ed neighborhood contrib-
utes equally. For subtler smoothing use  Process → Filters → 
Gaussian Blur… ; the sigma value is the standard deviation of a 
Gaussian curve which is applied to each pixel—fractional values 
between 0.5 and 1.0 are a good alternative to the 3 × 3 mean.   

   3.     Convolution kernels : For even better control,  Process → Filters 
→ Convolve…  allows one to specify a custom fi lter. ImageJ’s 
online documentation gives thorough explanations of how to 
use this feature, but note that entering the matrix 
((1,1,1),(1,10,1),(1,1,1)) amounts to applying the mean fi lter 
with radius 1 and then averaging the resulting blurred image 
with the original; the matrix ((1,1,1,1,1),(1,4,4,4,1),(1,4,54,4,1),
(1,4,4,4,1),(1,1,1,1,1)) blends one part of the 5 × 5 mean, one 
part 3 × 3 mean, and two parts original image. One cannot do 
the equivalent operation with the median fi lter in a single step, 
but one can create median-fi ltered versions with successively 
larger radii, and use the Image Calculator to blend them with 
the original to create a partially median-fi ltered image.   

   4.     Over depth  …: The sole fate of many focal series is to be pro-
jected straight-on. If noise within each frame is problematic (it 
adds up in the brightest point projection) then one can com-
pute a grouped Z projection or a running Z projection (e.g., 
using the “Running ZProjector” plug-in) of two or three suc-
cessive frames  averaged  together prior to maximum projection 
of the whole stack. If the series has been sampled suffi ciently 
fi nely (that is, more frequently than the optical  Z -axis resolu-
tion), this trick rarely alters any real image features.   

   5.    …  or time : When collecting time-lapse sequences one often 
prefers a faster frame rate at the cost of noisier individual 
images, meaning that each frame follows immediately after its 
predecessor, in which case computing the running average of 
two or three frames is equivalent to going back to collection 
time and deciding to average a few times after all. One can use 
the median (over time instead of XY space) with the “Running 
ZProjector” plug-in, but this is only meaningful with subsets 
of three or more frames; with two frames only the average 
makes sense.    

    Operating on the frequency-domain (Fourier-transformed) repre-
sentation of an image is a powerful processing and analysis tech-
nique which is beyond the scope of this chapter to explore fully; 
the ImageJ online documentation includes several explanations 
with examples, and Wolf [ 4 ] provides a gentle introduction to the 
theory. Here I describe only one specifi c application, which is to 
remove periodic patterns that can appear in confocal images due to 
variations in laser intensity (Fig.  7a ). These artifacts usually mean 

3.9  Fourier Filtering 
to Remove Periodic 
Contaminants

Confocal Image Processing



102

that one needs a new laser or better cooling, but the contaminated 
data collected in the meantime can be corrected with a straightfor-
ward procedure.

   This method is based on the premise that all images are really 
a superposition of a series of waves which vary in frequency, direc-
tion, phase, and relative power—a Fourier series [ 4 ]. Any periodic 
pattern within the image, whether a real feature or an artifact, 
means that the waves with frequency and direction that add up to 

  Fig. 7    Eliminating periodic noise. ( a ) Original image; single section from a time-lapse sequence of a sand dollar 
embryo expressing GFP–EB3, which binds growing microtubule tips. ( b ) Power spectrum of ( a ); FFT. ( c ) Power 
spectrum with spots blacked out. ( d ) Restored image without horizontal lines; inverse FFT. ( e ) The mask alone. 
( f ) The difference between ( a ) and ( d ), multiplied 15× to make the removed lines visible. ( g ) and ( h ) are a 
phase-contrast image from an arranged diatom slide and its power spectrum; in this case, spots in the spec-
trum represent very real, repeating features of the specimen       
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create that pattern have more power than other waves. ImageJ can 
display and manipulate the “power spectrum” of an image: with 
any image window active, choose  Process → FFT → FFT . This 
command produces a two-dimensional image which is actually a 
plot in which the brightness of each pixel indicates the power 
assigned to waves of each frequency (the horizontal and vertical 
axes). The lowest frequencies—corresponding to the broadest 
 gradients—are at the center, whereas the highest—the fi nest 
details—are at the periphery. (The phase information, which is 
required to reconstruct the image, is not displayed.) 

 The power spectrum  is  the image, just represented in the fre-
quency domain. The familiar spatial-domain version is recovered 
by reversing the transformation: with the power spectrum window 
active, choose  Process → FFT → Inverse FFT  to re-create the 
original. One can modify pixel intensities—the relative powers—in 
the frequency-domain version of the image to accomplish changes 
that would be diffi cult in the spatial-domain version. In this case, to 
get rid of the artifactual horizontal banding, we want to suppress—
that is, reduce the relative power assigned to—a certain subset of 
waves which do not belong. These show up in the power spectrum 
as distinct spots (Fig.  7b ). In the crudest possible way, one can 
simply blot them out: using a selection tool or the pen, cover them 
with black (Fig.  7c ). This is equivalent to applying the mask in 
Fig.  7e  to the power spectrum. Inverting the Fourier transform 
now re-creates the image without this pollution (Fig.  7d ). 

 In ImageJ, doing this to an entire stack of images simultane-
ously requires slightly more steps, and of course it must be the case 
that the  same  periodic pattern is present in all frames:

    1.    Choose a frame from the stack to be processed in which it is 
obvious which is artifact and which is real. Use  Process → 
FFT → FFT  to display the power spectrum.   

   2.    Once you have guessed which spots correspond to the con-
taminant, use selection tools to draw the smallest circles or 
rectangles which cover those spots and as little else as possible; 
hold down the shift key to add successive selections. It helps 
to zoom in on the power spectrum image to do this accurately. 
The selected areas should be as close to symmetrical around 
the center as possible.   

   3.    Choose  Edit → Selection → Create Mask  to produce a new 
image window which contains black background with white 
areas corresponding to the selected spots. We want the oppo-
site however, so choose  Edit-Invert .   

   4.    With the copied test frame as the active window, verify that 
this mask will eliminate the contaminant: choose  Process → 
FFT → Custom Filter… , and choose the mask image for 
the fi lter.   

Confocal Image Processing



104

   5.    Optional: Slightly better results will be achieved if the mask 
image is blurred (choose  Process → Filters → Gaussian 
Blur…  with a sigma of 3 or so) so that it consists of fuzzy 
spots instead of sharp-edged blots.   

   6.    Assuming that the results are satisfactory, make the window 
containing the stack active, and revisit  Process → FFT → Custom 
Filter… , selecting the option to process the entire stack.    

  (Not all spots in the power spectrum are pollution! For exam-
ple,  see  Fig.  7g  and its power spectrum, Fig.  7h .)  

  Currently the QuickTime 7 Pro player remains the easiest and 
most reliable way to turn rendered frames into effi ciently present-
able, high-quality movie fi les. Apple’s documentation for 
QuickTime Pro covers simple editing features; the procedures 
below are appropriate for encoding the kind of frame sequence cre-
ated in Subheading  3.1  ( see   Notes 12  and  13  on compression and 
key parameters). 

 Because of ongoing changes in both ImageJ and QuickTime, 
directly exporting QuickTime movies from ImageJ is presently trou-
blesome. Therefore, once you are ready to create a display version:

    1.    In ImageJ, convert the image sequence to 8-bit or RGB, and 
use  File → Save As → Image Sequence…  to export a series of 
numbered fi les in TIFF format (no compression).   

   2.    In the QuickTime player, choose  File → Import Image 
Sequence… . At this point you must choose a frame playback 
rate; I recommend using 15 or 30 ( see   Note 13 ). Changing it 
later within QuickTime means dropping or interpolating 
frames, not speeding up or slowing down the video.   

   3.    Choose  File → Export , and select “Movie to QuickTime 
Movie” from the pop-up menu; click “Options.”   

   4.    In the Options dialog, the buttons arranged under the “Video” 
heading all need attention; the “Filter…” button just needs to 
be clicked to make sure that “None” is selected.   

   5.    QuickTime does high-quality image scaling to arbitrary 
dimension, so if resizing is necessary, this is a good place to do 
it; if not, make sure that “Current” is chosen; otherwise, 
QuickTime retains the last values used.   

   6.    Click “Settings…” to specify compression parameters. Select 
“H.264” from the drop-down menu at the top. Under 
“Motion,” make sure that “Current” is chosen for frame rate. 
Anything else drops or interpolates frames—remember that the 
frame rate should be set on import ( step 2 ). Unless experiment 
suggests otherwise, use “Automatic” for key frame frequency.   

   7.    One can either constrain the data rate or the image quality. If 
one chooses to use the image quality control, for H.264 “best” 
is usually nearly fl awless but ineffi cient; “medium” is often 

3.10  Encoding 
Movies Using 
QuickTime
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acceptable. However it is usually better to specify the data rate: 
for standard-size video (640 × 480) it should be possible to 
achieve acceptable image quality somewhere between 3 and 
10 Mbit/s.     

 Your eyes are the best judge of whether compression has lost 
anything important, but with hundreds of frames they could use 
some help. To compare compressed video to the original using 
ImageJ:

    1.    Open the original frames into ImageJ as one stack, e.g., by 
choosing  File → Import → Image Sequence…  to import the 
series used as input to QuickTime.   

   2.    ImageJ can open QuickTime movies, but it is presently unclear 
how much this depends on operating system, Java version, 
etc.; if your ImageJ declines to open QuickTime fi les directly, 
then within the QuickTime player choose  File → Export… , 
specify “Movie to Image Sequence,” and save the frames as 
TIFFs. Check that the exported frame rate is the same as the 
movie’s playback rate.   

   3.    Open the sequence of encoded frames in ImageJ using 
 File → Import → Image Sequence… .   

   4.    Use  Process → Image Calculator…  to compute a new stack 
consisting of the difference between the original and encoded 
frames.   

   5.    With the window resulting from  step 4  active, Choose 
 Analyze → Histogram , clicking “Yes” when prompted 
whether to include the whole stack. If the histogram shows 
that the maximum pixel value in the difference image is smaller 
than 32 with a distribution skewed strongly to the left, then it 
would be very diffi cult to spot the difference between com-
pressed and original frames.   

   6.    For compressors like H.264 that use inter-frame compression, 
it can be informative to examine the difference stack by making 
a Z profi le: select a region (or the entire frame), and choose 
 Image → Stacks → Plot Z-axis Profi le ; if key frame frequency 
and data rate are poorly matched, the Z profi le of the difference 
stack will exhibit large periodic oscillations.     

 QuickTime’s fi le format is a container which coordinates the 
timed display of various kinds of media, not just video. This makes 
it straightforward to add simple graphic overlays—scale bars, 
pointers, or captions—nondestructively. One needs only to make 
the overlay as a graphic fi le, add it to the QuickTime fi le as a sepa-
rate track, and set a few options:

    1.    Open the movie in the QuickTime player and move to a con-
venient reference frame (the fi rst one or the principal one on 
which the overlay is to appear).   
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   2.    Choose  Edit → Select None —this ensures that only the current 
frame is selected—and then  Edit → Copy .   

   3.    In PhotoShop, create a new fi le the exact size of the movie 
frame, selecting “Transparent” for the background fi ll. Paste 
in the copied movie frame.   

   4.    Draw the desired graphics and text as layers over the movie 
frame. If some graphics—like a scale bar—are to appear 
throughout the movie but others—like an explanatory cap-
tion—are only to appear for some portion of the movie, one 
should segregate them into different layer groups; this will 
make it convenient to save these sets as separate fi les.   

   5.    To all graphics and text layers, it helps to apply a drop shadow 
effect. This ensures that a white overlay shows up almost as 
well when placed over lighter areas of the image (same for 
black on dark areas). Select the layer in the Layers palette, and 
then choose  Layers → Layer Style → Drop Shadow… ; to 
make a tight-fi tting shadow, specify 100 % opacity, distance of 
1 or 2 pixels, spread of 0 pixels, and size of 1 or 2 pixels.   

   6.    Hide the layer containing the reference movie frame by click-
ing the layer visibility icon in the Layers palette. One should 
see only the overlays against a transparent background. Use 
 File-Save As…  to export the currently visible layers as a PNG 
fi le (this preserves transparency). If making several overlays 
that will be visible at different times, save the relevant layers as 
separate fi les.   

   7.    Open the PNG fi le in the QuickTime player—it will look 
strange; ignore this—and choose  Edit → Select All  and then 
 Edit → Copy .   

   8.    Go to the movie window; choose  Edit → Select All  if the 
overlay should be added to the entire movie. If the overlay is 
to show for only a part of the movie, then instead select the 
appropriate portion using the draggable selection controls on 
the movie playback bar, just below the pointer which indicates 
the current position.   

   9.    Then choose  Edit → Add to Selection and Scale .   
   10.     Step 9  blocks out the movie; to blend them, fi rst choose 

 Window → Show Movie Properties . This brings up a win-
dow in which all tracks within the fi le are listed. Select the new 
track (which is of type PNG), and click the heading for “Visual 
Settings.” At the lower left is a “transparency” control; from 
the menu choose “Straight Alpha.” It may be necessary to jog 
the movie from frame to frame to see the effect. (Layer order 
matters in this step: in the Movie Properties dialog, it is set 
within the Visual Settings set, next to the transparency option, 
and the overlay should have smaller/more negative numbers 
than the movie).       
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4    Notes 

     1.    When using ImageJ’s 3D projection function, if the starting 
data are larger than about 800 square pixels, it is tempting to 
scale the stack down before rendering: both rendering and 
movie playback are cumbersome with large frames. However, 
because of the way ImageJ’s 3D project function works, pre-
reduction can reduce the quality in a surprising way: if the 
axial distance between frames is about the same as the pixel 
width, the frames adjacent to the straight-on view (small 
angles) will be little different from the straight-on view itself, 
resulting in jerks during playback. The same quirk leads to 
stereo pairs that appear to have only a few distinct layers. 
Therefore, if available memory allows, it is better to render 
fi rst and then scale. For stereo pairs, it sometimes helps to scale 
 up , then render, and scale down.   

   2.    The “Lower Transparency Bound” in the 3D projection func-
tion can be useful to eliminate a background haze; anything 
below the specifi ed value will not contribute to the 
projection.   

   3.    When rendering a 3D animation, if you only want to rock the 
view in one axis, you could stop after  step 2  in Subheading  3.1 . 
ImageJ will animate the frames in reverse as well as forward. 
However, if you intend to save the animation as a QuickTime 
or an AVI movie, it is a good idea to conduct  step 5  as well: 
although QuickTime can loop movies back and forth, other 
players cannot, and it imposes diffi culties for all but the sim-
plest video compressors. Duplicating frames in reverse order 
avoids any trouble at the cost of “merely” doubling fi le size.   

   4.    The appropriate angle of separation for a stereo pair is 
 somewhere between 5˚ and 8˚. It depends on how far the 
screen or the page is from the viewer. Trial and error, with a 
specimen whose aspect ratio you have an intuitive feel for, will 
tell you approximately the “correct” angle. Too great an angle 
will accentuate the depth artifi cially.   

   5.    It would be great to render movies in stereo. Using ImageJ’s 
built-in functions it is only possible to create a swing around 
the Y-axis in stereo: render two 30˚ swings using 
 Image → Stacks → 3D Project… , one starting from –18˚ and 
the other from –12˚, and then use  Image → Stacks → 
Combine…  to place them side by side.   

   6.    The diverged/wall-eyed and convergent/cross-eyed methods 
for viewing stereo images have contrasting intrinsic virtues. 
The former seems to involve less strain, but the latter is less 
dependent on the physical size of the images to be fused. For 
this writer, divergent viewing (which I do almost without 
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meaning to) leads to an apparently larger, and consequently 
more detailed, image compared to cross-eyed viewing (which 
I do with diffi culty).   

   7.    The gamma function multiplies every pixel value by one over 
the maximum value, raised to the specifi ed power (the gamma 
value): a gamma of 1.0 means no change—a linear look-up 
table—whereas a gamma of 0.5 makes a look-up table shaped 
like the square root function on the interval 0–1.0, and a 
gamma of 2.0 corresponds to the equivalent part of the 
parabola.   

   8.    ImageJ can use color look-up tables for display, and if the same 
color coding scheme is used repeatedly, the necessary RGB 
values can be computed using a spreadsheet (columns R, G, 
and B), saved as a CSV table, and imported using 
 File → Import → LUT… . This requires more forethought 
but saves time and memory.   

   9.    When reslicing stacks to make a kymograph, the “Avoid 
Interpolation” option is suggested to make one pixel in the 
resultant stack correspond to a single time point and to ensure 
that all pixels of the original are represented once and only 
once. However with short sequences or rapid motion it may 
be useful to stretch time, which can be done by manipulating 
the voxel depth (e.g., make it 2× the pixel width and height) 
and then instructing the reslicer to use a slice spacing equal to 
one of the original pixels, unchecking “Avoid Interpolation.”   

   10.    “Kymographs” in diffi cult cases: If objects do not move on 
straight lines and yet one must quantify just the  speed  of a few 
recognizable objects, then ImageJ’s ability to straighten an 
arbitrary path will be useful. Use the segmented path selection 
tool (right-click or control-click on the straight line selection 
tool), and follow objects of interest, one at a time, setting 
down additional points while using the keys  <  and  >  to move 
through the stack; then use  Image → Stacks → Reslice…  to 
create a plot of path length over time.   

   11.    Background subtraction and noise reduction require care. 
Noise and background both represent extremes: the highest 
and lowest frequencies, which, if excessive, distract perceptu-
ally from the detail we care about. If it is more than just a 
distraction, one cannot usually do much about the noise or the 
background and still recover detail unaltered. Trying to keep 
the operator’s opinion out of it (by relying on canned rou-
tines) is foolish because informed judgement is essential. 
Whatever fi ltering is done should be rationalized and repeat-
able, and one must be able, in principle, to put a sharp pencil 
on all features of interest in the original and fi nd them again in 
the product.   
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   12.    QuickTime offers many different compressors. For short 
sequences (<100 frames), use Photo JPEG. It is virtually loss-
less at “best” quality, and nearly as good at “high” quality, and 
it plays backwards and forwards smoothly and edits without 
complication. For longer sequences or to achieve the very 
smallest fi le size, use H.264; of all the true video compressors 
in QuickTime, which use both inter- and intra-frame compres-
sion, H.264 usually yields by far the best image quality for a 
given compression ratio. It suffers from one sporadic annoy-
ance, which is that the color table is sometimes slightly differ-
ent from the input frames.   

   13.    Key parameters for movie encoding are the frame rate, frame 
size, fi le size, and data rate. These are tightly coupled. There is 
little point encoding video frames at greater than 30 frames 
per second; humans perceive that to be smooth motion. If one 
needs to speed up the video, eliminate the extra frames to save 
space. At the other end, below 15 frames per second, an image 
series looks like just that: one still picture after another. 

 File size is more or less proportional to frame size—to detail 
level, actually—and playback quality depends on whether the 
computer can read the data and decode it fast enough to keep 
up with the specifi ed frame rate; a comfortable range at the time 
of writing is between 320 × 240 and 1,024 × 768, leaning 
toward the smaller end of that range for Internet playback. 

 For presentation within PowerPoint or Keynote, 
compression should achieve a data rate of less than 20 Mbit/s 
to ensure smooth playback. For Web presentation, compression 
should either achieve a small enough fi le that the average user 
will not give up while waiting to download (10 MB or so) or 
a data rate that allows video to stream while downloading over 
a moderately fast connection (3–6 Mbit/s). Note that one can 
halve the data rate (for streaming presentation) without 
 dropping a single frame by choosing to play back at 15 fps 
instead of 30 fps.         
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    Chapter 7   

 TEM Analyses of Chaetognath Reproductive Organs 

           George     L.     Shinn    

    Abstract 

   Transmission electron microscopy (TEM) enables analysis of subcellular organization. It is especially useful 
for describing the diverse array of cell types in the gonads and embryos of marine invertebrates. Here, 
I describe methods for preserving and embedding the reproductive organs of marine arrow worms for 
TEM, including procedures for staining thick sections for light microscopy and thin sections for TEM.  

  Key words     Embedding  ,   Fixation  ,   Karnovsky’s fi xative  ,   Lead citrate  ,   Staining  ,   Uranyl acetate  

1      Introduction 

 Transmission electron microscopy (TEM) provides high- resolution 
images of biological structures, including the types and arrange-
ment of organelles within a cell and the locations of plasma mem-
branes of complexly shaped cells (Fig.  1 ). This information allows 
the characterization of the diverse cell types within, for example, 
the gonads and embryos of marine invertebrates, as well as the 
structural changes that occur during cellular processes such as 
gametogenesis [ 1 ] and fertilization [ 2 ].

   Preparation of specimens involves chemical preservation, com-
monly referred to as fi xation, in toxic chemicals that simultane-
ously arrest enzymatic activity and cross-link molecular components 
in order to stabilize their positions [ 3 ]. The preserved tissues are 
then infi ltrated with and embedded in a plastic resin that physically 
supports the internal structures of specimens so that they can be 
cut into slices, called sections [ 4 ]. Typically, stained “thick sec-
tions” are fi rst examined by light microscopy in order to gain an 
understanding of the general cellular organization of the specimen. 
Targeted parts of the specimen are then “thin sectioned” for more 
detailed study by TEM. Thin sections are stained with heavy metal 
stains to enable visualization of components. The image produced 
by TEM is essentially a shadow of the thin section. The electron 
beam passes through lightly stained “electron lucent” parts of the 
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specimen, showing up as light parts of the image; the heavily 
stained “electron dense” parts of the specimen show up as darker 
parts of the image.  

2    Materials 

 Use only “EM-grade” reagents. Volumes can be adjusted propor-
tionally to suit the amount of material being used ( see   Note 1 ). 
Wear gloves and use a fume hood when working with fi xatives 
(glutaraldehyde, paraformaldehyde, osmium tetroxide), propylene 
oxide, and the components of epoxy resin (NMA, DDSA, DMP- 
30,    EMbed 812). Osmium tetroxide is a particularly volatile and 
potent fi xative and should never be held near the eyes or nose. 
Similarly, avoid contact with the uranyl acetate and lead citrate 

  Fig. 1    Transmission electron micrograph showing accessory fertilization cells (afc1, afc2) of the arrow worm 
 Adhesisagitta hispida. Arrows  indicate sectional profi les of the coiled cytoplasmic process extending from afc2 
through the fertilization canal in afc1.  jc  jelly coat of vitellogenic oocyte (voc),  nu  nucleus of afc1,  odc  cellular 
oviduct. Scale bar = 5 μm       
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used for staining thin sections. Carefully follow institutional regu-
lations for disposal of chemical wastes. 

      1.    0.2 M buffer stock solution A: 2.76 g of monobasic sodium 
phosphate dissolved in 100 mL distilled water in a 125 mL 
fl ask. Store covered at room temperature.   

   2.    0.2 M buffer stock solution B: 53.65 g of dibasic sodium 
phosphate heptahydrate dissolved in 1,000 mL distilled water 
in a 1 L fl ask. Store covered at room temperature.   

   3.    Sorensen’s phosphate buffer (0.2 M, fi nal pH 7.4): 19 mL 
buffer stock solution A and 81 mL buffer stock solution B.   

   4.    8 % Paraformaldehyde: in a fume hood, pour 50 mL distilled 
water into a 100 mL beaker and heat to 60–70 °C (with stir 
bar on a hot plate). Add 4 g paraformaldehyde to heated dis-
tilled water, stirring until dissolved. Add 1 N NaOH dropwise 
until solution clears ( see   Note 2 ). Cool solution to room tem-
perature, keep covered, and use within 24 h.   

   5.    50 % Glutaraldehyde (EM grade): Store 10 mL sealed ampoule 
(Electron Microscopy Sciences, Hatfi eld, PA, USA) in original 
container in refrigerator. Just before use, warm to room tem-
perature; shake well and wipe exterior of ampoule before 
opening.   

   6.    Modifi ed Karnovsky’s primary fi xative: 50 mL 8 % paraformal-
dehyde, 10 mL of 50 % glutaraldehyde, and 40 mL of 0.2 M 
Sorensen’s phosphate buffer in a 4 oz amber glass bottle.   

   7.    Secondary fi xative: 2 % osmium tetroxide (OsO 4 ) in 0.1 M 
Sorenson’s buffer: combine in a scintillation vial 5 mL 0.2 M 
Sorenson’s buffer with 5 mL of 4 % OsO 4  from 5 mL sealed 
ampoule of 4 % OsO 4  (EMS) that had been kept in original 
shipping canister, refrigerated, until needed. Open only in a 
fume hood.   

   8.    Epoxy resin: 11.5 g EMbed 812, 3.5 g DDSA, 0.4 mL DMP- 
30, and 7.4 g NMA from EMbed 812 Resin Kit with DMP-30 
(EMS) ( see   Note 3 ).   

   9.    4 oz amber glass bottles with leak-proof lids (Fisher Scientifi c) 
( see   Note 4 ).   

   10.    8 mL Wheaton “Snap-Cap” specimen vials (EMS or Ted Pella, 
Inc.).   

   11.    20 mL glass scintillation vials with leak-proof lids.   
   12.    95 % Ethanol (reagent grade).   
   13.    100 % Ethanol (EM grade).   
   14.    Propylene oxide.   
   15.    4 oz plastic specimen containers (EMS).   
   16.    Silicon embedding molds (Ted Pella, Inc.).   
   17.    Dedicated benchtop oven, set to 60 °C.      

2.1  Fixation 
and Embedding 
Components
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      1.    1 % Methylene blue stock: 1 g of methylene blue added to 
100 mL distilled water in a screw-top jar. Shake to dissolve, 
store    at room temperature.   

   2.    1 % Azure II stock: 1 g of azure II and 1 g sodium tetraborate 
added to 100 mL distilled water in a screw-top jar. Allow to 
dissolve, store at room temperature.   

   3.    Richardson’s stain: 10 mL of 1 % methylene blue stock stain 
added to an equal volume of 1 % azure II stock stain; fi lter 
mixture into a 100 mL fl ask just before use.   

   4.    Wire loop for collecting thick sections during sectioning 
( see   Note 5 ).      

      1.    Uranyl acetate stain: 2 g of uranyl acetate added to 100 mL of 
boiled, room-temperature ultrafi ltered distilled water. Adjust 
pH to 5 with 1 N NaOH. Store in brown bottle, wrapped in 
aluminum foil, in refrigerator. Shelf life approximately 5 weeks 
( see   Note 6 ).   

   2.    Lead citrate stain: 1.33 g lead nitrate (reagent grade), 1.76 g 
sodium citrate (reagent grade), and 30.0 mL boiled, room- 
temperature distilled water in a 50 mL volumetric fl ask. 
Stopper and shake vigorously for 1 min. Allow to stand with 
intermittent shaking for 30 min. Adjust pH to 12 by adding 
8.0 mL 1 N NaOH (prepared from carbonate-free 10 N 
NaOH, Fisher Scientifi c Co.). Add distilled water to make 
50 mL of solution. Mix by inversion; precipitate will dissolve. 
If solution is turbid, check water source for dissolved CO 2 , 
NaOH for carbonates or the lead nitrate for age. Store in 
brown bottle in refrigerator. Shelf life is approximately 5 weeks.   

   3.    NaOH pellets.   
   4.    Stainless steel, fi ne-tipped reverse-action forceps, as many as 

fi ve pairs (Ted Pella, Inc.).       

3    Methods 

  The entire procedure spans parts of four days, including nearly all 
of the second day ( see   Note 7 ).

    1.    Prepare the modifi ed Karnovsky’s primary fi xative.   
   2.    Pour a small amount of primary fi xative into a suitable shallow 

container, and introduce the specimens into the fi xative with 
as little seawater as possible. Immediately replace the diluted 
fi xative with fresh fi xative ( see   Note 8 ).   

   3.    After the specimens have hardened for a few minutes, cut them 
into pieces, being careful to minimize damage due to handling 
( see   Note 9 ). Transfer specimens to Snap-Cap vials, along with 
more than enough fi xative to keep the specimens completely 

2.2  Components 
for Staining Thick 
Sections

2.3  Components 
for Staining Thin 
Sections

3.1  Fixation 
and Embedding

George L. Shinn
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covered ( see   Note 10 ). Use multiple vials if needed to avoid 
stacking of specimens in the bottom of the vial. Fix for 1–2 h.   

   4.    While waiting for primary fi xation to occur, prepare a 0.1 M 
phosphate buffer (for rinsing during  steps 5  and  8 ) by mixing 
10 mL 0.2 M Sorensen’s phosphate buffer with 10 mL dis-
tilled water. Also, prepare the secondary fi xative.   

   5.    Replace primary fi xative with 0.1 M phosphate buffer rinse, 
and leave specimens for 5–10 min.   

   6.    Replace buffer rinse with the secondary fi xative; leave speci-
mens in secondary fi xative for 1 h.   

   7.    While waiting for secondary fi xation to occur, prepare a fi rst 
batch of epoxy resin by very thoroughly mixing components. 
Then, prepare the propylene oxide/epoxy resin mixtures for 
use during  steps 11  and  12  and create “spacers” in the embed-
ding molds ( see   Notes 11 and 12 ).   

   8.    Replace secondary fi xative with 0.1 M phosphate buffer rinse; 
mix gently and leave for 2–5 min.   

   9.    Dehydrate specimens by transferring them through a graded 
ethanol series. Specimens should remain for 10 min in each 
dilution of ethanol: 25, 50, 75, 95, and 100 %. Replace the 
100 % ethanol twice with fresh 100 % ethanol ( see   Note 13 ).   

   10.    Replace 100 % ethanol with propylene oxide: two changes for 
10 min each ( see   Note 14 ).   

   11.    Replace propylene oxide with a 2:1 mixture of propylene 
oxide/epoxy resin. Very gently rotate containers to mix resid-
ual propylene oxide with the resin mixture. Leave capped for 
4 h, with gentle occasional stirring ( see   Note 15 ).   

   12.    Replace propylene oxide with a 1:2 mixture of propylene 
oxide/epoxy resin. Leave vials capped, with occasional gentle 
stirring, for 12 h (e.g., overnight).   

   13.    Prepare a fresh batch of epoxy resin by very thoroughly mix-
ing 11.5 g EMbed 812, 3.5 g DDSA, 0.4 mL DMP-30, and 
7.4 g NMA. Use a clean dry pipette to fi ll embedding molds 
with resin ( see   Note 16 ).   

   14.    Transfer specimens to embedding molds. Allow specimens to 
settle to bottom of embedding molds, and then orient 
 specimens within mold ( see   Note 17 ). Cure epoxy resin by 
placing embedding molds into 60 °C oven for 24 h.   

   15.    Store embedded specimens at room temperature in well- 
labeled containers.    

        1.    “Thick sections” for light microscopy are cut at a thickness of 
850–1,000 nm ( see   Note 18 ).   

   2.    Slides to receive sections should be pre-cleaned with soap, 
thoroughly rinsed with hot water, and dried quickly while still 
hot so that they do not accumulate lint from the paper towels.   

3.2  Staining Thick 
Sections
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   3.    Prepare Richardson’s stain.   
   4.    Use a clean wire loop to transfer sections to a small pool 

of fi ltered, distilled water on a clean glass microscope slide 
( see   Note 19 ).   

   5.    Dry thick sections down onto the microscope slide by placing 
the slide on a hot plate set to a relatively low temperature. 
To ensure that the sections are fi rmly attached to the slide, 
continue heating the slide for 30 s after the water has fully 
evaporated (no adhesive is used).   

   6.    While the slide is still being heated, add several drops of freshly 
mixed, freshly fi ltered Richardson’s stain directly onto the 
 sections; stain for approximately 1 min ( see   Note 20 ).   

   7.    Wash away all excess stain by holding the slide under gently 
fl owing tap water, followed by immersion in distilled water for 
1 min. Dry the bottom of the slide on a paper towel and place 
the slide back on the hot plate to evaporate the remaining 
rinse water.   

   8.    Add a very small amount of warmed, high viscosity (HV) 
immersion oil as the mounting medium, and then carefully 
lower a clean No. 1 cover glass over the sections; fi rmly press 
the cover glass down to ensure that the immersion oil is 
 distributed as an ultrathin layer ( see   Note 21 ).      

      1.    Allow stock solutions of uranyl acetate and lead citrate to 
come to room temperature. Do not shake bottles and pipette 
carefully so as not to suspend any precipitate.   

   2.    Stain grids with uranyl acetate as follows: for each grid to be 
stained, dispense three drops of uranyl acetate as a small pool 
on a Parafi lm-lined Petri dish. Using reverse-action forceps, 
fl oat a grid, section side down, on top of each pool. Cover 
Petri dish; stain for 20 min ( see   Note 22 ).   

   3.    Retrieve the grids and very gently but thoroughly rinse with 
distilled water. Dry the grids with fi lter paper ( see   Note 23 ).   

   4.    Stain grids with lead citrate as follows: avoiding contamination 
due to CO 2 , carefully dispense drops of lead citrate onto Petri 
dish containing pellets of NaOH ( see   Note 24 ). Stain grids for 
10 min. Rinse grids thoroughly and dry them.      

  The ultimate goal of TEM is to obtain high-quality photographs of 
specimens. Images must be evenly illuminated, precisely focused, 
and have an optimal balance between contrast and resolution of 
image details. The areas to be photographed should have well- 
preserved membranes visible as thin continuous lines that unam-
biguously reveal the edges of cells and parts of cells. The following 
procedures apply to a JEOL JEM-100SX that has been retrofi tted 
with an AMT digital camera, but they should be broadly applicable 
to other models of TEM.

3.3  Staining Thin 
Sections

3.4  Examining 
Stained Thin Sections 
by TEM
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    1.    Turn on TEM and achieve a working vacuum, but leave both 
the accelerating voltage and fi lament set to off.   

   2.    Using reverse-action forceps, load a stained grid into specimen 
exchange rod from TEM. Insert specimen exchange rod into 
its port on side of column, and evacuate antechamber; move 
exchange rod through inner airlock of antechamber, but keep 
exchange rod and grid out of the beam path ( see   Note 25 ).   

   3.    With room lights off ( see   Note 26 ), turn on high voltage (step-
wise to 80 kV then back to 60 kV), slowly turn up fi lament to 
saturation ( see   Note 27 ), and align column ( see   Note 28 ).   

   4.    With brightness (condenser lens) at the lowest setting (electron 
beam maximally spread), insert grid into beam path and warm 
all sections on the grid by using the stage controls to system-
atically move all sections through the beam path ( see   Note 29 ). 
At the same time, assess orientation and quality of sections 
( see   Note 30 ). Select a single section to examine in detail and 
warm it further with gradually higher settings of the bright-
ness until the parts of the specimen can be studied.   

   5.    Focus by viewing the fl uorescent screen using the binoculars 
mounted by the viewing port. Before focusing the objective 
lens on the image of the specimen, the individual user must 
focus the binoculars, including both eyepieces, on the fl uores-
cent screen. To focus the objective lens, engage the “wobbler” 
function of the microscope. Focus exists when the doubled 
offset images created by the wobbler are superimposed as one 
( see   Note 31 ).   

   6.    Frame area to be photographed ( see   Note 32 ), double-check 
focus, adjust brightness as needed, and lift fl uorescent screen 
out of the beam path to capture image.   

   7.    Before saving an image, adjust the black, white, and gamma 
values as needed to enhance brightness and contrast. Save the 
captured digital image as a TIFF fi le at the highest allowed 
 resolution. Record essential information about the photo-
graph, including magnifi cation, grid number, and identity of 
the subject.   

   8.    Remove grid from beam path, return scope to standby condi-
tions, remove specimen exchange rod from column, and 
remove grid from specimen exchange rod. Save backup copies 
of digital image fi les on a separate storage device.       

4    Notes 

     1.    Through each step of the fi xation process, the volume of fl uids 
should be 5–10 times the volume of tissues.   

   2.    When fi rst dissolved, the paraformaldehyde solution is opaque 
white; when suffi cient NaOH is added, the solution becomes 
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abruptly more transparent, but a small amount of white pre-
cipitate commonly persists in suspension.   

   3.    Except for the DMP-30, I use a top loading scale, placed in a 
fume hood, to weigh the components of the resin into a single 
4 oz disposable plastic specimen container; zero (“tare”) the 
scale before adding each subsequent chemical. The chemicals 
are quite viscous and easily dispensed by pouring from their 
original containers. I very carefully measure out the DMP-30 
with a 1 mL disposable syringe. Small variations in the amount 
of DMP-30 will affect the harness and brittleness of the hard-
ened resin. Layering the DMP-30 between other ingredients 
ensures that it gets well mixed with other components of the 
resin. I stir the combined ingredients using two wooden appli-
cator sticks, counting 200 strokes. This introduces thousands 
of minute bubbles, which I eliminate by placing the mixed 
resin in the 60 °C oven for a few minutes. I like to use a rela-
tively hard formulation of the embedding medium. By chang-
ing the proportions of ingredients, softer formulations of the 
resin are possible: 11.2 g EMbed 812, 4.7 g DDSA, 0.4 mL 
DMP-30, and 6.3 g NMA are considered “medium” hard; 
and 10.9 g EMbed 812, 5.8 g DDSA, 0.4 mL DMP-30, and 
5.3 g NMA are considered “soft.”   

   4.    Containers used for dissection and fi xation must be completely 
free of particulates that might adhere to specimens and interfere 
with sectioning. Thoroughly rinse containers, including new 
ones, with distilled water but do not dry them with paper tow-
els. Containers to be used for the embedding process must be 
kept perfectly dry; clean dust out of these using compressed air.   

   5.    I make wire loops using 0.2 mm diameter palladium/gold wire 
(it is durable and does not rust). A four-inch piece of wire is 
folded in half around the tapered end of a Pasteur pipette, and 
the two ends of the wire are twined around each other. This 
twined stem is taped to the end of a wooden applicator stick.   

   6.    Avoid contact with the uranyl acetate and lead citrate, in either 
solution or powdered forms. Always wear latex or vinyl gloves 
throughout the entire staining procedure and be extremely 
careful not to spill the stains or let stray drops of the stains fall 
on the counter top. Avoid breathing dried stain powder. 
Properly dispose of used stains in the appropriate waste con-
tainer in a fume hood.   

   7.    The entire procedure typically spans 4 days. On the fi rst day, 
preparation of buffers and the 8 % glutaraldehyde solution 
takes 1–2 h. Fixation occupies most of the second day. I typi-
cally arrange events so that the 12-h second step of the infi ltra-
tion process occurs overnight. Specimens will need to be 
placed into embedding molds early on the morning of the 
third day; this step typically takes 1–2 h.   
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   8.    When I collect arrow worms using a plankton net, I keep them 
alive for 1–2 days in 1 L jars of seawater; surviving specimens 
heal, yielding improved preservation of epidermal structures. 
For the initial step of fi xation, I use the bottom part of a 3 cm 
plastic Petri dish. Replacing the fi xative eliminates the cloudy 
white precipitate that forms when the phosphate buffer in the 
primary fi xative contacts seawater.   

   9.    Cutting the arrow worms transversely enables the fi xative to 
penetrate the body quickly and is essential for high-quality 
preservation. In general, specimens to be embedded for elec-
tron microscopy should be cut down to 1 mm per side. I make 
my cuts near recognizable anatomical landmarks, so that inter-
nal organs will be more easily targeted for sectioning after the 
body has become opaque due to secondary fi xation in OsO 4 . 
For example, I cut a short distance anterior to the ovary and 
just anterior to the ciliated funnel of the sperm duct. I create 
scalpels by attaching pieces of double-edged razor blades to 
wooden applicator sticks. The individually wrapped razor 
blades are bent lengthwise to snap them in half, and each half 
is broken into 4–5 smaller pieces. One end of the applicator 
stick is incised; the blade fragment is inserted and then glued 
into place with fi ngernail polish.   

   10.    During all steps, it is essential that the specimens be protected 
from physical damage that would be visible as artifacts when 
viewed by TEM. I transfer specimens using a plastic pipette 
that has been cut to enlarge the opening; I never use forceps 
to handle preserved specimens. During subsequent steps, 
specimens are left in the Snap-Cap vials, and the fl uids are 
exchanged. Care should be taken to avoid damaging speci-
mens with the tip of the pipette. Also, I leave a very small 
amount of the original fl uid in the vial during each exchange 
of fl uids to ensure that the surfaces of specimens do not desic-
cate. This is especially important for steps involving volatile 
fl uids such as 100 % ethanol and, especially, propylene oxide.   

   11.    A “spacer” is thin layer of epoxy resin, pre-hardened in a well 
of an embedding mold. Introduce a very small amount of fl uid 
resin into the mold, spread the resin with the tapered end of a 
broken applicator stick, remove air bubbles adhering to the 
sides of the well, and then harden the resin by placing the 
mold into the 60 °C oven until needed the next day (approxi-
mately 24 h). Without spacers, elongate specimens such as 
arrow worms will not be surrounded by enough resin for 
effective cross-sectioning.   

   12.    I prepare the mixtures of propylene oxide/epoxy resin in 
20 mL glass scintillation vials capping them tightly, mix by 
shaking, and keep covered until needed during later steps; 
I approximate amounts of each component added to the vials, 
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rather than contaminating other containers for making more 
precise measurements.   

   13.    The dehydration in ethanol must be complete since any water 
molecules remaining in the specimens will prevent the epoxy 
resin from infi ltrating and hardening evenly.   

   14.    Propylene oxide is extremely volatile. In humid environments, 
rapid evaporation of propylene oxide will cool the container, 
leading to condensation of water on its walls. Keep the con-
tainer of propylene oxide covered as much as possible to mini-
mize evaporation, and dry the condensate to avoid 
reintroducing this water to the dehydrated specimens.   

   15.    Gentle mixing is achieved by holding the vials at an angle and 
slowly rotating them, being careful to keep the resin away 
from the lid.   

   16.    Examine the empty molds with a dissecting microscope to 
ensure that they are free of debris; use compressed air to blow 
dust, lint, dog hairs, or other contaminants out of the molds. 
After adding the resin, place the molds into the 60 °C oven for 
a few minutes to force air bubbles to the surface. If necessary, 
use the tapered end of a broken applicator stick to lift residual 
bubbles out of the resin and away from the top. I do this while 
looking through a dissecting microscope.   

   17.    After specimens have been introduced to embedding molds, I 
put the molds back into the oven to accelerate evaporation of 
residual propylene oxide. The specimens gradually settle to 
the bottom of the molds. A broken applicator stick is used to 
center the specimens in the wells and ensure that they are 
 oriented parallel to the sides of the wells.   

   18.    Section thickness is    determined empirically to minimize curl-
ing of sections as they come off the sectioning knife. Thinner 
sections yield more delicate staining.   

   19.    The loop must be cleaned by holding the looped end in a 
fl ame until the wire becomes red hot; the loop must be thor-
oughly rinsed with fi ltered distilled water to remove any ash 
that may adhere to the loop. I do this once and then keep the 
loop clean by avoiding touching it with my fi ngers or any 
other potentially contaminated surface. Distilled water is fi l-
tered using a 0.02 μm syringe fi lter attached to a 50 mL dis-
posable syringe.   

   20.    Filtering the stains before use and thoroughly rinsing sections 
after staining are essential steps for removing stain debris that 
would ruin otherwise good sections. The problem of remov-
ing stain debris is exaggerated if the stain is allowed to dry 
down. Staining time is determined empirically. Optimally, all 
parts of the specimen can be distinguished on the basis of dif-
ferential intensity of staining.   
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   21.    Once it cools to room temperature, the HV oil serves as the 
mounting medium, requiring no drying time. If the layer of 
HV oil is too thick, or if the cover glass used is too thick (e.g., 
No. 1½), sections will appear out of focus when viewed at 
high magnifi cations with a compound light microscope. Slight 
heating of the slide as the cover glass is being added helps to 
ensure a thin layer of mounting medium, but extreme care 
must be taken, because the heated oil soon begins to dissolve 
the stain out of the sections, ruining them.   

   22.    Extreme care should be taken to avoid contaminating reverse- 
action forceps, containers, and other materials used during 
staining. Because the risk of contamination from either exter-
nal sources or stain precipitates is fairly high, I never stain all 
the grids from one sectioned block at a single time. Examining 
stained grids with the TEM is the only way to verify that there 
have been no problems with the procedure. To dispense the 
stains from the stock bottles, wipe the outside of a glass Pasteur 
pipette with a Kimwipe   , and then use the pipette to draw a 
small volume of stain from the middle of the jar, avoiding the 
surface stain, bottom stain, and the sides of the jar, as these 
areas may include precipitates.   

   23.    Grids are retrieved from the stains and rinsed one at a time. 
I do three rinses of 1 min each. Three clean, dust-free beakers 
are fi lled with distilled water. A single grid, held by the reverse- 
action forceps, is immersed into a beaker and moved about 
continuously using a slicing motion. To avoid losing sections, 
the grid is never moved with a paddle-like motion that would 
force the water through the meshes of the grid. One quick way 
to dry a grid without allowing the sections to contact a surface 
is to touch the thin edge of the grid to a piece of fi lter paper. 
Alternatively, a small piece of fi lter paper can be inserted 
between the tines of the forceps and slowly moved towards the 
grid, until water begins to wick up on the paper, but pushing 
the paper too far will cause the forceps to release the grid.   

   24.    Avoid contaminating the lead citrate with CO 2  by holding 
your breath during each step that the lead citrate is exposed to 
air. Before adding the stain to the Petri dish, arrange 10–20 
NaOH pellets around the perimeter of the Petri dish. Once 
the stain has been added, keep the dish covered except when 
adding or retrieving individual grids.   

   25.    If the specimen is not introduced into the column at the 
 outset, the beam will have to be turned off to later accomplish 
this step.   

   26.    One challenge when using a TEM is that the viewed image, 
formed by a fl uorescent screen, is very dim. Room lights must 
be turned off and the operator’s eyes adjusted to darkness.   
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   27.    Turning the fi lament up quickly or operating the scope with 
the fi lament setting higher than necessary will shorten the life 
of the fi lament. The fi lament has burned out if the current 
meter reading fails to rise as the fi lament is turned up (assum-
ing accelerating voltage is on).   

   28.    Exact alignment of the column is essential for achieving even 
illumination and optimal contrast and resolution during pho-
tography, but not for general viewing of sections. I typically 
work through  step 4 , evaluating the quality of new sections 
and allowing the electronics of the scope to warm up and sta-
bilize for 30–60 min, before aligning the column. During 
alignment, selection of a small-diameter objective aperture 
(e.g., 30 μm) enhances contrast, but slightly reduces resolu-
tion of detail compared to a larger aperture (e.g., 50 μm).   

   29.    These processes should never be bypassed as gradual warming 
at low brightness stabilizes the embedding medium so that 
sections can be examined with a more condensed beam (higher 
brightness) as magnifi cation is increased. It also functions to 
anchor sections to grid bars and lighten the embedding 
medium so that stained details of the specimen are more con-
spicuous. In general, with dark-adapted eyes, use the lowest 
brightness necessary to see the desired parts of the specimen. 
This should always be below the level at which the edge of the 
beam is evident on the fl uorescent screen. If the specimen 
moves by itself, brightness has been increased too quickly; de- 
condense the beam and warm the section more thoroughly. 
Even modest brightness settings can cause physical damage to 
parts of specimens that are not supported on all sides by a grid 
bar or that have holes in the embedding medium.   

   30.    For complex multicellular subjects, it is essential to know the 
histological structure of the specimen from light microscopic 
examination of stained thick sections. Sections vary with 
respect to how they land on grids; for some, the important 
parts will be obscured by grid bars or will not be supported on 
all sides by grid bars. When viewed at low magnifi cation, sec-
tions commonly vary in overall shade. The lightest sections are 
the thinnest. These typically yield lower contrast images, most 
evident at low magnifi cation, but better resolution of detail, 
most evident at high magnifi cation.   

   31.    TEMs are not parfocal and must be refocused whenever mag-
nifi cation is changed. For a microscope that has been retrofi t-
ted with a digital camera, I focus the specimen on fl uorescent 
screen of the TEM. Focusing live digital images on the com-
puter monitor is diffi cult because of the slow refresh rate and 
graininess of the live camera mode. If fi nal (captured) digital 
images are blurry, then the digital camera itself must be focused 
relative to the fl uorescent screen.   
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   32.    Take low-magnifi cation photographs fi rst. These typically 
reveal groups of cells and provide a context for understanding 
the positional setting of higher-magnifi cation images. Medium-
magnifi cation photos typically show characteristic structures of 
single whole cells, including the nucleus, and high-magnifi cation 
images reveal important subcellular details. Because it would 
contain information about the relative sizes and positions, a 
single photograph that clearly shows three parts is more useful 
that three photographs each showing just one part.         
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    Chapter 8   

 SEM Analysis of Marine Invertebrate Gametes 

           John     Buckland-Nicks    

    Abstract  

  Scanning electron microscopy (SEM) enables a close-up investigation of topographical features at the 
 cellular level down to a resolution of about 3 nm. In terms of gametes this allows for examination of 
 minute surface details and changes that occur during fertilization. Sometimes these features are hidden 
from view and must be carefully exposed during preparation in order to be made visible in the SEM. This 
chapter describes methods that can reveal surface details of gametes for observation, as well as fi x them 
permanently, while keeping fi xation artifacts to a minimum.  

  Key words     Chiton gametes,     Fixation artifact,     Osmolarity,     Transitional solvent,     Immunogold,     Critical 
point drying,     Sputter coating,     Remounting,     Stereo pairs,     Back scatter,     Secondary electrons  

1      Introduction 

 In scanning electron microscopy (SEM), a focused beam of 
 electrons scans the sample, interacting with its surface and releas-
ing a variety of signals. Such signals in turn can provide detailed 
topographical information that complements structural informa-
tion revealed by transmission electron microscopy (TEM). For 
example, low-energy “secondary electrons” detected by SEM are 
used to form an image of surface features at about 100× better 
resolution than is obtainable by conventional light microscopy 
(Figs.  1 ,  2 ,  3 ,  4 ,  5 , and  6 ). Other forms of electromagnetic radia-
tion, including back scattered electrons, X-rays, and cathodolumi-
nescence, may also be captured by specifi c detectors and used to 
reveal more information about the sample. In most situations this 
requires that the cells and tissues be stabilized as close to their 
natural state as possible with fi xatives that maintain osmolarity, 
cross-link proteins, and impregnate cells with heavy metals. These 
procedures prevent the electron beam from penetrating too deeply 
and instead facilitate interactions with the sample’s surface. Cells 
and tissues usually must be fully dehydrated without causing  drastic 
changes to cell volume, shape, or fi ne structure. Fine details that 



126

  Fig. 1    Egg of the white chiton,  Stenosemus albus . Note: removing eggs soon after 
they are spawned avoids debris. Filtering solutions that contact these eggs also 
reduces particulate contamination on the hooked spines. Scale bar = 50 μm       

  Fig. 2    Egg of the chiton  Mopalia muscosa  rolled on sticky tab to remove cupules 
and allow interior views. Scale bar = 100 μm       
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are hidden from view must be revealed by removing layers or dis-
secting away parts that confuse or confound the key targets of the 
study. All of these techniques require meticulous attention to detail 
for best results. Fortunately, since the inception of SEM in the 
1960s, various helpful SEM techniques have been described [ 1 – 4 ], 
including reliable methods for processing gametes and embryos 

  Fig. 3    Photograph of sperm fertilizing egg of  Stenosemus albus  taken in 2007. 
Note: small charge line ( arrow ). Scale bar = 1 μm       

  Fig. 4    Same sperm as in Fig.  3  photographed in 2010 after storage in desiccator 
for 3 years. Recoating with gold has removed charge line. Resolution has been 
improved by reducing working distance and spot size. Scale bar = 1 μm       
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[ 5 – 13 ]. This chapter takes advantage of the discoveries of these 
SEM  pioneers and adds new details on how to process gametes for 
SEM, while making these techniques accessible to fi rst time elec-
tron microscopists.

2           Materials 

 SEM reveals both important structural details and unwanted debris 
or unnatural form. Thus it is imperative to keep all experimental 
solutions free from particulates by fi ltering them. Moreover, to 
minimize contamination even when animals spawn in dishes, 
replace natural sea water (SW) with fi ltered SW ( see   Note 1 ). 
Furthermore, manipulations of fi xed samples to reveal inner layers 
or remove contaminating debris, crucial as these steps are, should 
be kept to a minimum. Most solutions used in SEM are toxic and 
must be disposed of correctly. In addition, the majority of proce-
dures involve volatile or otherwise hazardous materials that should 
be carried out wearing double gloves under the fumehood. All 
materials listed are available from EM Sciences Ltd. unless other-
wise stated. 

      1.    Filtered sea water (FSW): 0.22 μm FSW. Vacuum fi lter 500 mL 
sea water with a 0.22 μm Millipore fi lter kit.   

   2.    100 mm petri dishes.   
   3.    20 mL glass scintillation vials with poly-seal lined screw caps.      

       1.    Primary fi xative buffer: 0.2 M sodium cacodylate buffer. Weigh 
4.28 g sodium cacodylate and transfer to 100 mL distilled 
water (DW) in a beaker. Mix and adjust pH to 7.4.   

   2.    10 mL ampoule of 25 % EM grade glutaraldehyde.   

2.1  Obtaining 
Gametes

2.2  Fixation

  Figs. 5 & 6       Stereo pair of SEMs of cracked egg of Stenosemus albus. Scale bars = 10 μm       
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   3.    Isotonic primary fi xative: 2.5 % glutaraldehyde, 0.1 M sodium 
cacodylate buffer, FSW, 0.06 M sucrose, pH 7.4. Add 10 mL 
25 % glutaraldehyde to 40 mL FSW in a beaker. Add 50 mL 
primary fi xative buffer. Weigh and dissolve 2.74 g sucrose. 
Refrigerate ( see   Note 2 ).   

   4.    Isotonic buffer rinse: 0.1 M sodium cacodylate, FSW, 0.26 M 
sucrose, pH 7.4. Mix 50 mL FSW with 50 mL primary fi xative 
buffer in a beaker. Weigh and dissolve 8.9 g sucrose.   

   5.    Osmium tetroxide (OsO 4 ) stock solution: 5 % OsO 4.  Break 1 g 
ampoule of OsO 4  along the score line and upend into 20 mL 
FSW in new scintillation vial, cap tightly, seal with Parafi lm. 
Leave in fumehood overnight to dissolve ( see   Note 3 ).   

   6.    Isotonic secondary fi xative: 1.25 % OsO 4,  0.1 M sodium caco-
dylate buffer, FSW, 0.21 M sucrose, pH 7.4. Mix 5 mL OsO 4  
stock solution with 5 mL FSW in a new vial. Add 10 mL pri-
mary fi xative buffer. Weigh and dissolve 0.72 g sucrose. Cap 
the vial, seal with Parafi lm, and store in fumehood until use.   

   7.    Uranyl acetate solution: 0.5 % uranyl acetate. Weigh 0.1 g ura-
nyl acetate and add to 20 mL DW in scintillation vial. Cap, 
cover with aluminum foil, mix, and leave for 24 h to dissolve.   

   8.    Tefl on ®  microporous specimen capsules (78 μm pore size) 
(EMS Cat# 70187-10).   

   9.    5 × 7 mm silicon wafers (Ted Pella Inc, Cat#16007).   
   10.    Wet chamber: place two layers of fi lter paper in lid of petri dish 

and wet with DW.   
   11.    Overlay with a strip of 2″ Parafi lm cut to fi t.   
   12.    0.1 % Poly- L -Lysine hydrobromide 70,000–150,000 MWt.   
   13.    G-gard-ER or Formalex ( see   Note 4 ).   
   14.    Corn oil ( see   Note 5 ).      

      1.    Anhydrous ethanol (100 %).   
   2.    Ethanol series: 10, 30, 50, 70, 90, 95 %. Made from anhydrous 

ethanol and DW and run through 0.22 μm fi lter, before use.   
   3.    Powder free vinyl or nitrile gloves.   
   4.    Acetone.   
   5.    Chloroform.   
   6.    Amyl acetate.   
   7.    60 mm Pyrex ®  petri dishes.   
   8.    35 and 60 mm disposable petri dishes.   
   9.    50 mL Pyrex ®  beakers.   
   10.    Vacuum desiccator with dry desiccant.   
   11.    Critical point dryer (CPD).      

2.3  Dehydration
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      1.    SEM stubs, 12.7 mm diam ( see   Note 6 ).   
   2.    12 mm double-sided carbon sticky tabs.   
   3.    Carbon cement or silver cement.   
   4.    SEM stub storage box.   
   5.    DuMont #5 fi ne forceps.   
   6.    Dumoxel SEM specimen mount forceps.   
   7.    000 gauge insect pins (Fine Science Tools Cat# 26001-10) 

( see   Note 7 ).   
   8.    Chloroform glue ( see   Note 8 ).   
   9.    Breakable double edge carbon steel razor blades ( see   Note 9 ).   
   10.    Wooden applicator sticks 15 cm × 2 mm.   

   11.    LePage’s 5 Minute ®  epoxy glue.      

      1.    250 mL glass media bottles with screw caps.   
   2.    10 mL ampoule 10 % paraformaldehyde solution.   
   3.    Tris buffer: 20 mM    Tris, 150 mM NaCl, pH 7.6. Weigh 2.42 g 

Tris base, dissolve in 800 mL deionized DW, adjust pH to 7.6 with 
1 N HCl. Weigh and dissolve 8.7 g NaCl. Adjust to IL with DW.   

   4.    0.4 M Millonig’s phosphate buffer: weigh 11.8 g Sodium 
phosphate (monobasic) and dissolve in 200 mL DW. Weigh 
and dissolve 2.85 g NaOH. Adjust pH to 7.4.   

   5.    Buffer wash: 0.1 M Millonig’s phosphate buffer, 3 % NaCl, 
pH 7.4. Mix 25 mL 0.4 M Millonig’s phosphate buffer with 
75 mL DW. Weigh and dissolve 3 g NaCl.   

   6.    Immunofi xative: 4 % paraformaldehyde, 0.1 M Millonig’s 
phosphate buffer, 3 % NaCl, pH 7.4. Mix 7 mL DW, 8 mL 
10 % paraformaldehyde, and 5 mL 0.4 M Millonig’s phosphate 
buffer. Weigh and dissolve 0.6 g NaCl.   

   7.    5 mm × 7 mm silicon wafers (Pelco). Scratch labels with 
 diamond pencil on “back side” of each wafer ( see   Note 10 ).   

   8.    Aldehyde blocking buffer: 100 mM glycine, Tris buffer, pH 7.4. 
Weigh 0.75 g glycine and dissolve in 100 mL Tris buffer.   

   9.    Antibody blocking buffer: Tris buffer, 1 % fi sh skin gelatin 
(Sigma), pH 7.4. Weigh and dissolve 2 g fi sh skin gelatin in 
200 mL Tris buffer.   

   10.    Primary antibody: dilute 1:50 in “antibody blocking buffer” 
( see   Note 11 ).   

   11.    Secondary antibody conjugated to 15 nm gold. Dilute 1:50 in 
“antibody blocking buffer.”   

   12.    Whatman fi lter papers, 55 mm circles.   
   13.    Wet chamber: 60 mm petri dish containing two layers of wet 

fi lter paper overlaid with strip of Parafi lm cut to size.       

2.4  Mounting

2.5  Immunogold 
Labeling
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3    Methods 

 It is best to observe fertilization in real time with light microscopy 
(Phase contrast or Nomarski) before deciding how to process unfa-
miliar gametes for SEM. Eggs such as those of chitons [ 11 ], and 
ascidians [ 15 ] have elaborate egg envelopes (Fig.  1 ) that may 
obscure fi ne surface details or fertilization events. Eggs of echino-
derms and some mollusks, including basal chitons, have a jelly coat 
that must be removed prior to fertilization in order to examine 
sperm–egg interaction at the vitelline layer. Methods for obtaining 
eggs and removing jelly coats are well established for echinoderms 
[ 5 – 7 ,  14 ] and ascidians [ 15 ] ( see   Notes 12  and  13 ) but not for 
mollusks. 

      1.    Bring animals into the lab from the fi eld and isolate individu-
als overnight in separate petri dishes containing FSW, either 
on a running sea water table or held at room temperature 
(RT). Observe frequently to detect fi rst signs of spawning 
( see   Note 14 ).   

   2.    If spawning does not occur, add to these dishes two drops of 
sperm concentrate that have been dissected from gravid males 
( see   Note 15 ).   

   3.    Remove any spawning animals, wash in sea water then FSW 
and place in clean separate dishes with FSW. Collect any freshly 
released, unfertilized eggs ( see   Note 16 ).   

   4.    Invertebrates with internal fertilization usually require special 
handling ( see   Note 17 ).      

      1.    Using a Pasteur pipette ( see   Note 18 ), gently transfer less than 
a monolayer of eggs into scintillation vials containing FSW. 
Wash two times by gently aspirating most of the solution and 
replacing it with fresh FSW ( see   Notes 19  and  20 ). Keep vials 
on a thin layer of crushed ice in the fumehood.   

   2.    Take one vial of about 30 unfertilized eggs and fi x as in  step 5 .   
   3.    To a second vial of 30 eggs, add dilute activated sperm to 

induce natural fertilization and development and label. Rinse 
eggs with FSW after 5 min and fi x after 1 h as in  step 5 .   

   4.    To a third vial containing about 100 eggs, add activated sperm 
concentrate ( see   Note 21 ) to induce polyspermy. Pipette ali-
quots of 20 eggs to primary fi xative in labeled vials, at timed 
intervals of 10 s, 30 s, 1 min, 5 min, and 1 h. This series is 
likely to reveal the key events of sperm entry. However, be 
prepared to vary times.   

   5.    For each vial, aspirate the solution and replace it with 5 mL 
cold primary fi xative by dribbling it down the side of the vial, 
to avoid mechanical damage to delicate eggs.   

3.1  Obtaining 
Gametes

3.2  Fixation and 
Dehydration of Eggs
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   6.    Fix all samples for 1 h on ice and then move vials onto a dry 
surface and allow fi xation to continue for another 2 h, or over-
night, as temperature rises to RT.   

   7.    Aspirate most of the fi xative by tipping the vial at an angle and 
highlighting it against a black background, while carefully 
observing the aspirations to avoid losing any eggs. Discard pri-
mary fi xative ( see   Note 22 ) and gently replace with buffer rinse 
that is dribbled via a clean pipette down the side of the vial.   

   8.    After 10 min repeat this process with a second buffer rinse and 
incubate 10 min.   

   9.    Replace buffer rinse with isotonic secondary fi xative in the 
same way. Fix for 1 h at RT.   

   10.    Aspirate secondary fi xative against a white background, as eggs 
will now be black, and replace with DW. After 10 min, repeat 
this process with fresh DW ( see   Note 23 ).   

   11.    Replace half the DW with 10 % ethanol. 10 min later replace 
half of this solution with 30 % ethanol. Repeat this with 50, 70, 
80, 90, 95, 100 % ethanol ( see   Note 24 ). Aspirate most of the 
100 % ethanol and replace with 20 mL 100 % ethanol. Repeat 
two times.   

   12.    Transitional solvent ( see   Note 25 ). Add ten drops of amyl ace-
tate to each vial in the fumehood. Gently swirl to mix. Ten 
minutes later remove 1 mL and add 1 mL of amyl acetate. 
Gently swirl to mix. Repeat this with 3, 5, 10 and 15 mL with 
10 min gaps. Finally replace most of the solution with fresh 
amyl acetate and repeat this after 10 min.   

   13.    Gently suck up eggs into a Pasteur pipette already containing 
some amyl acetate and transfer them to open 78 μm Tefl on ®  
capsules sitting in a 60 mm Pyrex ®  petri dish half-fi lled with 
amyl acetate in the fumehood. In general pipette a maximum 
of 50 eggs per capsule. Label outside of capsule lid with a 
graphite pencil and with gloves on, cap the capsules (Fig.  7 ).

          There are several excellent ways to prepare sperm for SEM. As 
opposed to the method described below, others have used round 
12 mm coverslips ( see   Note 26 ) or have found that 25 mm nucleo-
pore fi lters in combination with a Millipore “Swimmex” fi lter 
holder (Fisher Cat# 09300-6) [ 3 ] or Tefl on ®  capsules [ 9 ] also 
work well.

    1.    With fi ne forceps, remove each 5 × 7 mm silicon wafer from the 
plastic backing and label the back with a diamond pencil. Dip 
each wafer into Poly- L -Lysine solution before air drying on 
fi lter paper in a petri dish.   

   2.    Transfer dried wafers to a wet chamber and pipette drops of 
activated sperm concentrate ( see   Note 21 ) onto front side of 
wafers and let sit for 5 min with the chamber closed.   

3.3  Fixation 
and Dehydration 
of Sperm
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   3.    Pick up each wafer with fi ne forceps and place under cold 
 primary fi xative in a 35 mm petri dish on ice for 3 h.   

   4.    Wash each wafer in two 10 min changes of phosphate buffer 
rinse and transfer to secondary fi xative in a clean 35 mm petri 
dish for 1 h at RT.   

   5.    Transfer each wafer through DW for 10 min. Insert one wafer 
into each Tefl on ®  capsule sitting in DW in a petri dish and 
close caps. Label caps as before.   

   6.    Transfer capsules through an ethanol series up to 100 % etha-
nol, using a glass petri dish with 10 min between each change.   

   7.    Run capsules through an amyl acetate series in a Pyrex ®  petri 
dish, as for eggs, then transfer quickly to the CPD ( see   Note 27 ).    

     Specimens are best dried before mounting by using a CPD in 
which the solvent is replaced with liquid CO 2 . This procedure min-
imizes shrinkage artifact that is introduced by evaporation of liq-
uids during air drying. The solvent can be 100 % ethanol, but in 
general fi rst replacing ethanol with amyl acetate gives the best 
results.

    1.    Quickly transfer each Tefl on ®  capsule of eggs or sperm sam-
ples to the open chamber of the CPD, stacking them effi -
ciently. Close the chamber, tighten the hold down nuts and 
quickly fi ll chamber with liquid CO 2  to limit evaporation of 
solvent ( see   Note 28 ).   

3.4  Critical Point 
Drying of Specimens

  Fig. 7    Tefl on ®  microporous specimen capsule (TC) with lid labeled E2 in pencil; 
12.7 mm Cambridge stub (S) adapted to JEOL 9 mm stub with central hole and 
Allen key (A) on side. Coverslip has been grounded to metal stub with carbon 
cement ( white arrow  ). QuantomiX 102 capsule (Qx) adapted to JEOL stub; silicon 
wafers (SW) one on carbon tab (CT) on JEOL 9 mm stub. Scale bar = 6 mm       
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   2.    Alternately fill and partially vent the chamber (into the 
fumehood) while keeping the temperature below 8 °C with 
the cooling cycle ( see   Note 29 ). This procedure gradually 
replaces all the amyl acetate or ethanol with liquid CO 2 .   

   3.    Arrange a white card at the edge of the fumehood so that after 
a few minutes of venting the stream of gases can be directed at 
it. When most of the solvent has been replaced, a white cone of 
dry ice will develop on the card. When this is fl icked off it will 
leave “wet” spots of solvent. Continue fl ushing with liquid 
CO 2  until no wet spots appear.   

   4.    Close all control knobs to the chamber, turn off the CO 2  tank, 
and turn on the heating cycle.   

   5.    The temperature and pressure rise slowly in the chamber until 
the critical point is reached (about 31 °C and 1,072 psi), when 
the chamber should automatically vent excess pressure but 
should be left closed for another 5 min.   

   6.    Undo the purge control to vent the chamber manually so that 
it slowly loses pressure (100 psi/min) down to atmospheric 
pressure, about 10 min.   

   7.    Once at atmospheric pressure again, the samples should be 
removed and transferred to a desiccator, or they can be 
mounted on SEM stubs right away.   

   8.    Dried silicon wafers can be mounted directly onto 12 mm 
 carbon tabs on Cambridge stubs or 9 mm carbon tabs on JEOL 
stubs (Fig.  7 ). Label each STUB with a Sharpie ®  marker pen.    

         1.    Eggs: If there are 20 or more eggs in a capsule, remove the cap 
and touch the edge of the capsule to the edge of the carbon tab 
on a labeled specimen stub ( see   Note 30 ). Then in one motion 
roll the capsule onto the stub, thus tipping the eggs out. Tap 
the bottom of the capsule to free up stuck eggs and remove the 
capsule with the same rolling motion.   

   2.    Under a dissecting microscope check for any eggs remaining in 
the capsule. Use a 000 gauge needle dipped in chloroform 
glue to pick up these individual eggs and place them at the 
perimeter of a separate labeled stub. Similarly, when there are 
less than 20 eggs in a capsule, they can be handled individually 
and placed evenly around the perimeter of a stub.   

   3.    In placing individual eggs with a needle, touch the needle to 
the carbon tab and roll it under and away from the egg, leaving 
the egg behind with any damaged surface beneath it.   

   4.    View the stub with >20 random eggs stuck to it. Under the 
microscope see if there is any way to improve their arrange-
ment. Use the mounted needle to gently knock apart stacks of 
eggs; pick up and place individual eggs that are not fi rmly 

3.5  Mounting 
of Specimens
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attached; and remove any hairs or debris that can easily be 
attracted to an eyelash brush or needle dipped in chloroform 
glue, or picked off with fi ne forceps ( see   Note 31 ).   

   5.    Use the 000 gauge needle to roll individual eggs on the sticky 
carbon tab, which strips off the outer envelopes (Fig.  2 ) 
( see   Note 32 ). Repeat this with about half of the eggs, always 
choosing those eggs that are already damaged or have debris 
stuck to them that can be removed in this way. The cleanest 
and best preserved eggs are reserved for examination intact.   

   6.    A few of the best eggs can be cut in half with a 15° micro- 
surgical knife or homemade razor knife (Fig.  9 ) ( see   Note 9 ). 
Working with eggs at the edge of the stub, aim the knife to the 
middle of the egg and cut through it into the carbon tab. If suc-
cessful, gently pry one way, then the other, to separate the two 
pieces of the egg and then remove the knife ( see   Note 33 ).   

   7.    Once operations on one stub are completed use the proper 
forceps to transfer it to the specimen box and then into the 
desiccator until ready to sputter coat.      

  Molecules of interest on the surface of gametes can be labeled for 
SEM by using immunogold techniques that attach gold particles of 
known size to exposed antigens. The samples are then viewed in 
the backscatter mode of the SEM, which detects differences greater 
than 3 in the atomic numbers of elements. This enables the 
 operator to spot large (15 nm) gold particles against a background 
of low atomic number elements, such as C, N, P, O, and identify 
the locations of each antigen [ 16 ,  17 ]. The molecular cross-linking 
caused by most primary fi xatives may mask delicate antigens and in 
general alters immunological characteristics. To overcome these 
problems one can use short exposures to non-coagulating, dilute 
fi xatives prior to immunolabeling, followed by a stronger post- 
label fi xation, as described below, or one can quick freeze sperm or 
eggs [ 9 ], or do wet SEM [ 18 ,  19 ] with the aid of QuantomiX 
capsules (EMS Cat# SP-202-24) (Fig.  7 ). Not covered in this 
chapter but dealt with elsewhere are methods for working with 
fractions of eggs or sperm, such as mitochondria, membranes or 
fl agella [ 20 ,  21 ] and high resolution (1 nm) Field Emission Gun- 
SEM of immunolabeled samples for viewing back scattered elec-
trons or cathodoluminescence [ 16 ,  17 ].

    1.    Attach sperm or egg samples to labeled silicon wafers for 
30 min as in Subheading  3.3 . Dry back of wafer by blotting on 
fi lter paper, but keep front surface wet.   

   2.    Immerse wafers under immunofi xative in a 60 mm petri dish at 
RT for 30 min.   

   3.    Rinse wafers in three changes of phosphate buffer wash, 10 min 
each.   

   4.    Immerse wafers in aldehyde blocking buffer for 10 min.   

3.6  Immunogold 
Labeling of Specimens
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   5.    Rinse wafers in three changes of Tris buffer, 10 min each.   
   6.    Immerse wafers in antibody blocking buffer for 30 min.   
   7.    Rinse wafers in three changes of Tris buffer, 10 min each, blot 

back of wafer.   
   8.    Place wafer in wet chamber and add 10 μL primary antibody 

onto sample.   
   9.    Incubate 2–3 h in closed wet chamber.   
   10.    Rinse wafers in three changes of Tris buffer, 10 min each. Dry 

back of wafer.   
   11.    Place wafer in wet chamber and pipette on 10 μL secondary 

antibody.   
   12.    Incubate 1–2 h in closed wet chamber.   
   13.    Rinse wafers in two changes of Tris buffer, 10 min each, fol-

lowed by primary fi xative buffer for 10 min.   
   14.    Immerse in isotonic primary fi xative ( see  Subheading  2.2 ) for 

2 h at RT.   
   15.    Rinse wafers in two changes of primary fi xative buffer, 10 min 

each.   
   16.    Immerse in isotonic secondary fi xative for 1 h at RT.   
   17.    Rinse in DW, place vertically in Tefl on ®  capsule sitting in 

petri dish with DW. Close capsule and run quickly through 
ethanol series (2 min per change), then CPD as before 
( see  Subheading  3.4 ).   

   18.    Remove dried samples and mount on SEM stubs as in 
Subheading  3.5 .   

   19.    Sputter coat with carbon ( see   Note 34 ).   
   20.    Observe samples either right away in SEM or store in desiccator.    

    Stubs that are ready for observation by SEM must fi rst be sputter 
coated with an inert conductive metal such as gold ( see   Note 35 ) 
so that excess electrons from the electron beam can be effectively 
grounded without causing overheating ( see   Note 36 ) or charging 
problems on the specimen surface (Fig.  3 ).

    1.    Sputter coat eggs twice with 1-min exposures at a distance of 
5 cm from the gold target with 18 mAmp plasma current 
( see   Note 37 ). This provides a gold coating about 30 nm 
thick ( see   Note 38 ).   

   2.    After coating, release vacuum slowly so as not to disrupt any 
delicate structures.   

   3.    Coated stubs can be viewed in the SEM immediately or stored 
in a desiccator. Sometimes, even after years there is little 
change in surface morphology if desiccant is maintained 
(Fig.  4 ) ( see   Note 39 ).    

3.7  Sputter Coating 
of Specimens
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    Most SEMs can be operated in either SEI (secondary electron 
image) mode or BEI (back scatter electron image) mode. In SEI 
mode, low-energy secondary electrons emerging from the surface 
of the specimen are captured by a positively biased detector placed 
to one side and reveal topographical features of the specimen. In 
BEI mode, high-energy primary electrons are captured by a sepa-
rate detector placed above the specimen and encircling the elec-
tron beam ( see   Note 40 ). These electrons, emerging from deeper 
in the specimen, reveal information about the distribution of high 
atomic number elements in the sample, distinguishing best between 
elements that differ by more than 3 in atomic number. This mode 
can be used also to detect immunogold labeled antigens on the 
specimen surface. In most SEMs the SE signal can be combined 
with the BSE signal often permitting identifi cation of the exact 
location of labeled antigens in the sample ( see   Note 41 ).

    1.    Insert specimen stubs into stub holder and tighten nuts that 
properly ground the stubs.   

   2.    Vent the SEM, open the access door and attach stub holder to 
specimen platform. Close door and evacuate column.   

   3.    Choose basic settings: 10 kV, 20 mm working distance, 
 mid- range spot size (i.e. if the spot size has an arbitrary scale of 
0–30, choose 15). Whole eggs, roughly 300 μm in diameter, 
can be photographed effectively with these settings, up to a 
magnifi cation of about 1,000× ( see   Note 42 ).   

   4.    Once working vacuum has been reached, turn on HT and increase 
fi lament current until fi lament is saturated ( see   Note 43 ).   

   5.    In TV mode, focus at lowest magnifi cation and fi nd a specimen 
to examine.   

   6.    Focus on an area at two or three steps higher in magnifi cation 
than you intend to use and correct any astigmatism in the 
beam (usually two adjustment knobs), then refocus. Decrease 
magnifi cation to where you want to observe and photograph, 
this will produce the best image.   

   7.    If charging occurs at a sharp edge of the specimen (“edge 
effect”), one can try reducing the voltage and put up with a 
slight loss of resolution. If this does not work it may be neces-
sary to check that the stub is properly grounded with carbon 
cement and recoat the specimen.   

   8.    Specimens can be viewed from any angle by rotating the stage 
and by tilting it to as much as 90° in some SEMs, in order to 
make visible, parts that are hidden from view. Increasing the 
“detector bias” will capture electrons from the “dark side” and 
can be used to illuminate those areas in the fi nal image.   

   9.    In BEI mode one can view samples that have been immunola-
belled with gold. Begin with settings at 15 kV, medium to 

3.8  Introduction 
to Using SEM
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large spot size, 20 mm working distance and focus with  Z -axis 
control (working distance control).    

    In the case of eggs and examining sperm–egg interaction it is often 
useful to take stereo pairs, by tilting the specimen between two 
photographs, to provide 3D visualization of the target area.

    1.    Focus and adjust contrast and brightness of the fi rst stereo 
image in the normal way and photograph it ( see   Note 44 ).   

   2.    Tape a piece of clear acetate to the video screen and trace the 
outline of the specimen with a wax pencil, noting one key 
point of focus near the center that can be found again.   

   3.    Tilt the specimen +8° and recenter it onto the wax outline. 
Then refocus using the  Z -axis control (working distance 
adjustment) ( see   Note 45 ).   

   4.    Finally adjust the brightness and contrast to match the fi rst 
micrograph and photograph its stereo image [ 3 ,  8 ].   

   5.    Arrange the printed images side by side, view them with stereo 
glasses and adjust them to exactly overlap features and see the 
3D effect (Figs.  5  and  6 ).      

   Sometimes excellent results can be obtained by reusing a sample 
for TEM that has already been observed with SEM. This is most 
useful with rare specimens (Fig.  8 ).

     1.    Use a mounted needle to gently knock eggs off SEM stub into 
100 % ethanol in petri dish.   

3.9  Taking Stereo 
Pairs for 3D Viewing

3.10  Reusing Rare 
SEM Specimens 
for TEM

  Fig. 8    TEM of oocyte of the chiton  Acanthopleura granulata  from a recycled SEM 
sample. Note surface coating of gold (G), vitelline layer (VL), cortical granule (C), 
and yolk granule (Y). Preservation is adequate even though this SEM sample was 
in the desiccator for 10 years before processing for TEM. Scale bar = 1 μm       
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   2.    Eggs should sink to the bottom when fully infi ltrated with 
ethanol. Pipette eggs into a scintillation vial containing 5 mL 
fresh 100 % ethanol.   

   3.    Follow directions in Chapter   7     by Shinn for infi ltration and 
embedding, but use a 1:1 mixture of Spurr’s and Epon resins 
for best results with these specimens ( see   Note 46 ).    

4       Notes 

     1.    Plastic 0.22 μm vacuum fi ltration units (EMS Cat# 67046-13) 
are convenient for fi ltering sea water and alcohols but not ace-
tone or amyl acetate. Use only glass Pasteur pipettes to dis-
pense these solvents. Disposable 0.22 μm fi lters on syringes 
can be used to dispense primary fi xative or heavy metal stains 
but usually not osmium tetroxide solutions.   

   2.    Osmolarity of fi xatives and buffer rinses is critical in SEM. 
Preferably the total osmolarity of a solution should be isotonic 
or very slightly hypotonic to cells and tissues in the sample. 
The osmolarity of sea water varies, but the accepted standard is 
about 1,000 mOsm [ 9 ].   

   3.    OsO 4  solutions can be prepared quickly by running the 
ampoule under hot water until crystals melt (wear double 
gloves, use fumehood). Tap liquid beads of OsO 4  into large 
end and cool ampoule under cold water to solidify them. Dry 
ampoule then break off top at score mark and push open end 
into new scintillation vial containing 20 mL DW. Cap and seal 
with Parafi lm, otherwise vapors of OsO 4  leak out. Heat with 
hot water until crystals melt again and then swirl to mix for 
about 15 min. Solution turns pale yellow as beads disappear. 
Ready to use.   

   4.    Waste solutions of formaldehyde and glutaraldehyde should be 
neutralized with G-Gard-ER or Formalex. Manufacturers 
claim that treated solutions are safe for septic systems.   

   5.    OsO 4  solutions can be reduced and kept safer by pouring them 
into a glass jar containing corn oil, in the fumehood. Full jars 
can be sealed and sent for recycling.   

   6.    12.7 mm “Cambridge” stubs are an optimal size of specimen 
viewing area and can be easily adapted to other SEMs. For 
example, many JEOL SEMs use a 9 mm stub. One of these can 
be adapted by drilling in the center with a 3 mm drill bit and 
tapping in a 3 mm Allen screw on the side, to hold a 12.7 mm 
stub (Fig.  7 ).   

   7.    Insect pins can be mounted on sharpened applicator sticks with 
5 min epoxy resin to make delicate tools for manipulating eggs 
or cracking them open (Fig.  9 ). The pins can be sharpened 
even fi ner on a moonstone.

SEM of Invertebrate Gametes
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       8.    Chloroform glue is made by dissolving either ten adhesive tabs 
(EMS Cat# 76760) or 30 cm clear Scotch tape in 10 mL chlo-
roform in a scintillation vial in the fumehood. The backing 
tape or paper tabs can be removed after glue has dissolved. 
A needle or eyelash brush (Fig.  9 ) dipped in this solution dries 
sticky and can be used to pick up dried eggs and embryos.   

   9.    Carbon steel razor blades can be broken with fi ne pliers to 
yield small pieces of blade that can be mounted with 5 minute® 
epoxy glue to make fi ne dissecting knives (Fig.  9 ).   

   10.    Wafers of silicone are sold in 4” discs already scored into 
5 × 5 mm squares or 5 × 7 mm rectangles on a plastic backing. 
5 × 7 mm is the best size for processing in Tefl on ®  capsules.   

   11.    Primary and secondary antibodies used for SEM analysis 
should be more concentrated than in TEM protocols. A 1:50 
dilution in antibody blocking buffer is recommended as a start-
ing point.   

   12.    Gametes of gravid sea urchins may be obtained by intracoelo-
mic injection of 2 mL 0.53 M KCl (40 g/L) using a #23 nee-
dle inserted into the perioral membrane. Gametes are collected 
by placing the animal aboral side down over a beaker with 
slightly smaller diameter and full of FSW. If milky sperm are 
released the animal can be removed, dried and placed on a 
60 mm Pyrex ®  petri dish to collect “dry sperm” concentrate, 
or else sperm can be pipetted directly from the gonopores as it 
is extruded. Eggs are more granular, sometimes colored, and 
should be rinsed with FSW soon after spawning. Eggs can be 
fi xed with jelly coat intact or it can be removed to reveal events 
or details at the vitelline layer by washing the eggs through a 
Nitex nylon cloth with a mesh size 1.6× the diameter of the 
egg [ 14 ]. De-jellied eggs can be fertilized by exposure to a 

  Fig. 9    Instruments made with 5 min epoxy resin and applicator sticks:  1 . Carbon 
steel razor fragment.  2 . 00 gauge insect pin,  3 . 000 gauge insect pin,  4 . Eyelash 
brush.  5 . glass electrode, double-pulled to give sharp, strong point. Scale at 
 left  in mm       
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solution of just activated sperm (two drops of dry sperm to 
100 mL FSW) and fi xed at intervals as for chiton eggs.   

   13.    Gametes of gravid sea stars may be obtained by injecting each 
arm with 0.4 mL 1-methyladenine solution. Sperm concen-
trate may be pipetted directly from gonopores of males. The 
female can be placed in a large dish of fi ltered sea water and 
eggs pipetted into fresh FSW as they are released.   

   14.    It is generally accepted that the stress associated with these 
changes often causes the animals to release gametes. If not, 
one can try introducing heat stress by raising water bath tem-
perature to 10 °C above ambient for 30 min, then return to sea 
water at RT.   

   15.    Eggs of chitons that are dissected out are rarely in a condition 
to be fertilized by sperm, due to presence of follicle cells or 
poor elevation of cupules. Natural spawning of eggs is usually 
a prerequisite for examination of fertilization events.   

   16.    Marine invertebrate eggs, particularly chitons, rapidly pick up 
debris on their surface. Thus it is important to remove eggs 
from dishes as soon as they are spawned and wash them in 
FSW.   

   17.    Mature sperm of most invertebrates, including internal 
 fertilizers such as snails, can be dissected out from the gravid 
testes or sperm storage organs of the properly euthanized ani-
mal by pricking the organ several times with a 00 gauge needle 
and aspirating the extruded sperm. Release of eggs may some-
times be stimulated in gravid snails, such as  Littorina  sp., by 
placing the animal in a FSW solution of 5 μM serotonin [ 12 ].   

   18.    The diameter of the pipette tip should be larger than the eggs 
to prevent unwanted breakage of spines or jelly coat. If Pasteur 
pipette is too small use plastic disposable pipettes which can be 
cut to best size.   

   19.    Removing most of the previous solution provides an opportu-
nity to eliminate tiny particles that could contaminate gamete 
surfaces. However, when removing volatile solutions, such as 
100 % ethanol, propylene oxide, or amyl acetate, always leave 
some solution covering the gametes, so that they do not dry 
out prematurely.   

   20.    Highlight vial with a bright fi ber optic light to illuminate all 
the contents.   

   21.    To obtain activated sperm for natural fertilization of eggs, add 
1 drop of sperm concentrate to 100 mL FSW with stirring 
(provides 1 × 10 7  sperm/mL). To obtain an activated sperm 
concentrate for inducing polyspermic eggs that in turn provide 
more chances to fi nd a penetrating sperm, use 1 drop of sperm 
concentrate in 10 mL FSW. Check under microscope for 
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intense activity before using. If sperm activity is poor, sample a 
different male.   

   22.    Double fi xation with glutaraldehyde then osmium tetroxide 
enables both SEM and TEM to be done on specimens. 
Furthermore, samples that have been viewed with SEM can be 
removed from the stub and effectively processed for TEM with 
reasonable results (Fig.  8 ) ( see  Subheading  3.10 ). If TEM is 
not planned, an excellent simpler alternative fi xative for all 
gametes is 0.4 % OsO 4  in FSW for 1 h on ice followed by rins-
ing in FSW and dehydration in an ethanol series (Ron Koss 
personal communication), also  see  [ 9 ].   

   23.    If you have excess eggs or embryos it is worth transferring 
some through 0.5 % uranyl acetate that has been fi ltered with 
a 0.22 μm fi lter syringe to remove any particulates. This fur-
ther impregnates the cells with a heavy metal, which decreases 
beam penetration, prevents damage and enhances resolution 
by releasing more secondary electrons.   

   24.    If at any time the solution begins to turn dark, replace it with 
fresh solution of the same concentration.   

   25.    Eggs and sperm can be critical point dried from 100 % ethanol, 
but better results are obtained if samples are fi rst passed 
through amyl acetate. This should be done in a stepwise 
 manner, gradually increasing the concentration of amyl acetate 
until 100 % is reached.   

   26.    Silicon wafers are conductive and provide a better substrate 
than glass for observation of gametes in SEM. However, 
12 mm coverslips cleaned then dipped in Poly- L -Lysine have 
been used successfully to image sperm samples in the SEM. 
Ten coverslips can be stacked in a CPD coverslip holder kit 
(EMS Cat# 70193-01) and processed at once but must be 
kept wet with solvent at all times. Otherwise, the samples will 
dry out prematurely.   

   27.    Tefl on ®  capsules (Fig.  7 ) can be closed and transferred quickly 
enough to the CPD chamber without signifi cant evaporation. 
Thus amyl acetate does not need to be added to the chamber. 
This is important as amyl acetate can take 10× longer to purge 
with liquid CO 2  than ethanol.   

   28.    CO 2  tanks come with about 45–50 lb of CO 2  in them. Place 
the new tank on a heavy duty bathroom scale and take initial 
weight. When weight has dropped by 40 lb, after several uses, 
change to a new tank. Also use an in-line fi lter to prevent con-
taminants near the bottom of the tank from entering chamber. 
Change fi lter once per year.   

   29.    While the solvent is being displaced prior to refi lling with liq-
uid CO 2,  try not to let the liquid level fall below the specimens 
to avoid premature drying.   
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   30.    Label each stub underneath with a fi ne Sharpie ®  permanent 
marker before mounting specimens.   

   31.    Any surface is easily damaged and any damage is readily visible 
in the SEM, so manipulation must be kept to the practical 
minimum.   

   32.    Currently this is the best method for removing the hull of chi-
ton eggs. Care must be taken to roll in one motion about 90° 
and then leave that egg alone (Fig.  2 ), because rolling too far 
can strip off both outer layers and some of the egg itself.   

   33.    Eggs may be cracked in two also by piercing with a mounted 
insect pin or glass electrode (Fig.  9 ). If eggs are rare, cutting 
them in half can be postponed until after the initial photogra-
phy of intact eggs is completed.   

   34.    Many sputter coaters come equipped with a separate chamber 
that can deposit carbon or metals such as chromium [ 16 ,  17 ] 
onto specimens. For carbon evaporation, specimens need to be 
about 6 mm away from the carbon rods. A small piece of white 
ceramic tile with a drop of oil on it is placed in the chamber. 
The oil stops carbon deposition and so one can see how much 
is deposited next to it on the ceramic tile. Coating is fi nished 
when the area around the oil droplet turns light brown, which 
takes about 1 min.   

   35.    Gold/Palladium targets form fi ner particles than gold alone 
and can improve resolution, but they are more expensive. Gold 
is good for routine work (Figs.  1 – 6 ).   

   36.    A cooled specimen stage can prevent overheating of specimens 
but usually is not essential.   

   37.    Plasma current is produced in the sputter coater when argon 
gas molecules are ionized by electrons fl owing from cathode to 
anode. These positively charged argon gas molecules are force-
fully attracted to the cathode, where they smash into the gold 
target releasing a cloud of gold particles that “sputter” over all 
exposed surfaces in the chamber.   

   38.    A 1-min exposure (15 nm thickness) is usually enough for 
sperm on silicon wafers or coverslips to ensure that surface 
details are not obscured.   

   39.    Before using specimens that have been stored for more than a 
couple of months it is a good idea to recoat with gold for 60 s 
at 18 mAmp of plasma current.   

   40.    Recent development of easy to operate, compact, bench-top 
analytical SEMs, such as the Hitachi TM3000, will make SEM 
analysis available to inexperienced users, such as undergradu-
ates. These instruments can operate with variable vacuum pres-
sures enabling examination of robust, uncoated, hydrated 
specimens, such as insects and plants. They also come equipped 

SEM of Invertebrate Gametes



144

with an energy dispersive X-ray spectrometer (EDS) that 
enables elemental analysis of any sample. Furthermore, 3D 
topographical analysis may be performed using a combination 
of the four backscatter electron detectors.   

   41.    Often the BSE and SE signals can be combined in the SEM to 
create a composite image that allows one to see exactly where 
the gold particles are located on the specimen surface.   

   42.    When examining details of sperm and sperm–egg interaction 
from 5,000 to 50,000× it is best to reduce spot size to 5 on the 
arbitrary scale, reduce working distance to 10–15 mm (increases 
resolution but reduces depth of fi eld) and increase voltage to 
15 kV to provide more secondary electrons in the fi nal image. For 
helpful discussion of the relationship between resolution, working 
distance, apertures, depth of fi eld, and voltage, consult [ 3 ].   

   43.    If there is not a preset stop for fi lament current, use “linescan” 
to show increasing fi lament current and enable correct increase 
of  Y -axis peaks up to their maximum (saturated) and not 
beyond (oversaturated).   

   44.    Stereo pairs can be captured digitally or on fi lm. A  photographic 
negative is more permanent and allows both for printing of a 
micrograph as well as scanning the image at high resolution 
(600–1,200 dpi) and working with it digitally.   

   45.    This method retains the same magnifi cation and orientation, 
which would not be the case if focused as usual with the fi nal 
condenser lens.   

   46.    It is recommended to include the lower viscosity Spurr’s resin 
in the embedding medium to ensure that gold-coated samples 
become properly infi ltrated with resin. Follow manufacturer’s 
instructions for mixing “standard” hardness.         
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    Chapter 9   

 Imaging Neural Development in Embryonic 
and Larval Sea Urchins 

           Oliver     Krupke    ,     Shunsuke     Yaguchi    ,     Junko     Yaguchi    , and     Robert     D.     Burke    

    Abstract 

   Imaging is a critical tool in neuroscience, and our understanding of the structure and function of sea 
urchin nervous systems owes much to this approach. In particular, studies of neural development have 
been facilitated by methods that enable the accurate identifi cation of specifi c types of neurons. Here we 
describe methods that have been successfully employed to study neural development in sea urchin embryos. 
Altering gene expression in part of an embryo is facilitated by injection of reagents into individual blasto-
meres, which enables studies of cell autonomous effects and single embryo rescue experiments. The simul-
taneous localization of an in situ RNA hybridization probe and a cell type specifi c antigen has enabled 
studies of gene expression in specifi c types of neurons. Fixatives and antibodies can be capricious; thus, we 
provide data on preservation of antigens with commonly used fi xatives and buffers.  

  Key words     Blastomere  ,   Fixation  ,   Morpholino  ,   Oligonucleotide  ,   Immunofl uorescence  ,   In situ 
hybridization  

1      Introduction 

 Interest in deuterostome evolution, embryonic signaling, and larval 
biology continues to stimulate studies of neural development and 
the structure of the nervous system of sea urchins. Echinoderm 
nervous systems are not easily analyzed by conventional electro-
physiological approaches, and identifi cation of neurons from ultra-
structural features or histochemical dyes has met with only limited 
success [ 1 – 4 ]. However, antibodies and RNA hybridization probes 
that are specifi c for proteins and genes that are expressed only in 
neurons have enabled detailed studies of neuroanatomy and neural 
development [ 5 – 7 ]. Many of these probes have resulted from 
access to genomic tools derived from the sequencing of the sea 
urchin genome [ 8 ,  9 ]. A powerful approach to understanding 
developmental mechanisms is obtained when these neuroanatomi-
cal methods are combined with methods for altering expression 
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levels of specifi c genes, such as morpholino antisense oligonucle-
otides or in vitro transcribed mRNA [ 10 – 12 ]. 

 We are fortunate in having a number of excellent reviews of 
imaging methods that can be applied to sea urchin eggs and 
embryos [ 13 – 17 ]. As well, methods for injecting eggs have been 
well described [ 18 – 20 ]. The objective of this chapter is to describe 
methods that have proven useful in studying neural development 
in sea urchin embryos. Inhibiting translation or expressing a spe-
cifi c gene in part of the embryo has facilitated studies of signaling; 
this we do by injecting individual blastomeres. Identifying expres-
sion of specifi c genes in neurons has been accomplished by com-
bining fl uorescent in situ methods with immunofl uorescence. 
Choice of fi xative for imaging studies is critical and guided by the 
need to preserve specifi c combinations of antigens and details of 
cellular structure. Thus, we compare several fi xatives commonly 
used in studies of sea urchin embryos.  

2    Materials 

 Gametes should be prepared and cultured following conventional 
procedures previously described [ 21 – 25 ] ( see  also Chapter   1     in this 
volume). Prepare all solutions using deionized, distilled water, and 
analytical grade reagents. 

  For injection of blastomeres there are differences in how embryos 
of different species respond to divalent cations.  Strongylocentrotus 
purpuratus  has a thick hyaline layer, and embryos can be treated 
with calcium and magnesium-free seawater without dissociating. 
 Hemicentrotus pulcherrimus  embryos can tolerate only calcium- 
free seawater without dissociating.

    1.    Natural seawater: taken from 2 to 3 m depth and fi ltered 
through qualitative fi lter paper (FSW) for culturing embryos. 
Store at 15 °C.   

   2.    MBL-artifi cial seawater (ASW): 423 mM NaCl, 9.0 mM KCl, 
9.27 mM CaCl 2 , 22.94 mM MgCl 2 , 25.5 mM MgSO 4 , 2.14 mM 
NaHCO 3  (ASW is satisfactory for many applications).   

   3.    Calcium- and magnesium-free artifi cial seawater for  S. purpu-
ratus  (Ca 2+ Mg 2+ -free ASW): 500 mM NaCl, 9.0 mM KCl, 
2.0 mM NaHCO 3 , 29 mM Na 2 SO 4 . Add 700 ml water to a 
graduated cylinder or a glass beaker, and stir with magnetic 
stirrer. Weigh and add the following reagents in turn: 29.22 g 
NaCl, 0.67 g KCl, 0.168 g NaHCO 3 , 4.12 g Na 2 SO 4 . Mix 
well and make up to 1 L with water. Store at 15 °C.   

   4.    Calcium-free artifi cial seawater (Ca 2+ -free ASW) for  H. pulcher-
rimus :  435 mM NaCl, 9.3 mM KCl, 24.5 mM MgCl 2 , 25.5 mM 
MgSO 4 , 2.15 mM NaHCO 3  [ 2 ]. Add 700 ml water to a 

2.1  Blastomere 
Injections and Double 
Injection Components
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graduated cylinder or a glass beaker, and stir with magnetic 
stirrer. Weigh and add the following reagents in turn: 25.43 g 
NaCl, 0.69 g KCl, 2.33 g MgCl 2  (anhydrous), 3.07 g MgSO 4  
(anhydrous), and 0.18 NaHCO 3 . Mix well and make up to 
1 L with water. Store at 15 °C.   

   5.    FSW containing 3-amino-1,2,4-triazol (ATA): 100 mM ATA- 
FSW stock (100×); use 1:100 dilution in FSW as a working 
solution [ 3 ]. Store at 4 °C.   

   6.    Protamine sulfate solution: 1 % (w/v) protamine sulfate in 
water; aliquot in 1.5 ml tubes. Store at −20 °C until use.   

   7.    Injection solution 1: To alter gene activity, morpholino oligo-
nucleotide (MO) or in vitro transcribed mRNA is used. MO is 
commercially available from Gene Tools (  www.gene-tools.com    ). 
mRNA is synthesized following the instruction of the mMes-
sage mMachine kit (Life Technologies;   www.lifetechnologies.
com    ). Mix the mRNA or MO at optimal concentration in 
24 % glycerol, fi lter the mixture through 0.22 μm membrane 
fi lters (Millipore), and back-fi ll injection needles ( see   Note 1 ).   

   8.    Injection solution 2: For blastomere injections to be followed 
by immunological detection of an injected cell lineage tracer, 
several options have been used successfully. We have used myc 
mRNA because a reliable specifi c antibody (9E10) is available 
[ 26 ]. A stock solution of myc mRNA at 1.0 μg/μl in 24 % 
glycerol is fi ltered and stored at −20 °C until use. Prior to 
loading, dilute this stock with MO or mRNA solution 1:10, to 
a fi nal concentration of 100 ng/μl in the injection needle. For 
live imaging, alternatives include GFP mRNA, DSRed mRNA, 
or fl uorescent dextran. GFP or DSRed can be detected after 
prolonged fi xation with specifi c antibodies, whereas fl uores-
cent dextran is lost after fi xation. Most fi xatives readily pre-
serve myc protein translated from injected mRNA.    

        1.    Paraformaldehyde in Seawater (PFA): For a hot water bath, 
put 175 ml distilled water in a 250 ml beaker and heat to boil-
ing. Put 25 ml of fi ltered seawater in a 50 ml plastic tube, add 
30 mg Tris base. Dissolve    Tris by vortexing the solution. 
Loosen cap completely and heat the solution in a microwave 
to 80 °C, being careful not to overheat. In a 1,200 W micro-
wave this takes 15–20 s. Immediately add 1.0 g paraformalde-
hyde and vortex. Immerse in hot water bath, remove the tube 
and shake vigorously or vortex every few minutes. The solu-
tion will gradually clear. Do not heat the paraformaldehyde 
solution in the microwave. When the solution is completely 
clear, cool the solution to room temperature in an ice bath, 
and adjust pH to 7.0 using pH paper. Use immediately or 
aliquot and freeze at −20 °C.   

2.2  Immunological 
Methods: Fixatives 
and Components
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   2.    Methanol (MeOH, analytical grade): Store at −20 °C and use 
while ice-cold.   

   3.    Modifi ed microtubule stabilization buffer (PEM): 100 mM 
PIPES, 5 mM EGTA, 2 mM MgCl 2 , 0.2 % Triton X-100. 
Adjust the pH to 7.0 and store at room temperature (stable 
for several months). Immediately prior to fi xation, combine 
nine parts PEM buffer with one part formalin (37 % formalde-
hyde solution). Use immediately.   

   4.    Blocking buffer: “Superblock” (Pierce Chemical), 0.03 % 
Triton X-100. When using antibodies to phosphorylated pro-
teins, add NaF (10 mM) or Na 3 VO 4  (1 mM) and incubate 
45 min at room temperature.      

  Prepare all solutions using deionized, distilled water and analytical 
grade reagents.

    1.    Fixative: 4 % paraformaldehyde in FSW.   
   2.    MOPS buffer: 0.1 M MOPS, pH7.0, 0.5 M NaCl, 0.1 % 

Tween-20. Mix from the following stock solutions. 1 M 
MOPS (10×): Add 350 ml water to a graduated cylinder or a 
glass beaker, and stir with magnetic stirrer. Weigh and add 
104.7 g MOPS and adjust pH to 7.0 with 5 N KOH. Make up 
to 500 ml and sterilize it with 0.22 μm fi lter. Store at room 
temperature (RT) in dark. 5 M NaCl (10×): Add 600 ml water 
to a graduated cylinder or a glass beaker, and stir with mag-
netic stirrer. Weigh and add 292.2 g NaCl and make up to 1 L 
and autoclave to sterilize. 10 % Tween-20 (100×): Add 2.0 ml 
Tween-20 to 18 ml sterilized water. Mix well and store at RT.   

   3.    Blocking buffer: 5 % Lamb serum in MOPS buffer, prepare 
immediately before use.   

   4.    Antibodies: Dilute rabbit anti-serotonin antibody (Sigma) 
1:1,000 in blocking buffer. Dilute goat anti-rabbit IgG conju-
gated with horseradish peroxidase (Sigma) 1:2,000 in block-
ing buffer. Sheep anti-digoxygenin (DIG) antibody conjugated 
with peroxidase (Roche) was used in 1:1,000 dilution in 
blocking buffer.   

   5.    Tyramide signal amplifi cation (TSA) system: TSA Fluorescein 
system and TSA tetramethyl-Rhodamine (TMR) system were 
obtained from Perkin Elmer.   

   6.    Hybridization buffer: 70 % formamide, 0.1 M MOPS, pH 7.0, 
0.5 M NaCl, 1 % bovine serum albumin (BSA), 0.1 % 
Tween- 20 [ 5 ].   

   7.    RNA probes: DIG-labeled RNA probe encoding antisense 
nucleotides against a target gene is made from plasmid or PCR 
product. Choose the RNA polymerase that binds the antisense 
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strand 5′ to the start of translation. Following the Takara T7 
RNA polymerase instructions: mix the following reagents in a 
0.5 ml plastic tube; 1.0–1.5 μg plasmid DNA template (or 
200 ng/μl PCR product) in 6.0 μl sterilized pure water, 1.0 μl 
10× RNA polymerase buffer, 1.0 μl 50 mM DTT, 1.0 μl 10× 
DIG RNA labeling mix (Roche), 1.0 μl T7 polymerase. 
Incubate it at 37 °C for 3–3.5 h. Add 1.0 μl TurboDNase 
(Life Technologies) and incubate it at 37 °C for 15 min. Mix 
1.5 μl lithium solution (from mMessage mMachine kit) and 
38 μl 100 % ethanol. Store at −20 °C overnight. Centrifuge at 
14,000 ×  g  at 4 °C for 15 min with a conventional high-speed 
centrifuge. Wash the pellet with 75 % ethanol–water. 
Centrifuge at 14,000 ×  g  at 4 °C for 5 min and remove etha-
nol. Air-dry briefl y and dissolve it with molecular biological 
grade water at 100 ng/μl.       

3    Methods 

 The gametes of sea urchin are collected by intra-coelomic injection 
of 0.5 M KCl. Eggs are stored in a glass beaker fi lled with FSW at 
4 °C, and sperm are collected as dry-sperm and stored in a 1.5 ml 
tube at 4 °C. Eggs can be stored at 4–15 °C for up to 2 days. Adding 
antibiotics (penicillin or streptomycin) helps to keep eggs longer. In 
contrast, the sperm can be stored stably for a week at 4 °C. 

  The following double injection method permits injection of one 
reagent into the fertilized egg, and after the fi rst cleavage, another 
reagent is injected into one blastomere of 2-cell stage. This type of 
experiment facilitates examination of cell autonomous processes 
and single embryo rescue experiments. The basic injection meth-
ods are derived from previous reports [ 19 ,  20 ,  27 ].

    1.    Fill injection dish, coated with 1 % protamine sulfate, with 
1 mM ATA-FSW. A row of eggs is settled on the bottom of an 
injection dish with a mouth pipette. After 1 min, remove any 
eggs that do not stick to the dish or stick outside of the regis-
tration lines marked on the dish. The number of eggs for 
 double injection should not be large; we normally put 
100–200 eggs on one dish. This dish should be kept on an 
ice-chilled tray, not directly on ice, for  S. purpuratus . For 
 H. pulcherrimus , the dish should not be stored on ice-chilled 
tray, but at 15 °C.   

   2.    Inseminate eggs with a few drops of 1:100 diluted sperm in 
FSW. Wait until fertilized envelope is obvious. Avoid using 
excess sperm, as polyspermy and putrefaction can be a 
problem.   

3.1  Blastomere 
Double Injections
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   3.    Inject the fi rst reagent (morpholino, mRNA, protein, antibody, 
or chemical) into the aligned eggs. Un-injected eggs should 
be removed after injecting all other eggs on one dish.   

   4.    After washing four or fi ve times with FSW to remove ATA and 
extra sperm, culture the injected eggs at 15 °C until fi rst cleav-
age is complete (about 2 h). To ensure cytokinesis is complete, 
wait longer until just before the second cleavage starts.   

   5.    Remove FSW and add Ca 2+ Mg 2+ -free ASW for  S. purpuratus  
or Ca 2+ -free ASW for  H. pulcherrimus , and repeat 3–5 times.   

   6.    After 5–10 min, the embryos will be ready for the second injec-
tion. Inject the reagent into one of the blastomeres. To pene-
trate extraembryonic layers and the membrane, set the injector 
with constant fl ow, press the tip of the needle on the surface of 
the blastomere to be injected and gently tap the manipulator 
or the base of the microscope to vibrate the needle.   

   7.    The embryos will only tolerate divalent cation-free seawater 
for about 20 min, after which blastomeres will dissociate.   

   8.    Remove Ca 2+ Mg 2+ -free ASW and add FSW gently, and repeat 
3–5 times. Culture them at 15 °C until the stage at which they 
will be analyzed (Fig.  1 ).

  Fig. 1    Double injection strategy and image of an embryo in which a dorsal– 
ventral axis has been induced without Nodal signaling. The secondary (dorsal–
ventral) axis in the sea urchin embryo depends on Nodal, which is expressed in 
prospective oral ectoderm during cleavage [ 28 ]. In this experiment we initially 
blocked endogenous Nodal activity by injecting mRNA encoding Lefty, a Nodal 
antagonist, into the unfertilized egg. After the fi rst cleavage, mRNA encoding a 
constitutively activated Smad2/3 (actSmad2/3), which is an intracellular media-
tor of Nodal signaling [ 29 ], and myc mRNA were simultaneously injected into one 
of the blastomeres. At 72 h embryo, the myc-injected cells are detected following 
immunolocalization procedures. This embryo has lost the endogenous diffusible 
Nodal, which by itself would produce an embryo without a dorsal–ventral axis 
[ 28 ]. However that cells expressing Smad 2/3 behave as though they are acti-
vated by Nodal and differentiate as oral ectoderm, which established the ectopic 
dorsal–ventral axis. In this image, the Myc-positive side of the embryos is a 
thickened oral ectoderm surrounded by a ciliary band, and the oral-half of the 
gut. The  dashed-line  outlines aboral ectoderm, which is not visible in this image       
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         In some experiments it is necessary to simultaneously detect an 
mRNA and an antigen, such as a protein or a neurotransmitter, in 
the same specimen. We have successfully combined immunofl uores-
cence and in situ hybridization methods with the TSA system (Perkin 
Elmer). A major limitation of this method is that mRNAs require 
prolonged fi xation with the result that some antigens are undetect-
able. This is the case with anti-synaptotagmin (1E11), a neural 
marker that is sensitive to formaldehyde cross-linking. However, 
anti-serotonin has proven very useful in this type of experiment.

    1.    Fix embryos or larvae with 4 % PFA-FSW overnight in a well 
of 96-well plate (4 °C). All subsequent steps, except for TSA- 
treatment, are carried out in this fl at-bottom 96-well plate 
using a dissecting microscope and an aspirator. Alternatively, 
0.5 ml clear microcentrifuge tubes can be used; although spec-
imen loss can be a problem, rinsing steps can be reduced in 
number from 5 to 3.   

   2.    Remove PFA-FSW and add MOPS buffer. Discard the used 
fi xative safely. This MOPS buffer rinse is repeated at least fi ve 
times for 7–10 min each.   

   3.    Treat samples with 5 % Lamb serum in MOPS (blocking buf-
fer) for 1 h at room temperature (RT).   

   4.    Remove blocking buffer and add 1:1,000 diluted rabbit anti- 
serotonin antibody in blocking buffer, and incubate it for 
1–2 h (RT).   

   5.    Wash with MOPS buffer fi ve times for 7–10 min each.   
   6.    Add 1:2,000 diluted goat anti-rabbit IgG antibody conju-

gated with horseradish peroxidase in blocking buffer and incu-
bate it for 1–2 h at RT.   

   7.    Wash with MOPS buffer fi ve times for 7–10 min each.   
   8.    Transfer all samples to 0.5 ml clear tubes and remove MOPS 

buffer.   
   9.    Add diluted TSA-TMR in diluent and incubate it for less than 

10 min in the dark.   
   10.    Remove TSA reagent and wash with MOPS buffer once. 

Protect the samples from light for the following steps.   
   11.    Transfer samples to 96-well plate and wash it with MOPS buf-

fer fi ve times for 7–10 min each. Check a few of samples with 
a fl uorescent microscope.   

   12.    Remove MOPS buffer and add 100 μl hybridization buffer per 
well and mix well by tapping the plate. Incubate it for 15 min. 
Change the hybridization buffer three times.   

   13.    Incubate it for 1–3 h at 50 °C (pre-hybridization) with 
 adhesive PCR sheet on wells to avoid evaporation of the 
buffer.   

3.2  In Situ 
Hybridization and 
Immunofl uorescence
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   14.    After pre-hybridization is fi nished, mix 0.4 μl DIG-labeled 
probe per 100 μl pre-warmed hybridization buffer. Remove 
the pre-hybridization buffer from the well and add hybridiza-
tion buffer with probe.   

   15.    Incubate the sample for 7 days at 50 °C with wells covered by 
an adhesive PCR sheet.   

   16.    Remove the hybridization buffer and wash sample with MOPS 
buffer fi ve times for 7–10 min each at RT.   

   17.    Wash sample with MOPS buffer three times for 1 h each at 
50 °C.   

   18.    Wash sample with MOPS buffer three times for 7–10 min each 
at RT.   

   19.    Add 5 % Lamb serum in MOPS buffer (blocking buffer) and 
incubate sample for 1 h at RT.   

   20.    Remove the blocking buffer and incubate with 1:1,000 sheep 
anti-DIG antibody in blocking buffer for 1 h at RT.   

   21.    Wash the sample with MOPS buffer at least fi ve times for 
7–10 min each. Longer is better. An overnight wash some-
times gives a better signal.   

   22.    Transfer all samples to a 0.5 ml clear tube and remove MOPS 
buffer.   

   23.    Add diluted TSA-Fluorescein and incubate it for 10 min.   
   24.    Remove TSA reagent and wash samples fi ve times for 7–10 min 

each.      

         Transfer seawater containing embryos to an appropriate sized ves-
sel and centrifuge. Pellet embryos by gentle centrifugation 
(<1,000 ×  g ) in all steps. A manual, crank-driven centrifuge with a 
swinging bucket rotor is convenient. A mini-microcentrifuge will 
also work, however we fi nd the fi xed angle and high  g  forces on 
most models result in embryos being damaged during processing. 
Once embryos have been fi xed they will settle to the bottom of 
tube without centrifugation and are readily resuspended without 
damaging embryos. The volumes presented assume 1 ml of embryo 
suspension containing about 50 μl pelleted embryos. Smaller vol-
umes, with fewer embryos, in 0.5 ml tubes save reagents.

    1.    Remove the seawater supernatant and resuspend embryos in 
1 ml PFA fi xative ( see   Note 2 ). Incubate at room temperature 
for 15 min.   

   2.    Centrifuge, remove supernatant, and resuspend in 1 ml PBS. 
Incubate for 5 min at room temperature, centrifuge, remove 
supernatant, and repeat this wash once more.   

   3.    Remove the supernatant and resuspend embryos in 500 μl of 
blocking buffer.   

3.3  Immunological 
Localizations: PFA 
Fixation
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   4.    Add antibodies or anti-sera at appropriate dilutions, mix gen-
tly by slowly rocking the tube and incubate overnight at 4 °C 
or for 4 h at  room temperature.   

   5.    Centrifuge embryos, remove supernatant and rinse three times 
each with of 1 ml PBS.   

   6.    Centrifuge, remove supernatant and resuspend embryos in 
500 μl PBS containing appropriate concentrations of second-
ary antibodies or fl uorescent conjugates. Incubate in a dark 
place for 1 h at room temperature.   

   7.    Centrifuge, remove supernatant, wash three times with PBS, 
and resuspend in 20 μl PBS. 0.01 % (w/v) Sodium azide can 
be added to this fi nal resuspension, allowing storage of fi xed 
embryos for up to three weeks.   

   8.    Alcohol-clean a glass slide and fi x two strips of double-sided 
tape across the width, spaced 15 mm apart. Place 10 μl of 
SlowFade reagent between the strips of tape. Resuspend 
embryos by gentle agitation/trituration and place 10 μl onto 
the slide and mix with the SlowFade reagent, carefully mount 
a cover glass so that it spans the two strips of tape and creates 
a fl uid fi lled space containing the specimens. Seal the edges 
with a small amount of vacuum grease to prevent leakage and 
evaporation.    

        1.    Protocol is carried out as described as in Subheading  3.3 .   
   2.    At  step 1 , substitute 1 ml of ice-cold methanol for PFA.   
   3.    Incubate embryos in methanol for 5 min at room temperature 

( see   Note 3 ).   
   4.    Remove methanol and carrying out all remaining steps 

described in Subheading  3.3 .      

      1.    Protocol is carried out as described for Subheading  3.3 .   
   2.    At  step 1  substitute 1 ml of PEM fi xative for PFA ( see   Note 4 ).   
   3.    Fix embryos in PEM for 15 min at room temperature.   
   4.    Remove PEM and carrying out all remaining steps described 

in Subheading  3.3 .      

         1.    Protocol is carried out as described for Subheading  3.3  except 
that following the 15 min incubation in PFA ( step 1  in 
Subheading  3.3 ), embryos are post-fi xed in PEM.   

   2.    Follow the instructions for PFA fi xation for 15 min at room 
temperature, then centrifuge and remove the PFA.   

   3.    Resuspend the embryos in 1 ml PEM buffer and incubate at 
room temperature for 15 min.   

   4.    Centrifuge, remove PEM and carry out all remaining steps as 
described in Subheading  3.3  ( see   Note 5 ).      

3.4  Immunological 
Localizations: MeOH 
Fixation

3.5  Immunological 
Localizations: PEM 
Fixation

3.6  Immunological 
Localizations: PFA/
PEM Fixation 
( See   Note 5 )
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  Often experiments yield only a few embryos that are to be pro-
cessed for immunofl uorescence. In these situations, all steps for 
removing buffer or reagents are performed in a 96-well plate under 
a dissecting microscope. A mouth pipette consisting of a length of 
latex tubing with a mouth piece and a PVDF in-line fi lter enables 
precise control of pressure, yet prevents accidental aspiration. To 
facilitate complete rinsing, the number of rinse steps is increased.

    1.    Collect embryos in a well of 96-well plate. Remove the seawa-
ter. Add fi xative (PFA, MeOH, PEM) and fi x samples for 
15 min at RT.   

   2.    Remove fi xative and wash samples with PBS fi ve times for 
10 min each.   

   3.    Block sample with blocking buffer: Superblock (Pierce 
Chemical), 0.03 % Triton X-100.   

   4.    Remove blocking buffer and add mixture of diluted antibodies 
in blocking buffer. Incubate the sample overnight at 4 °C.   

   5.    Remove antibody solution and wash samples with PBS fi ve 
times for 10 min each.   

   6.    Add secondary antibody mixture and incubate samples for 2 h 
at RT.   

   7.    Remove antibody solution and wash samples with PBS fi ve 
times for 10 min each.       

4    Notes 

     1.    The glycerol permits visualization of fl ow from the tip of the 
injection needle and reduces evaporation.   

   2.    Preservation of cell surface antigens is enhanced with PFA 
fi xation and the cilia are clearly presented, however detail on 
the basal cell surface is lacking in some instances and cytoskel-
etal architecture is not preserved. Preservation of serotonin is 
excellent; however, the epitope recognized by anti-synapto-
tagmin B (1E11) is only preserved by fi xing embryos for about 
15 min (Figs.  2  and  3 ).

        3.    Methanol provides effective immunofl uorescent labeling in 
select cases but is not suitable in preserving several cell-sur-
face, cytoskeletal and nuclear features (Figs.  2  and  3 ). Serotonin 
is not preserved with methanol fi xation; however, the epitope 
recognized by anti-synaptotagmin (1E11) remains intact with 
methanol fi xations up to 30 min.   

   4.    PEM-buffered formaldehyde enhances visualization of many 
internal structures at the expense of structures on the surface 
of the embryo. Preservation of cytoskeletal details is excellent. 
Nucleoplasm and strands of chromatin are well resolved and 

3.7  Preparing Small 
Numbers of Embryos
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protein complexes associated with the inner apical membrane 
(PAR6, aPKC) are well preserved (Fig.  3n, o ) and cytoplasmic 
background fl uorescence is reduced signifi cantly compared 
with PFA fi xation (Fig.  3n, o  and  h, i ). The cell-surface anti-
gen αC integrin is well preserved on the basal surface (Fig.  3p ) 
but antigens on the apical surface show only weak fl uores-
cence. Visualization of cytoskeletal detail is enhanced with 
PEM and actin arrays in regions of apical constriction are easily 
identifi ed (Fig.  3r ) although fi ne detail in membrane blebs and 

  Fig. 2    Confocal images of a portion of the apical organ of 5-day embryos prepared for the localization of syn-
aptotagmin (1E11), serotonin (5HT), and actin. Embryos were fi xed with methanol, PFA, or PEM and processed 
for immunofl uorescence as described. All the fi xatives preserve the synaptotagmin epitope ( a – c ), however 
fi xations longer than 15 min produced poorer results. Serotonin is well localized with PFA, not at all with 
methanol, and PEM fi xation produces a less intense signal with higher background ( d – f ). In these preparations 
laser power and photomultiplier voltage were set at the highest values and satisfactory localization of 5HT can 
be obtained with PEM. Actin is reliably preserved only with PEM ( g – i ). Bar = 20 μm       
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  Fig. 3    Confocal images of 28 h embryos prepared using different fi xation methods and their effects on pres-
ervation of cytoskeletal, nuclear, cell-surface, and membrane-associated protein complexes. Embryos are 
fi xed with methanol ( a – f ), paraformaldehyde (PFA) ( g – l ); or PEM buffered formalin ( m – r ), or PFA/PEM ( s – x ). ( a , 
 g ,  m ,  s ) DAPI stained nucleoplasm shows the most clarity and preservation of detail when PEM and PFA/PEM 
fi xation methods are used. Antibodies against Par6 ( b ,  h ,  n ,  t ) and aPKC ( c ,  i ,  o ,  u ) illustrate PEM is the best 
fi xative for preserving these membrane associated apical complexes. Methanol fi xation causes abundant 
background fl uorescence in the cytoplasm with many of the antibodies used ( b ,  d ,  e ) and although aPKC (atypi-
cal Protein Kinase C) shows some specifi city at cell–cell junctions ( c ), this is poorly presented in comparison 
with other fi xation methods. ( d ,  j ,  p ,  v ). Preservation of cell-surface antigens is illustrated using αC integrin. 
PEM buffer provides the best preservation of basal structures while PFA provides the best preservation of api-
cal structures. ( e ,  k ,  q ,  w ) Phosphorylated myosin II light chain (pMIILC) is preserved best with PEM buffer ( q ). 
( f ,  l ,  r ,  x ) Filamentous actin structures are preserved with the most clarity and preservation of structure using 
PFA/PEM fi xation. Cytoskeletal preservation with methanol is not satisfactory as f-actin is not preserved ( f ) and 
labeling of pMIILC is absent ( e ). Bar = 20 μm       
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fi lopodia associated with mesenchyme internalization is lack-
ing. Localization of pMyo is also satisfactory with PEM.   

   5.    The combination of PFA and PEM yields a fi xation that has 
the benefi t of preserving cytoskeletal architecture with a high 
level of detail while enhancing the preservation of internal 
structures on the apical membrane. These benefi ts are at the 
expense of cell surface antigen and pMyo preservation. 
Nucleoplasm and chromatin are highly resolved (S) and fl uo-
rescence is similar to that seen with PEM alone (Fig.  3m, s ). 
The apical proteins, PAR6 and aPKC are clearly preserved, 
with little cytoplasmic background fl uorescence (Fig.  3t, u ). 
Preservation of cell surface antigens appears poor and αC fl uo-
rescence on both apical and basal surfaces is reduced signifi -
cantly by this double fi xation (Fig.  3v ). The actin cytoskeleton 
is preserved in fi ne detail (Fig.  3x ), allowing the visualization 
of basal structures normally diffi cult to preserve. These include 
fi lopodia, membrane blebs (arrowheads), and fi laments associ-
ated with ingression of mesenchyme cells into the blastocoel.         
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    Chapter 10   

 Preparation and Use of Sea Urchin Egg Homogenates 

           Anthony     J.     Morgan     and     Antony     Galione    

    Abstract 

   Cell homogenates provide a simple and yet powerful means of investigating the actions of Ca 2+ -mobilizing 
second messengers and their target Ca 2+  stores. The sea urchin egg homogenate is particularly useful and 
almost unique in retaining robust Ca 2+  responses to all three major messengers, i.e., inositol 
1,4,5- trisphosphate (IP 3 ), cyclic ADP-ribose, and nicotinic acid adenine dinucleotide phosphate (NAADP) 
   (Lee and Aarhus. J Biol Chem 270: 2152–2172, 1995). It is not only invaluable for probing the pharma-
cology and mechanism of action of these messengers, but can also be used to assay Ca 2+  uptake mecha-
nisms (Churchill et al. Cell 111: 703–708, 2002), second messenger production (Morgan et al. Methods 
in cADPR and NAADP research. In: Putney JW Jr (ed) Methods in calcium signalling, CRC: Boca Raton, 
FL, 2006), and dynamics of luminal pH (pH L ) changes within acidic Ca 2+  stores (Lee and Epel. Dev Biol 
98: 446–454, 1983; Morgan and Galione. Biochem J 402: 301–310, 2007). Here, we detail the protocols 
for preparing and using egg homogenates, wherein eggs are shed and collected into artifi cial sea water 
(ASW), dejellied, washed several times in Ca 2+ -free ASW, and then fi nally washed and resuspended in an 
intracellular-like medium. Homogenization is effected with a Dounce glass tissue homogenizer (at 50 % 
(v/v)) and aliquots frozen and stored at −80 °C. For Ca 2+  (or pH L ) measurements, homogenate is thawed 
and sequentially diluted in an intracellular-like medium and the fl uorescence of Ca 2+ - or pH L -sensitive dyes 
monitored in a standard fl uorimeter or plate-reader.  

  Key words     IP 3   ,   cADPR  ,   NAADP  ,   Ca 2+   ,   pH  ,   Fluorescence  

1      Introduction 

 Ca 2+ -mobilizing second messengers are hydrophilic, membrane 
impermeant molecules, and their introduction into intact cells 
requires micropipettes or chemical derivatization to yield 
membrane- permeant forms    [ 1 ]. In the case of sea urchin eggs, 
microinjection is feasible [ 2 ] but hardly high-throughput, and the 
usual trick of synthesizing esterifi ed “pro-drug” analogues of sec-
ond messengers [ 1 ] is not applicable since many sea urchin species 
appear to lack suffi cient cytosolic esterases to generate the parent 
messenger [ 3 ]. As a result, egg homogenates allow free access to 
the “cytosol” in a simple, inexpensive, and potentially high- 
throughput preparation that can be stored well over many years. 
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Moreover, no specialized equipment is required other than a 
standard cuvette-based fl uorimeter (or plate reader).  

2    Materials 

 All solutions should be prepared with ultrapure water (~18 mΩ cm) 
and analytical grade reagents to minimize contamination by 
Ca 2+  and heavy metals. They should also be prepared and stored 
in plasticware to circumvent Ca 2+  leeching and contamination 
from glass. 

      1.    Artifi cial sea water (ASW): 435 mM NaCl, 10 mM KCl, 
40 mM MgCl 2 ,15 mM MgSO 4 , 11 mM CaCl 2 , 2.5 mM 
NaHCO 3 , 7 mM Tris base, 13 mM Tris–HCl, pH 8.0. 
Microadjust pH if necessary with HCl or NaOH. Store 4 °C, 
≤3 months.   

   2.    EGTA-ASW: As for ASW but substitute 11 mM CaCl 2  with 
1 mM EGTA.   

   3.    Ca 2+ -free ASW: As for ASW but without CaCl 2  (or EGTA).   
   4.    Glucamine intracellular medium (GluIM): 250 mM potas-

sium gluconate, 250 mM  N -methyl- D -glucamine, 20 mM 
Hepes (acid), and 1 mM MgCl 2 , pH 7.2. NMDG does not 
dissolve readily without adjusting the pH with glacial acetic 
acid (~13 ml/l) ( see   Note 1 ).   

   5.    Final GluIM: on the day of requirement, supplement with the 
ATP regenerating system and Complete™ EDTA-free prote-
ase inhibitor cocktail tablets (Roche) ( see   Note 2 ). Typically 
prepare 50–100 ml. Store on ice.      

      1.    0.5 M KCl, in water. Store 1 l at room temperature, ≤6 
months.   

   2.    ATP regenerating system: 0.1 M ATP (Mg 2+  salt), 1,000 U/ml 
Creatine phosphokinase (CPK), 1 M Phosphocreatine (PCr). 
All dissolved in water, store at −20 °C (≤6 months) in 100 μl 
aliquots.   

   3.    Fluorescent Ca 2+  dye: 3 mM Fluo-3 (K +  salt). Dissolve in 
water, store at −20 °C (≤6 months) in 10 μl aliquots. Light 
sensitive.   

   4.    Fluorescent pH L  dye: 10 mM acridine orange. Dissolve in 
water, store at −20 °C (≤1 month). Can be freeze-thawed sev-
eral times. Light sensitive.   

   5.    1–10 mM NAADP. Dissolve in water, store at −20 °C (≤6 months) 
in 5–50 μl aliquots.   

   6.    5 mM IP 3 . Dissolve in water, store at −20 °C (≤6 months) in 
5–50 μl aliquots.   

2.1  Buffers

2.2  Miscellaneous 
Stock Solutions
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   7.    10 mM cADPR. Dissolve in water, store at −20 °C (≤6 
months) in 5–50 μl aliquots. cADPR is particularly sensitive to 
multiple freeze–thaw cycles.   

   8.    100 mM β-NAD + . Dissolve in water, store at −20 °C 
(≤6 months) in 5–50 μl aliquots.   

   9.    500 mg/ml heparin (~3,000 kDa, low MW) in water, store at 
−20 °C (≤3 months).   

   10.    3 mM 8-Br-cADPR in water; store at −20 °C (≤3 months).   
   11.    5 M nicotinamide in water; store at −20 °C (≤3 months).   
   12.    5 mM ionomycin (acid form) in DMSO; store at −20 °C (≤6 

months) in 10 μl aliquots.   
   13.    10 mM nigericin in DMSO, store at −20 °C (≤6 months) in 

10 μl aliquots.   
   14.    10 mM valinomycin in ethanol; store at −20 °C (≤6 months) 

in 10 μl aliquots.   
   15.    1 M NH 4 Cl in water; store at room temperature ≤1 month.   
   16.    0.5 M EGTA (K +  salt, pH 7–8) in water; store at 4 °C ≤3 

months (−20 °C ≤6 months).      

   To dejelly large volumes of eggs, we make our own fi ltration units 
(Fig.  1 ;  see   Note 3 ). Take a 50-ml Falcon tube and saw-off the 

2.3  Filtration Units

  Fig. 1    Preparation of a fi ltration unit to dejelly eggs. A 50-ml Falcon tube ( a ) is 
modifi ed by drilling a 20–25 mm diameter hole in the lid and sawing off the  bot-
tom  ( b ). Holding the tube body upright, a 100-μm nylon mesh gauze (47 mm 
diameter) is placed and aligned centrally on  top  ( c ) and then the modifi ed lid is 
screwed on to secure and tauten the mesh ( d )       
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bottom to make an open tube. Drill out a hole in the screw-on lid 
(e.g., a 20-25 mm hole in a cap of ~32 mm diameter). Place cen-
trally a 47-mm diameter nylon net fi lter (100-μm mesh; Millipore—
 see   Note 4 ) over the threaded end of the tube and carefully screw 
on the annular lid. The trapped gauze across the aperture should be 
taut. Make at least four for a large-scale preparation. The units are 
washed and reused indefi nitely; the fi lters are changed almost daily.

3        Methods 

  For large-scale preparations, we recommend several people work 
together as a “factory,” assigned to their particular tasks. This 
shortens the time enormously and ameliorates the homogenate 
quality. The natural temperature for  Lytechinus pictus  (Californian 
Blonde) is 17 °C so maintain room temperature as close to this as 
is feasible. Ensure that the solutions have reached room tempera-
ture to avoid temperature shock.  See  Fig.  2  for a schematic fl ow 
diagram of the whole procedure.

     1.     Lytechinus pictus  (Marinus Inc., Long Beach, CA, USA) sea 
urchin eggs are collected during the gravid season (May to 
September). For large-scale homogenate preparations, we 
normally harvest eggs immediately upon receipt of the ship-
ment (typically 500 animals of which 300 might be female).   

   2.    20-ml universal tubes are fi lled to the brim with ASW. We use 
old scintillation racks to hold them and avoid adjacent places 
to allow suffi cient space between animals.   

   3.    Gamete shedding is stimulated by fi ve intracoelomic injections 
of 0.5 M KCl solution (up to 1 ml total volume) into each 
chamber on the oral face using a 1-ml syringe fi tted with a 
25G needle. From the aboral surface, yellow-orange eggs (or 
white sperm from males) will begin to appear. The spawning 
female is inverted and placed upon the fi lled universal tube. 
Eggs tend to be shed over a period of 5–20 min with volumes 
of 1–5 ml ( see   Note 5 ).   

   4.    Once shedding is complete, the sea urchin carcasses are dis-
carded, and the process of pooling the eggs together begins 
(eggs are precious—take care at each stage to retain them). To 
reduce dilution and minimize volumes, the excess (clear) 
supernatant above the settled eggs in each universal tube is 
carefully discarded. Gently swirl ( not  invert) each tube to 
resuspend the remaining loose egg pellet (~5–10 ml) and pool 
into a single large volume (e.g., 2 l) beaker (gently decant the 
suspension down the tilted beaker’s side—like pouring a beer). 
Do  not  discard the “empty” tube that still contains eggs! To 
collect the residual eggs, rinse the fi rst “empty” tube with 

3.1  Egg Collection

Anthony J. Morgan and Antony Galione



165

  Fig. 2    Flow diagram of egg homogenate preparation. 20-ml Sterilin tubes are 
fi lled to the brim with ASW. Each animal is injected intracoelomically with 1 ml of 
0.5 M KCl ( 1 ), and once eggs start to appear from the gonopores on the aboral 
surface, the animal is inverted and placed on the tube ( 2  ). After shedding is 
completed, the eggs are pooled in a large beaker, the tubes rinsed to collect 
residual eggs ( 3  ), and dejellied, by passing the egg suspension through the fi ltra-
tion unit ( 4  ). Ca 2+  and ASW are removed by sequential rounds of centrifugation 
and resuspension ( 5  ), and egg pellets are fi nally resuspended in an equal volume 
of intracellular- like medium (GluIM). A Dounce homogenizer is used to break 
open the eggs ( 6  ), and the homogenate is spun briefl y in 2-ml uncapped tubes 
to pellet granules ( 7  ) before collecting the supernatant in an ice-chilled beaker 
( 8  ). Finally, the homogenate is dispensed as 500-μl aliquots in microfuge tubes 
and stored at −80 °C ( 9  )       
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10–15 ml of ASW. Swirl, and gently decant this straight into a 
second “empty” tube. Repeat for 5–10 consecutive tubes 
(depending upon the egg carry-over) and fi nally add these 
washes to the “pooled” beaker.   

   5.    Once all the eggs are collected, you can end up with at least 
1–2 l of egg suspension. Seal the beaker with Parafi lm and 
immerse in a chilled 17 °C water bath and allow the eggs to 
settle for ~45 min.    

        1.    Carefully aspirate/decant any clear supernatant from the 
pooled eggs.   

   2.    Eggs are mechanically dejellied by fi ltering through a mesh 
slightly smaller than the egg diameter. This “nicks” the egg 
jelly coat as they pass through. For  L. pictus  (120-μm eggs) we 
routinely use a 100-μm mesh ( see  Subheading  2.3 ). Filter units 
are pre-wetted with ASW and held by hand inside another 
large volume beaker. Approximately forty microliters of egg 
suspension are poured into the fi ltration unit at a time, and the 
dejellied eggs allowed to drain into the second beaker. Always 
keep the fi lter in superfi cial contact with the receiving suspen-
sion. In between fi ltrations, clogging of the mesh is countered 
by washing deionized water across the mesh (in both direc-
tions—do  not  collect these cleaning washes!). However, large 
volumes of suspension will ultimately block the fi lters which 
need to be replaced several times during the course of the day. 
Repeat steps until all the eggs are dejellied.   

   3.    Dejellied eggs are then washed twice to remove Ca 2+ . The dej-
ellied egg suspension is transferred into (and fi lls) multiple 
50-ml Falcon tubes and eggs pelleted by centrifugation at 
300 ×  g  for 1–2 min at 10 °C. We use a centrifuge with buckets 
that hold 16 tubes at a time. Decant (or aspirate) as much 
supernatant as possible (without losing eggs) and discard. The 
egg pellet should be compact but not too fi rm and no more 
than 15 ml per tube. Resuspend up to ~50-ml with EGTA- 
ASW (gentle inversion and fl icking of the tube bottom with 
the thumb may help). Centrifuge as before and remove super-
natant ( see   Note 6 ). Repeat steps above.   

   4.    Eggs are then washed twice to remove EGTA. Resuspend pel-
lets in ~40-ml Ca 2+ -free ASW. Centrifuge as before and remove 
supernatant. Repeat.   

   5.    Eggs are then washed twice in intracellular medium. Resuspend 
pellets in ~40-ml GluIM. Centrifuge as before and remove 
supernatant. Repeat. After the last spin, aspirate as much of 
the supernatant as possible.   

   6.    Estimate the volume of each pellet and add an equal volume of 
ice-cold Final GluIM to each tube just before homogenization 
(50 % v/v).   

3.2  Egg Preparation 
and Homogenization
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   7.    Resuspend the pellet in Final GluIM (≤ 10 ml) by gentle 
pipetting and swirling and transfer to a pre-chilled, tight- 
fi tting Dounce homogenizer.   

   8.    Use the  minimum  number of strokes to homogenize 
( see   Note 7 ).   

   9.    With a pipettor and a 10-ml tissue-culture pipette, rapidly ali-
quot the homogenate into 2-ml capless tubes and spin in a 
cooled microfuge (as brief as possible (<30 s), pulsing up to 
~13,000 ×  g  and then immediately stopping). This should only 
form a small pellet of dark granules (a few mm across); too 
vigorous a spin and you will form a large, orange pellet con-
taining the actual vesicles you want ( see   Note 8 ).   

   10.    Rapidly collect the supernatant by pouring it out and tapping 
the tube into a small plastic beaker kept on ice.   

   11.    Once all the homogenate has been collected, use a repeater 
pipette to rapidly dispense 500 μl aliquots in Eppendorf 
microfuge tubes which have been pre-placed in freezer storage 
racks/boxes.   

   12.    Cap and promptly store at −80 °C. Snap-freezing is not 
necessary.   

   13.    From 500 animals, a good homogenate preparation will yield 
300 aliquots; a poor one as few as 50. Stored at −80 °C, where 
they last for many years ( see   Note 9 ).      

     To measure Ca 2+  (or pH L ) changes, concentrated (50 %) egg 
homogenate is diluted  gradually  20-fold over ~3 h (to facilitate 
optimal Ca 2+  loading of the stores), fl uorescent dyes are added and 
fl uorescence changes monitored in a stirred cuvette in a standard 
fl uorimeter (summarized in Fig.  3 ).

     1.    On the day of the experiment, equilibrate 10 ml of GluIM 
( see   Note 10 ) in a 15-ml Falcon tube at 17 °C in a chilled 
water bath and when ready, thaw the following: a 500 μl aliquot 
of homogenate, one tube each of the ATP regenerating system 
components. All the steps below are carried out at 17 °C.   

   2.    Add 100 μl each of ATP, CPK, and PCr to the GluIM and mix 
(=GluIM+).   

   3.    In another 15-ml Falcon tube, carefully pipette the 500 μl of 
homogenate directly to the bottom of the tube and similarly 
add and mix 500 μl GluIM+. Incubate in the water bath for 
45–60 min.   

   4.    Add 1 ml GluIM+, incubate for 30 min.   
   5.    Add 2 ml GluIM+, incubate for 30 min.   
   6.    Add 3 ml GluIM+, incubate for 30 min.   
   7.    Add 3 ml GluIM+, incubate for 30 min.   
   8.    The 10 ml of 2.5 % (v/v) homogenate is now ready to use.   

3.3  Fluorimetry to 
Measure Ca 2+  Release
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  Fig. 3    Monitoring Ca 2+  and pH L  using fl uorimetry. ( a ) Homogenate is diluted 
20-fold (2.5 % v/v fi nal) over 3 h at 17 °C in a 15-ml tube. When measuring Ca 2+ , 
3 μM fl uo-3 is added to the 10 ml homogenate and 600 μl added to a semi-micro 
cuvette complete with a micro stir bar and placed in the chilled sample block of 
a fl uorescence spectrometer. Fluo-3 monitors Ca 2+  in the extravesicular (“cyto-
solic”) compartment. Drug additions are made in 0.6–6.0 μl aliquots. ( b ) Sample 
trace of Ca 2+  signals in response to addition of second messengers; note their 
homologous desensitization. To calibrate fl uorescence in terms of absolute 
[Ca 2+ ], the minimum and maximum fl uorescence ( F  min  and  F  max ) are determined 
at the end of the run by addition of 0.5 mM EGTA and 10 mM CaCl 2  respectively 
(note the break in the trace after Ca 2+  addition). RFU = relative fl uorescence unit. 
( c ) To monitor pH L  changes within acidic vesicles, fl uo-3 is omitted and either 
1–10 μM acridine orange or a Lysosensor is added to the cuvette 5–10 min 
before recording. Sample trace of acidic vesicle alkalinization in response to 
NAADP and 10 mM NH 4 Cl       
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   9.    For Ca 2+  measurements, 10 μl of fl uo-3 (3 μM fi nal) is added 
to the entire 10 ml of homogenate.   

   10.    We use an LS-50B Perkin Elmer fl uorescence spectrometer 
whose cuvette holder is water-cooled to 17 °C (fed from the 
same water bath for the homogenate dilution) and which con-
trols a magnetic stir bar ( see   Note 11 ).   

   11.    Place a micro-fl ea in the bottom of a semi-micro cuvette ( see  
 Note 12 ), add 600 μl of homogenate (or a suitable volume for 
the light path) and place in the cuvette holder.   

   12.    Fluo-3 is excited at 506 ± 3 nm (526 ± 2 nm emission) and 
fl uorescence recorded ≥1 Hz.   

   13.    Generally, compounds are added in 6 μl volumes (from 100× 
stocks). However, to minimize the concentration of solvents 
(e.g., DMSO or ethanol), 1,000× stocks are prepared for 
0.6 μl additions. In either case, add to the bottom of the 
cuvette to ensure effi cient mixing by the fl ea.   

   14.    Fluo-3 fl uorescence can be calibrated in terms of absolute 
Ca 2+  concentration using the following equation: 
[Ca 2+ ] =  K  d  × ( F  −  F  min )/( F  max  −  F ), where [Ca 2+ ] is in the same 
units as the  K  d  of fl uo-3 (e.g., 0.4 μM or 400 nM),  F  is the 
fl uorescence at any time,  F  min  and  F  max  are the fl uorescence in 
the “absence” of Ca 2+  and presence of saturating Ca 2+ , respec-
tively ( see   Note 13 ).   

   15.    At the end of each run,  F  min  and  F  max  are empirically deter-
mined by the sequential addition of 500 μM EGTA and 
10 mM Ca 2+ , respectively (6 μl of 50 mM EGTA; 6 μl of 1 M 
CaCl 2 ).  See  Fig.  3 .   

   16.    Plate-readers can be excellent for high-throughput screening. 
With sea urchin egg homogenates, however, there are some 
additional considerations. For example, maintaining 17 °C is 
diffi cult (or impossible) for many models. With manual drug 
additions, temporal resolution is often inferior to the cuvette 
system due to delays between addition and recording as well 
as a lower sampling frequency throughout the experiment. 
The former can be reduced with multichannel pipettes. 
Mixing can be problematic. Each well of a 384-well plate 
holds 50 μl of homogenate. Adding 0.5 μl of sample requires 
physical “stirring” with the pipette tip. We also purchase low 
retention volume pipette tips to increase accuracy when using 
such small volumes.    

    When NAADP evokes Ca 2+  release from acidic Ca 2+  stores the pH L  
of these target vesicles increases [ 2 ,  4 ,  5 ]. Indeed, the pH L  of acidic 
vesicles is regulated by NAADP and fertilization (in intact eggs) in 
overlapping ways which underscores its physiological importance 
[ 2 ,  5 ,  6 ].

3.4  pH L  of Acidic 
Ca 2+  Stores
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    1.    The best signal for pH L  monitoring is achieved with acridine 
orange although Lysosensor family members can also be used 
[ 2 ,  4 ,  6 ] ( see   Note 14 ).   

   2.    Dilute and prepare homogenate as above (Subheading  3.3 , 
 steps 1 – 8 ).   

   3.    To a fl ea and 600 μl of homogenate in a cuvette, 0.6 μl of 
acridine orange is added (1–10 μM fi nal) and fl uorescence 
monitored at the same wavelengths as for fl uo-3,although 
probably with narrower slit widths since acridine orange is 
brighter than fl uo-3.   

   4.    As the acridine orange accumulates into the acidic vesicle 
lumen, it self-quenches and the fl uorescence falls. This takes 
about 5–10 min.   

   5.    Once a stable plateau is reached, test compounds can be 
added. Note that the dynamic range of acridine orange is less 
than that of fl uo-3. The acridine orange fl uorescence is pro-
portional to the pH L  (an increase in fl uorescence refl ects an 
increase in pH L ) although non-linearly.   

   6.    Calibration in terms of absolute pH L  is diffi cult and so relative 
changes are recorded. We frequently normalize the fl uorescence 
changes to that observed at the end of the run with a maximal 
concentration of NH 4 Cl (10 mM; 6 μl of 1 M stock) [ 7 ].    

    Although there are multiple methods to assay cADPR and NAADP 
concentration or ADP-ribosyl cyclase (ARC) activity [ 8 ], a simple 
yet sensitive method utilizes egg homogenate and Ca 2+  release as a 
“bioassay” for messenger synthesis [ 8 ]. In the fi rst mode, second 
messengers are generated in other cells (intact or broken), 
extracted, and assayed for Ca 2+  release activity. In the second mode, 
ARC activity in the egg homogenate itself can be monitored as the 
conversion of substrate, β-NAD + , into product cADPR (and Ca 2+  
release) [ 9 ]; we routinely use the latter to screen compounds 
against ARC activity [ 10 ].

    1.    Egg homogenate is prepared as above and Ca 2+  measured with 
fl uo-3 (Subheading  3.3 ,  steps 1 – 9 ).   

   2.    Cytosolic, de-proteinated extracts from other cells should be 
pH-neutral before addition to egg homogenate. Neutralization 
of acid extracts is best effected with bicarbonate (rather than 
hydroxide) which has a broader equivalence point and reduces 
the likelihood of overshooting the pH (note: NAADP is 
hydrolyzed at alkaline pH);  see  [ 11 ] for details.   

   3.    6–60 μl of extract is added to homogenate in a fl uorimeter and 
Ca 2+  release measured ( see   Note 15 ).   

   4.    Which messenger(s) is present in the extract should be 
 confi rmed by blockers added to the cuvette several minutes 

3.5  Discontinuous 
Bioassay of Secondary 
Messenger Production
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 before  the extract [ 8 ]: IP 3  is blocked by 1 mg/ml heparin 
( see   Note 16 ), cADPR by 30 μM 8-Br-cADPR, and NAADP 
by a self- inactivating concentration of NAADP (5–10 nM) 
[ 3 ]. Always verify that the inhibitors are active (and appropri-
ately selective) against maximal concentrations of  bona fi de  
messengers.   

   5.    Once identifi ed, the absolute amount of messenger produced 
can be calibrated by comparison with a detailed (half-log) con-
centration–response curve to pure, commercial messenger. 
Approximate EC 50  in egg homogenate: 0.2 μM (IP 3 ), 40 nM 
(cADPR), 30 nM (NAADP).   

   6.    In the case of cADPR, assay sensitivity can be further improved 
by adding 2 mM caffeine 1 min before the extract/messenger: 
this sensitizes the target ryanodine receptor and decreases the 
cADPR EC 50  fourfold (to 10 nM) [ 8 ].    

        1.    Egg homogenate is prepared as above and Ca 2+  measured with 
fl uo-3 (Subheading  3.3 ,  steps 1 – 9 ).   

   2.    The reaction is initiated by addition of 50–150 μM β-NAD +  to 
the cuvette ( see   Note 17 ). There should be a signifi cant delay 
before Ca 2+  begins to rise (representing the time taken to gen-
erate cADPR product)—an immediate rise with β-NAD +  sug-
gests contamination by Ca 2+  or product.   

   3.    The requirement for ARC activity can be confi rmed by its 
inhibition with 5 mM nicotinamide [ 9 ].   

   4.    The rate and amplitude of Ca 2+  release is an index of ARC 
activity.       

4    Notes 

     1.    The presence of the sugar derivatives greatly reduces the 
GluIM storage time due to bacterial/fungal growth, even at 
4 °C (≤2 months). This period can be extended by sterile 
(0.22 μm) fi ltering or storage at −20 °C (≤6 months).   

   2.    The fi nal GluIM will be diluted 1:1 with eggs. Therefore, sup-
plement with the ATP system and protease inhibitors at twice 
their fi nal concentration, i.e., 2 mM ATP, 20 U/ml creatine 
phosphokinase, 20 mM phosphocreatine, 2 protease tablets 
per 50-ml GluIM.   

   3.    For smaller scale preparations, we make the units from 15-ml 
Falcon tubes.   

   4.    Each sea urchin species has its own characteristic egg diameter 
( L. pictus  120 μm,  S. purpuratus  80 μm,  P. californicus  
200 μm), and therefore, the mesh pore size will have to be 
changed accordingly.   

3.6  Measuring 
ADP-Ribosyl Cyclase 
Activity
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   5.    Healthy eggs are a vibrant yellow-orange and sink in broken 
strands; unhealthy eggs appear dull-colored and/or settle as 
unbroken elongated, “spaghetti” (presumably due to egg lysis 
releasing sticky DNA).   

   6.    Egg lysis can occur when placed into Ca 2+ -free media, and this 
is manifested as cloudy supernatants. This is greatest with poor 
quality (or handling) of eggs and can lead to a substantial loss 
(≤50 %) of the cells in the worst instances.   

   7.    Successful homogenization is heralded by a marked increase in 
the resistance to a Dounce stroke (presumably when intracel-
lular DNA is released). Only give 1–2 more strokes and avoid 
over-homogenization. If unsure, check a drop of homogenate 
on a petri dish on a light microscope—there should be no, or 
very, few intact eggs remaining.   

   8.    Historically, this fi nal spin was designed to remove cortical 
granules since they contain damaging proteases. However, 
quite a lot of precious homogenate is wasted in the process. 
Therefore, we recently omitted this step and observed no 
obvious change in the Ca 2+  response to the three second mes-
sengers. We do not yet know whether the long term storage of 
this homogenate batch will be compromised.   

   9.    Occasionally you come across a rogue aliquot that does not 
pump Ca 2+  down after thawing (<1 % of all tubes). We do not 
know why this occurs; perhaps it is due to different freezing 
times compromising vesicular integrity.   

   10.    In our hands, GluIM can often be contaminated with an 
unknown substance that inhibits NAADP-dependent Ca 2+  
release. We have found that pretreating GluIM with activated 
charcoal removes this factor [ 3 ]: stir 50–100 ml GluIM with 
10 mg/ml charcoal for 60 min at room temperature; to remove 
the charcoal, centrifuge at ~3,000 ×  g  for 5 min, carefully pour 
off and collect the supernatant and fi nally fi lter with a 0.2 μm 
fi lter unit attached to a 50-ml syringe. Store in plastic.   

   11.    Stirring is essential for two reasons: to prevent the homoge-
nate settling and to ensure rapid mixing of additions particu-
larly with non-aqueous solvents such as DMSO. Individual 
micro fl eas differ greatly in their effi ciency of mixing; some 
merely “vibrate” and do little; good fl eas spin around. Each 
fl ea should be examined by eye in an empty cuvette and non- 
spinners discarded.   

   12.    Ensure that the semi-micro cuvettes are suitable for fl uorime-
try. They should transmit at all wavelengths required and they 
must not be “frosted” on any face.   

   13.    Ca 2+  calibration is recommended and is essential when com-
paring signals across different machines; their absolute fl uores-
cence changes will not be the same.   
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   14.    With pH L  reporters, chronic loading of the entire homogenate 
in one fell swoop must be avoided since these compounds 
continue to partition into acidic vesicles and will eventually 
alkalinize them [ 12 ]. Instead, acute addition to each cuvette is 
recommended.   

   15.    The volume of extract required will be determined by how 
much messenger is present. The smaller the volume, the 
better.   

   16.    Some heparin preparations can be contaminated with Ca 2+  and 
addition evokes a large Ca 2+  spike. Allow this Ca 2+  to be re- 
sequestered by the homogenate before addition of IP 3  or 
extracts.   

   17.    Different batches of homogenate convert β-NAD +  to cADPR 
with different effi ciencies. It is more reassuring to see a slight 
lag before Ca 2+  rises in keeping with the conversion time, so 
determine the optimal β-NAD +  concentration for each batch.         
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    Chapter 11   

 Microinjection and 4D Fluorescence Imaging in the Eggs 
and Embryos of the Ascidian  Phallusia mammillata  

           Alex     McDougall     ,     Karen     Wing-man     Lee    , and     Remi     Dumollard   

    Abstract 

   Time-lapse 4D imaging of fl uorescently tagged proteins to follow the dynamics of cellular structures 
(chromosomes, microtubules, actin, centrosomes, cortical structures like the CAB in ascidians, etc.) com-
bined with targeted gene knockdown during embryonic development is a powerful technique to under-
stand the mechanisms of embryonic development. The eggs and embryos of the primitive marine chordate 
 Phallusia mammillata  are an excellent model system for combining live cell imaging with gene knock-
down experiments. Here we describe simple methods for microinjecting  Phallusia  eggs with mRNA 
encoding fl uorescent fusion proteins combined with 4D time-lapse imaging techniques we use to follow 
all of embryonic development from the egg to late tailbud stage.  

  Key words     Ascidian  ,    Phallusia mammillata   ,   4D imaging  ,   Fluorescent fusion proteins  , 
  Gene  knockdown  ,   Microinjection  

1      Introduction 

 A systems-level approach using in toto imaging of all cells  during 
embryonic development is a major goal of imaging studies aimed at 
deciphering how different cell behaviours are generated during 
embryonic development [ 1 ]. Control of cell division orientation 
plays a major role in early embryo body plan specifi cation [ 2 ]. This 
is typifi ed by simple marine chordate embryos such as ascidians 
where both the cell division orientation and cell cycle duration are 
precisely controlled [ 3 ]. Cell division axis reorientation is most dra-
matic in two posterior vegetal cells at the 8-, 16-, and 32-cell stages. 
In these cells the mitotic spindle is attracted towards a cortical 
structure, causing the cell to divide in a precise orientation while 
also cleaving unequally to generate daughter cells of different sizes 
[ 4 ]. Although these cells are the most studied examples of unequal 
cleavage in ascidian embryos, many other cells divide unequally. 
Cell cycle duration is also precisely controlled in ascidian embryos. 
For example, at the 16-cell stage cycle duration is shorter in the 
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8 vegetal blastomeres generating a brief 24-cell stage. Further 
 asynchrony in the vegetal blastomeres yields an embryo at the time 
of gastrulation composed of precisely 112 cells [ 5 ]. Importantly, 
each blastomere in the gastrula has a distinctive size, shape, and 
position relative to its neighbors. One of our goals is to decipher the 
mechanisms regulating unequal cleavage, oriented cell division and 
cell cycle duration which together create the distinctive morphol-
ogy of the 112 cell gastrula-stage embryo, and for this we use live 
cell imaging of fl uorescently tagged proteins coupled with gene 
knockdown in the ascidian  Phallusia mammillata . 

 Ascidians embryos have been used for more than a century to 
study embryonic development. Their embryos display the typical 
chordate body plan but are composed of an extremely small number 
of cells. Gastrulation occurs about 3–4 h after fertilization at the 112-
cell stage, and a simple chordate type larva (tadpole) forms approx. 
12 h after fertilization composed of only about 2,600 cells [ 3 ].  Ciona 
intestinalis  was the fi rst ascidian to have its genome sequenced [ 6 ] and 
has provided an exceptional wealth of information concerning gene 
expression patterns during development. Excellent Web-based 
resources exist housing genomic and transcriptomic data sets: [ 7 ] 
Aniseed (  http://aniseed-ibdm.univ-mrs.fr/    ), [ 8 ] GHOST (  http://
hoya.zool.kyoto-u.ac.jp/SearchGenomekh.html#CDNA    ) as well as 
proteomic data CIPRO [ 9 ] (  http://cipro.ibio.jp/2.5/    ) and a 3D 
atlas of embryonic stages FABA [ 10 ] (  http://chordate.bpni.bio.keio.
ac.jp/faba/1.3/top.html    ). Some ascidian species like  Phallusia mam-
millata  are ideal for imaging studies (see fi lm archive at   http:// biodev.
obs- vlfr.fr/recherche/biomarcell/    ), not only because their eggs and 
embryos are completely transparent [ 11 ], but also because their unfer-
tilized eggs translate well exogenous mRNA, which is not the case for 
 Ciona intestinalis  [ 12 ]. This is important since eggs and many early 
cleavage stage embryos including ascidians are transcriptionally inac-
tive. Until transgenic lines that express in the egg become available 
(transgenic tadpole and juvenile lines of  Ciona intestinalis  are avail-
able. See:   http://marinebio.nbrp.jp/ciona/imageListAction.do?strai
nType=All&stage=ALL    ), a simple means of introducing molecular 
markers into the egg is required. Since protein production is time-
consuming, mRNA injection is the simplest method for producing 
fl uorescent fusion protein constructs in unfertilized ascidian eggs. The 
recent availability of extensive EST databases for  Phallusia  (currently 
120,000 ESTs from mixed embryonic stages) has made it possible to 
obtain the nucleotide sequence around the fi rst ATG, making it 
straightforward to design morpholino oligonucleotides to perform 
gene knockdown experiments. We have recently exploited this in  P. 
mammillata  to perform the fi rst 4D fl uorescence confocal imaging 
study coupled to morpholino knockdown during early cleavage cycles 
in  P. mammillata  [ 12 ]. Here we describe in detail the procedures for 
microinjecting mRNA into  P. mammillata  eggs and for performing 
4D fl uorescence imaging of embryos expressing fl uorescently tagged 
proteins.  
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2    Materials 

       1.    mRNA: mix at around 2 μg/μl in distilled water and store in 
1 μl aliquots at −80 °C. We use mMessage mMachine and fol-
low the manufacturer’s protocol which we do not detail here 
(Ambion). It is important to note that the only mRNA that 
translates well has a poly A tail ( see   Note 1 ).   

   2.    1 % GF: in a 50 ml Falcon add 0.5 g Gelatin (Sigma Type A 
from porcine skin) to 40 ml distilled water and heat in a water 
bath at 60 °C for 10 min to dissolve. Once the gelatin has dis-
solved, leave it to cool and then add 1.35 ml of 37 % 
Formaldehyde and bring the total volume to 50 ml by  adding 
more distilled water. We call this stock solution 1 % GF ( see  
 Note 2 ).   

   3.    0.1 % GF: dilute the 1 % GF with distilled water to make a 
0.1 % GF solution. Coat plasticware, coverslips, and slides on 
one side with 0.1 % GF and leave to air-dry. Briefl y, add enough 
0.1 % solution to each petri dish to coat the bottom or apply 
40 μl 0.1 % GF to one side of a coverslip and spread with a 
pipette tip then stand to air-dry. Once dry, wash all coated 
surfaces with distilled water and leave to air-dry before 
storing.   

   4.    VaLaB: mix 1:1:1 Vaseline, lanolin, and beeswax. We use this 
to prepare the mounting chamber or “Wedge” for microinjec-
tion ( see  Fig.  1 ) ( see   Note 3 ).

       5.    To prepare the mounting chamber. The mounting chamber is 
based on the design of Kiehart [ 13 ]. First use one GF-coated 
glass coverslip and one uncoated coverslip. Cut the GF-coated 
coverslip into small pieces using a diamond knife (approx. 
10 mm by 3 mm) and cut larger pieces of glass from the non- 
coated coverslip (approx. 15 mm by 4 mm) which we term 
“spacers.” Cut about ten pieces of each and store as GF and 
Spacers ( see  Fig.  1 ).   

   6.    Sea water: prepare 500 mM TAPS pH buffer (pH 8.2) and 
100 mM EDTA (pH 8.0) both in distilled water. Filter natural 
seawater through 0.2 μm fi lter to remove bacteria and debris. 
Add 5 ml of 500 mM TAPS and 0.5 ml of 100 mM EDTA to 
500 ml fi ltered sea water and pH to 8.2 with NaOH and HCl. 
Store sea water at 16 °C ( see   Note 4 ).   

   7.    1 % Trypsin solution (bovine pancreas): mix in TAPS-buffered 
fi ltered sea water and store as 1 ml aliquots at −20 °C.   

   8.    Cut capillary free microinjection needles (GC100T10) into 
8 mm long pieces and keep for later use as “fi lling tubes” for 
mRNA microinjection ( see  Fig.  1 ).       

2.1  Solutions, 
Plasticware, and 
Glassware for 
Microinjection

Microinjection and 4D Fluorescence Imaging



  Fig. 1    Microinjection of  Phallusia  eggs. ( a ) Coat one side of coverslip with 0.1 % gelatin/formaldehyde 
 (formaldehyde cross-links the gelatin). ( b ) Cut pieces with diamond knife (approx. 10 mm by 4 mm). ( c ) Heat 
on hot plate until VaLaB melts. ( d ) Remove from heat and once VaLaB is set, remove spacer. ( e ) Mounting cham-
ber with wedge and fi lling tube attached. Model showing mounting chamber and fi lling tube. Wedge  containing 
eggs fi xed to mounting chamber with Dow Corning vacuum grease. ( f ) Mounting chamber on microscope stage. 
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3    Methods 

      1.    Remove a tube of 1 ml 1 % Trypsin to defrost ( see   Note 5 ).   
   2.    Prepare eggs. Cut through the hard protective tunic (com-

posed of a type of cellulose) of the ascidian making a cut from 
the oral siphon to the atrial siphon with a razor blade or scis-
sors. Use thumbs to pry open the tunic and remove the soft-
bodied ascidian. Lay animal so that eggs and sperm are facing 
up on a paper towel to absorb water. Remove eggs fi rst by 
puncturing oviduct with needle then aspirate the eggs with a 
1 ml disposable plastic pipette and add directly to 4.5 ml fresh 
fi ltered sea water in a 5 cm petri dish. Next collect the sperm in 
a similar manner but store the sperm “dry” in a 1.5 ml 
Eppendorf ( see   Note 6 ).   

   3.    Dechorionation (removal of the outer layer of the egg by tryp-
sin treatment). Add 1 ml 1 % trypsin solution to the 4.5 ml 
eggs and agitate on an orbital shaker for 1 h 30 min at 20 °C 
(or until approx. 10 % of the eggs begin to lose their outer 
layer) to dechorionate the eggs.   

   4.    Once approx. 10 % of the eggs begin to dechorionate gently 
pipette approx. ten times without making air bubbles to decho-
rionate the remaining eggs.   

   5.    Wash eggs to remove trypsin, chorionated eggs and dead eggs. 
Gently swirl in a circular motion to collect dechorionated eggs 
and remove the excess sea water. Add fresh TAPS fi ltered sea 
water and repeat four or fi ve times or until most of the dead or 
chorionated eggs are removed leaving only dechorionated 
eggs.   

   6.    Transfer the dechorionated eggs to a larger a fresh petri dish 
which has been GF-coated and store at 16 °C ( see   Note 7 ).   

   7.    With a mouth pipette or a handheld pipette transfer approx. 
50–100 eggs to an injection chamber or “wedge” ( see  Fig.  1 ).   

   8.    Proceed to microinjection of  Phallusia  eggs.      

3.1  Preparing 
Dechorionated Eggs

Fig. 1 (continued) The microinjection needle tip is fi rst broken on the side of the fi lling tube. The microinjection 
needle is then tip-fi lled using negative pressure (be sure to use fi lament-free capillaries (e.g., GC100 T-10)). 
Keep the meniscus in view to check balance. Inject egg at around 10–20 psi. ( g ) Microinjection of eggs in the 
wedge. The strip of VaLaB is to the left and the opening of the wedge is to the  right  as in ( f ). The microinjection 
needle is inserted into the egg so that the tip is near the center (the far side of the egg is also fi ne but inserting 
the tip at the near side kills the egg more readily). The egg is injected near the center or even near the opposite 
side of the egg an in this example. Displacement of the egg cytoplasm reveals the site of microinjection 
( arrow  ). Typically for mRNA injections 1–3 % egg volume is injected. The microinjection needle is then removed 
from the egg       

Microinjection and 4D Fluorescence Imaging



180

      1.    We use an inverted Olympus IX70 with left mounted stage 
control, right-hand mounted three-way Narishige hydraulic 
micromanipulator, and an air compressor providing the com-
pressed air for a Narishige IM300 injection box.   

   2.    Our microinjection method is as described previously with 
some small modifi cations [ 13 ]. The mounting chamber is 
made of Perspex ( see  Fig.  1 ). Briefl y, the injection chamber is 
73 mm long, 25 mm wide and 4 mm thick. The central reser-
voir is 1 mm thick and has a 15 mm by 15 mm piece removed 
that will make a reservoir for approx. 400 μl of seawater once 
the coverslips are attached ( see  Fig.  1 ).   

   3.    Prepare the wedge fi rst as shown in Fig.  1  (verify that GF-coated 
glass surfaces are pointed towards each other).   

   4.    Dow Corning vacuum grease is applied to both sides of the 
injection chamber where the coverslips will later be attached.   

   5.    The coverslip with the wedge is attached fi rst to the fl at side of 
the mounting chamber with the “wedge” facing what will be 
the seawater reservoir ( see  Fig.  1 ).   

   6.    Next using a binocular microscope 50–100 eggs are trans-
ferred into the wedge by mouth pipette (capillary action pulls 
the seawater and eggs into the wedge so long as a small enough 
volume is applied).   

   7.    Then a coverslip is applied to the other side to make a sand-
wich with the wedge and eggs in the center ( see  Fig.  1 ).   

   8.    Next the reservoir between both coverslips is fi lled up with 
TAPS fi ltered sea water carefully so as not to dislodge the eggs.   

   9.    Then place the mounting chamber into a large enough petri 
dish on two pads of water-soaked tissue paper to create a humid 
environment so that the 400 μl reservoir does not evaporate 
and store at 16 °C until required.   

   10.    Once the eggs have been prepared for microinjection, prepare 
the mRNA Filling tube. Pipette 1 μl RNAase free mineral oil 
into a “Filling Tube” prepared previously (    step 8  of 
Subheading  2.1 ). Then pipette 1 μl RNA into the same Filling 
tube then pipette a further 1 μl oil making an oil-mRNA-oil 
sandwich. Attach this to the underside of the injection cham-
ber with a little VaLaB ( see  Fig.  1 ).  Note ,  we keep these Filling 
tubes with mRNA in them for up to about 6 weeks at 4 °C and 
can reuse the same 1 μl of mRNA several times over that 6 week 
duration.    

   11.    Place the mounting chamber with eggs and wedge onto the 
stage and advance the microinjection needle towards the injec-
tion chamber ( see  Fig.  1 ). We use fi lament-free glass needles to 
prepare the microinjection needles (pulled from GC100T10 
pipettes) using a Narishige PN-30 horizontal puller.   

3.2  Microinjecting 
 Phallusia  Eggs

Alex McDougall et al.
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   12.    First break the tip of the needle against the Filling tube then 
suck up some mRNA from the Filling tube into the injection 
pipette using negative pressure. (We inject using the 10× 
objective and suck up enough mRNA to fi ll the fi eld of view, 
keeping the meniscus in view at all times.)   

   13.    Set the balance on the IM300 so that the meniscus is stable.   
   14.    Advance the microinjection needle towards the egg ( see  Fig.  1 ).   
   15.    Insert the needle into the center of an egg and apply a brief 

10 ms pulse of negative pressure to break the plasma mem-
brane. Then inject the mRNA into the center of the egg 
( see  Fig.  1 ).   

   16.    Remove the injection needle slowly until it is almost out of the 
egg and then remove it very rapidly to avoid killing the egg 
(we use the left-hand stage control for the fast removal).   

   17.    Push those injected eggs out the edge of the wedge using the 
microinjection needle. Once suffi cient eggs have been injected 
collect them with a mouth or handheld suction pipette and 
transfer to a GF-coated petri dish containing TAPS fi ltered sea-
water and store at 16 °C until required (we sometimes keep 
injected eggs overnight but not for longer).      

      1.    For imaging events in the egg such as meiotic spindle behavior 
leave mRNA-microinjected eggs overnight to accumulate suf-
fi cient fl uorescent fusion protein. If monitoring fl uorescence 
from the 16-cell stage onwards, eggs can be fertilized 2–3 h 
after microinjection, and there will be fl uorescent fusion pro-
tein the embryo at the 8–16-cell stage ( see  Fig.  2 ).

       2.    To fertilize eggs sperm are fi rst activated. Add 2–4 μl “dry” 
sperm to 500 μl pH 9.5 sea water and agitate for 20 min ( see  
 Note 8 ) then add approx. 10 μl of this mixture near some eggs 
in a petri dish containing about 5 ml TAPS fi ltered sea water.   

   3.    Once eggs have fertilized wash them with fresh sea water to 
dilute out remaining sperm to avoid polyspermy.   

   4.    Mount the eggs or embryos for 4D fl uorescence imaging 
between GF-coated slide and coverslip sealed with Dow 
Corning vacuum grease making an airtight chamber. Be care-
ful not to compress the embryos.   

   5.    We use either an objective mounted Piezo or an x, y, z stage to 
perform 4D fl uorescence imaging.   

   6.    A typical low light level imaging protocol using a 75 W Xenon 
lamp and a fi lter wheel would consist of ten z steps approx. rang-
ing from 1 μm spacing to 10 μm spacing depending on what we 
want to monitor, 200 ms exposure at each fl uorescence wave-
length and 20 ms bright fi eld every 1–2 min. We typically use a 
2 × 2 bin with our cooled CCD camera which has 6.7 μm square 
pixels ( see   Note 9 ). For longer duration  experiments (up to 15 h 

3.3  4D Imaging

Microinjection and 4D Fluorescence Imaging
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of embryonic development), this protocol works well ( see  
Fig.  2 ). However, in order to improve the image quality, we also 
perform 4D confocal microscopy, but here we can image for 
approx. 90 min with a similar protocol before embryonic devel-
opment is adversely affected ( see  Fig.  2 ).   

  Fig. 2    Fluorescence imaging in  Phallusia  embryos. ( a ) Confocal images of  Phallusia  embryo at the 16–44-cell 
stage. These embryos are bilaterally symmetrical. This offers the possibility of performing an internal control 
for embryo quality by injecting only one of the two blastomeres at the 2-cell stage (as has been performed 
here). mRNA encoding MAP7::EGFP was injected at the 2-cell stage into the right-hand blastomere. The 
plasma membrane was then labeled at the 16-cell stage with the red lipophilic dye FM4-64. Confocal micros-
copy was performed with a Leica SP5. Ten z sections were collected over a 60 min period during which time 
the germ lineage precursor blastomeres (B5.2) at the 16-cell stage divided unequally a further two times 
resulting in two small posterior vegetal cells (B7.6). ( b ) Epifl uorescence images taken from a 4D data set of a 
 Phallusia  embryo that was previously microinjected with a mixture of three different mRNAs (encoding PH::GFP 
to label the plasma membrane, MAP7::EGFP to label microtubules and    HH2B::Rfp1 to label the chromosomes). 
Three images from the 76 cell, neurula, and late tailbud stages are shown. For each time point the bright-fi eld 
image and two fl uorescence images are shown together with the overlay of all 3. Note that the embryo forms 
normally indicating that neither the exogenous mRNA nor the 4D fl uorescence imaging protocol hindered 
development to the late tailbud stage ( bottom right-hand  image shows the late tailbud stage II following more 
than 10 h of imaging (ten z sections every 2 min)). P is posterior and A anterior       
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   7.    In both examples shown in Fig.  2  one blastomere at the 2-cell 
stage was injected. Ascidian embryos display bilateral symme-
try (the fi rst cleavage creates one left-hand and one right-hand 
blastomere that will form the left- and right-hand sides of the 
embryo). Microinjection of mRNA encoding fl uorescent 
fusion proteins into one blastomere at the 2-cell stage there-
fore allows us to compare development in the injected and 
non-injected halves of the embryo ( see  Fig.  2 ). A typical 4D 
confocal imaging experiment can be seen in Fig.  2a . An exam-
ple of a 4D low-light level imaging experiment can be seen in 
Fig.  2b —this embryo was imaged from the 76-cell stage to the 
late tailbud stage II [ 9 ] without development being adversely 
affected.       

4    Notes 

     1.    To make mRNA we use mainly pSPE3 but also sometimes a 
modifi ed pRN3 to make C ter. PH::GFP fusion constructs. 
One important point is that the mRNA has a 3′poly A tail of 
30 or more adenines. For example, mRNA prepared from 
other vectors such as pCS2 only becomes translated effi -
ciently when we polyadenylate the mRNA product before 
microinjection.   

   2.    0.1 % GF prevents the dechorionated egg from sticking to the 
glassware or plasticware. The formaldehyde cross-links the gel-
atin creating a thin layer (approx. 1 μm thick) on the  coverslip/
plastic. For microscopy this is convenient since it does not 
increase appreciably the thickness of the coverslip and is com-
pletely transparent. 1 % GF is stored at room temp.   

   3.    Heat the VaLaB mixture on a hotplate until it melts then mix 
and cool to solidify. VaLaB can be kept for years.   

   4.    EDTA is used to remove potential contaminating heavy met-
als. This improves embryonic development.   

   5.    Be sure to use a form of trypsin that is not inactivated by cal-
cium—which is 10 mM in sea water. The most common prob-
lem for poor dechorionation is that the pH drifts. If 
dechorionation is poor try adding more TAPS pH buffer dur-
ing the dechorionation reaction.   

   6.    Take a look at the dechorionated eggs with a binocular micro-
scope. If there are more than 20 % dead eggs (dead eggs appear 
opaque) discard and use another animal.   

   7.    The dechorionated eggs should be smooth in appearance. 
If the eggs have been left too long in the trypsin solution they 
will form cytasters (the eggs take on a golf ball texture). Eggs 
like these should be discarded.   

Microinjection and 4D Fluorescence Imaging
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   8.    Change the pH with NaOH, not KOH which is spermicidal.   
   9.    Apparent pixel size is an important consideration. For ideal 

imaging pixel size should not limit the objective resolution and 
one should strive for pixels that are two or even three times 
smaller than the objective resolution. However, when embryo 
viability takes precedence over resolution this means limiting 
light exposure. Having maximized light capture by using your 
best objective lens (the 40×/1.3 NA oil obj. gives the brightest 
images of all standard objectives) and a good quality sensitive 
back-illuminated cooled CCD camera, if embryo viability is 
still compromised then pixel binning is an option. A 2 × 2 bin 
increases the light per pixel by a factor of 4 and a 3 × 3 bin by a 
factor of 9 and so on. However, binning also increases the 
apparent pixel size, thus limiting resolution. We fi nd that a 
good compromise between objective resolution and apparent 
pixel size is a 2 × 2 bin. With 6.7 μm pixels the apparent pixel 
sizes with the different objectives (20×/40×/60×) and bin-
ning protocols are as follows: 

 Objective lens 

 Fluorescence 
resolution (0.61  λ /na 
when  λ  is 500 nm) 
(nm) 

 Apparent pixel size (6.7 μm/
obj. mag) (nm) 

 1 × 1 bin  2 × 2 bin  3 × 3 bin 

 20×/0.75 na  407  335  670  1,005 

 40×/0.90 na  339  167  334  502 

 40×/1.3 na  235  167  334  502 

 60×/1.20 na  254  112  224  335 
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    Chapter 12   

 Isolating Specifi c Embryonic Cells of the Sea Urchin 
by FACS 

           Celina     Juliano    ,     S.     Zachary     Swartz    , and     Gary     Wessel    

    Abstract 

   Isolating cells based on specifi c gene expression enables a focused biochemical and molecular analysis. 
While cultured cells and hematopoietic cells, for example, are routinely isolated by fl uorescence activated 
cell sorting (FACS), early embryonic cells are a relatively untapped source for FACS applications often 
because the embryos of many animals are quite limiting. Furthermore, many applications require genetic 
model organisms in which cells can be labeled by fl uorescent transgenes, or antibodies against cell surface 
antigens. Here we defi ne conditions in the sea urchin embryo for isolation of embryonic cells based on 
expression of specifi c proteins. We use the sea urchin embryo for which a nearly unlimited supply of 
embryonic cells is available and demonstrate the conditions for separation of the embryo into single cells, 
fi xation of the cells for antibody penetration into the cells, and conditions for FACS of a rare cell type in 
the embryo. This protocol may be adapted for analysis of mRNA, chromatin, protein, or carbohydrates 
and depends only on the probe availability for the cell of interest. We anticipate that this protocol will be 
broadly applicable to embryos of other species.  

  Key words     Sea urchin  ,   FACS  ,   Embryonic cells  ,   Antibody  ,   Vasa  

1      Introduction 

 Lineage-specifi c gene expression is a major theme of developmental 
biology. However, the dynamics of differential gene expression 
may be obscured by experimentation in which the whole embryo 
is tested. Techniques that fractionate the embryo into its constitu-
ent lineages are therefore desirable for performing focused analy-
ses. In the sea urchin embryo, protocols are available for isolating 
several cell types. For example, micromeres, the skeletogenic cells 
produced at the fourth embryonic cleavage, can be collected en 
masse by sucrose gradients due to their small size relative to other 
blastomeres [ 1 ,  2 ]. McClay and colleagues devised a procedure for 
separating the ectoderm from the endoderm based on differential 
adhesion, which was then adopted for applications of cell adhesion 
studies and mRNA comparisons [ 3 – 5 ]. Primary mesenchyme cells, 
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the derivatives of micromeres could also be isolated by differential 
affi nity to lectins which enabled their isolation en masse following 
ingression into the blastocoel [ 6 ]. However, all of these methods 
target a limited number of cell types at particular developmental 
time points. 

 Fluorescence activated cell sorting (FACS) affords great fl exi-
bility in isolating cells of interest. Traditional FACS uses antibodies 
against cell surface proteins to label specifi c live cells for isolation 
from a suspension, and more recently, of fl uorescent protein label-
ing of cells by genetic means. Such approaches yield viable popula-
tions of isolated cells; however, they require antibodies against 
surface antigens or a model organism in which genetic manipula-
tion is possible [ 7 ,  8 ]. Alternatively, cells may be fi xed, permeabi-
lized, and labeled with antibodies against cytoplasmic antigens 
(Juliano and Swartz, unpublished observations). However, this 
approach has typically precluded further downstream analysis of 
the cell isolates, such as gene expression profi ling. 

 We present a method that combines the fl exibility of FACS 
using antibodies to antigens inside of cells with fi xation conditions 
that allow downstream extraction of RNA for qPCR. In brief, cul-
tured blastula stage embryos are disaggregated into a suspension of 
single cells, methanol fi xed, immunolabeled, and FACS isolated 
(Fig.  1 ). Fixed, dissociated cells maintain their morphology and 
can be effectively immunolabeled (Fig.  2 ). By titrating different 
amounts of YP30-labeled labeled cells (a ubiquitous cytoplasmic 
protein) into unlabeled cells, we fi nd that positive cells represent-
ing as little as 1 % of the total population can be effectively FACS 
isolated (Fig.  3 ). We go on to show isolation of the small micro-
meres of the sea urchin embryo, a rare (approximately 4 cells within 
an embryo of 1,000 cells) multipotent cell population with germ 
line competency (Fig.  4 ) [ 9 ,  10 ]. With antibodies specifi c to small 
micromere proteins Vasa and Nanos2, the small micromeres can be 
distinguished and FACS isolated from other cells in the suspension 
(Figs.  2  and  4 ).

  Fig. 1    Scheme for isolating specifi c  S. purpuratus  embryonic cell populations by FACS.  S. purpuratus  embryos 
are dissociated, fi xed, and immunolabeled with an antibody that recognizes your cell population of choice. 
Positive cells are sorted by FACS and RNA is isolated for RT-qPCR analysis of candidate genes       
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      The following protocol is adaptable to a number of different 
cell types and perhaps different species. The most critical aspect of 
this method is the selection of an antibody that targets the cells of 
interest and is compatible with methanol fi xation, which in our 
hands best preserves RNA.  

  Fig. 2    Immunolabeled single cells from mesenchyme blastula embryos Mesenchyme blastula stage embryos 
were dissociated, fi xed, and immunolabeled with antibodies that recognize YP30 (ubiquitous, cytoplasmic), 
Transglutaminase (ubiquitous, nuclear), Vasa (small micromere specifi c, cytoplasmic), or Nanos2 (small micro-
mere specifi c, cytoplasmic) [ 9 ,  11 ,  12 ]. Cells were uniformly labeled with antibodies against transglutaminase 
and YP30. Approximately 1–2 % of cells were labeled with the small micromeres-specifi c antibodies       

  Fig. 3    Separation of YP30 immunolabeled from unlabeled single embryonic  S. purpuratus  cells by FACS. FACS 
plots demonstrate successful separation of dissociated mesenchyme blastula cells based on YP30 immuno- 
labeling ( see  Fig.  2 ). First, cells immunolabeled with YP30 or a secondary alone negative control were run 
separately followed by the successful sorting of mixed populations containing 50, 10, or 1 % YP30 immunola-
beled cells. The R2 population was gated as YP30-positive cells       
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2    Materials 

      1.    Materials: 4 L glass beaker; Stirring paddle; 50 and 15 mL con-
ical tubes; Plastic transfer pipettes; 45 and 20 μM Nitex ®  mesh.   

   2.    Artifi cial Sea Water such as Coral Life Scientifi c Grade Marine 
Salt (Carson, CA), follow manufacturer’s instructions.   

   3.    Calcium-free Sea Water: to 900 mL ddH 2 O, add 29.3 g NaCl 
(0.5 M), 0.75 g KCl (0.01 M), 0.21 g NaHCO 3  (1.5 mM), 
2.5 g NaOH (0.06 M), and 7.6 g EGTA (0.02 M). Adjust pH 
to 8.0 with HCl and then fi ll to 1 L with ddH 2 O.   

   4.    Dissociation Buffer: 1 M Glycine, 25 mM EDTA, pH 8.0. 
Store at 4 °C.      

      1.    Materials: 15 mL conical tubes, 100 mm × 15 mm petri dishes.   
   2.    100 % MeOH. Chilled at −20 °C.   

2.1  Dissociation 
of Embryos into 
Single Cells

2.2  MeOH Fixation 
of Single Cells

  Fig. 4    Separation of  S. purpuratus  small micromere descendents by FACS. 
( a ) Single cells dissociated from mesenchyme blastula were immunolabeled 
with a Vasa antibody ( see  Fig.  2 ) and separated by FACS on the basis of fl uores-
cence. 270,000 cells were collected from the sort ( box  denoted by  R2 ), which 
represented 0.75 % of the total cells sorted. ( b ) 50 ng of total RNA was isolated 
from the Vasa-positive small micromere descendents (SM). RT-PCR demon-
strates that these cells contain the small micromere-specifi c gene  nanos , but not 
the ectoderm specifi c gene  spec1 . As a control for the RT-PCR, total RNA was 
isolated from the total cell population before FACS (TC)       
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   3.    1 L 1× PBS–Tween: In 800 mL of RNase-free water dissolve 
8 g NaCl, 0.2 g KCl, 1.44 g Na 2 HPO 4 , and 0.24 g KH 2 PO. 
Adjust pH to 7.4 with 1 M HCl. Add 1 mL Tween-20 (0.1 % 
fi nal concentration). Add RNAse-free water to 1 L and fi lter- 
sterilize through 0.22 μM fi lter.      

      1.    Materials: 15 mL conical tubes, PBS–Tween (see above for 
recipe), primary and secondary antibodies of choice.      

      1.    FACS collection tubes.   
   2.    Trizol ®  LS, Catalog #10296028 (Invitrogen; Carlsbad, CA).   
   3.    Glycogen, Catalog #10901393001 (Roche; Indianapolis, IN).   
   4.    RQ1 DNase, Catalog #M6101 (Promega; Madison, WI).   
   5.    Acid Phenol–Chloroform, Catalog # AM9720 (Ambion; 

Austin, TX).   
   6.    5 M ammonium acetate, pH 5.2.   
   7.    100 % EtOH.   
   8.    High Capacity cDNA Reverse Transcription Kit, Catalog # 

4368814 (Applied Biosystems; Foster City, CA).       

3    Methods 

      1.    Fertilize between 1 and 5 mL of  S. purpuratus  eggs and cul-
ture for 24 h ( see   Note 1 ) in artifi cial seawater (ASW) at 16 °C 
in a 4 L beaker with stirring.   

   2.    Collect and concentrate embryos into two to four 50 mL con-
ical tubes using 45 μM Nitex ®  mesh.   

   3.    Spin down the embryos in a clinical centrifuge at ~130 ×  g  for 
5 min and remove seawater.   

   4.    Resuspend the embryos in up to 50 mL of calcium-free seawa-
ter per conical tube.   

   5.    Spin down the embryos in a clinical centrifuge at ~130 ×  g  for 
5 min and remove calcium-free seawater.   

   6.    Resuspend the embryos in approximately 20 mL of dissocia-
tion buffer per 1 mL of embryos and incubate on ice for 
10 min.   

   7.    Pipette the embryos up and down using a plastic transfer 
pipette, which will dissociate the embryos into single cells. 
Monitor the progress of dissociation by periodically examining 
a drop of the suspension under a compound microscope. 
When approximately 95 % of suspension is single cells, the dis-
sociation step is completed.   

2.3  Immunolabeling 
of Single Cells

2.4  FACS Sorting 
and RNA Extraction 
for RT-qPCR

3.1  Dissociation 
of Embryos into 
Single Cells

Isolating Specifi c Embryonic Cells by FACS
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   8.    Strain the dissociated cells through a 45 μM Nitex ®  mesh and 
collect the fl ow through. Strain this sample now through a 
20 μM Nitex ®  mesh and collect the resulting fl ow through. 
This removes all whole embryos and clumps of cells from the 
single-cell suspension.   

   9.    Transfer the single-cell suspension into 15 mL conical tubes. 
The number of tubes depends on the volume of your 
suspension.   

   10.    Spin the single-cell suspension at ~255 ×  g  for 5 min and 
remove the dissociation buffer.   

   11.    Resuspend the single cells in calcium-free seawater.   
   12.    Repeat  steps 10  and  11  twice.      

      1.    Collect approximately 0.5 mL of single cells into a 15 mL 
conical tube and spin for 5 min at ~255 ×  g  ( see   Note 2 ).   

   2.    Remove all but 2 mL of the calcium-free seawater and resus-
pend the cells.   

   3.    Add 8 mL of ice-cold 100 % MeOH drop-wise while slowly 
vortexing ( see   Note 3 ).   

   4.    Pour the suspension into a 100 × 15 mm petri dish and incu-
bate at −20 °C for 1 h.   

   5.    Collect the cells into a 15 mL conical tube.   
   6.    Spin for 5 min at ~255 ×  g .   
   7.    Remove MeOH and add up to 15 mL of PBS-Tween.   
   8.    Repeat  steps 6  and  7  twice.      

      1.    Prepare antibody-labeling solution by diluting antibody in 
2–10 mL of PBS-Tween per 500 μL of single cells ( see   Notes 
4 – 6 ).   

   2.    Spin single cells for 5 min at ~255 ×  g  and remove last PBS- 
Tween wash.   

   3.    Add antibody solution to the single cells and incubate over-
night at 4 °C with end-over-end rotation ( see   Note 7 ).   

   4.    Spin the single cells for 5 min at ~255 ×  g  and remove 
supernatant.   

   5.    Add up to 15 mL of PBS-Tween.   
   6.    Repeat  steps 4  and  5  twice.   
   7.    Prepare secondary antibody solution in 2–10 mL of PBS- 

Tween. Choose a conjugated fl uorochrome that is compatible 
with the Flow Cytometer that you will use. Dilute secondary 
antibody as per manufacturer’s instructions.   

   8.    Add secondary antibody solution to the single cells after the 
last wash is removed.   

3.2  MeOH Fixation 
of Single Cells

3.3  Immunolabeling 
of Single Cells

Celina Juliano et al.
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   9.    Incubate for 1 h at room temperature with end-over-end 
rocking.   

   10.    Spin the single cells for 5 min at ~255 ×  g  and remove 
supernatant.   

   11.    Add up to 15 mL of PBS-Tween.   
   12.    Repeat  steps 10  and  11  twice.   
   13.    Check labeling under fl uorescence microscope (Fig.  2 ).      

      1.    Bring labeled cells immediately to FACS machine for sorting 
(Figs.  3  and  4a ).   

   2.    Sort the cells directly into Trizol ®  LS. Fill an appropriately 
sized tube (depending on the instrument) with 750 μL of 
Trizol ®  LS and sort the cells into tube until the volume reaches 
1 mL. To collect more cells, use multiple tubes. Both the posi-
tive and negative populations can be collected if this is desired 
for downstream applications. If necessary, after sorting adjust 
the fi nal sample volume with nuclease free or Trizol LS water 
such that the fi nal ratio is three parts Trizol LS to one part 
aqueous sample.   

   3.    Isolate RNA from sorted cells following the Trizol ®  LS manu-
facturer’s protocol. During isopropanol precipitation, add 
0.5 μL of glycogen to help visualize the pellet.   

   4.    Resuspend the pellet in 10 μL of DNase solution (8 μL nuclease- 
free water + 1 μL 10× buffer + 1 μL DNase) ( see   Note 8 ).   

   5.    Incubate at 37 °C for 30 min.   
   6.    Bring volume up to 300 μL with nuclease-free water.   
   7.    Extract RNA with acid phenol–chloroform following manu-

facturer’s instructions.   
   8.    EtOH-precipitate RNA overnight at −20 °C (0.1 volumes of 

ammonium acetate and 2.5 volumes of 100 % ethanol).   
   9.    Resuspend pellet in 10 μL of nuclease-free water.   
   10.    Use entire volume for cDNA synthesis.   
   11.    Proceed with qPCR to test the relative abundance of candi-

date genes between distinct cell populations ( see   Note 9 ).       

4    Notes 

        1.    The time of embryo culture depends on the desired stage and 
cell type that you wish to collect. The dissociation works well 
for the morula stage through mesenchyme blastula. 
Dissociation of the gastrula stage is still possible, especially if 
ectodermal cells are desired. Once the embryos reach the lar-
val stage, isolation of endodermal and mesodermal cells 
becomes more challenging.   

3.4  FACS Labeling 
and RNA Extraction 
for RT-qPCR

Isolating Specifi c Embryonic Cells by FACS
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   2.    All volumes can be scaled up if necessary.   
   3.    Although single cells can be fi xed using other methods, such 

as 4 % paraformaldehyde in seawater, we found that the RNA 
is better preserved using MeOH fi xation. Furthermore, the 
quantity of RNA obtainable is much higher from MeOH fi xed 
cells versus paraformaldehyde. Be aware that different fi xing 
conditions will likely have a direct impact on the effectiveness 
of your antibody labeling. We suggest testing your antibody 
labeling with different fi xes on whole embryos before choos-
ing a condition to use for single-cell labeling.   

   4.    Ideal concentrations for labeling differ greatly between differ-
ent antibodies. The concentration used for a specifi c antibody 
should be determined empirically.   

   5.    The volume used for antibody labeling should be as high as 
possible to reduce the possibility of cell clumping. To conserve 
antibody, consider saving the solution and reusing for future 
experiments.   

   6.    We fi nd that using blocking reagents such as Bovine Serum 
Albumin (BSA), including those certifi ed as RNAse free, will 
cause severe RNA degradation and should thus be avoided if 
possible. This could affect the quality of the antibody labeling, 
and these conditions should be tested in whole embryo label-
ing before single-cell labeling is done. In general, all incuba-
tion times and centrifugations should be minimized, and 
whenever possible, performed at 4 °C to minimize RNA deg-
radation. RNAse-free reagents should be selected whenever 
available.   

   7.    If it does not decrease the quality of the antibody labeling, 
consider decreasing the labeling time, which may increase the 
quality of the RNA recovered from the sorted cells.   

   8.    Alternatively, the pellet can be resuspended in 10 μL of 
nuclease- free water and can be used directly for cDNA synthe-
sis ( step 10 ). In this case though, there will likely be contami-
nating genomic DNA in the sample. If primer pairs are 
designed to span an intron for use in RT-qPCR, contaminat-
ing genomic DNA should not be a problem.   

   9.    In our hands, the RNA collected from this method is not of 
high enough quality for microarray or deep sequencing. 
Therefore this method cannot be used for gene discovery, but 
is better suited for testing if candidate genes are enriched in 
your cell population by RT-qPCR. This would be particularly 
useful for testing genes of low abundance that cannot be 
detected by whole-mount in situ RNA hybridization. 
However, it is possible that further improvements to this pro-
tocol could yield suffi ciently high quality RNA for gene 
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 discovery. Many new experimental applications would be pos-
sible if an investigator were capable of isolating specifi c cell 
populations. The most direct application of the defi ned pro-
tocol herein is in mRNA analysis though improvement of the 
mRNA fi delity will be important in order to take full advan-
tage of the protocol. Alternatively, if antibodies are available 
that recognize a cell surface component, they can be used in 
live-cell immunolabeling and traditional FACS protocols. In 
this situation, the cells need not be fi xed, and the mRNA will 
be protected as long as the cell remains intact. Chromatin 
Immunoprecipitation (ChIP) for the analysis of epigenetic 
modifi cations and for promoter occupancy tests would bene-
fi t from this FACS protocol. In this case, the DNA is sheared 
to small (500 bp) fragments following cell isolation and 
EDTA can be added to the fi xed cells to minimize nucleases 
that may chemically cleave the DNA. In this application the 
isolated cells present a more homogeneous population of 
chromatin that may be more effective than use of the whole 
embryo and may enable a more refi ned condition for analysis 
of DNA or protein modifi cations, and for trans-factor analysis 
of promoter occupancy. With new proteomic technologies 
enabling whole cell analysis, this FACS protocol will enable 
analysis of protein products. In many cases, cells will accumu-
late an mRNA but not translate the protein, so such analysis 
will inform what proteome the cell is working with at the 
time of isolation. This approach will also enable more effec-
tive identifi cation of post-translational modifi cations of spe-
cifi c proteins including phosphorylation, glycosylation, 
ubiquitylation, and sumoylation. Since the protein samples 
are trypsinized prior to analysis, fi xation with methanol or 
even formaldehyde will not prevent protein identifi cation, 
and for phosphorylation and glycosylation, a pre-purifi cation 
column (e.g., Fe3+ IMAC enrichment of phosphopeptides) 
will enable more focused analysis of the biochemical question 
at hand [ 13 ].         
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    Chapter 13   

 Biotinylation of Oocyte Cell Surface Proteins 
of the Starfi sh  Patiria miniata  

           Samantha     Cihal     and     David     J.     Carroll    

    Abstract 

   Understanding the signal transduction processes that occur during oocyte maturation and fertilization 
requires knowledge of the constituent proteins from the cell surface to relevant intracellular compart-
ments. To identify starfi sh oocyte and egg cell surface proteins, a biotinylation method was adapted from 
prior protocols using B cells, leukocytes, mouse oocytes, and sea urchin eggs    (Cole et al. Mol Immunol 
24:699–705, 1987; Flaherty and Swann NJ. Mol Reprod Dev 35:285–292, 1993; Haley and Wessel. 
Dev Biol 272:191–202, 2004; Hurley et al. J Immunol Methods 85:195-202, 1985). This method 
utilizes the water-soluble Sulfo-NHS-Biotin, which does not cross the egg plasma membrane. The pro-
cess of biotinylation does not appear to have any effect on the process of oocyte maturation or fertiliza-
tion. Furthermore, it can be used with either vitelline-intact or vitelline-free oocytes and allows the 
proteins to be visualized successfully through immunoblotting, immunoprecipitation, or by scanning 
confocal microscopy.  

  Key words     Biotin  ,   Cell surface proteins  ,   Streptavidin  ,   Oocyte  ,   Echinoderm  

1      Introduction 

 Fertilization involves the fusion of a single sperm with a single egg. 
The sperm receive signals from the oocyte in the form of peptide 
chemoattractants that direct sperm towards the oocyte    [ 5 ]. Once the 
sperm reaches the oocyte, the gametes interact via cell surface mole-
cules and fusion of the gametes can occur [ 6 ]. Intracellular Ca 2+  is 
released in the form of a wave, which acts as a polyspermy block and 
allows the oocyte to resume the cell cycle [ 7 ,  8 ]. The    Ca 2+  wave that 
sweeps across the entire oocyte that begins at the site of sperm fusion 
is a universal feature of egg activation in all species that have been 
examined [ 7 ,  9 ]. 
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 In echinoderm oocytes, the egg activation pathway involves 
many signaling molecules, including several Src family kinase 
(SFK) members and phospholipase Cγ (PLCγ) [ 10 – 13 ]. 
SFKs can act as upstream regulators of PLCγ, which is located 
in the plasma  membrane of echinoderm eggs [ 12 – 17 ]. Once 
PLCγ is activated, it travels from the cytosol to the plasma 
membrane where it has  better access to PIP 2  [ 11 – 13 ,  18 ]. Src 
and PLCγ are both required for egg activation in echinoderms 
[ 14 ,  15 ,  18 – 21 ]. However, other molecules hypothesized to be 
involved in the fertilization signal transduction pathway (such 
as a hypothetical egg cell surface receptor for sperm that inter-
acts with either Src or PLCγ) are not very well characterized, 
except for the sea urchin egg receptor for sperm that appears to 
be involved in species-specifi c gamete interaction [ 22 – 24 ,  26 , 
 27 ]. Therefore, identifi cation of oocyte and egg cell surface 
proteins remains an important component for eventual under-
standing of these mechanisms. 

 Biotin can be used to label the surface proteins on the starfi sh 
oocyte. Labeling of cell surface proteins has been successfully 
accomplished in the past by radioactive iodine labeling; however, 
because of the concerns regarding radioactivity, biotinylation has 
become the preferred alternative labeling method [ 1 ,  4 ,  23 ]. 
Biotinylation has been successful in labeling human B-cell line 
BALM-1, leukocytes, and sea urchin and mouse oocytes [ 1 – 4 ,  31 ], 
Flaherty and Swann 1993; Haley and Wessel 2004). Biotin 
labeling has also been accomplished in other cell types such as 
platelets, erythrocytes, and lymphocytes    [ 25 ,  28 – 30 ]. Biotin is 
water soluble with a reactive pH between 7.0 and 9.0, which 
makes it convenient for use with gametes in vitro. Biotin forms a 
covalent bond between free primary amine groups via a stable 
amide bond. Sulfo- N -hydroxysuccinimide can be used to selec-
tively label the cell surface because the sulfonate groups prevent 
the biotin from permeating the cell membrane, unless the cells are 
broken [ 1 ]. Avidin and streptavidin conjugates provide reliable 
systems for detecting biotinylated surface proteins [ 1 – 4 ]. Biotin 
has a very high affi nity for avidin with a dissociation constant of 
10 −15  M [ 4 ]. This means that the detection system is very sensitive 
and stable. 

 In this chapter, a method for labeling surface proteins in the 
oocytes and eggs of the starfi sh  Patiria miniata  is described. Two 
different oocyte preparations are compared: those with an intact 
extracellular matrix (the vitelline coat) and those in which the 
extracellular matrix has been removed. Confocal microscopy utiliz-
ing fl uorescein-conjugated streptavidin on living and fi xed speci-
mens is used to determine whether the labeling is restricted to the 
oocyte plasma membrane.  
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2    Materials 

      1.    Pronase ®  Protease (Calbiochem; Gibbstown, NJ): store 
 powder at 4 °C. Handle with gloves.   

   2.    9″ glass Pasteur pipette ( see   Note 1 ).   
   3.    Disposable culture tubes (Fischer Scientifi c; Fair Lawn, NJ): 

13 × 100 mm disposable borosilicate glass tubes are used for 
protease treatment, biotinylation, and maturation ( see   Note 2 ).      

      1.    Sulfosuccinimidyl-6-[biotin-amido]hexanoate (EZ Link ®  
Sulfo- NHS-LC-Biotin) (Pierce; Rockford, IL) ( see   Note 3 ).   

   2.    Filtered natural seawater (NSW): natural seawater was fi ltered 
using a Millipore fi lter apparatus with 0.4-μm nitrocellulose 
fi lter discs.   

   3.    Glycine wash (0.1 M in NSW) is prepared fresh just before use 
and stored at 17 °C.   

   4.    Labquake tube rotator (Thermo Fisher Scientifi c, Pittsburgh, PA).      

      1.    The hormone 1-methyladenine (1-MA; Acros Organics, Geel, 
Belgium) at a concentration ranging from 0.5to 5 μm 
( see   Note 4 ).   

   2.    Zeiss Axioskop 50 microscope (Carl Zeiss, Inc., Thornwood, 
NY) for observation of oocytes and eggs.      

      1.    Lysis buffer: 20 mM HEPES, pH 7.0, 150 mM NaCl, 10 mM 
Na 3 VO 4 , 10 mM NaF, 1 mM EDTA, and 1× Protease Inhibitor 
Cocktail (PIC). Prepare fresh for each use and keep on ice.   

   2.    Protease Inhibitor Cocktail set III (Calbiochem/EMD 
Biosciences, Gibbstown, NJ).   

   3.    Resuspension buffer: 20 mM HEPES, pH 7.0, 150 mM NaCl, 
10 mM Na 3 VO 4 , 10 mM NaF, 1 mM EDTA, 60 mM Na-β- 
glycerophosphate, 1 % Triton X-100, and 1× PIC. Prepare 
fresh for each use and keep on ice.   

   4.    Protein Assay Dye Reagent Concentrate (Bio-Rad; Hercules, 
CA): use as recommended and store at 4 °C.   

   5.    Albumin standard (Thermo Scientifi c; Rockford, IL): store at 
room temperature until used for standard in Bio-Rad protein 
assay then store at 4 °C.      

      1.    Immobilized protein A plus resin (Pierce; Rockford, IL).   
   2.    α-Phosphotyrosine primary antibody (Exalpha; Watertown, 

MA): store at −20 °C, use at a 1:500 dilution.   

2.1  Protease 
Treatment

2.2  Biotinylation 
of Oocytes

2.3  Maturation 
of Oocytes

2.4  Cell Lysis

2.5  Immunoprecipi-
tation with 
α-Phosphotyrosine

Biotinylation of Oocyte Cell Surface Proteins of the Starfi sh  Patiria Miniata 
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   3.    1X phosphate buffered saline plus 0.2 % Triton X-100 (PBS-T): 
phosphate buffered saline tablets (Sigma-Aldrich, St. Louis, 
MO) dissolved in DI water to give a 0.01 M phosphate buffer 
solution that was then autoclaved. Triton X-100 (Fischer 
Scientifi c; Fair Lawn, NJ) is added to 0.2 % of the fi nal 
volume.      

      1.    Resolving gel: all resolving gels are prepared at 7 % in Bio-Rad 
mini gel format (7 % acrylamide/bis, 375 mM Tris–HCl, 
pH 8.8, 0.1 % SDS, 0.05 % APS and TEMED).   

   2.    Stacking gel: all stacking gels are prepared at 5 % (5 % acryl-
amide/bis, 375 mM Tris–HCl, pH 6.8, 0.1 % SDS, 0.05 % 
APS and TEMED).   

   3.    Thirty percent acrylamide/bis solution 29:1 (3.3%C; Bio-Rad; 
Hercules, CA): store at 4 °C.   

   4.    Ammonium persulfate (APS; Bio-Rad; Hercules, CA) 
( see   Note 5 ).   

   5.    TEMED (Bio-Rad; Hercules, CA).   
   6.    Running buffer (5×): 25 mM Tris-base, 192 mM glycine, and 

0.1 % (w/v) SDS.   
   7.    Precision Plus Protein All Blue standard (Bio-Rad; Hercules, 

CA): store at −20 °C; use 5 μl per lane of the gel.   
   8.    Laemmli (2×) sample buffer: 0.125 M    Tris, pH 6.8, 4 % SDS, 

20 % glycerol, and <2 mg bromophenol blue ( see   Note 6 ). Mix 
and store in 0.9 ml aliquots at −20 °C. Just prior to use, add 
2-mercaptoethanol to 10 % (v/v).      

      1.    Transfer buffer (5×): 25 mM Tris-base, 192 mM glycine, 0.1 % 
(w/v) SDS, and 25 % (v/v) methanol.   

   2.    Trans-Blot ®  transfer medium pure nitrocellulose membrane 
0.45 μm and blot fi lter paper were used from Bio-Rad, 
Hercules, CA.   

   3.    TST: 20 mM Tris, pH 7.6, 150 mM NaCl, pH 7.6, add 
0.001 % (v/v) Tween-20.   

   4.    Bovine Serum Albumin, Fraction V (BSA; bio-WORLD; 
Dublin, OH): 3 % solution (w/v) in TST for each use.   

   5.    ImmunoPure ®  streptavidin, horseradish peroxidase conjugated 
(Pierce Chemical, Thermo Scientifi c, Rockford, IL): long-
term storage at −20 °C and short-term storage at 4 °C for up 
to 6 months.   

   6.    α-Phosphotyrosine primary antibody (Exalpha; Watertown, 
MA): store at −20 °C; use at a 1:500 dilution.   

2.6  SDS–
Polyacrylamide Gel 
Electrophoresis 
(SDS–PAGE)

2.7  Western Blotting 
for Biotinylated 
Surface Proteins
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   7.    Goat anti-mouse secondary antibody (Bethyl Labs; 
Montgomery, TX): store at 4 °C; use at a 1:5,000 dilution.   

   8.    Blotto: 4 % (w/v) dry, nonfat milk in TST.      

      1.    Microscope slides (Fischer Scientifi c; Fair Lawn, NJ): plain, 
pre- cleaned, glass slides 3″ × 1″ × 1.0 mm. Clean with ethanol 
prior to use.   

   2.    Microscope coverslips (Corning; Edison, NJ): glass 22-mm 
square, pre-clean with ethanol.   

   3.    Phosphate buffered saline (PBS): phosphate buffered saline 
tablets from Sigma (St. Louis, MO). Dissolve in DI water to 
give a 0.01 M phosphate buffer solution; adjust pH to 7.4. 
Autoclave and store at 4 °C.   

   4.    Paraformaldehyde (Electron Microscopy Sciences; Hatfi eld, 
PA): prepare an 8 % (w/v) solution in 1× PBS, pH 7.4 
( see   Note 7 ).   

   5.    Streptavidin–FITC (Invitrogen; Camarillo, CA): store stock 
solution at 4 °C and avoid light. Prepare fresh dilutions prior 
to each use and store at 4 °C.       

3    Methods 

      1.    Dissect ovaries from adult  Patiria miniata  using a 3-mm cor-
ing tool and place in a 25-ml beaker with NSW ( see   Note 8 ).   

   2.    Chop the ovaries using straight spring scissors with 8-mm 
blades to release the oocytes.   

   3.    Gently pour the chopped ovaries through 210-μm Nitex mesh 
to remove the ovary pieces while allowing the 190-μm-diameter 
oocytes to pass through.   

   4.    Rinse oocytes three times with NSW and place at 17 °C.   
   5.    Periodically, check the oocytes via microscope to make sure 

they are healthy and not undergoing spontaneous maturation.   
   6.    Dissect testis from adult  Patiria miniata  via a 3-mm hole in 

the dorsal body wall and placed in an Eppendorf tube on ice.   
   7.    Release sperm from testis by mincing with fi ne scissors. Sperm 

were kept on ice and diluted in NSW as needed.      

      1.    Prepare stock solution of pronase in NSW (1 mg/ml) and 
store on ice until use.   

   2.    Dilute oocytes in NSW as a 10 % suspension (in a 10 ml total 
volume approximately 1 ml volume is occupied by the oocytes).   

2.8  Confocal 
Imaging for 
Biotinylated Surface 
Proteins

3.1  Collection 
of Gametes

3.2  Pronase 
Treatment
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   3.    Resuspend oocytes by swirling and transfer 0.9 ml of the 10 % 
suspension to a 13 × 100-mm glass culture tube. Place at 17 °C 
( see   Note 9 ).   

   4.    Dilute pronase 1/10 by adding 100 μl to the oocytes in the 
glass culture tubes. Final pronase concentration is 0.1 mg/ml.   

   5.    Resuspend oocytes every 2–3 min after addition of pronase. 
Also, pipette oocytes up and down with a 9″ Pasteur pipette 
to help mechanically remove the vitelline coat. Observe 
oocytes under a microscope every 5 min to make sure the 
vitelline coat is lifting off. When the vitelline coat begins to 
lift away, begin NSW washes. Do not let oocytes sit in  pronase 
for more than 22 min.   

   6.    After 20–22 min, rinse the oocytes 1× with 4 ml NSW, then 
rinse 5× with 1 ml NSW. Now the vitelline-free oocytes are 
ready to biotinylate.      

      1.    Sulfosuccinimidyl-6-[biotin-amido]hexanoate (EZ Link ®  
Sulfo-NHS- LC-Biotin; Pierce) should be taken out of −20 °C 
freezer and allowed to warm to room temperature before being 
dissolved in fi ltered natural seawater (NSW) at a 1.0 mg/ml 
concentration.   

   2.    Adjust oocyte concentration to a 10 % suspension in NSW.   
   3.    Incubate oocytes for biochemical analysis in 100 μg/ml Sulfo-

NHS- LC-Biotin in NSW for 1 h at 17 °C with rotation on a 
Labquake tube rotator. For confocal imaging, incubate oocytes 
in 100 μg/ml Sulfo-NHS-LC-Biotin in NSW with rotation for 
30 min at 17 °C.   

   4.    Quench the biotin reaction by replacing the biotin solution 
with 0.1 M glycine in NSW. Wash the biotinylated samples 
three times with the 0.1 M glycine wash, followed by four 
washes with NSW.   

   5.    The biotinylated oocytes can then be induced to mature with 
1-methyladenine or immediately frozen in liquid nitrogen for 
later analysis.      

      1.    To initiate maturation, incubate oocytes in 2 μM 
1- methyladenine in NSW at 17 °C. After 30 min, check the 
oocytes for germinal vesicle breakdown (GVDB) under a 
microscope.   

   2.    Prepare a 1:1,000 dilution of sperm in NSW.   
   3.    Replace the entire 1-MA solution with the sperm dilution. 

Check for the presence of a fertilization envelope under the 
light microscope and record % fertilization.   

3.3  Biotinylation 
of Oocytes

3.4  Maturation and 
Fertilization of 
Biotinylated Oocytes
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   4.    Freeze samples in liquid nitrogen and store at −80 °C for later 
biochemical analysis or prepare samples for visualization by 
laser scanning confocal microscope.      

      1.    Lyse biotinylated samples by repeated aspiration in a 0.5 or 
1.0 ml volume of lysis buffer using a tuberculin syringe and 
27 ½-gauge needle.   

   2.    Allow samples to incubate on ice for 20 min for effi cient pro-
tein solubilization.   

   3.    Centrifuge samples at 12,127 ×  g  for 30 min at 4 °C to pellet 
insoluble material.   

   4.    Remove the soluble supernatant and place into a fresh, 
 prechilled Eppendorf tube before immersing in liquid 
nitrogen.   

   5.    The supernatant samples can be stored at −80 °C while pro-
cessing the pellet.   

   6.    Resuspend pellet in resuspension buffer using a syringe with a 
25 ½-gauge needle to break the pellet up completely.   

   7.    Allow the resuspended pellet samples to solubilize on ice for 
20 min.   

   8.    Determine the protein concentration per sample and equalize 
all samples to the lowest concentration using resuspension 
buffer.      

      1.    Once the protein concentrations in each sample have been 
equalized, add α-phosphotyrosine antibody to each sample at 
an appropriate dilution. Final antibody concentrations can 
range from 0.1 to 10 μg/ml, depending upon your sample.   

   2.    Incubate samples with antibody for 1.5 h on a rocker at 4 °C.   
   3.    Add 20 μl immobilized protein A plus resin to each sample and 

incubate 1.5 h on a rocker at 4 °C ( see   Note 10 ).   
   4.    Wash samples 4× with PBS-T. Solubilize proteins using equal 

volume of Laemmli sample buffer. The proteins can now be 
separated by SDS–PAGE.      

      1.    The SDS–polyacrylamide gels are run using the Mini- 
PROTEAN  ®  3 Cell (Bio-Rad; Hercules, CA) tank system.   

   2.    Heat samples for 3–5 min at 95 °C before loading onto the 
gel.   

   3.    Resolve proteins at 115 V on a 7 % gel.   
   4.    Stop the electrophoresis run when the bromophenol blue 

reaches the bottom of the gel.      

3.5  Preparation of 
Oocytes for Cell Lysis

3.6  Immunoprecipi-
tation with 
α-Phosphotyrosine

3.7  SDS–
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      1.    Assemble the sandwich that is used to transfer the proteins 
from the gel to the nitrocellulose membrane with everything 
 completely immersed in the transfer buffer. The sandwich 
should consist of the plastic support cassette, sponges, fi lter 
paper, and the gel and nitrocellulose membrane.   

   2.    Following electrophoresis, remove the gels from the glass 
plates, one at a time, making sure to keep them wet at all 
times.   

   3.    Gently lay the gel on top of the fi lter paper, which should be 
on top of a sponge and cassette and submerged in transfer 
buffer.   

   4.    Wet the nitrocellulose membrane in transfer buffer and place 
on top of the gel. Keep in mind the orientation of the lanes of 
the gel. It is useful to clip the right upper corner of the nitro-
cellulose paper to mark the orientation of the gel.   

   5.    Place the cassettes into the transfer tank with an ice block, stir 
bar, and transfer buffer, and transfer overnight using constant 
current for a total exposure of 1,000 mA h (i.e., transfer at 
50 mA for 20 h).   

   6.    Following the transfer, remove nitrocellulose membranes from 
cassettes and label appropriately.   

   7.    Incubate membranes in 4 % Blotto for 1 h at RT with gentle 
rocking.   

   8.    Prepare ImmunoPure streptavidin–HRP in 4 % Blotto. 
Appropriate dilution will have to be determined for your 
system. Our dilution factors range from 1:10,000 to 
1:150,000.   

   9.    Incubate membranes in the diluted ImmunoPure streptavidin–
HRP for 1 h at RT with gentle rocking.   

   10.    Wash four times with 100 ml TST.   
   11.    Develop signal by enhanced chemiluminescence (ECL) as for 

an immunoblot ( see   Notes 11  and  12 ; Fig.  1 ).

             1.    To determine localization of the biotinylated proteins in the 
starfi sh oocyte, either live or fi xed oocytes were labeled with 
streptavidin–FITC for visualization by confocal microscopy.   

   2.    In initial experiments, live biotinylated oocytes were incubated 
with streptavidin–HRP at a fi nal dilution of 1:2,000 in NSW. 
Alternatively, oocytes were fi xed in 4 % paraformaldehyde in 
PBS for 1 h at room temperature.   

   3.    Fixed oocytes were solubilized using 1 % Triton X-100 with 
3 % BSA for 1 h at room temperature.   

3.8  Affi nity Blotting 
for Biotinylated 
Surface Proteins

3.9  Confocal 
Imaging for 
Biotinylated Surface 
Proteins
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   4.    Oocytes were incubated in streptavidin–HRP for 30 min 
before washing twice in NSW for live oocytes or in PBS for 
fi xed oocytes.   

   5.    After rinsing, place oocytes on a clean glass microscope slide 
and pop any air bubbles that may have formed.   

   6.    Place a coverslip that has had its edges supported with wax or 
clay feet onto the sample. Gently press the sides of the cover-
slip down, so the sample is gently compressed to improve clar-
ity on the microscope.   

   7.    Visualize using the appropriate fi lters and settings for your 
microscope (Fig.  2 ).

  Fig. 1    Sulfo-NHS-Biotin labeling of egg and zygote proteins. Live immature 
 starfi sh oocytes were incubated with Sulfo-NHS-Biotin prior to stimulation of 
maturation with 1-methyladenine. Unfertilized eggs (UF) or zygotes at 1 min 
(UF1), 5 min (UF5), or 10 min (UF10) after fertilization were treated as described 
in the protocol to separate soluble (S) from insoluble (I) proteins. Control samples 
(C) were prepared from unfertilized eggs that had not been incubated with Sulfo-
NHS- Biotin. Proteins were resolved by SDS–PAGE and transferred to nitrocellu-
lose for affi nity labeling with streptavidin–HRP. Labeling was visualized by 
enhanced chemiluminescence (ECL) and the image captured on x-ray fi lm. As 
seen, the majority of the labeled proteins partitioned to the insoluble fraction, but 
a sizable population was also observed in the soluble fraction. Based upon the 
immunolocalization of the biotinylated proteins via laser scanning confocal 
microscopy ( see  Fig.  2 ), the labeled proteins from both S and I fractions are local-
ized to the cell surface       
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4            Notes 

        1.    Oocytes are pipetted through the 9″-long glass tip to help 
mechanically remove the vitelline coat prior to labeling, 
 maturation, and fertilization. The shorter 5″-long Pasteur 
pipettes are not as effective at removing the vitelline coats.   

   2.    The culture tubes are just the right size and shape to allow the 
oocytes to settle quickly by gravity and spread out in a single 
layer on the bottom of the tube.   

  Fig. 2    Sulfo-NHS-Biotin labels the oocyte cell surface and has no effect on fertilization or early embryonic 
development in the starfi sh. ( a ) Live vitelline-free oocytes were incubated with Sulfo-NHS-Biotin before fi xa-
tion with 4 % paraformaldehyde in fi ltered natural seawater. The oocytes were then incubated with streptavi-
din–FITC, washed, and visualized by laser scanning confocal microscopy under defi ned conditions. 
( b ) Non- biotinylated oocytes were processed as for biotinylated oocytes, the only difference being lack of 
exposure to Sulfo-NHS-Biotin. ( c  and  d ) After exposure to Sulfo-NHS-Biotin, oocytes were stimulated to mature 
by exposure to 1-methyladenine. Following maturation, the eggs were fertilized and incubated at 18 °C in fi l-
tered natural seawater and allowed to develop through cleavage ( c ) and gastrulation ( d ). No developmental 
differences were observed between biotinylated and non-biotinylated embryos. Scale bar = 100 μm       
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   3.    A fresh solution of Sulfo-NHS-Biotin in either fi ltered natural 
seawater or artifi cial seawater should be prepared prior to each 
use. The EZ Link ®  Sulfo-NHS-LC-Biotin solid is moisture 
sensitive and stored at −20 °C. Acclimate to room temperature 
before weighing.   

   4.    1-Methyladenine is very slow to dissolve in solution. We pre-
pared a stock solution of 1 M in deionized water by constant 
stirring at room temperature over a several hour period. 
Once dissolved, the 1 M 1-MA is aliquoted into smaller 
 volumes, fl ash frozen in liquid nitrogen, and stored at 
−80 °C. A fresh working solution of 0.5–5 μm 1-MA is pre-
pared prior to each use.   

   5.    A fresh solution of 10 % ammonium persulfate should be pre-
pared prior to each use because it starts to break down once 
dissolved in water. The free radicals that are formed from the 
persulfate with the aid of TEMED are needed for polymeriza-
tion, and the effi ciency decreases with the age of the solution. 
TEMED should also be relatively fresh. As the TEMED ages, 
polymerization time for the gels will increase signifi cantly until 
they no longer polymerize.   

   6.    Glycerol is very viscous and diffi cult to measure accurately at 
smaller volumes. To reduce variability, weigh the glycerol 
rather than measure the volume. Measure 2.582 g for the 2 ml 
of glycerol needed here.   

   7.    Carefully heat solution using a hot plate and stir bar under a 
fume hood at 65 °C until paraformaldehyde dissolves. Filter 
solution to remove any particulates that may have been in the 
solution and store at 4 °C.   

   8.    Tools for working with gonads and gametes can be purchased 
from Fine Science Tools, Inc. (Foster City, CA). The 3-mm 
sample corer works well to expose the ovary without too much 
damage to the adult starfi sh. Use the plunger to clean the cor-
ing tool after each use. The spring scissors with 8-mm blades 
are convenient for chopping the ovary without harming the 
oocytes.   

   9.    The 13 × 100-mm glass culture tubes are highly recommended 
for working with the starfi sh oocytes. They allow the oocytes 
to settle quickly during washes, and the oocytes are maintained 
in a monolayer at the bottom of the tube. This allows for bet-
ter exposure to the pronase than would be accomplished if an 
Eppendorf tube were used. It is also more gentle than rocking 
or rotating, which may damage the oocytes because the vitel-
line coat is being removed and the plasma membrane is 
exposed.   
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   10.    When using a P1000 Pipetman and standard 200–1,000-μl 
pipette tips for transferring the oocytes, the end of the pipette 
tip should be shaved to a larger size using a single-edge razor. 
Shave the tip so that the diameter of the opening is at least 
0.5 mm.   

   11.    A control consisting of sample incubated with the protein A 
beads alone (without antibody) is recommended. If the  protein 
A beads bind to protein in your sample, it then becomes nec-
essary to preclear the protein lysate with protein A before add-
ing the immunoprecipitating antibody for each experiment.   

   12.    The signal generated by the ImmunoPure streptavidin–HRP 
on the nitrocellulose membrane can be very strong, making it 
diffi cult to resolve the individual bands on the blot. Several 
strategies can be employed to combat this issue, including 
reduction of protein concentration loaded onto the gel, 
increase dilution of ImmunoPure streptavidin–HRP, decreased 
time of exposure, or even dilution of the ECL reagent before 
exposure to the sample on the nitrocellulose.         
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    Chapter 14   

 Perturbations to the Hedgehog Pathway 
in Sea Urchin Embryos 

           Jacob     F.     Warner      and     David     R.     McClay    

    Abstract 

   The Hedgehog pathway has been shown to be an important developmental signaling pathway in many 
organisms    (Ingham and McMahon. Genes Dev 15:3059–3087, 2001). Recently that work has been 
extended to developing echinoderm embryos    (Walton et al. Dev Biol 331(1):26–37, 2009). Here we 
describe several methods to perturb the Hedgehog signaling pathway in the sea urchin. These include 
microinjection of Morpholinos and mRNA constructs as well as treatments with small molecule inhibitors. 
Finally we provide simple methods for assaying Hedgehog phenotypes in the sea urchin embryo.  

  Key words     Hedgehog  ,   Patched  ,   Smoothened  ,   Cyclopamine  ,   Sea urchin  ,   Microinjection  ,   Phalloidin  

1      Introduction 

 The Hedgehog (Hh) pathway is a highly conserved signaling 
pathway involved in patterning germ layers, limbs, symmetry, 
organs, and other embryonically important components [ 1 ,  3 – 5 ]. 
Signal transduction in the simplest terms is as follows: in a non-
Hh- responding cell, the Hh receptor Patched (Ptc) inhibits the 
activity of the co-receptor Smoothened (Smo). In the absence of 
Smo activity, the downstream effector Gli is phosphorylated and 
proteolytically cleaved to a short repressor form that translocates to 
the cell nucleus and represses target genes. In an Hh-responding 
cell, the ligand Hh binds to the receptor Ptc which relieves the 
repression of the co-receptor Smo. This allows Smo to promote the 
stabilization of the full-length activating form of Gli, which then 
translocates to the nucleus and activates target gene expression [ 6 ]. 

 In the sea urchin genome, single homologous genes are pres-
ent for each of the main Hh pathway components [ 7 ]. Functionally, 
Hh signaling was found to be required for proper patterning of 
mesodermal tissues [ 2 ]. In this chapter, we present several meth-
ods to perturb Hh signaling in the sea urchin embryo and methods 
to assay for mesodermal phenotypes. Hh signaling can be activated 
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by microinjecting a mutated form of Smo mRNA (ActSmo) [ 8 ] or 
inhibited by injecting an  o -methyl-substituted antisense oligonu-
cleotide (MASO) targeted to the Hh translational start site. Both 
of these reagents, however, are specifi c to the species of interest. 
For situations where these reagents are not available, we describe 
below a protocol to treat embryos with cyclopamine: a small mol-
ecule inhibitor of Hh signaling [ 8 ,  9 ]. We then describe practical 
methods for assaying mesodermal phenotypes, including visualiza-
tion of the skeleton with polarized light, and staining for muscle 
using phalloidin.  

2    Materials 

      1.    LB broth growth media: 10 g bacto-tryptone, 5 g yeast extract, 
and 10 g NaCl. Adjust pH to 7.5 and bring volume to 1 L 
with dH 2 O.   

   2.    Competent  E. coli . We recommend DH5alpha-cells (catalog 
number 18258012) (Invitrogen).   

   3.    LB agar plates with ampicillin prepared as described in 
Sambrook and Russell [ 10 ].   

   4.    Full-length clone of Smo in an appropriate expression vector 
such as pCS2+.   

   5.    Mutagenizing primers as described below (from Integrated 
DNA Technologies).   

   6.    High-fi delity polymerase. We recommend Advantage 2 from 
Clontech (catalog number 639201).   

   7.    DpnI restriction endonuclease (catalog number R0176L from 
New England Biolabs).   

   8.    mMESSAGE mMACHINE kit (catalog number AM1344) 
(Ambion).   

   9.    Tris-acetate-EDTA (TAE) agarose gel running buffer: 40 mM 
   Tris–HCl, 20 mM acetic acid, and 1 mM EDTA in deionized 
water.   

   10.    1.5 % agarose gel: add 0.75 g agarose to 50 ml of TAE and 
heat until fully dissolved. Cast the gel per manufacturer’s 
instructions of the gel running apparatus.      

      1.    0.25 % (W/V) protamine sulfate (catalog number P4380) 
(Sigma) solution in water.   

   2.    Injection plates: coat the lid of a 60 × 15 mm petri dish with 
the 0.25 % (W/V) protamine sulfate solution. Wait for 1 min, 
then rinse the plates with water and allow to dry inverted over-
night. Store long term in a dust-free container.   

   3.    1.0 mm × 152 mm glass thin-walled capillary tubes (catalog 
number TW120-6) (World Precision Instruments, Inc.).   

2.1  Generating an 
Activated Smoothened 
Construct

2.2  Microinjection 
of Sea Urchin Embryos
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   4.    Pasteur pipettes.   
   5.    105 μm Nitex mesh (this only applies if working with 

 Lytechinus variegatus  embryos).   
   6.    Picospritzer injection apparatus with micromanipulator.   
   7.    Artifi cial seawater (ASW): 437 mM NaCl, 9 mM KCl, 

22.9 mM MgCl 2 ·6H 2 O, 25.5 mM MgSO 4 ·7H 2 O, 2.1 mM 
NaHCO 3 , and 9.3 mM CaCl 2 . Adjust pH to 8.0 ( see   Notes 1  
and  2 ).      

      1.    Dimethyl sulfoxide (DMSO).   
   2.    Cyclopamine (catalog number BML-GR334) (Enzo Life 

Sciences).   
   3.    Plastic 6-well tissue culture plates (catalog number 353046) 

(BD Falcon).   
   4.    Artifi cial seawater as described above.      

      1.    4 % (W/V) paraformaldehyde (PFA) in ASW: add 2 g PFA to 
40 ml ASW in a 50 ml conical tube. Heat to 65 ° and vortex 
occasionally. PFA takes several hours to go into solution. Once 
most of the PFA is in solution, adjust the volume to 50 ml and 
continue heating/vortexing. Stock PFA is stored at −20 °C 
( see   Note 3 ).   

   2.    Phosphate buffered saline Tween-20 (PBST): dissolve the fol-
lowing in 800 ml of distilled H 2 O: 8 g NaCl, 0.2 g KCl, 1.44 g 
of Na 2 HPO 4 , 0.24 g of KH 2 PO 4 , and 1 ml of Tween-20. 
Adjust the pH to 7.2 and bring the volume to 1 l with dH 2 O.   

   3.    Microscope slides and glass coverslips.   
   4.    Double-sided tape or modeling clay.   
   5.    Rhodamine phalloidin (catalog number R415) (Invitrogen) 

( see   Note 4 ).   
   6.    Dimethyl sulfoxide (DMSO).   
   7.    50 % glycerol / 50 % PBST solution.   
   8.    0.25 % (W/V) protamine sulfate solution in water.       

3    Methods 

  The techniques associated with molecular cloning are beyond the 
scope of this protocol. A good reference for these techniques is 
 Molecular Cloning  by Sambrook and Russell [ 10 ]. To design 
Morpholinos, the sequence 5′ and 3′ of the ATG translation start site 
must be known for the species of interest. Alternatively the sequence 
of intron–exon boundaries can be used to design splice- blocking 
Morpholinos, but it should be noted that all of the  L. variegatus  Hh 

2.3  Cyclopamine 
Treatment of Sea 
Urchin Embryos

2.4  Assaying Sea 
Urchin Embryos 
for Hh Perturbation 
Phenotypes

3.1  Generating an 
Activated Smoothened 
mRNA and Morpholino 
Design
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pathway-specifi c Morpholinos published are designed against the 
translation start site [ 2 ]. Gene sequences can then be submitted to 
Gene Tools Inc (  www.genetools.com    ) for design. 

 To create an activated Smo (ActSmo) construct, a full-length 
copy of this gene must be cloned or isolated from a cDNA library 
and subcloned in-frame into an appropriate expression vector with 
a T7, Sp6, or T3 promoter (e.g., pCS2+). The ActSmo construct 
contains a single base pair change from G to T results in an amino 
acid change of W to L. This mutation is analogous to the mouse 
ActSmo mutation W539L described in Taipale et al. [ 8 ].

    1.    Using a full-length Smo clone, design gene-specifi c primers 
containing the appropriate mutation analogous to the W539L 
mutation in mouse. These primers should include the specifi c 
point mutation as well as fl anking gene sequences.   

   2.    Perform a PCR reaction using high-fi delity polymerase such as 
Pfu (available from Promega) or Advantage 2 (Clontech), in 
which the primers amplify the entire plasmid.   

   3.    Confi rm PCR product sizes using agarose gel 
electrophoresis.   

   4.    Clean up the PCR reaction using a PCR cleanup kit or phe-
nol–chloroform extraction followed by ethanol precipitation.   

   5.    Digest the product with the restriction enzyme Dpn1. This 
enzyme only cleaves the methylated DNA from the PCR tem-
plate leaving the mutagenized plasmid intact.   

   6.    Transform the plasmid, plate, and pick single colonies for 
overnight 5 ml cultures.   

   7.    Mini-prep overnight cultures.   
   8.    Verify the presence of the mutation by sequencing.   
   9.    Cut the plasmid using a restriction endonuclease that cuts the 

vector singly and immediately 3′ of the ActSmo coding region. 
Phenol–chloroform extract, ethanol precipitate, and resus-
pend the reaction product in nuclease free water at 0.5 μg/μl.   

   10.    Use this as a template for an mRNA synthesis reaction using 
an mMESSAGE mMACHINE kit (Ambion) or other mRNA 
transcription kits. Follow kit instructions.   

   11.    Phenol–chloroform extract and ethanol precipitate the above 
reaction.   

   12.    Resuspend mRNA in 10 μl nuclease-free H 2 O.   
   13.    Quantitate mRNA concentration using a spectrophotometer.   
   14.    Verify the mRNA product by running 0.5 μl using electropho-

resis with an RNAse-free gel ( see   Note 5 ). A single band 
should be visible.   

   15.    Aliquot and store at −80 °C.   

Jacob F. Warner and David R. McClay
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   16.    Just before use, thaw and dilute mRNA in 20 % glycerol/
nuclease-free H 2 O ( see   Note 6 ).   

   17.    This mRNA can be microinjected into fertilized sea urchin 
eggs as described below.    

     Different echinoderms require different optimal temperatures for 
proper development. The experiments here describe perturbation 
of  L. variegatus  embryos for which the optimal growth tempera-
ture is 23 °C, although these experiments may also be carried out 
at room temperature. Additional information on the husbandry of 
other species of urchin as well as an extensive overview of the tech-
niques associated with microinjection can be found in Methods in 
Cell Biology, vol. 74 [ 11 ,  12 ].

    1.    Induce spawning of adult  L. variegatus  urchins by injecting 
1 ml of 0.5 M KCl into the body cavity and shaking the animal 
vigorously. Examine the top of the animal for the appearance 
of eggs (which will appear yellow) or semen (white). For 
males, collect the semen using a Pasteur pipette and place at 
4 °C. For females, invert the spawning animal onto a glass 
beaker that is smaller than the diameter of the animal and fi lled 
with artifi cial seawater (ASW).   

   2.    Allow the animal to complete spawning. Afterwards, discard 
the animal and remove the jelly coat of the eggs by passing 
them through a 105 μm Nitex mesh three times. Afterwards, 
wash the embryos three times by allowing them to settle, then 
removing and replacing the ASW ( see   Notes 7  and  8 ).   

   3.    Transfer several thousand eggs to a petri dish and set the 
remaining aside for other experiments.   

   4.    Make embryo transfer pipettes by fl aming a Pasteur pipette 
just at the taper until soft, then removing it from the fl ame and 
quickly pulling it long and thin. Break off the excess glass and 
test it with the eggs. If the diameter is too small, the eggs will 
deform or sheer; if too large, the eggs will not be single fi le.   

   5.    Make injection needles using the glass capillary tubes and a 
horizontal needle puller following the manufacturer’s instruc-
tions ( see   Note 9 ).   

   6.    Fill these needles with the appropriate injection solution 
(Morpholinos, ActSmo mRNA, etc.) by pipetting 1 μl of injec-
tion solution onto the end of the needle and allowing capillary 
action and gravity to draw it to the end ( see   Notes 10  and  11 ).   

   7.    Using the transfer pipette, pick up several hundred eggs and 
gently expel them in a row onto an injection plate fi lled with 
ASW. Allow the embryos to settle then immediately fertilize 
them by adding a few drops of sperm diluted in ASW directly 
to the plates ( see   Notes 12  and  13 ).   

3.2  Microinjection 
of Sea Urchin Embryos
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   8.    After 1 min, check for the presence of fertilization envelopes. 
Add more sperm if needed.   

   9.    Load a fi lled needle into a Picospritzer or other pressurized 
injection devices.   

   10.    Position the injection plate beneath the micromanipulator 
holding an injection needle. The needle should approach the 
dish at approximately a 30° angle. Carefully move the needle 
into the light path and lower it to the seawater using the course 
adjustments. Using the joystick, break the needle tip by gently 
rubbing it along the scratch on the bottom of the injection 
plate. The fl ow can be observed just out of focus. Adjust the 
fl ow rate as needed ( see   Note 14 ).   

   11.    To inject, adjust the needle height so it is equatorial to the egg 
to be injected. Inject the egg by pushing into the egg and fer-
tilization envelope until the needle breaks through. At this 
point, the injection solution should enter the egg as you 
quickly and smoothly remove the needle.   

   12.    Continue this process using the stage controls and joystick to 
inject all of the eggs desired. If the fl ow slows or stops, the 
needle can be cleared using the clear button on the Picospritzer 
or the needle can be re-broken to a larger diameter.   

   13.    If a fl uorescent dye was co-injected, un-injected, or over- 
injected, embryos can be removed using a dissecting micro-
scope fi tted with a fl uorescent arc lamp and an embryo transfer 
pipette.    

    If genetic clones, sequences, or injection equipment is not avail-
able, the Hh pathway can also be perturbed using commercially 
available pharmacologic agents. The drawback from using this 
approach to inhibit the pathway is determining the proper dosage 
that will give an optimal phenotype without being toxic to embryos. 
Here we will focus on cyclopamine, a drug that inhibits Hh path-
way by binding the co-receptor Smo [ 9 ]. There are also other 
commercially available drugs that modulate the Hh pathway [ 13 ] 
described in Subheading  4 , but these have not been tested in sea 
urchin ( see   Note 15 ).

    1.    Resuspend the powdered cyclopamine at a concentration of 
4 mg per ml in DMSO. This stock can be stored at −20 °C for 
up to 3 months ( see   Note 16 ).   

   2.    Make several working dilutions of cyclopamine in DMSO.   
   3.    Spawn animals and wash embryos three times as described in 

 steps 1  and  2  of Subheading  3.2  above. Dejellying the eggs is 
not necessary.   

   4.    Fertilize embryos by adding 2 μl of sperm directly to the bea-
ker and swirling.   

3.3  Inhibition of the 
Hh Pathway Using 
Cyclopamine
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   5.    Allow embryos to settle, and then wash once to remove the 
sperm. Streak 100 μl of the embryos onto a slide and check for 
complete fertilization. If needed, add more sperm and repeat 
this step.   

   6.    Using a 100 μl of embryos as a representative density, count 
the number of embryos. Repeat this count three times to 
obtain the average embryo concentration.   

   7.    Dilute the embryos in ASW to a concentration of less than 
500 embryos per ml and add 5 ml of the embryo culture to 
each well in the 6-well plate.   

   8.    Add the appropriate amount of cyclopamine to obtain a fi nal 
volume of the desired dosage. It is highly recommended to 
perform a dose response when using cyclopamine as the dos-
age varies on the age of the stock solution, the quality of the 
animals, and the species of interest. For  L. variegatus , the opti-
mal dose is generally between 100 and 500 nM.   

   9.    Mix the solutions by gently agitating the plates laterally. Avoid 
swirling as this concentrates the drug in the center of the well.   

   10.    Grow embryos to the desired stage in a humid chamber.    

    Hh signaling is necessary for proper patterning of the mesoderm in 
sea urchin [ 2 ]. Two of these mesodermal tissues in particular, mus-
cle and skeleton, are very easy to assess for patterning defects. The 
skeleton of the embryo can be visualized with polarized light. The 
musculature can be labeled with fl uorescently conjugated phalloi-
din, a modifi ed fungal toxin that binds to fi lamentous actin [ 14 ]. 
Alternatively, if a fl uorescent or confocal microscope is not avail-
able, muscle function can be scored by an embryo’s ability to swal-
low latex beads ( see   Note 17 ).

    1.    To visualize skeletal phenotypes, mount embryos on a slide. 
A coverslip is optional but will help immobilize the embryos. 
The slide can also be coated with 0.25 % protamine sulfate to 
 immobilize live embryos. Rotate a polarizing fi lter between 
the light source and specimen until only the skeleton is visible. 
Embryos with inhibited Hh signaling will display a truncated 
skeleton ( see  Fig.  1 ) ( see   Note 18 ) [ 2 ].

       2.    To visualize muscle phenotypes, phalloidin staining can be 
employed. Fix embryos in 4 % PFA in ASW for 1 h at room 
temperature.   

   3.    Wash 4 times with PBST for 5 min each.   
   4.    Dissolve dry phalloidin or DMSO stock to 5 U/ml in PBST. 

Mix the solution by pipetting ( see   Note 19 ).   
   5.    Transfer the embryos to the phalloidin solution and incubate 

for 30 min to 1 h.   
   6.    Wash once with PBST for 5 min then 3× in PBS ( see   Note 20 ).   

3.4  Assaying Sea 
Urchin Embryos 
for Hh Phenotypes

Perturbations to the Hedgehog Pathway
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   7.    Transfer into 50 % glycerol/ 50 % PBST.   
   8.    Transfer a few embryos along with about 100 μl of 50 % 

PBST/50 % glycerol onto slides and apply coverslips supported 
with “feet” to avoid crushing the embryos ( see   Note 21 ).   

   9.    Image with a fl uorescent or confocal microscope, at an excita-
tion wavelength appropriate for the conjugated fl uorophore, 
soon after mounting as the staining will diminish if stored.    

4        Notes 

     1.    If available, high-quality fi ltered seawater can be used.   
   2.    When making artifi cial seawater, add each of the salts, except 

the CaCl 2 ·2H 2 O, to a volume that is 10 % less than the desired 
fi nal volume. Wait until everything else is in solution and add 
the CaCl 2 ·2H 2 O, then add water to the desired fi nal volume. 
When all of the salts are in solution, the salinity can be tested 
with a refractometer and should be 34–36 parts per 
thousand.   

   3.    Wear gloves and a protective mask when working with PFA to 
avoid accidental inhalation. Powdered PFA will dissolve in sea-
water more readily than granular PFA.   

   4.    We have listed rhodamine phalloidin here, but there are a vari-
ety of different fl uorescently conjugated phalloidins available.   

   5.    Generally, a normal agarose gel will be suffi cient to analyze the 
mRNA product. If needed an RNAse-free formaldehyde gel 
can be used.   

  Fig. 1    Polarized light image of a pluteus stage sea urchin embryo showing the larval skeleton. Embryos 
injected with an ActSmo construct ( 1’ ) exhibit ectopic skeletal growths       
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   6.    Dilute Morpholinos or mRNA in 20 % glycerol in water. 
Generally several doses should be tested to determine the opti-
mum injection concentration. 1:4, 1:10, 1:20, and 1:40 are 
generally good starting concentrations.   

   7.     S. purpuratus  eggs can be dejellied using acidic seawater. For 
all other species, a comprehensive guide to echinoderm egg 
handling can be found in chapter 3 of Methods in Cell Biology, 
Vol. 74 [ 11 ]. To dejelly eggs using acidic seawater, fi rst add 
30 μl of 0.5 M citric acid to 15 ml fi ltered seawater. The fi nal 
pH of the seawater should be 4–5 and can be adjusted using a 
pH meter as needed. Transfer the eggs to a petri dish contain-
ing the acid seawater and incubate for 1–2 min. Swirl the plate 
to concentrate the eggs in the center, then using a Pasteur 
pipette, transfer the eggs to a petri dish containing normal 
fi ltered seawater carrying over as little of the acid seawater as 
possible. Next, transfer the eggs again to a third petri dish 
containing fi ltered seawater. The eggs are now dejellied.   

   8.    Dejellied eggs do not keep very long and are best if used 
within an hour. Eggs that have yet to be dejellied however can 
be used up to 3 h later.   

   9.    The settings of each needle puller need to be optimized for 
successful injections. We fi nd shorter rigid needles easier to 
use than fi ne fl exible needles. Some researchers note that the 
ideal needle will taper along a length of 65 μm and taper from 
a width of 10 μm to a width of about 10 nm [ 12 ]. In any case, 
experimentation with each needle puller is highly 
recommended.   

   10.    You can make a needle holder using a line of modeling clay 
along the bottom of a petri dish.   

   11.    Needle loading pipette tips can also be used to load needles if 
the outer diameter of the pipette tip is smaller than the inner 
diameter of the needle.   

   12.    Less sperm is better as sperm can clog injection needles. We 
fi nd it best to use 100 μl of a 1:1,000 sperm to seawater dilu-
tion added to the eggs.   

   13.     S. purpuratus  embryos can be fertilized in  para -aminobenzoic 
acid (PABA) seawater to soften the fertilization envelope. To 
do this, add 150 mg of PABA (catalog number A6928) 
(Sigma) to 500 ml of fi ltered seawater for a fi nal concentration 
of 2 mM.   

   14.    Both continuous fl ow and spritzing can be used for injections. 
In both cases, a slight minimal back pressure needs to be set 
to avoid sucking contents from the embryos or the water into 
the needle.   

Perturbations to the Hedgehog Pathway
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   15.    There are many other molecules that have been shown to 
modulate Hh activity [ 13 ]. Three in particular that are com-
mercially available from but have not been used in sea urchin 
are Jervine ( ALX-350-378 ), SAG ( ALX-270-426 ), and 
GANT61 ( ALX-270-482 ). All of these are available from Enzo 
Life Sciences.   

   16.    Once resuspended in DMSO, the effi cacy of cyclopamine will 
gradually decline over the course of 3 months. Therefore, it is 
best to perform a dose response to determine the optimal con-
centration and then proceed immediately with planned 
experiments.   

   17.    If the muscle is disrupted or mispatterned, then peristalsis of 
the foregut muscles will be impaired and the embryo will be 
unable to swallow. To test this, culture the embryos as 
described above for the drug treatment. Next, add 20 embryos 
to 1 ml of ASW. Add one drop of a 100 ml solution containing 
ASW and 50 μl of 10 μm polystyrene beads (Polysciences, Inc 
Warrington, PA cat# 17136). Allow the embryos to feed for 
30 min then image the embryos under a light microscope to 
assay for the presence or absence of beads in the gut [ 2 ].   

   18.    In order to obtain an image similar to Fig.  1 , the embryo must 
be lying fl at. Embryos that are resting at an angle can be 
“coaxed” by dabbing at the mounting media, or ASW, with a 
pipette tip; the resultant fl ow will often reorient the embryo. 
If a coverslip is being used, gently push an edge of the cover-
slip with a pipette tip to reorient the embryo.   

   19.    Phalloidin is often shipped dry in a tube. Some suppliers rec-
ommend resuspending and storing it in methanol for long- 
term stability. Methanol, however, can disrupt staining; 
therefore, it is recommended to resuspend phalloidin in 
DMSO and keep frozen, thawing before each use. If you 
decide to resuspend and store the phalloidin in methanol, it is 
important to completely dry the stock before use. To do this, 
transfer the amount you intend to use to a microcentrifuge 
tube and dry using a SpeedVac or place the tube unsealed in a 
dark place and allow the methanol to evaporate.   

   20.    PBS is used for washes as PBST can dissociate the phalloidin 
from the sample.   

   21.    These “feet” keep the coverslip from crushing the embryo. 
Double-sided tape is very handy for mounting pluteus stage 
embryos. Simply cut two thin (~1–2 mm) strips and apply 
them to the slide are before transferring the embryos. Four 
small pieces of clay can also be used, especially for earlier stage 
embryos. To do this, “scrape” each corner of the coverslip 
along the clay to gather the clay. Only a small amount is needed 
on each corner (about the size of the tip of a ball-point pen). 
Transfer the embryos then lay the coverslip down carefully and 
depress the corners until the coverslip contacts the fl uid.         
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    Chapter 15   

 Regulation of DNA Synthesis at the First Cell Cycle 
in the Sea Urchin In Vivo 

           Jolanta     Kisielewska     and     Michael     Whitaker    

    Abstract 

   Using fl uorescent and non-fl uorescent recombinant proteins has proved to be a very successful technique 
for following postfertilization events, in both male and female pronuclei during the fi rst cell cycle of sea 
urchin in vivo. Proteins and dyes are introduced by microinjection into the unfertilized egg, and their 
function can be monitored by fl uorescence or confocal/two-photon (2P) and transmitted light micros-
copy after insemination. Here, we describe expression and purifi cation of GFP/RFP-tagged proteins 
involved in regulation of DNA replication. We also explain the techniques used to introduce recombinant 
proteins and fl uorescent tubulin into sea urchin eggs and embryos.  

  Key words     Fluorescent proteins  ,   PCNA  ,   GFP/RFP  ,   Microinjection  ,   Confocal/2P imaging  ,   Male 
and female pronuclei  

1      Introduction 

 Unlike vertebrates, insects, or  C. elegans , sea urchin eggs are 
arrested in G1 after completion of meiosis with licensed replication 
origins in the maternal nucleus [ 1 ,  2 ]. The superior optical proper-
ties of sea urchin eggs and embryos make them a very good model 
to study the fi rst round of DNA replication after fertilization in 
vivo [ 3 ,  4 ]. Sea urchins represent invertebrate system which none-
theless readily accepts cell cycle proteins derived from frogs, mouse, 
or humans. Although these proteins may differ at the level of both 
genetic code sequence and amino acid sequence, their cell cycle 
control functions are conserved [ 5 ,  6 ]. As protein expression from 
mRNA takes about 30 min [ 3 ], recombinant proteins proved to be 
a better tool for studying early postfertilization events [ 6 ]. For 
injected recombinant proteins to be active, the condition of their 
expression plays a major role in obtaining good quantities of soluble 
and properly folded protein. While purifi cation is usually well 
described in instruction manuals provided with different vector 
systems (see Stratagene,    Instruction Manual ‘Affi nity Protein 
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Expression and Purifi cation System’ and ‘Affi nity Protein Expression 
Vectors’; Novagen pET System, for more details and protocols), 
the expression conditions need to be adjusted individually to each 
protein. 

 The use of GFP–PCNA (green fl uorescent protein fused with 
proliferating cell nuclear antigen) for visualization of replication 
foci in vivo was fi rst described in mammalian cells [ 7 ]. This method 
has been adapted to the sea urchin model system in our laboratory. 
Microinjection of GFP/RFP–PCNA (green/red fl uorescent pro-
teins) allows the timing and degree of DNA synthesis in both male 
and female pronuclei to be established (Fig.  1 ) [ 3 ]. Because PCNA 
   is involved in DNA synthesis and DNA repair, fl uorescent recom-
binant PCNA may also be used to assess the DNA damage response 
[ 8 ,  9 ]. Use of proteins involved in the control process of licens-
ing such as components of the pre-replicative complex (pre-RC) 
and geminin allows the determination of mechanisms that prepare 
DNA origins for replication [ 10 ]. Cell cycle fl uorescent recombi-
nant proteins such as cdk2 or cyclin E injected into sea urchin eggs 
allow their distribution and nuclear localization to be studied in 
vivo [ 3 ,  11 ].

   Moreover, unlike  Xenopus , sea urchin eggs and early embryos 
are permeable to most of the soluble inhibitors of MAP kinase, 
the proteasome and cdks, allowing the regulatory details of DNA 
synthesis after fertilization to be studied in vivo [ 4 ,  12 ]. 

 In this chapter, we describe methods for expression and micro-
injection of cell cycle proteins involved in regulation of DNA rep-
lication. These approaches can be used for other regulatory proteins 
and their mutants or in combination with commercially available 
inhibitors, dyes, toxins, or antibodies. We provide some tips on 
expression conditions which can be applied to other less easily 
expressed proteins.  

  Fig. 1    GFP–PCNA pattern. The pattern of RFP–PCNA accumulation during the fi rst S phase of  L. pictus  after 
fertilization. ( a ) Injected RFP–PCNA recombinant protein does not enter an unfertilized egg nucleus ( arrow  ). 
( b ) Accumulation of RFP–PCNA in male ( M  ) and female ( F   ) pronuclei indicating DNA replication before pronu-
clear fusion. ( c ) The end of S phase/prophase. ( d ) Nuclear envelope breakdown (NEB). Bar 50 μm       
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2    Materials 

      1.    Recombinant proteins: Express and purify soluble proteins 
such as GFP/RFP–PCNA, GFP/RFP-cdk2, GFP-cyclin E, 
geminin–RFP, GFP-Orc6, and p27 Kip1  as described below.   

   2.    Vectors: In our study, we used pCAL-n (Stratagene;  see   Note 1 ) 
and pET32a (Novagen;  see   Note 2 ) expression vectors, both 
ampicillin resistant.   

   3.    Competent cells such as BL21(DE3)pLysS  E. coli  or 
Origami(DE3)pLysS (Stratagene;  see   Note 3 ).   

   4.    Ampicillin stock in dH 2 O, 100 mg/mL.   
   5.    LB agar plates ( see   Note 4 ).   
   6.    SOC medium: SOC medium can be purchased commercially 

from Stratagene or Sigma and also can be homemade as fol-
lows: 20.0 g tryptone, 5.0 g yeast extract, and 0.5 g NaCl. 
Add deionized water to a fi nal volume of 1 L and autoclave. 
Add 10 mL of 1 M MgCl 2  and 10 mL MgSO 4  prior to use and 
fi lter sterilize. Add 2 mL of 20 % (w/v) sterile glucose solution 
to 100 mL of medium and fi lter sterilize. Store as aliquots in 
−80 °C.      

      1.    2XYT broth medium: Dissolve 31 g of powdered medium 
(Melford or Merck) in 1 L of purifi ed deionized water, divide 
to appropriate volume, and autoclave; at this stage, do not add 
ampicillin.   

   2.    Terrifi c medium: 47.6 g of powdered medium (Melford or 
Merck) per 1 L deionized water with 4 mL of glycerol, pH 
7.2; sterilize by autoclaving.   

   3.    IPTG (isopropyl β- D -1-thiogalactopyranoside): 200 mM stock 
in dH 2 O.   

   4.    2× Laemmli sample buffer (2× SB): 4 % SDS, 20 % glycerol, 
10 % 2-mercaptoethanol, 0.004 % bromophenol blue, and 
0.125 M Tris–HCl.   

   5.    NuPAGE 10 or 4–12 % gradient Bis-Tris precast gels 
(Invitrogen).   

   6.    20× MOPS running buffer (Invitrogen).   
   7.    Gel staining solution: for 1 L, 450 mL methanol, 450 mL 

dH 2 O, 100 mL acetic acid, and 2.5 g Coomassie brilliant blue 
(Fluka).   

   8.    Gel destaining solution: for 1 L, 450 mL methanol, 500 mL 
dH 2 O, and 50 mL acetic acid.      

2.1  Vectors 
and Inserts

2.2  Fusion Protein 
Expression
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      1.    Protease inhibitor stocks as follows: 1 M benzamidine; 10 mg/mL 
leupeptin, pepstatin, and aprotinin.   

   2.    DNAse I from bovine pancreas (Calbiochem), stock 20 mg/mL.   
   3.    RNAse A from bovine pancreas (Sigma), stock 10 mg/mL.   
   4.    Lysozyme 100 mg/mL (Sigma).   
   5.    Triton X-100 10 % stock in dH 2 O.   
   6.    For purifi cation with pCAL-n   :

 –    Calmodulin affi nity resin (Stratagene).  
 –   Calcium-binding buffer (CaCl 2 BB): 50 mM Tris–HCl 

(pH 8.0), 150 mM NaCl, 10 mM β-mercaptoethanol, 
1 mM magnesium acetate, 1 mM imidazole, and 2 mM 
CaCl 2 .  

 –   Elution buffer  I : 50 mM Tris–HCl pH 8.0; 10 mM 
β-mercaptoethanol; 2 mM EGTA; and 150 mM NaCl 
( see   Note 5 ).  

 –   Elution buffer  II : 50 mM Tris–HCl pH 8.0; 10 mM 
β-mercaptoethanol; 2 mM EGTA; and 1 M NaCl.      

   7.    For purifi cation with pET32 vector, use His Bind purifi cation 
kit (Novagen) and Ni-NTA His Bind Resin    (Novagen).   

   8.    Poly-Prep chromatography columns (Bio-Rad).   
   9.    PD-10 columns (GE Healthcare).   
   10.    Vivaspin columns (Sartorius Stedim Biotech): 10,000 or 

30,000 MWCO.      

      1.    Sea urchin injection buffer: 20 mM PIPES, 500 mM KCl, and 
0.1 mM EGTA; pH 6.8 is for injection into unfertilized eggs 
and pH 7.2 into embryos.   

   2.    Poly- L -lysine (Sigma), 1 or 10 % stock.   
   3.    Micropipettes, GC150F-10 (Harvard Apparatus).   
   4.    Imaging and microinjection chambers ( see   Note 10 ).       

3    Methods 

       1.    Prepare 1:10 dilution of your DNA construct, for example, 
pCAL-n GFP–PCNA, in DNAse-free water. Prepare a bucket of 
ice, 37 and 42 °C water baths/heaters, SOC medium, and LB 
agar plates supplemented with ampicillin ( see   Notes 4  and  6 ).   

   2.    Take 20 μL of BL21(DE3)pLysS,  E. coli  (Stratagene;  see   Note 3 ) 
and thaw on ice (the volume of competent cells varies, and 
homemade cells can be used at 100 μL volume as their 
 competency is usually lower).   

2.3  Purifi cation 
of Fusion Proteins

2.4  Microinjection
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   3.    Add 1 μL of 1:10 dilution of your plasmid into the bacteria 
solution and gently mix (fl ick with your fi nger, NEVER vortex 
competent cells). Leave on ice for 30 min.   

   4.    After 30 min, apply the heat shock by placing the tube for 
1 min in the 42 °C water bath. Although the duration of this 
step is critical and varies between 20 s and 1.5 min, we found 
the best transformation after 1 min.   

   5.    Put the tube with the transformation reaction on ice for 2 min 
following by addition of 200 μL SOC medium and incubate 
for 0.5–1 h in the 37 °C water bath. Although mild shaking is 
recommended (250 rpm), we noticed that without shaking, 
we also obtain a high effi ciency of transformation.   

   6.    Instead of 200 μL of SOC, 0.9 mL of SOC medium can also 
be added, and this step is then followed by light centrifugation 
after the 37 °C incubation to concentrate the cells. The cell 
pellet is then resuspended in 200 μL of fresh SOC medium.   

   7.    Spread the cells on LB agar plates (approximately 50–100 μL 
per plate) with a sterile spreader and incubate the plates at 
37 °C overnight.   

   8.    The next day there should be lots of colonies on the plates.      

         1.    Prepare 200 mL of sterile 2XYT for overnight culture and few 
fl asks of 500 mL sterile 2XYT for protein expression. A smaller 
volume of medium in the fl ask will make growth conditions 
better for the bacteria. Before use, add 1:1,000 dilution of 
ampicillin from the stock.   

   2.    Divide 200 mL of 2XYT broth medium supplemented with 
ampicillin between 12 × 50 mL tubes. Each of the tubes should 
contain approximately 15 mL of medium.   

   3.    Pick up a single colony with a sterile tip and inoculate the fi rst 
tube leaving the tip inside. Each tube should be inoculated 
with a single colony. Put the tubes into a 37 °C orbital shaker 
overnight.   

   4.    It is important to establish which colony is the best for large- 
scale expression. For this purpose, a small-scale culture 
should be undertaken. For each overnight culture, prepare 
two separate tubes with 0.9 mL of fresh 2XYT medium sup-
plemented with ampicillin.   

   5.    Add 0.1 mL of overnight culture to each of the two tubes 
and 2.5 μL of IPTG (fi nal conc. 0.5 mM) to only one of them 
( see   Note 7 ).   

   6.    Put all tubes into the 37 °C orbital shaker for 2 h.   
   7.    After this time, move 1 mL of each culture to the Eppendorf 

tubes and centrifuge at room temperature:    9,300 ×  g  for 
3 min.   

3.2  pCAL-n GFP–
PCNA Expression and 
Purifi cation Conditions
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   8.    Remove the medium and resuspend the pellet in 100 μL of 2× 
SB, and boil for 5 min in 95 °C.   

   9.    Apply 10–15 μL from each tube, placing IPTG-induced sam-
ple next to the control sample. GFP/RFP–PCNA will run at 
~80 kDa on 10 % Bis-Tris gel. We use NuPAGE precast gels 
(Invitrogen), but 10 % homemade gels are also as good as the 
precast ones. Precast gels usually run for 1 h at 180–200 V 
during SDS–PAGE electrophoresis.    

   10.    For large-scale expression, use colonies that show the best 
ratio between induced and noninduced samples at the expected 
protein size level. Add 5–15 mL from overnight culture into 
500 mL of 2XYT supplemented with ampicillin (0.5 mL of 
stock).   

   11.    Grow bacteria in a 37 °C orbital shaker (180 rpm) until 
OD 600  = 0.5–0.6. When the cells reach the appropriate density, 
add 1.25 mL of IPTG (fi nal conc. 0.5 mM) and allow them to 
progress at the same temperature for the next 3 h.   

   12.    After this time, place each 500 mL culture in a separate 
500 mL centrifuge container and spin at 10,800 ×  g  for 8 min 
in fi xed angle rotor (we use Sorvall centrifuge RC-5B Plus and 
SLA-3000 rotor).   

   13.    After centrifugation, the pellet should be green (in the case of 
a GFP fused protein). If you don’t see clearly a green (or light 
green) pellet, it is possible that either the bacteria did not 
express the recombinant protein, usually due to defective 
DNA sequence or growth conditions; if the latter, these need 
to be adjusted see below for other proteins. If you see a clear 
greenish pellet, remove the medium and freeze the containers 
at −80 °C until purifi cation. We often freeze the pellet at 
−20 °C for couple of days before purifi cation.      

           1.    For GFP–PCNA purifi cation, we follow the Stratagene protocol 
with some modifi cations.   

   2.    Thaw containers containing the bacterial pellet on ice.   
   3.    Resuspend the pellets with ice cold CaCl 2 BB supplemented 

with protease inhibitors (2 μg/mL leupeptin, pepstatin, apro-
tinin, 1 mM benzamidine fi nal concentration) and put the 
contents into sterile 50 mL tubes.   

   4.    Use 30 mL of the buffer per 1 L of bacteria culture. This solu-
tion can be supplemented with lysozyme (fi nal concentration 
of 200 μg/mL). The tubes are incubated for 15 min at room 
temperature on the roller. Alternatively, resuspended pellets 
can be put into the liquid N 2  for 15 min followed by thawing 
in a 30 °C water bath.   

   5.    Sonicate the contents on ice for 30 s on the pulse setting and 
40 % duty cycle (Cole-Parmer ultrasonic homogenizer 4710, 

3.3  Purifi cation of 
pCAL-n GFP–PCNA
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250 W, 20 kHz on control setting number 4). Check the 
viscosity of the contents. If the liquid contains fl occulations, 
repeat the sonication step. Don’t over sonicate as this can 
result in protein damage.   

   6.    Add DNAse I and RNAse A to a fi nal concentration of 5 μg/mL 
and leave on the roller at room temperature for 15 min. If the 
liquid is still thick and gluey, leave it for another 15 min.   

   7.    After this time, the viscosity of the liquid should be low. 
Centrifuge the tubes at 15,000 ×  g  for 30 min at 4 °C (or 
45 min at 10,500 ×  g ) ( see   Note 8 ).   

   8.    Prepare the calmodulin affi nity resin (Stratagene) on the column 
(we use BIO-RAD Poly-Prep chromatography columns, cat nr 
731-15550).   

   9.    Load the column with the resin (~1 mL of resin per 1 L of 
culture) and wash the resin with 50 mL of CaCl 2 BB (no 
inhibitors).   

   10.    The washed resin removed from the column should be com-
bined with the supernatant from step 7 in 50 mL tube/s and 
incubate on the roller at 4 °C overnight.   

   11.    Next day, load the column with the content of the tubes. You 
should be able to see green resin (or another color depending 
on the fl uorescent tag) on the bottom of the tube.   

   12.    After removing unbound supernatant (it can be collected and 
used again if the expression yield was very high), wash the 
remaining resin in the column with at least 200 mL of 
CaCl 2 BB. Ideally, the buffer will remove all unbound proteins 
leaving only these bound to the resin.   

   13.    The eluate from the column has to be as pure as possible. 
Check the eluted liquid in glass cuvettes at OD 280  during the 
buffer washing step. We usually proceed with protein elution 
when OD 280  < 0.03–0.003. If the OD is still high ~0.8, extend 
the washing time of the column.   

   14.    Depending on the scale of culture, prepare appropriate amount 
of collecting tubes for elution I and elution II.   

   15.    For 2 L of culture, use ~8–12 tubes for elution step I and ~8 
tubes for elution step II. In case of fl uorescent proteins, the 
elution step is easy to see as it is obvious when the protein 
leaves the column.   

   16.    Apply elution buffer I to the column and collect 1 mL of the 
fraction.   

   17.    When a low concentration of salt does not elute the entire 
protein (as judging by color remaining on the column), use 
elution buffer II with higher salt concentration and collect 
samples in the remaining tubes.   

   18.    Prepare twin tubes for each fraction with 3 μL of 5× SB.   
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   19.    Add 17 μL from each fraction to the corresponding tubes. 
Keep the eluted samples on ice.   

   20.    Run SDS–PAGE electrophoresis of all your sample elutes to 
establish which sample contains the purest and the highest 
amount of GFP–PCNA.   

   21.    Exchange the buffer as in Subheading  3.7 .      

      1.    The construct has been transformed into high-effi ciency 
Origami(DE3)pLysS expression strain. Because p27 is an 
inhibitor, we were interested in producing active protein in 
reasonable quantity.  E. coli  Origami-competent cells grow 
much more slowly than BL21 or Tuner allowing much better 
protein folding.   

   2.    The small-scale culture is the same as in Subheading  3.2 .   
   3.    Grow large-scale culture at 20 °C until OD 600  ~ 0.6–0.8.   
   4.    Add IPTG to the fi nal concentration of 0.2 mM and allow the 

expression for the next 6 h.   
   5.    Alternatively decrease the temperature to 16 °C after induc-

tion and allow expression for the next 24 h. We noticed that in 
case of this protein slightly higher temperature decreases the 
amount of soluble protein by 50 %. On the other hand, using 
pET32a vector produces an extremely high yield of p27 Kip1 , 
but with signifi cant cleavage of the protein. Lower tempera-
ture allowed us to obtain 7 mg/mL of p27 Kip1  from 2 L of 
bacterial culture.   

   6.    For purifi cation, follow the protocol for GFP–PCNA 
(Subheading  3.3 ).   

   7.    CBP_p27 Kip1  migrates at about 30 kDa marker on 10 % 
Bis-Tris gel.      

   For small-scale culture, follow the protocol in Subheading  3.2 . 
The difference is that for pET32a GFP-cyclin E and GFP/RFP- 
cdk2, use Terrifi c broth medium supplemented with 1 % glucose 
instead of 2XYT medium:

    1.    BL21(DE3)pLysS are good for expression of cyclin E and 
cdk2. Grow the culture at 30 °C until OD 600  = 0.6. We used 
0.2 mM IPTG to induce the expression, but this could be 
adjusted depending on the expression yield expected.   

   2.    After induction, decrease the temperature to 20 °C for 12 h 
allowing slower growth and better protein folding.   

   3.    Purifi cation of His-tagged proteins requires an Ni-NTA His 
binding resin. We used the His-tag purifi cation kit from 
Novagen, but other companies also provide similar prepared 
buffers.   

3.4  pCAL-n p27 Kip1  
Expression Conditions

3.5  Expression and 
Purifi cation of pET32a 
GFP- Cyclin E and GFP/
RFP-cdk2
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   4.    Bacterial pellets were thawed on ice and resuspended in binding 
buffer (Novagen) supplemented with protease inhibitors at the 
same concentrations as for CaCl 2 BB and 0.05 % fi nal concen-
tration of Triton X-100. Use 40 mL of the buffer for 1 L of 
bacterial culture. This stage should be performed on ice.   

   5.    Add 100 μg/mL of lysozyme and leave on a roller for 15 min 
at room temperature.   

   6.    Follow the protocol in Subheading  3.3 .   
   7.    Sonicate the solution on ice as in Subheading  3.3  ( step 5 ) and 

leave for 15 min on ice.   
   8.    Check the viscosity. If the liquid is still viscous, add DNAse I 

and RNAse A as in Subheading  3.3 .   
   9.    Prepare His bound resin on the column washing with the buf-

fers provided. This step should be followed according to the 
manufacturer’s protocol.   

   10.    Add washed resin to the supernatant and leave on the roller 
for 30 min at room temperature.   

   11.    Apply the total content of the tube to the column and wash 
the resin with binding buffer (Novagen). We usually use three 
times more buffer at this step than recommended by 
manufacturer.   

   12.    Usually, it is one-step elution, and the protein comes off the 
column within the fi rst few fractions.    

    Geminin is a very soluble protein; however, the additional fl uores-
cent tag at the C-terminus requires specifi c expression conditions. 
We found that RFP (or other fl uorescent tags) attached to the 
C-terminus does not interfere with cell cycle activity of geminin:

    1.    Transform the construct into the Rosetta-gami  E. coli  strain 
(Novagen) as in Subheading  3.1 .   

   2.    For small-scale culture, follow the protocol at Subheading  3.2  
including the use of 2XYT medium supplemented with 
ampicillin.   

   3.    For the large-scale culture, grow bacteria at 20 °C until 
OD 600  ~ 0.6–0.8, which can take up to 12 h as Rosetta-gami 
grows very slowly. The yield of the protein is lower, but the 
activity very high.   

   4.    Induce bacteria with 0.2 mM IPTG and continue growing for 
the next 12 h at the same temperature.   

   5.    After centrifuging as in Subheading  3.3 , the pellet is usually 
very pink (for geminin–RFP).    

   6.    For the purification, follow the protocol for His-tagged 
proteins above (Subheading  3.5 ).      

3.6  Expression 
Conditions for His 
Geminin–RFP
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       1.    Choose the appropriate number of PD-10 columns sample 
concentrators you want to use for the buffer exchange 
remembering that for each column, 2.5 mL of sample can 
be used, for example, 2 columns for 5 mL of eluted protein.   

   2.    Equilibrate the column with 25 mL of the sterile injection 
buffer pH 6.8 (or pH 7.2).   

   3.    Apply 2.5 mL of your sample allowing it to settle on the resin 
and removing the column discharge.   

   4.    Elute your protein with 3.5 mL of the injection buffer (collect 
the eluted protein!).   

   5.    GFP/RFP–PCNA molecular weight is ~80 kDa, so to con-
centrate the protein, we use Vivaspin 6 columns with the 
membrane having a 30,000 molecular weight cutoff (MWCO); 
however, 50,000 will be still ok. For smaller proteins such as 
CBP_p27 Kip1  with MW ~ 30 kDa, use a 10,000 MWCO 
membrane.   

   6.    Apply your samples on the column sample concentrator and 
spin in swing-out rotor 4,000 ×  g  for 20 min. Depending on 
how much final concentration is needed, extend the time 
of centrifugation. This step requires constant checking as if 
the centrifugation time is too long, your protein will be left 
on the membrane and you may not recover it!      

  For precise small micropipettes, we used a micropipette puller from 
Sutter Instrument CO., Model P-97. It gives a broad range of 
required tips. In our applications, we use different microinjection 
systems with oil or air pressure. For air pressure, we used either 
pneumatic PicoPump PV820 or integrated FemtoJet from 
Eppendorf. We also used Eppendorf micromanipulator InjectMan 
Ni 2 to introduce the microinjection needle into the egg/embryo.

    1.    Eggs or embryos have to be immobilized on 0.01–0.001 % 
poly- L -lysine [ 13 ]. Poly- L -lysine sticks very well to the glass 
bottom of the chamber ( see   Note 9 ); the excess of poly-
 L -lysine needs to be removed before sea water is applied into 
the chamber ( see   Note 10 ). Immobilization can be used for 
dejellied eggs or embryos without fertilization envelope as 
well as 72 h larvae.   

   2.    It is important to place the pipette in the right angle to allow 
one sharp push into the egg (50–55°).   

   3.    With your naked eye, place the needle above the chamber 
directly above the objective. Lower it slowly.   

   4.    Looking at the eyepiece, you should easily see the shadow of 
the pipette. Place the micropipette end of the tips on the 
egg/embryo.   

3.7  Buffer Exchange 
and Protein 
Concentration
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   5.    Either using a Piezo advance (PM 20,   http://www.wpi-europe.
com/en/products/microinjection/piezo.shtml    ) or with a sharp 
push, place the end of the pipette in the egg. Release your 
solution into the egg and slowly remove the pipette. This step 
requires a lot of practice. Depending on the system, it may 
easily damage or activate an egg.   

   6.    Depending on the protein concentration in the tube, sharper 
tips are much better. Sea urchin eggs are very delicate and 
accept between 100 pL and 1 nL of injected volume. Higher 
volumes may easily damage the egg.   

   7.    Unfertilized eggs are usually suitable for injection after dejell-
ing for 30 min–1 h. It is a good idea to prepare a fresh batch 
of eggs after this time.   

   8.    Injection of proteins usually requires slightly bigger diameter 
of tips. It is possible to overcome this problem by simple dilu-
tion of the protein. For example, typical concentration of 
GFP–PCNA should be no more than 2 mg/mL in the tube.   

   9.    It is problematic to inject fl uorescently labelled tubulin (Figs.  2  
and  3 ). Usually, Cytoskeleton Inc. provides tubulin which can 
be injected into the sea urchin eggs or embryos; however, high 
concentration of this protein requires needles to be ice cold, and 
even if they are kept on ice, the protein blocks the pipette after 
just one injection. We found that simple dilution of tubulin by 
at least three or fi ve times increases its fl ow through a pipette 
and also cells survive such a concentration much better.

  Fig. 2    FITC tubulin. Accumulation of PCNA at the beginning of the second S phase occurring before completion 
of the fi rst cytokinesis. ( a ) GFP–PCNA in  L. pictus ; bar 50 μm. ( b ) Green tubulin injected together with RFP–
PCNA into  P. miliaris ; 50 μm       
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4             Notes 

     1.    pCAL-n vector contains a CBP (calmodulin-binding peptide)-
coding sequence upstream of the multiple cloning site. 
The presence of the T7 promoter and T7 terminator makes it 
easy to sequence the insert. We would not recommend this 
vector for in vitro transcription as the mRNA would also con-
tain the sequence for CBP which makes the cellular expression 
of the insert ineffi cient. The pCAL-n vector is very effi cient for 
highly soluble proteins such as GFP–PCNA, but based on our 
experience, it is less suitable for less soluble proteins such as 
pre-RC proteins.   

   2.    The pET32a vector system was obtained from Novagen. 
Additional protocols associated with the system can be found 
at   www.Novagen.co.uk     (His Bind kit manuals   ). The vector 
used by us has a very broad spectrum of restriction sites allow-
ing straightforward cloning strategies. For us, the advantage 
of this vector was the His-tag from N- and C-terminus together 
with the T7 promoter and T7 terminator. This vector also 
gives high level of expression in combination with the appro-
priate  E. coli  strain hosts and adjusted expression conditions. 
Using Novagen reagents, we modifi ed the purifi cation 
procedure.   

   3.     E. coli  expression strains can be commercially purchased or 
homemade and should be always aliquoted and stored in 
−70 °C. Avoid multiple freeze-thaw cycles as this decreases 

  Fig. 3    Fluorescein-labelled tubulin injected together with RFP–PCNA into unfertilized eggs of  S. miliaris . Tubulin 
was diluted 1:5 and injected together with recombinant PCNA. ( a ) Mitotic spindle at metaphase. ( b ) The second 
S phase begins before the fi rst cytokinesis. Bar 50 μm       
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strain competency and results in a loss of effi ciency. BL21(DE3)
pLysS-competent cells are used for general expression of 
soluble, nontoxic proteins. This strain can inhibit induced 
expression, and we do not recommend this strain for less 
soluble proteins.   

   4.    LB agar plates 1 L: Dissolve 37 g of LB agar in 1 L of deion-
ized water, autoclave, and store until use. Before preparation 
of the plates, boil agar in a microwave until the medium is 
melted. Allow the temperature of the medium to decrease 
enough for antibiotic to be added. After antibiotic addition, 
resuspend the medium on Petri dishes and allow setting in 
room temperature. The plates can be stored in 4 °C for many 
weeks covered with foil to protect drying.   

   5.    For 20 mL of elution buffer I: Add 1 mL of 1 M Tris–HCl 
(pH 8.0), 15.0 μL of β-mercaptoethanol, 0.2 mL of 200 mM 
EGTA, and 0.75 mL of 4 M NaCl. 

 For 20 mL of elution buffer II: Add 1 mL of 1 M Tris–
HCl (pH 8.0), 15.0 μL of β-mercaptoethanol, 0.2 mL of 
200 mM EGTA, and 5 mL of 4 M NaCl.   

   6.    Ampicillin stock is 100 mg/mL in double deionized (dd) 
water, and we use 1:1,000 dilution, for example, 0.2 mL per 
200 mL of medium.   

   7.    Concentration of IPTG should be established. We found no 
difference between 0.2 and 0.5 mM.   

   8.    Remember to take small samples of the suspension before cen-
trifuging and after a sample of both the supernatant and the 
pellet. This will give an indication of how much protein 
remains in the pellet and how much is in a soluble form.   

   9.    The bottom of the glass chamber is covered by poly- L -lysine 
(Sigma) up to the fi nal concentration of 0.01 % in water. 
Higher concentration of poly- L -lysine results in embryonic 
death. Lower concentration then 0.001 % will not keep eggs 
in one place during microinjection. It may also result in 
detaching embryo during imaging.   

   10.    Chambers: For in vivo imaging with inverted microscope, it is 
important that chambers have glass bottom. We use plastic 
edges covered with high-vacuum silicone grease (VWR inter-
national) to stick 22 × 64 borosilicate cover glass thickness 
No.1 (VWR).         
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    Chapter 16   

 Immunoblotting Analyses of Changes in Protein 
Phosphorylations During Oocyte Maturation 
in Marine Nemertean Worms 

           Jose     R.     Escalona     and     Stephen     A.     Stricker    

    Abstract 

   Immunoblotting analyses combined with phospho-specifi c antibodies can provide a powerful means for 
assessing protein activity states in various cellular extracts. This chapter describes a traditional, fi lm-based 
immunoblotting method for monitoring the phosphorylation status of proteins in marine nemertean 
oocytes undergoing maturation. Similarly, with minor modifi cations, the protocol could potentially be 
applied to a wider variety of cellular processes and extract types that might be analyzed in other investigations 
of marine invertebrate development.  

  Key words     Western blots  ,   Kinases  ,   Lysis buffer  ,   SDS-PAGE  ,   Enhanced chemiluminescence  

1       Introduction 

 In order for development to proceed normally, oocytes must 
undergo a complex maturation process that is typically controlled 
by various protein kinases and phosphatases [ 1 ,  2 ]. Such kinases 
and phosphatases in turn modulate the phosphorylation status of 
several key regulatory proteins, thereby altering the activity states 
of these targeted regulators. In order to monitor the types of 
protein phosphorylations that occur during oocyte maturation, 
extracts of maturing oocytes can be subjected to immunoblotting 
analyses utilizing phospho-specifi c antibodies that determine 
whether or not critical sites on the assayed proteins are phosphory-
lated and thus modifi ed to either up- or downregulate protein 
activity. Final processing and quantifi cation of such immunoblots 
can be done with a turnkey system that allows high-sensitivity 
detection of signal over a relatively wide dynamic range without 
the need for fi lm processing (e.g., the Odyssey Infrared Imaging 
System,   www.licor.com    ). Alternatively, in the absence of an initial 
capital outlay for such automated instrumentation, it is also 
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possible to conduct the immunoblotting via a more traditional 
method that involves the detection of blots on fi lm. 

 This chapter describes a fi lm-based protocol for assaying 
immunoblots probed with phospho-specifi c antibodies, as specifi -
cally applied to analyses of maturing oocytes obtained from marine 
nemertean worms [ 3 ,  4 ]. As such, the techniques covered here 
are suitable for use at marine biology stations that might not 
be equipped with automated immunoblotting detection systems 
[ 5 – 12 ]. Moreover, these methods should also be adaptable for 
applications with other types of eggs or with extracts of non-egg 
tissues that might be assessed during alternative investigations of 
marine invertebrate development.  

2               Materials 

 Solutions should be mixed with high-quality (e.g., Milli-Q) water 
and, unless stated otherwise, prepared fresh from newly dissolved 
reagents or from stocks maintained at either room temperature or 
4 °C (see specifi c comments next to the various recipes). 

      1.    Lysis buffer: 100 μL 0.5 M HEPES, pH 7, 750 μL 0.5 M 
NaCl, 1,250 μL 2 % NP-40, 150 μL 1 M β-glycerophosphate, 
150 μL 0.25 M EGTA, pH 8, and 100 μL 1 M NaF. Just 
before vortexing and subsequent use on samples, add to the 
above the following: 4.5 mg sodium orthovanadate, 25 μL 
100 mM PMSF (from aliquots dissolved in DMSO and stored 
at −20 °C), and ¼ tablet of Complete Protease Inhibitor Mini 
Tablet (Roche Diagnostics, Mannheim, Germany). Combine 
all nine components listed above and vortex for 2 min; let sit 
on ice for 10 min and transfer fl uid component to microcentri-
fuge tube to avoid froth on top. Formulation is based on a 
recipe from ref. [ 13 ], using stocks stored at 4 °C, and makes 
2.5 mL (i.e., enough for at least 50 protein assay samples).   

   2.    10 % resolving gel: 16.4 mL Milli-Q water, 13.2 mL premixed 
acrylamide solution (37:5:1, Bio-Rad Corp., Hercules, CA, 
#161-0158), 10 mL 1.5 M Tris–HCl resolving buffer, pH 8.8, 
400 μL 10 % SDS (w/v), 200 μL 10 % ammonium persulfate 
(freshly made), and 20 μL TEMED. In a sidearm Erlenmeyer 
fl ask, add solutions in the order listed and gently swirl ~10 
times in each direction to mix without generating bubbles.   

   3.    4 % stacking gel: 12.2 mL Milli-Q water, 2.6 mL premixed 
acrylamide solution (37:5:1, Bio-Rad Corp., Hercules, CA, 
#161- 0158), 5 mL 0.5 M Tris–HCl stacking buffer, pH 6.8, 
200 μL 10 % SDS (w/v), 100 μL 10 % ammonium persulfate 
(freshly made), and 20 μL TEMED. Mix as described above 
for the resolving gel. The above “quadruple-batch” gel recipes 

2.1  SDS 
Polyacrylamide Gel 
Components
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make enough monomer for four 4 %/10 % gels that can be 
used to separate various proteins in the 20–250 kDa MW range 
when the four gels are run simultaneously as two pairs con-
nected to two electrophoresis power packs. For running just 
two gels, halve the amounts, and when analyzing relatively 
high- or low- MW proteins that are not suitably separated with 
such a 4/10 formulation, gel concentrations can be altered to 
optimize protein separations (see Bio-Rad Instruction Manual 
for Mini-PROTEAN Tetra Cell, for further details). Note: 
Acrylamide is toxic and should be handled with care. Allow 
leftover monomer mixes to polymerize overnight so that the 
less toxic solid form of the gel can be disposed more safely.   

   4.    Sample buffer: 3.55 mL Milli-Q water, 1.25 mL 0.5 M Tris–
HCl, pH 6.8, 2.5 mL glycerol, 2 mL 10 % SDS (w/v), and 
0.5 % 0.2 mL bromophenol blue (w/v). This formulation is 
based on a recipe in ref. [ 14 ], using stock solutions stored at 
room temperature. Just before use on samples, add appropriate 
amount of DTT ( see  Subheading  3.1 ,  step 3 ).   

   5.    10× running buffer: 30.3 g Tris–HCl, 144 g glycine, and 10 g 
SDS. Bring all three to 1 L in Milli-Q water. Stock solution is 
stored at room temperature; 1× working solutions can also be 
used after several months of storage at 4 °C.      

      1.    Transfer buffer: 3.03 g Tris–HCl, 14.4 g glycine, 800 mL 
Milli-Q water, and 200 mL methanol (spectroscopy grade or 
higher quality). After mixing the above on a stirrer, add 0.5 g 
SDS and stir for at least an additional 15 min. For each run, 
make 1 L for two transfers or 2 L for four transfers.   

   2.    10× TBS (Tris-buffered saline) washing solution: 80 g NaCl, 
24.2 g Tris–HCl, and ~800 mL Milli-Q water. Dissolve and 
pH to 7.6 with concentrated HCl before bringing up total to 
1 L. Stock solution is stored at room temperature. Make at 
least 250 mL of 1× working solution for each run.   

   3.    TTBS (Tween-Tris-buffered saline): To each liter of 1× TBS 
solution, add 500 μL of Tween-20 and stir for at least 15 min. 
Make 2 L of TTBS for each run. Stored at room temperature, 
this TTBS working solution is used for all washes of mem-
branes except for the last (plain TBS) washes before conduct-
ing the enhanced chemiluminescence (ECL) protocol.   

   4.    Blocking solution: 5 % nonfat dry milk freshly dissolved in 
TTBS.   

   5.    Cold stripping buffer (made fresh just before use): 3 g glycine, 
0.2 g SDS, and 80 mL Milli-Q water. Put on stirrer and pH to 
2.2 with 6 N HCl (takes ~6 mL). Bring up to 98 mL in a grad-
uated cylinder and add 2 mL Tween-20. Mix up and down 
numerous times to dissolve the Tween.      

2.2  Transfer 
Components
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      1.    Clear plastic wrap (e.g., Saran wrap).   
   2.    White refl ective screen (fold a 8.5 × 11 in. white paper in half, 

and have the 5.5 × 8.5 in. doubled sheet laminated at a print 
shop. Make several screens for multiple ECL incubations).   

   3.    Forceps.   
   4.    Laboratory tape.   
   5.    Plastic transfer pipettes.   
   6.    Book with a black non-refl ective cover.   
   7.    Timer.   
   8.    Sharpie marker.   
   9.    X-ray fi lm, 5 × 7 in. for mini-blots (Sterling X-ray fi lm from Life 

Science Products, Frederick, CO, has better sensitivity and 
costs less than comparable Kodak fi lm).   

   10.    Enhanced chemiluminescence solution (keep in dark and 
combine the two components of the ECL in the darkroom 
immediately before use on the blots).       

3     Methods 

       1.    Make lysis buffer as directed in Subheading  2 . Add 36 μL to 
each sample and vortex for 25 s so that froth is visible in each 
tube. Centrifuge samples at 4 °C and 16,000 ×  g  for 12 min in 
a microcentrifuge. Maintain samples throughout the proce-
dure on ice, and after protein assays have been completed, 
store at −20 °C ( see   Note 1 ).   

   2.    After centrifugation, transfer 2 μL of the supernatant from 
each sample into a cuvette containing 798 μL of Milli-Q water 
for the protein assay. Set aside the cuvettes and continue 
processing the samples as described below.   

   3.    After removing the 2 μL aliquot for a protein assay, add 26 μL 
of freshly made sample buffer (850 μL of stock solution from 
Subheading  2  plus 150 μL of 1 M DTT added just before use) 
to the remaining 34 μL of lysed sample. Mix by briefl y vortex-
ing and snap spin the tubes to bring down the sample. Boil 
the tubes for 4 min and subsequently store them at −20 °C 
( see   Note 2 ).   

   4.    After boiling the samples in sample buffer, add 200 μL of 
Bradford reagent (Bio-Rad, Hercules, CA) to each cuvette. 
Mix gently to avoid excessive bubbles by pipetting up and 
down with a plastic transfer pipette until the solution is a uniform 
color ( see   Note 3 ).   

   5.    Read the absorption of each cuvette at 595 nm, using a cuvette 
containing 798 μL of Milli-Q water, 2 μL of lysis buffer, and 
200 μL of Bradford reagent as the blank.   

2.3  Supplies to Take 
to the Darkroom When 
Developing Film

3.1  Sample 
Processing
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   6.    To convert absorbance into total protein per sample, construct 
a standard curve based on serial dilutions of bovine serum 
albumin.      

      1.    Use either precast gels (e.g., Bio-Rad Mini-PROTEAN TGX) 
or pour gels as follows: fi rst, prepare resolving gel solution 
according instructions in Subheading  2  ( see   Note 4 ).   

   2.    Using a pipette, add the gel fl uid slowly and steadily to the side 
of the glass plates, to avoid introducing bubbles. In order to 
leave room for the stacking gel, the resolving gel should 
extend to 1 cm below the level of where the comb of the wells 
will protrude once inserted into the overlying stacking gel 
( see   Note 5 ).   

   3.    After the gel has been poured, gently add a Milli-Q water cap 
until the water reaches the top of the short plate. Let the gel 
polymerize for at least 45 min at room temperature ( see   Note 6 ).   

   4.    Following gel polymerization, pour out the water cap by tilting 
the glass plates, and use a paper towel to remove the remaining 
water without touching the gel.   

   5.    Mix the stacking gel according to the recipe in Subheading  2  
and pipette it on top of the resolving gel, fi lling to the top of 
the short glass plate. To avoid squirting out liquid acrylamide, 
tilt the comb and slowly insert from one side rather than rapidly 
putting it in straight down on the stacking gel.   

   6.    Let stacking gel polymerize for 45 min, and then cover with 
plastic wrap and keep in the refrigerator for use within the next 
few days.   

   7.    Mix up 1× running buffer and store in refrigerator overnight 
so it will be cold when used.      

      1.    Thaw frozen samples that had been boiled in sample buffer 
and vortex them briefl y to mix.   

   2.    Place the gel into its holder ensuring there is a good seal 
(Fig.  1 ). Once assembled, put the holder with its two gels in a 
gel rig and add cold running buffer ( see  Subheading  2 ) into the 
central area between the two sets of gels. Pour remaining run-
ning buffer outside the gels to fi ll the container ( see   Note 7 ).

       3.    Based on the protein assays, load the equivalent of 25 μg of 
total protein per well using a gel-loading pipette with its tip 
placed against the edge of the short glass to ensure that the 
fl uid fl ows into the well. It is important not to overload the wells. 
To determine well capacities in gels of varying thicknesses, 
consult the Bio-Rad Instruction Manual for Mini-PROTEAN 
Tetra Cell. Fill all wells; if one is to be left blank, add sample 
buffer. Also, add molecular weight markers to one or two of 
the lanes ( see   Note 8 ).   

3.2    Gels

3.3   Electrophoresis
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   4.    Plug the gel apparatus into an appropriate power supply that is 
set to a constant voltage of 100 V, and run the gel until the dye 
front is ~0.5 cm from the bottom (about 2–2.5 h) ( see   Note 9 ).      

      1.    After electrophoresis has been completed, turn off the power 
supply and carefully separate the gel plates. Using a clean razor 
blade, remove the stacking portion of the gel and rinse the 
remaining resolving gel in Milli-Q water for a few seconds.   

   2.    After rinsing, equilibrate the gel in transfer buffer 
( see  Subheading  2 ) for 15 min on an orbital shaker.   

   3.    While the gel is equilibrating, manually agitate for 90 s in 
methanol PVDF membranes (Bio-Rad, Hercules, CA), which 
had been precut to ~5.5 × 8.5 cm rectangles for use in a mini-blot 
apparatus. Discard the methanol and equilibrate the mem-
branes in transfer buffer for 15 min on an orbital shaker.   

   4.    Load the gels into the transfer setup in the correct order. For 
example, with Bio-Rad mini-blot transfer setups, start with the 
black side of holder on bottom, followed by sponge, fi lter paper, 
gel, membrane, fi lter paper, sponge, and clear side of holder. 
It is important to assemble this “sandwich” submerged in trans-
fer buffer in order to minimize trapped bubbles. To maintain the 
same order of the gel lanes on the blot, fl ip the gel horizontally 
so that the last lane of the gel is switched to the left side of the 
overlying membrane and thus will be on the right once the 
transfer is complete and the membrane is fl ipped over.   

3.4   Transfer

  Fig. 1    Proper assembly of the gel apparatus showing downward pressure while 
clamping with thumbs to minimize chances of leakage       
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   5.    Place the loaded sandwich into the transfer apparatus with the 
black side of the sandwich oriented toward the back of the 
chamber. Add a magnetic stir bar and place the transfer unit on 
a stirrer. Put in an ice pack and fi ll the unit with transfer buffer 
until the sandwich is completely covered.   

   6.    Turn on the stirrer, snap on the lid, and run the transfer at 100 
constant volts for 75 min. For two blots, the current should start 
around 230–270 mA and will gradually rise to 300–380 mA 
by the end of the run ( see   Note 10 ).      

      1.    When the transfer is complete, peel away the membrane (you 
should see the molecular weight markers on the membrane). 
If probing with multiple antibodies for proteins of divergent 
MWs, it may be possible to cut the blot into horizontal 
strips that can be incubated individually in smaller containers 
(Fig.  2 ). In any case, with full or cut blots, put the membrane 
directly in blocking solution ( see  Subheading  2 ) with the side 
that had been next to the gel faceup. Shake at room tempera-
ture on an orbital shaker for 60 min. Do not block for shorter 
or longer periods as this might result in increased  background 
or reduced signal ( see   Note 11 ).

       2.    Briefl y wash the blocked membrane with TTBS ( see  
Subheading  2 ) and add the primary antibody solution. Cover 
and agitate overnight at 4 °C ( see   Note 12 ).   

   3.    Decant the primary antibody solution, and retain for future 
use after freezing at −20 °C. Rinse the probed membranes with 
TTBS for 30 s; then, wash three times with minimal agitation 
for 5 min each in TTBS at room temperature ( see   Note 13 ).   

3.5   Antibody Probing

  Fig. 2    A topside and oblique view of an incubation chamber with a glued-down glass slide divider allowing two 
blot strips to be probed simultaneously       
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   4.    After washing, incubate with secondary antibody dissolved in 
blocking solution for 90 min at room temperature ( see   Note 14 ).   

   5.    Remove the secondary antibody, rinse for 30 s in TTBS, and 
wash twice for 10 min each in TTBS. After washing in TTBS, 
perform two 15 min washes in TBS ( see   Note 15 ).      

      1.    In addition to the probed membranes incubating in TBS, take 
to the darkroom items listed in Subheading  2 , and set up two 
pieces (~6 × 8 in.) of clear plastic wrap. Place the washed blots 
faceup on one sheet of wrap and quickly incubate them for 
90 s in the ECL solution. It is important to make sure that 
there are no dry spots on the blots.   

   2.    Remove the ECL solution and place the membranes facedown 
on the other sheet of wrap. Put a white refl ective screen on top 
of the membranes and neatly fold the wrap around the back of 
the screen before taping down the wrap. Make sure no bubbles 
or leaks are present.   

   3.    Turn off the room lights, and turn on red safety lights. Take out 
unexposed fi lm, keeping it a safe distance from the safety light, 
and place it on the ECL-loaded blots. Using a Sharpie, quickly 
make several small marks that extend across the edge of the fi lm 
to the refl ective sheet. This will allow subsequent orientation of 
the developed fi lm relative to the molecular weight markers.   

   4.    Cover with a book and expose. Exposure times vary depending 
on the intensity of the signal but are typically in the range of 
15 s–5 min ( see   Note 16 ).   

   5.    Place the fi lm in an automated fi lm processor or develop the 
fi lm manually using Kodak D19 developer and fi xer according 
to the manufacturer’s instructions.      

      1.    Keep the membranes in the refrigerator still wrapped in plastic 
on their white refl ective screens in order to avoid drying of the 
blots. For re-probing, remove the blots and quickly place them 
in stripping buffer ( see  Subheading  2 ) with agitation for 
30 min. Replace with fresh stripping buffer and agitate for 
another 30 min.   

   2.    Give the membranes three washes with TTBS for 15 min each.   
   3.    Incubate the membranes in freshly made blocking solution for 

1 h, transfer to primary antibody solution, and repeat the rest 
of the protocol as described above to get a second set of signals 
from the blot ( see   Note 17 ).      

      1.    Create a digital image of the blot signal that was recorded on 
fi lm.   

   2.    Invert the contrast so that background is dark, and the blot 
bands are light (this will allow higher-density bands to be 

3.6   Film Developing

3.7  Re-probing 
Stripped Membranes

3.8  Quantifi cation 
of Blot Intensities
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quantifi ed as higher numbers, as compared to lower-density 
bands) (Fig.  3 ).

       3.    Place a region of interest around each band to be quantifi ed 
and obtain an integrated intensity for that band using morpho-
metric software (e.g., MetaMorph, Molecular Devices, 
Sunnyvale, CA).   

   4.    After obtaining band densities, shift each region of interest to a 
background region of the fi lm and obtain a background read-
ing that is to be subtracted from the band intensity (thereby 
accounting for opacity in the fi lm itself). Such quantifi cation 
assumes that the blot signals are recorded in the linear range of 
the fi lm and are not either saturated or below a threshold 
detection value for the fi lm.       

4     Notes 

     1.    To adapt this protocol for non-oocyte cells or tissues, it may be 
possible to modify the lysis buffer and/or protein extraction 
steps. For example, longer incubations in lysis buffer or more 
stringent extractions employing sonication might be tried.   

   2.    When boiling samples, set the Bunsen burner/hot plate to the 
minimum required to obtain weak boiling, thereby reducing 
the chance of getting water into the sample should a tube pop 
open.   

  Fig. 3    Example of an original version of a blot ( top  image) and its inverted- 
contrast view ( lower  image) that in turn allows high-density bands to be recorded 
as high values during densitometric analyses       
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   3.    The same pipette can be used for more than one sample, as 
long as very little, if any, fl uid is transferred from one cuvette 
to the other. Also, the Bradford reagent loses signal over time, 
so the faster the readings are completed, the better.   

   4.    To mix the gel solution, gently swirl the container; if bubbles 
continue to appear in the blots, try degassing gel solutions for 
10 min in a vacuum prior to addition of the polymerizing 
agents (ammonium persulfate and TEMED).   

   5.    To determine the appropriate height of the resolving gel prior 
to gel pouring, place a comb within the gel plate setup and 
mark 1 cm below the bottom of the comb.   

   6.    Pour the water cap slowly to avoid mixing with the gel solution, 
which in turn can result in a curved gel front.   

   7.    Smaller quantities of running buffer can be used (e.g., as little as 
450 mL), but ~850 mL per gel setup ensures that any leakage 
from the central chamber will not lead to a signifi cant current 
decrease and an ensuing stoppage of the gel run.   

   8.    To reduce the amount of antibody solution needed, it is possible 
to cut the blot into strips that contain the proteins of the 
desired molecular weight for each antibody. These strips can fi t 
in containers that require as little as 8 mL to cover the blots 
entirely (Fig.  2 ). In order to help cutting horizontal strips for 
multiple antibody incubations, load two lanes of MW markers 
with one near either end of the gel.   

   9.    The current at the beginning of the run should be around 
45–55 mA and by the end of the run, about half of starting 
value. Because of this decrease, the E9 safety feature of certain 
Bio-Rad power supplies should be disabled prior to the start of 
the run to avoid having the power turn off as the current drops.   

   10.    It is possible to regulate the current by modulating the speed 
of the magnetic stirrer. Faster stirring will result in lower 
currents; adjust the speed until you reach the desired values.   

   11.    Thoroughly mix the milk into TTBS at least 30–60 min prior 
to blocking in order to avoid uneven blocking.   

   12.    Depending upon the strength of the primary antibody, try ini-
tial dilutions of 1:2,500–1:500 in TTBS containing 1–5 % 
bovine serum albumin as a blocking agent. For full blots, 
~18 mL of solution is required to cover the entire blot (however, 
 see   Note 8 ).   

   13.    It is possible to save some primary antibody solutions (e.g., 
phospho-ERK 1/2, phospho-Cdc2 Y15, phospho-AMPK 
T172) and freeze them at −20 °C for subsequent use on 
another blot. If the signal begins to fade, boost the solution by 
adding a few more microliters of concentrated antibody.   
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   14.    Following incubation in primary antibody, an appropriate 
secondary antibody conjugated to horseradish peroxidase 
(e.g., from Santa Cruz Biotechnology, Santa Cruz, CA). 
Initially, try a 1:5,000 dilution in blocking solution, and adjust 
accordingly.   

   15.    TTBS is to be avoided in the fi nal washes in order not to 
degrade the ECL signal.   

   16.    Keep the book still over the blot and fi lm in order to avoid 
blurring the signal. Use a book with a black non-refl ective 
cover. The ECL solution fades over time, with optimal results 
being achieved within 25 min of mixing. Because of this, later 
exposures take longer to get equivalent results; so, whenever 
possible, do longer exposures fi rst.   

   17.    Strong bands usually do not get fully stripped. Thus, it is better 
to probe for a weak band fi rst, and then probe the stronger 
band after stripping.         
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    Chapter 17   

 Multicolor Labeling in Developmental Gene 
Regulatory Network Analysis 

           Aditya     J.     Sethi    ,     Robert     C.     Angerer    , and     Lynne     M.     Angerer    

    Abstract 

   The sea urchin embryo is an important model system for developmental gene regulatory network (GRN) 
analysis. This chapter describes the use of multicolor fl uorescent in situ hybridization (FISH) as well as a 
combination of FISH and immunohistochemistry in sea urchin embryonic GRN studies. The methods 
presented here can be applied to a variety of experimental settings where accurate spatial resolution of 
multiple gene products is required for constructing a developmental GRN.  

  Key words     TSA Plus  ,   Digoxigenin  ,   Fluorescein  ,   Lineage  ,   Signaling  ,   Linkages  ,   Marker  ,   Perturbations  

1       Introduction 

 In recent years, considerable progress has been made towards 
elucidating gene regulatory networks (GRNs) underlying embry-
onic development [ 1 – 6 ]. Functional connections within and 
between GRNs are typically established by examining the responses 
of regulatory factor expression to experimental perturbations. For 
maximum accuracy, GRN responses need to be examined at several 
levels. These include quantitative measurements of transcript abun-
dance in the entire embryo [ 7 ], cis-regulatory analyses of genes 
encoding key factors [ 8 ,  9 ], and evaluations of gene function in 
specifi c blastomeres at defi ned developmental stages [ 10 ,  11 ]. 
The last type of analysis requires precise assessment of the spatial 
distribution of a gene product(s) of interest. 

 Optimum spatial resolution is critical when characterizing 
developmental GRNs for several reasons. First, during early 
embryogenesis, many key regulatory factors have dynamic expres-
sion patterns that evolve rapidly. Thus, within a few cell divisions, 
the same factor may be expressed in different blastomeres that give 
rise to distinct embryonic lineages [ 10 ,  12 – 16 ]. Important regula-
tory genes are also frequently expressed in precursors of multiple 
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lineages at a single developmental stage, and the same gene can 
have very different roles in each of these lineages [ 10 ,  14 ]. Also, 
experimental perturbations targeting a specifi c gene can have both 
localized and general developmental consequences. In such situa-
tions, whole-embryo measurements of gene product abundance 
are of limited value unless supplemented by accurate spatial data. 
Second, at early stages, embryos show relatively few morphological 
features that permit reliable identifi cation of specifi c blastomeres 
expressing a particular gene product(s). Consequently, they must 
be monitored at the molecular level. Third, during initial embry-
onic specifi cation, more than one lineage-specifi c GRN can oper-
ate in a group of progenitors [ 2 ]. Understanding GRN function 
during lineage segregation at these early stages therefore requires 
accurate spatial information about multiple gene products in the 
same blastomeres [ 2 ,  17 ]. In each of these situations, the distribu-
tion of a gene product(s) of interest needs to be resolved with refer-
ence to expression of a well-characterized molecular “landmark.” 

 Specifi c instances of GRN analysis where spatial assays are 
necessary for establishing accurate network connections include: 
 (a)  Identifying targets of transcription factors : Direct targets of key 
GRN transcription factors are expressed/repressed within several 
hours of their upstream regulators in the same cells. Indirect tar-
gets, on the other hand, can be regulated by transcription factor 
activities or intermediate signaling events within or outside an 
upstream factor’s expression domain. Spatial assays are therefore 
critical to locate both the upstream GRN factor and its putative 
target in order to establish GRN linkages. (b)  Lineage-specifi c regu-
lation of target genes : GRN factors frequently regulate distinct sets 
of target genes in precursors of multiple embryonic lineages. 
In these cases, whole-embryo assays of target abundance, by them-
selves, are incapable of resolving GRN responses within a specifi c 
lineage. This requires spatial assays of target gene responses rela-
tive to an appropriate lineage marker. (c)  Defi ning feedback loops : 
GRN factors commonly autoregulate themselves or respond to 
inputs from their targets through feedback loops. To distinguish 
between cell-autonomous and non-autonomous feedback loops, 
it is essential to locate the upstream GRN factor, the target it ini-
tially regulates, and the site of the “feedback” response. Thus, 
responses to experimental perturbations that test the loop must be 
resolved in space. 

 In this chapter we describe two methods that permit accurate 
localization of a gene product relative to a known molecular “land-
mark” in sea urchin embryos. The fi rst employs multicolor fl uores-
cent in situ hybridization (FISH) to examine the spatial distribution 
of transcripts encoded by up to three genes of interest. The second 
method combines FISH with immunohistochemistry in whole 
embryos. In contrast to conventional alkaline  phosphatase- mediated 
detection, fl uorescent labeling allows for unambiguous resolution 
of multiple gene products, which is especially critical when they are 
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expressed in overlapping territories [ 2 ,  17 ,  18 ]. Furthermore, 
fl uorescence-based approaches permit precise optical sectioning 
and volume projections of image stacks, thereby providing 
3-dimensional descriptions of spatial expression patterns. By incor-
porating nuclear counterstaining, fl uorescent labeling can easily be 
used to assess the numbers and distributions of cells expressing a 
gene product of interest. 

 The techniques described herein have been used to investigate 
a number of aspects of sea urchin GRN function. These include 
characterizing the expression of a regulatory factor during embryo-
genesis [ 18 ,  19 ] as well as understanding the effects of an experi-
mental perturbation on the expression of a gene in specifi c 
blastomeres marked by a second gene product [ 20 ]. Additionally, 
these methods have been used to identify regulatory targets in 
blastomeres adjacent to cells that selectively receive a reagent to 
disrupt a signaling process [ 20 ,  21 ]. They can also be used to dis-
tinguish between a localized response to an experimental perturba-
tion and a general developmental consequence such as toxicity 
caused by disruption of basic cellular function throughout the 
embryo [ 20 ].  

2     Materials 

      1.     Probe labeling : 10× digoxigenin labeling mix (Roche) and 10× 
fl uorescein labeling mix (Roche); ATP, CTP, GTP, and UTP 
(lithium salts, Roche); DNP-11-UTP (PerkinElmer); 10× 
DNP labeling mix consists of 10 mM each of ATP, CTP, and 
GTP, 6.5 mM UTP, and 3.5 mM DNP-11-UTP.   

   2.     In vitro transcription : SP6 and T7 RNA polymerases (New 
England Biolabs and others) with included 10× RNA transcrip-
tion buffers. Templates are discussed in Subheading  3.1 ,  step 2  
and  4   step 1 .   

   3.     Probe purifi cation : Turbo DNAse I (Ambion); ethylenediami-
netetraacetic acid (EDTA); Qiaquick    PCR purifi cation kit 
(Qiagen) or size-fractionation columns (Illustra ProbeQuant 
G-50 Micro Columns, GE Healthcare); diethylpyrocarbonate 
(DEPC)-treated (nuclease-free) water.      

       1.     Labware : 96-well fl at-bottomed plates; thermocycler-grade 
sealing fi lm; rubber tubing; glass Pasteur pipettes; standard 
suction line terminating in a 200 μL disposable pipette tip.   

   2.     Fixative : 4 % paraformaldehyde (v/v, use 16 % EM grade para-
formaldehyde solution, EM Sciences); 10 mM 
3-(N-morpholino)propanesulfonic acid (MOPS); 0.1 % 
Tween-20 in Artifi cial Sea Water (ASW: 0.461 M NaCl, 
0.0024 M NaHCO 3 , 0.009 M KCl, 0.026 M MgCl 2 ·6H 2 O, 
0.032 M MgSO 4 , 0.0097 M CaCl 2 , pH 8.1).   

2.1  Materials for In 
Situ Probe Synthesis

2.2  Materials for 
Multicolor FISH and 
Immunostaining

Multicolor Network Analysis
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   3.     Wash and hybridization buffers : Use nuclease-free molecular 
biology grade water. “MOPS wash buffer”: 0.1 M MOPS, 
pH 7.0, 0.5 M NaCl, and 0.1 % Tween-20. “Hybridization 
buffer 1”: 70 % formamide (v/v, use stock solution of com-
mercial molecular-grade formamide, pH 7–9, Sigma-Aldrich), 
0.5 M NaCl, 0.1 M MOPS, pH 7.0, 1 mg/mL bovine serum 
albumin (BSA), and 0.1 % Tween-20. “Hybridization buffer 
2”: 50 % formamide (v/v), 0.5 M NaCl, 0.1 M MOPS, pH 
7.0, 1 mg/mL BSA, and 0.1 % Tween-20 (add formamide 
only after all other buffer components have mixed to allow 
BSA dissolution or use a stock solution of BSA at 100 mg/mL, 
stored at −20 °C).   

   4.     Probe detection : Anti-fl uorescein-HRP (horseradish peroxidase) 
antibody (PerkinElmer); anti-digoxigenin-POD (peroxidase) 
Fab fragments (Roche, reconstituted to give 150 U/mL 
stock), both antibodies stored at 4 °C; anti-DNP-HRP stored 
at 4 °C (part of TSA DNP-HRP kit, PerkinElmer); lamb 
serum/normal goat serum (stored at −20 °C); BSA; “blocking 
buffer 1”: 10 % lamb/goat serum, 2.5 mg/mL BSA in MOPS 
wash buffer; “blocking buffer 2”: 5 % lamb/goat serum in 
MOPS wash buffer; Tyramide Signal Amplifi cation Plus (TSA 
Plus) system (PerkinElmer); 30 % hydrogen peroxide solution 
(v/v, Sigma- Aldrich, use protective labwear when handling 
hydrogen peroxide, store stock at RT away from light).   

   5.     Immunostaining and nuclear counterstaining : “PBST wash 
buffer”: 1× phosphate buffered saline (PBS) (use commercial 
10× PBS) and 0.1 % Tween-20; Alexa series of secondary anti-
bodies (Invitrogen), stored at 4 °C; 4′, 6-diamidino-2- 
phenylindole, dilactate (DAPI).   

   6.     Mounting and slide preparation : 25 × 75 × 1 mm glass slides; 
22 × 22 mm #1 coverslips; 13 or 20 mm inner diameter custom 
imaging spacers (Grace Bio-Labs, catalog #3181209 or 654006, 
respectively); custom MatTek 96-well fl at-bottomed plate with 
1.0 coverslip thickness (MatTek Corporation, catalog # P96G- 
1.0-5-F); glycerol.       

3     Methods 

     Take necessary precautions at each step of probe synthesis to main-
tain an RNase-free environment (gloves, dedicated labware for 
RNA work, and nuclease-free water as indicated).    Also, refer to 
notes for comments on probe preparation.

    1.    Set up a 10 μL reaction for in vitro transcription of each probe.   
   2.    Use 250–500 ng (plasmid) or 100–250 ng (PCR product) of 

template DNA in 3–5 μL of water. Templates can be appropri-
ately restricted plasmids or PCR products containing full- length 

3.1  In Situ Probe 
Synthesis
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or partial cDNA sequence of the gene of interest fl anked by a 
suitable bacteriophage promoter sequence. Aim for sequence 
lengths between 300 and 1,000 nt. For rare targets, use as 
long a template sequence as possible. Alternatively, two PCR 
templates spanning different regions of the mRNA can be 
mixed either at the synthesis step, if they use the same RNA 
polymerase, or after synthesis and before hybridization. Use of 
two probes also allows one to hybridize both and each sepa-
rately, providing confi dence in the results.   

   3.    Prior to use, template DNA should be purifi ed using a column- 
based method (Qiaquick Gel Extraction or PCR purifi cation 
kit, Qiagen) and eluted in nuclease-free water.   

   4.    Add to the DNA 1 μL of 10× RNA transcription buffer, 1 μL 
(this can be reduced to as low as 0.3 μL per 10 μL reaction to 
save reagent) each of the 10× digoxigenin, DNP, or fl uorescein 
labeling mix, nuclease-free water to bring the fi nal volume to 
10 μL and 0.5–1.0 U of RNA polymerase (SP6 or T7, usually 
0.5–1.0 μL).   

   5.    Incubate at 37 °C for 2 h.   
   6.    Add 1–2 U (0.5–1.0 μL) of Turbo DNAse I directly to the 

transcription reaction (Turbo DNAse I is engineered to be 
highly tolerant of the salt concentration in transcription 
buffers) and incubate at 37 °C for 15 min to remove template 
DNA.   

   7.    Add 1 μL of a 100 mM EDTA, pH 8.0 stock solution (make 
stock in nuclease-free water), incubate at room temperature 
(RT) for 5 min to stop enzymatic reactions. Addition of EDTA 
signifi cantly improves binding of RNA to, and elution from, 
Qiagen columns ( see   step 8 ), resulting in substantially higher 
recovery of product yields.   

   8.    Dilute reaction to 100 μL with DEPC-treated water.   
   9.    Purify synthesized probe using the Qiagen Qiaquick PCR 

purifi cation kit as per the manufacturer’s instructions for puri-
fi cation of standard PCR products using a microcentrifuge 
(Qiagen). Alternatively, purifi cation of synthesized RNA 
through size-fractionation columns (Illustra ProbeQuant G-50 
Micro Columns, GE Healthcare; follow manufacturer’s 
instructions) achieves comparable yields [ 15 ].   

   10.    Elute RNA in 30–50 μL of DEPC-treated water if using the 
Qiagen PCR purifi cation kit. Follow manufacturer’s instructions 
for the Illustra ProbeQuant G-50 columns for elution. Quantitate 
product by spectrophotometry. Store probe at −20 °C between 
uses. For long-term use, store probes as ethanol precipitates or in 
hybridization buffer 1 containing 70 % formamide and yeast 
tRNA, both of which inhibit RNase.    

Multicolor Network Analysis



254

         1.    Embryos are visualized with a dissecting microscope at 15–30× 
magnifi cation and typically carried in 96-well fl at-bottomed 
plates making solution transfers by mouth suction and pulled 
glass pipettes attached to rubber tubing. All steps from fi xation 
through hybridization and staining are done in the wells of 
these plates ( see  notes for comment on choice of plates for this 
procedure). Add 50 μL of fi xative and allow embryos to settle 
for 5 min at RT. Remove supernatant from well with suction 
line and replace with 150–200 μL of fi xative; incubate at RT 
for 1 h. Embryos may also be fi xed overnight at 4 °C, although 
this results in signifi cantly lower signal. Fixative should be 
freshly made on the day of embryo collection and can be used 
for up to 24 h at RT.   

   2.    Wash embryos fi ve times with 200 μL of MOPS wash buffer at 
RT. If required, embryos can be stored in MOPS wash buffer 
at 4 °C for up to 7 days prior to further processing. Seal 96-well 
plates when storing embryos to minimize evaporation. If stor-
ing embryos longer than 2 days, add 0.01 % sodium azide 
(w/v) to the MOPS wash buffer to prevent bacterial contami-
nation. For optimum signals and minimal background stain-
ing, MOPS wash buffer should be freshly made and used on 
the day of preparation if stored at RT. For long-term use, store 
buffer at −20 °C.   

   3.    To equilibrate embryos in hybridization buffer 1, incubate 
them in 150–200 μL of each the following solutions for 
30 min: 2:1 and 1:2 mix (v/v) of MOPS wash buffer and 
hybridization buffer, followed by hybridization buffer 1 alone. 
Store excess hybridization buffer at −20 °C.   

   4.    Prior to hybridization, place embryos in 200 μL of hybridiza-
tion buffer 1 for at least 1 h at 50 °C.   

   5.    Replace hybridization buffer 1 with 150–200 μL of preheated 
hybridization buffer 1 (at 50 °C) containing 0.05–0.3 ng/μL 
of digoxigenin – and/or DNP – and/or fl uorescein-labeled 
antisense RNA, as well as 500 μg/mL yeast tRNA to minimize 
nonspecifi c probe binding. Seal plates and hybridize at 50 °C 
for 3–7 days. Refer to Subheading  4  below for guidelines on 
probe conjugate selection.   

   6.    Wash embryos fi ve times with 200 μL of MOPS wash buffer at 
50 °C for 3 h, followed by three washes with 200 μL of MOPS 
wash buffer at RT over a total period of 1 h.   

   7.    Block embryos in 150–200 μL of blocking buffer 1 for 
30–60 min at RT.   

   8.    Incubate embryos overnight at either RT or 4 °C in 150 μL of 
a 1:750 dilution (v/v) of anti-fl uorescein-HRP in blocking 
buffer to label fl uorescein-containing hybrid RNA duplexes. 
Seal 96-well plate to minimize evaporation.   

3.2  Multicolor 
Fluorescent In Situ 
Hybridization (FISH) to 
Detect Endogenous 
Transcripts
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   9.    Wash embryos six times with 200 μL of MOPS wash buffer 
over 1.5–2 h at RT to remove unbound antibody.   

   10.    Detect bound anti-fl uorescein-HRP by adding 50 μL of freshly 
made Tyramide Amplifi cation working solution (a 1:150 dilu-
tion of the TSA stock solution in the included 1× plus amplifi -
cation diluent) for 2–8 min at RT (a 6-min incubation usually 
yields an optimum balance of signal intensity and minimal 
background staining). Ensure that all TSA kit solutions are at 
RT prior to use, and place embryos in the dark for all steps 
after addition of TSA Amplifi cation working solution. Refer to 
the guidelines on fl uor selection in Subheading  4 .   

   11.    Wash embryos six times each with 200 μL of MOPS wash buf-
fer at RT for 5–10 min per wash to remove excess TSA detec-
tion reagent.   

   12.    Quench the peroxidase activity of peroxidase-conjugated anti-
body by incubating embryos in 200 μL of a solution of MOPS 
wash buffer containing 3 % hydrogen peroxide (v/v, diluted 
from a 30 % stock solution) at RT for 1 h.   

   13.    Remove excess hydrogen peroxide by washing embryos six 
times, each with 200 μL of MOPS wash buffer at RT over a 
total of 90 min.   

   14.    Incubate embryos overnight at 4 °C in 150 μL of a 1:1,000 
dilution (v/v using reconstituted antibody stock) of anti-
digoxigenin- POD Fab fragments in blocking buffer 2 to label 
digoxigenin-containing hybrid duplexes. Seal 96-well plate to 
minimize evaporation.   

   15.    Wash embryos six times, each with 200 μL of MOPS wash 
buffer over 1.5–2 h at RT to remove unbound antibody.   

   16.    Detect bound anti-digoxigenin-POD by adding 50 μL of freshly 
made Tyramide Amplifi cation working solution (a 1:150 dilu-
tion of the TSA stock solution in the included 1× plus amplifi ca-
tion diluent) for 2–8 min at RT (6 min usually is optimal).   

   17.    Repeat  steps 11  through  13 .   
   18.    Incubate embryos overnight at 4 °C in 150 μL of a 1:250 dilu-

tion (v/v) of anti-DNP-HRP in blocking buffer 2 to label 
DNP-containing hybrid duplexes. Seal 96-well plate to mini-
mize evaporation.   

   19.    Wash embryos six times, each with 200 μL of MOPS wash buf-
fer over 1.5–2 h at RT to remove unbound antibody.   

   20.    Detect bound anti-digoxigenin-POD by adding 50 μL of 
freshly made Tyramide Amplifi cation working solution (a 
1:150 dilution of the TSA stock solution in the included 1× 
plus amplifi cation diluent) for 2–8 min at RT (6 min usually is 
optimal).   

Multicolor Network Analysis
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   21.    Wash embryos six times, each with 200 μL of MOPS wash 
buffer at RT for 5–10 min to remove excess detection reagent. 
Include an appropriate dilution of DAPI (based on specifi c 
stock purchased) in the fi rst MOPS wash if performing nuclear 
counterstaining.   

   22.    Equilibrate embryos in 50 % glycerol by successive washes 
through 15, 30, and 50 % glycerol made by diluting glycerol 
with MOPS wash buffer (v/v). Allow embryos to equilibrate 
at RT for 15 min between steps to minimize osmotic damage. 
Glycerol aids in embryo handling during slide preparation, and 
also provides a refractive index appropriate for microscopy. 
Alternatively, embryos can be transferred in MOPS wash 
buffer to 1.0 coverslip-thick fl at-bottomed 96-well plates and 
photographed directly ( see  custom MatTek plates in  item 6  of 
Subheading  2.2 ).     

 An example of three-color FISH is shown in Fig.  1 .

      For this application, the stringency of the hybridization conditions 
is reduced to prevent denaturation of the introduced double- 
stranded DNA, thereby excluding formation of RNA/DNA 
hybrids. Post-hybridization high stringency washes are used to 
maximize the signal-to-noise ratio. Modifi cations to the multicolor 
FISH protocol from Subheading  3.1  follow (only modifi ed steps 
with corresponding step numbers are described below; the rest of 
the protocol is identical to the one described for standard multi-
color FISH):

    1.    To equilibrate embryos in hybridization buffer 2, incubate 
them in 150–200 μL of each of the following solutions for 
30 min: 2:1 and 1:2 mix (v/v) of MOPS wash buffer and 

3.3  Multicolor FISH 
to Detect Transcripts 
Synthesized from an 
Exogenously 
Introduced DNA as 
Well as Endogenous 
Embryonic Transcripts

  Fig. 1    Multicolor FISH to characterize the expression patterns of three endogenous mRNAs:  z13  ( red ,  a ,  d ), 
 foxq2  ( green ,  b ,  d ), and  gcm  ( blue ,  c ,  d ) mRNAs were hybridized with DNP-, digoxigenin-, and fl uorescein- 
conjugated antisense probes, respectively, and detected sequentially as described in Subheading  3.2 . Wild- 
type embryos were fi xed at the mesenchyme blastula stage (22 h postfertilization) (shown in DIC in  e ). At this 
stage,  z13  mRNA is expressed in endoderm progenitors ( E   ) in the vegetal region of the embryo,  foxq2  tran-
scripts are restricted to the ectoderm near the animal ( An  ) pole ( e ), and  gcm  mRNA accumulates in pigment 
cell precursors within the secondary mesoderm ( M  ) ( e ).    Scale bar in ( d ) represents approximately 20 μm       
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hybridization buffer 2, followed by hybridization buffer 2 
alone. Store excess hybridization buffer 2 at −20 °C.   

   2.    Prior to hybridization, place embryos in 200 μL of preheated 
hybridization buffer 2 for at least 1 h at 45 °C.   

   3.    Replace prehybridization buffer with 150–200 μL of preheated 
hybridization buffer 2 (at 45 °C) containing 0.05–0.3 ng/μL 
of digoxigenin-labeled antisense RNA, DNP-labeled antisense 
RNA, and/or fl uorescein-labeled antisense RNA and 500 μg/mL 
yeast tRNA. Seal plates and hybridize at 45 °C for 3–7 days. 
Refer to Subheading  4  below for guidelines on probe conju-
gate selection.   

   4.    Wash embryos fi ve times, each with 200 μL of MOPS wash 
buffer at 50 °C for a total of 3 h, followed by two washes with 
200 μL of hybridization buffer 1 (containing 70 % formamide) 
at 50 °C over an hour. Wash three times with 200 μL of MOPS 
wash buffer at RT over an hour (Fig.  2 ).

       An example of two-color detection of transcripts synthesized 
from an exogenous template and an endogenous transcript is 
shown in Fig.  2 .  

  To combine FISH with immunostaining, use the following proto-
col after completing the in situ hybridization procedure in 
Subheading  3.1  (i.e., after fi nal MOPS wash buffer replacements 
in  step 18 ). For a list of antibodies that have been found to give 
acceptable signals in sea urchin embryos using this approach, refer 
to Subheading  4  below.

3.4  FISH Followed by 
Immunostaining

  Fig. 2    Dual-color FISH to detect a secondary mesoderm GRN response to a transcription factor introduced 
exogenously in clones of cells in blastula-stage embryos: This experiment was designed to show induction of 
the secondary mesoderm specifi cation gene,  gcm , in cells adjacent to those expressing the transcription fac-
tor, Pmar1 [ 20 ]. DNA constructs were used to misexpress Pmar1 and GFP under control of the hatching 
enzyme (HE) promoter. When these constructs are co-injected, Pmar1 and GFP are expressed in the same 
blastomeres, traced here with a fl uorescein-conjugated probe hybridized with  gfp  mRNA ( red ,  a ,  c ). A digoxi-
genin-coupled probe was used to detect ectopic induction of  gcm  ( green ,  b ,  c ) in cells adjacent to Pmar1 (and 
GFP)-misexpressing cells at the late hatching blastula stage (DIC in d) [ 20 ]. Endogenous  gcm  transcripts 
( arrowheads  in  b ,  c ) accumulate in specifi c blastomeres (non-skeletogenic mesenchyme precursors) not 
immediately adjacent to Pmar1 (and GFP)-misexpressing cells. Hybridization conditions were adjusted as per 
the protocol in Subheading  3.3 . Scale bar in ( d ) represents approximately 20 μm       
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    1.    Wash embryos twice, each with 200 μL PBST wash buffer at 
RT over 20 min.   

   2.    Introduce an appropriate dilution of primary antibody(s) of 
interest in 150 μL of PBST blocking buffer (consisting of 5 % 
lamb or goat serum in PBST wash buffer). Incubate embryos 
in this blocking buffer containing primary antibody(s) over-
night at 4 °C.   

   3.    Wash embryos four times with PBST wash buffer at RT for a 
total of 1 h to remove unbound primary antibody(s).   

   4.    Detect bound primary antibody(s) by adding 150 μL of a 
working dilution (determined separately for each secondary 
antibody used, usually 1:750 or 1:1,000, v/v) of an appropri-
ate secondary antibody (i.e., specifi c for the species that each 
primary antibody was raised in and conjugated to a fl uor differ-
ent from the one(s) used in the FISH procedure).   

   5.    Wash embryos three to four times, each with 200 μL of PBST 
wash buffer at RT for 5–10 min to remove unbound secondary 
antibody(s). Include an appropriate dilution of DAPI (based 
on the specifi c stock purchased) in the fi rst PBST wash if 
performing nuclear counterstaining.   

   6.    Equilibrate embryos in 50 % glycerol and PBST wash buffer as 
in  step 19  above.    

  An example of two-color detection of an RNA by FISH and a 
protein by immunostaining is shown in Fig.  3 .

4              Notes 

     1.     Probe preparation : A successful FISH experiment requires a 
pure antisense RNA probe of known sequence. It is essential 
to use a sequenced homogeneous DNA template (either a 

  Fig. 3     FISH  +  immunostaining : Multicolor labeling was used to show the distribution of cells containing SoxB1 
protein ( green ,  b – e ) compared to secondary mesoderm progenitors expressing the pigment cell gene,  gcm  
( red ,  a ,  c ,  e ). In this experiment,  gcm  transcripts were detected using a digoxigenin-conjugated antisense RNA 
probe and TSA-red, followed by immunohistochemical localization of endogenous SoxB1 protein and nuclear 
counterstaining with DAPI ( blue ,  d ,  e ) [ 20 ]. A stack of optical sections acquired with an axial tomography device 
(Zeiss) was used to generate a volume projection using Imaris 5.7.2 (Bitplane). Scale bar in ( e ) represents 
approximately 20 μm       
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completely sequenced highly purifi ed plasmid preparation or a 
PCR amplicon generated from a cloned DNA fragment). We 
caution against the routine use of PCR products amplifi ed 
from a heterogeneous source (e.g., cDNA synthesized from 
whole embryo RNA) unless the amplicon is sequenced to ver-
ify its identity. Also, a very important part of the probe prepa-
ration protocol is the column-based RNA purifi cation protocol 
described above. Not only is it quicker than traditional RNA 
precipitation and isolation procedures, but, in our experience, 
it also yields in situ hybridization patterns with signifi cantly 
superior signal intensity, specifi city, and reproducibility.   

   2.     Choice of labware : We strongly recommend the use of 96-well 
fl at-bottomed plates for all protocols described in this chapter. 
Compared to microcentrifuge tubes, 96-well plates offer 
superior visibility and retention of embryos through numerous 
buffer replacements and a more even distribution of embryos 
during hybridization and staining procedures. This facilitates 
consistent probe and buffer penetration and affords highly 
reproducible in situ hybridization patterns. Additionally, 
embryos can be inspected under fl uorescence after completion 
of each staining step without the need for any intervening 
mounting or slide preparation and consequent loss of sample. 
Hybridization and staining reactions can be sealed as effectively 
in plates as in microcentrifuge tubes by using thermocycler- 
grade sealing fi lms. These perform reliably through weeklong 
hybridization procedures at 50 °C. Finally, the use of plates 
makes handling of large numbers of samples much more 
effi cient.   

   3.     Probe conjugate selection : We fi nd that both digoxigenin and 
DNP-based labeling provide signifi cantly superior sensitivity 
and signal specifi city compared to fl uorescein-based labeling. 
Furthermore, in our experience, digoxigenin and DNP-based 
detection give signals of equivalent intensity and specifi city. 
Therefore, when performing dual-color FISH, detect  transcripts 
of interest using digoxigenin and DNP-labeled antisense 
probes. When studying the distribution of three transcripts, 
rare/spatially diffuse transcripts should be detected using 
digoxigenin or DNP-coupled antisense probes, and the more 
abundant and/or highly localized mRNAs should be hybrid-
ized with a fl uorescein-conjugated probe. Similarly, the rela-
tively abundant transcripts synthesized from an exogenously 
introduced construct (e.g., a tracer sequence) are detected with 
a fl uorescein-conjugated antisense probe and endogenous 
embryonic mRNAs with digoxigenin/DNP-coupled systems 
for optimum signals. If required, adjust the concentration of 
introduced DNA/RNA to maximize specifi c signals with the 
fl uorescein-labeled probe and minimize embryo toxicity. 
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Although our current FISH protocol uses digoxigenin, DNP, 
and fl uorescein labeling to detect up to three mRNAs of inter-
est, additional probe conjugates such as biotin have been used 
in other model systems [ 17 ,  22 ] for multicolor FISH.   

   4.     Fluor selection : In our experience, both Cy3- and fl uorescein- 
TSA Plus detection systems give signals of equivalent intensity 
and specifi city. With our current microscopy platform, the 
Cy5- TSA Plus kit gives signals of equivalent specifi city to those 
of Cy3 and fl uorescein, but signifi cantly lower intensity. 
Nevertheless, Cy5-TSA Plus is a viable option with abundant, 
highly localized transcripts if Cy3 and fl uorescein have already 
been allocated to other gene products in the same experiment. 
In addition to these, other TSA Plus fl uors are available from 
PerkinElmer.   

   5.    Order of probe detection: When performing three-color FISH, 
the fl uorescein-conjugated probe must be detected before 
those labeled with DNP and digoxigenin. This specifi c 
sequence avoids the anti-fl uorescein-HRP antibody binding 
with previously deposited TSA-fl uorescein staining reagent 
and amplifying artifactual signals in successive fl uor deposition 
steps. Subsequent detection of DNP- and digoxigenin-labeled 
transcripts can then be executed in any order with appropri-
ately selected TSA Plus fl uors. When detecting two transcripts 
of interest, fl uorescein-conjugated probes should not routinely 
be used and hence digoxigenin and DNP-labeled transcripts 
can be detected in any order.   

   6.     Dynamic range : Single and multicolor FISH have a narrower 
dynamic range of specifi c signal compared to traditional alka-
line phosphatase-based whole-mount in situ hybridization. 
We believe this to be a function of the kinetics of the fi nal 
staining reaction in each procedure. In the case of the FISH 
protocol described in this chapter, the fi nal fl uor deposition is 
extremely rapid (2–8 min to saturation) with limited user con-
trol. Conversely, alkaline phosphatase-based colorimetric 
deposition proceeds more slowly (1–24 h to saturation) and 
can be terminated whenever desired signal intensity has been 
achieved. This difference becomes signifi cant when attempting 
to assess subtle changes in the levels of gene expression across 
a set of experimental conditions. Standard colorimetric detec-
tion would therefore be a superior choice in such situations. 
The restricted dynamic range of detection seen in FISH exper-
iments is less signifi cant when larger differences in transcript 
abundance are seen across perturbations. Both approaches are 
at best, semiquantitative, and ideally should be supplemented 
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with more direct quantitative measurements of transcript 
abundance (Q-PCR etc   .).   

   7.     Signal specifi city and background issues : We have occasionally 
observed punctate background staining throughout the 
embryo when performing single or multicolor FISH. This is 
particularly evident when the target transcript is expressed at 
very low levels or has a broadly distributed expression pattern. 
Furthermore, sea urchin embryos at late mesenchyme blastula 
and gastrula stages tend to exhibit such nonspecifi c staining 
more frequently than at other developmental stages. This does 
not appear to be related to the choice of fl uor or probe conju-
gate, since the incidence of nonspecifi c staining is comparable 
across different fl uors and with digoxigenin-, DNP-, as well as 
fl uorescein-coupled antisense RNA probes. A modest improve-
ment in background staining can sometimes be achieved by 
lowering the concentration of the specifi c antisense probe. We 
have however, not encountered this issue with colorimetric in 
situ hybridization. Therefore, when characterizing a novel 
gene expression pattern, we strongly recommend an initial 
developmental series using both alkaline phosphatase and fl uo-
rescence-based detection. For mRNAs expressed ubiquitously 
or at very low levels, FISH may not be a viable option.   

   8.     FISH  ±  immunostaining : Immunostaining following a FISH 
procedure is used to detect antigens whose epitopes persist 
through the FISH process. SoxB1, Myc, phospho-Smad1/5/8, 
Sm30, and Sm50 can all be detected reliably using the proto-
col described above after completion of a single or dual-color 
FISH procedure. Typically, epitopes that require methanol-
based fi xation are not amenable to a combination of FISH and 
immunostaining as described herein. Furthermore, compared 
to immunofl uorescent detection performed in isolation, there 
is a signifi cant loss of signal intensity of the protein epitope- 
antibody complex when a complete FISH procedure is fol-
lowed by immunostaining. Modest improvements in staining 
intensity can sometimes be achieved with a higher concentra-
tion of primary antibody/longer incubations in the presence 
of the primary antibody but must be weighed against a con-
comitant increase in background labeling.         
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    Chapter 18   

 A 96-Well Plate Format for Detection of Marine 
Zooplankton with the Sandwich Hybridization Assay 

           Julio     B.    J.     Harvey    

    Abstract 

   The sandwich hybridization assay (SHA) is a ribosomal RNA (rRNA) targeted molecular method used 
to detect specifi c target organisms from diverse communities found in environmental water samples. 
This sensitive, robust assay is particularly useful for detecting zooplankton, including copepod grazers or 
reproductive propagules from broadcast spawning invertebrates. Herein, I describe the most basic applica-
tion of this fl exible methodology—a 96-well plate format for analysis of water samples in the laboratory. 
A microarray format SHA is also available and uses the same basic chemistry for remote, robotically medi-
ated, in situ target detection. Traditionally produced only in the laboratory, preassembled SHA reagents 
and consumables are now also available for purchase.  

  Key words     Sandwich hybridization assay  ,   Molecular probes  ,   rDNA  ,   rRNA  ,   Invertebrate larvae  , 
  Copepods  ,   Invasive species detection  

1       Introduction 

 The SHA uses two DNA probes, one for target capture and another 
for immunological signaling (Fig.  1 ). Variations on the core SHA 
methodology are well documented [ 1 – 5 ]. Capture probes are typi-
cally designed from hypervariable regions of high copy number 
genes such as the small or large subunits of the ribosomal DNA 
(rDNA). Signal probes code for highly conserved regions of target 
genes and are located tens to hundreds of base pairs distant from 
capture probe annealing sites. Target capture and signaling steps 
are separated spatially and temporally resulting in consistent, 
remarkably robust presence–absence and quantitative detection 
results. It is important to note that the SHA detects total target 
rRNA and rDNA and not absolute cell numbers [ 6 ]. Filter col-
lected samples are lysed in a guanidine thiocyanate (GuSCN) buffer. 
Biotinylated capture probes anchored via streptavidin to a polysty-
rene solid support are then exposed to sample lysates. After rRNA 
or rDNA target annealing to capture probes, detection is mediated 
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by digoxigenin (dig)-labeled signal probes. The latter anneal to 
conserved regions of target molecules and subsequently, attach to 
anti-dig horseradish peroxidase conjugate, producing a colorimet-
ric result upon substrate cleavage. The degree of enzyme kinetic 
response (signal strength) is spectrophotometrically quantifi ed as 
optical density (OD) at 650 and 450 nm.

   The 96-well plate format SHA has been successfully used to 
detect and monitor the progress of harmful algal bloom (HAB) 
species [ 3 ,  7 – 9 ] and marine bacterioplankton [ 10 ]. SHA probes 
for mussel, barnacle, polychaete, and invasive green crab ( Carcinus 
maenas ) larvae have also been developed and applied to environ-
mental samples successfully [ 2 ,  11 ]. Additionally, a microarray for-
mat SHA has been extensively used on board the Environmental 
Sample Processor (Spyglass Biosecurity, Inc., Marina, CA), a fully 
automated robotic system that collects water samples and conducts 
the SHA in situ during month-long mooring deployments [ 1 ,  10 – 15 ]. 
SHA probes have also been successfully developed for major groups 

Streptavidin

18S rRNA Target Molecule

100–300 bp

Capture Probe

Signal Probe

Digoxygenin (DIG)

Horseradish Peroxidase (HRP)

Anti-DIG 
HRP Conjugate

Colorimetric Reaction

HRP Substrate

Biotin

Biotinylated
Polystyrene Prongs

96-well Plate Row A

1 2 3 4 5 6 7 8 9 10 11 12 1 2 3 4 5 6 7 8 9 10 11 12
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  Fig. 1    Sandwich hybridization chemistry for 96-well plate assay. Biotinylated polystyrene prongs (solid support) 
fi rst acquire a capture probe via the biotin-streptavidin interaction. The capture probe then acquires single-
stranded target molecules present in the sample lysate solution. Subsequently, the signal probe attaches to 
target molecules and HRP enzyme catalyzes substrate cleavage, resulting in solution color change       
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of marine copepods and additional benthic invertebrate larvae 
(unpublished). Although the approach described below involves 
water samples, the SHA can theoretically be applied to any envi-
ronmental sample from which genomic material can be extracted 
in solution.  

2     Materials 

 All reagents are dispensed using sterile, individually packaged sero-
logical pipettes and autoclaved glassware subjected to pretreatment 
with RNAseZap (Applied Biosystems/Ambion, Austin, TX, USA) 
and four rinses with Sigma molecular reagent grade water (Sigma- 
Aldrich, St. Louis, MO, USA) immediately prior to use. Sigma 
water (or equivalent ultra-pure water) is used to make all reagents. 
All reagents are 0.22 μM fi ltered. Products and concentrations 
mentioned below are specifi c to zooplankton detection in some 
cases and may require modifi cation to use with other groups of 
organisms. Store reagents in sterile containers at room temperature 
unless otherwise noted. If precipitate forms in any reagent, gentle 
heating to 22 °C (but <25 °C) followed by 0.22 μM fi ltration into 
a new, sterile container is recommended. Strictly adhere to proper 
handling, disposal, and safety guidelines when working with 
reagents described below. Table  1  contains supplier and pricing 
information for primary materials described herein.

        1.    Vacuum manifold: 3-Place PVC or stainless steel and 6-place 
stainless steel vacuum manifolds (Fig.  2a ) are available for pur-
chase (Millipore, Billerica, MA, USA). Multiple 3-place PVC 
manifolds can be connected with additional fi ttings ( see   Note 1 ). 
Alternatively, manifolds can also be constructed from widely 
available materials—schedule 80 PVC is recommended for its 
durability and low reactivity.

       2.    200 mL polysulfone fi lter funnels with 25 mm fi lter holders 
(Pall Corporation, Ann Arbor, MI, USA): One fi lter funnel 
(Fig.  2b ) is required per each manifold place. Filter funnels 
should be gently cleaned between samples with a bottle brush 
and minimal Micro-90 (Cole-Parmer, Vernon Hills, IL, USA), 
then rinsed thoroughly with warm tap water followed by 
deionized water. The above fi lter funnel product includes plas-
tic fi lter frits necessary for proper fi lter installation.   

   3.    Size #8 rubber stoppers: 1 hole (McMaster-Carr, Elmhurst, 
IL, USA).   

   4.    Vacuum pump: A water-jet aspirator (Cole-Parmer) pump 
(Fig.  2c ) or equivalent ( see   Note 2 ) and a pressure gauge with 
regulator capable of creating a gentle vacuum <10 in. Hg 
(0.033 Mpa) are highly recommended. PVC tubing: (1) 1/4″ 

2.1  Sample Filtration 
and Storage 
Components

Sandwich Hybridization Assay 



266

inside diameter, 5/8″ outside diameter, 3/16″ wall thickness 
and (2) 1/2″ inside diameter, 3/4″ outside diameter, 1/8″ 
wall thickness or equivalent ( see   Note 3 ). Quick disconnect 
fi ttings are recommended for easy separation of manifold(s) 
from the vacuum system if mobility is desired.   

   5.    Filter membranes: For most zooplankton 25 mm, 5 μm 
Durapore PVDF disc fi lters or 30 μm nylon net fi lter mem-
branes (Millipore) are suffi ciently fi ne scale. Smaller organisms 
such as some phytoplankton and bacteria require fi ner scale 
fi lters. Additionally, 0.22 μm Millex 33 mm Durapore PVDF 

   Table 1  
  Materials suppliers and pricing   

 Equipment or reagent  Supplier  Catalogue number  Price (US $) 

 200 mL polysulfone fi lter funnels with 
25 mm fi lter holders (total price for 3 
needed) 

 Pall Corporation  4203  $434.00 

 PVC vacuum manifold 3-place  Millipore  XX2604735  $785.00 

 Water-jet aspirator pump  Cole-Parmer  EW-35031-00  $998.00 

 Pressure gauge and regulator  Cole-Parmer  EW-35031-16  $316.00 

 Saigene 96-well plate processor  Saigene, Inc.  –  $9,500.00 

 Saigene Plexiglas dust cover for plate 
processor 

 Saigene, Inc.  –  $850.00 

 VMAX Kinetic Microplate Reader  Molecular Devices  VMAX  $9,888.00 

 Evergreen 96-well microplates  Evergreen Scientifi c  222-8050-F1K  $84.00 

 Saigene 12-prong polystyrene solid 
support (20 pack) 

 Saigene, Inc.  SHA_PRG_20  $100.00 

 1.5 M lysis buffer, pH 9.0–1 L  Saigene, Inc.  SHA_LB1.5M_1000  $450.00 

 Wash buffer E—1 L  Saigene, Inc.  SHA_BE_1000  $200.00 

 HRP conjugate—1 L  Saigene, Inc.  SHA_CJ_1000  $2,200.00 

 1-Step Ultra TMB-ELISA (substrate)  Thermo fi sher 
scientifi c pierce 

 34028  $116.00 

 2 M signal solution—1 L  Saigene, Inc.  SHA_SB2M_1000  $450.00 

 Signal solution diluent—1 L  Saigene, Inc.  SHA_SDIL_1000  $350.00 

 Probe assay wash—1 L  Saigene, Inc.  SHA_PAW_1000  $200.00 

 Streptavidin—5 mg  Thermo fi sher 
scientifi c pierce 

 21125  $325.00 

 Signal probes  Oligos Etc.  –  Call for quote 

 Capture probes  Oligos Etc.  –  Call for quote 

Julio B.J. Harvey



267

disposable fi lters (Millipore) and sterile, disposable luer lock 
syringes (10 mL or greater depending on sample lysate volume) 
are required for preparing sample lysates prior to analysis. 
Nalgene 2 mL screw-top cryotubes (Thermo Fisher Scientifi c, 
Rochester, NY, USA) are recommended for sample fi lter freezing, 
storage, and lysis.   

   6.    Liquid nitrogen: An open mouth dewar (several liter volume) 
and a larger storage dewar are needed if samples will not be 
immediately processed. Sample storage must be in liquid 
 nitrogen (−80 °C or other conditions are not recommended) 
or in RNAlater (Sigma-Aldrich).      

  Fig. 2    Filtration equipment for water sample collection on 25 mm fi lters. ( a ) 6-Place PVC vacuum manifold for 
water sample fi ltration constructed by joining two 3-place manifolds together. ( b ) 200 mL polysulfone fi lter 
funnel atop a 25 mm fi lter holder. ( c ) Water-jet aspirator vacuum pump with pressure regulator and gauge       
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      1.    Guanidine thiocyanate (GuSCN) lysis buffer (Saigene Biotech, 
Inc., Monument, CO, USA): 1.5 M GuSCN, 50 mM Tris, 
15 mM EDTA, 2 % Sarkosyl, and 0.2 % SDS (v/v) pH 8.9–9 
[ 4 ,  11 ]. Stable up to 1 year or more at room temperature.   

   2.    Evergreen 96-well microplates (Evergreen Scientifi c, Los 
Angeles, CA).   

   3.    Wash buffer E (Saigene Biotech, Inc.): 50 mM Tris, 0.15 M 
NaCl, 0.05 % Tween-20, pH 7.6 [ 2 ,  16 ]. Stable up to 1 year 
or more at room temperature.   

   4.    Digoxigenin antibody horseradish peroxidase (HRP) conju-
gate (Saigene Biotech, Inc.): ImmunoPure Peroxidase 
Conjugate Mouse Anti-dig IgG (Cat. No. 200-032-156; 
Jackson ImmunoResearch Laboratories, Inc., West Grove, PA, 
USA) diluted 1:400 in Guardian TM  Peroxidase Conjugate 
Stabilizer/Diluent/Blocker (Cat. No. 37558B; Thermo Fisher 
Scientifi c Pierce, Rockford, IL, USA). Stable up to 1 year 
under dark, 4 °C conditions.   

   5.    HRP Substrate (Thermo Fisher Scientifi c Pierce): 1-Step TM  
Ultra TMB-ELISA substrate for horseradish peroxidase 
enzyme. Stable up to 1 year under dark, 4 °C conditions.   

   6.    Signal solution (Saigene Biotech, Inc.): 2 M GuSCN, 50 mM 
Tris, 10 mM EDTA, 0.5 % Tween-20, pH 8.6 [ 2 ,  4 ,  16 ]. 
Stable up to 1 year at room temperature. For zooplankton 
detection, the fi nal signal solution concentration should be 
0.5 M GuSCN.   

   7.    Signal solution diluent (Saigene Biotech, Inc.): 50 mM Tris, 
10 mM EDTA, 0.5 % Tween-20, pH 8.6 [ 2 ,  4 ,  16 ]. Stable up 
to 1 year at room temperature.   

   8.    Signal probes (Oligos Etc., Wilsonville, OR, USA): Three signal 
probes EUK519, EUK915, and EUK1194 (Table  2 ) are used to 
create the signal solution cocktail [ 2 ,  11 ]. The signal probe 
sequence is fl anked on both sides by Spacer9 TM  ethylene glycol 
backbone spacers with dig-labeled 5′ and 3′ terminal ends. 
Synthesis should be gel purifi ed two times; both before and after 
dig labeling. The fi nal concentration of signal probes in 0.5 M 
signal solution should be 100 ng/mL each probe ( see   Note 4 ). 
Preformulated signal solutions already containing signal probes at 
specifi ed concentrations are also available (Saigene Biotech, Inc.).

       9.    ImmunoPure streptavidin (Thermo Fisher Scientifi c Pierce): 
dilute in Sigma water to approximately 10 mg/mL. After dilu-
tion, 10 mg/mL stock is stable for up to 1 month if parafi lm 
sealed, under dark, 4 °C conditions.   

   10.    Probe Assay Wash (Saigene Biotech, Inc.): 0.1 M sodium 
phosphate dibasic, 0.5 % Tween-20, pH 8.0. Stable for up to 1 
year or more at room temperature.   

   11.    Capture probes (Oligos Etc.): Design should be within roughly 
100–250 base pairs of signal probe locations on the 18S rDNA 

2.2  Sample Lysis 
and 96-Well Plate 
Format SHA Chemistry 
Components
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molecule [ 2 ]. The capture probe sequence has three 5′ 
Spacer9s ™  with a biotin-labeled 5′ terminal end ( see   Note 5 ). 
Synthesis should be gel purifi ed two times; both before and 
after dig labeling.  See  Table  2  for examples of currently pub-
lished capture probes sequences for marine invertebrates.   

   12.    Linker probes (Oligos Etc.) (optional): Linkers are synthetic 
oligonucleotides complementary to both capture and signal 
probes. Although not strictly necessary for performing SHA, 
linkers represent “perfect targets” and are invaluable for test-
ing assay chemistry or diagnosing any problems that may arise 
[ 1 ,  2 ,  15 ].   

   13.    Polystyrene prongs (Saigene Biotech, Inc.): Biotinylated solid 
support for attachment of streptavidin-labeled capture probes. 
Stable for up to 1 year under dark, 4 °C conditions, lint-free 
cloth wrapped and packaged in plastic bags with desiccant 
 supplied by manufacturer.   

   14.    Hydrosulfuric acid solution: A 10 % H 2 SO 4  stock solution is 
necessary for stopping the enzymatic SHA signaling reaction 
after 96-well plate processing has completed. Dilute H 2 SO 4  
from manufacturer 1:10 with deionized water.      

      1.    Heating block (Fig.  3a ): Must be capable of heating 12–13 mm 
outside diameter cryogenic vials to 85 °C ( see   Note 6 ).

       2.    A 300 μL 12-channel pipette and sterile, aerosol-free (barrier) 
tips.   

2.3  Specifi c 
Laboratory Equipment 
Required

    Table 2  
  Published zooplankton probes   

 Probe 
type  Name 

 Target 
organism  Reference 

 Constant 
(μg/OD)  5′–3′ probe sequence 

 Capture  B1066  Barnacles  [ 2 ]  28.49  GTT GCG GAT TGC TGG TCG AC 

 Capture  EUK338  Eukaryotes  [ 2 ]  29.79  CCT GCT GCC TTC CTT GGA TG 

 Capture  M2B  Mussels  [ 11 ]  26.42  AAG GGC GAA AAA CCG GGA GGT AGG T 

 Capture  P1022  Polychaetes  [ 11 ]  25.86  TCC AAC GAA TCG AGA AAG AGC TA 

 Capture  GCRAB   Carcinus 
maenas  

 [ 11 ]  28.53  GGT TTC ACC TTA TAT GGG CTT 

 Capture  OS433   Osedax   [ 11 ]  27.40  AGC ATC GTT AGA TAG CCC GCA TT 

 Signal  EUK519  Eukaryotes  [ 2 ]  28.59  CTG GAA TTA CCG CGG CTG CTG 

 Signal  EUK915  Eukaryotes  [ 2 ]  29.60  GTG CCC TTC CGT CAA TTC CTT 

 Signal  EUK1194  Eukaryotes  [ 2 ]  26.61  CAT CTA AGG GCA TCA CAG ACC 

Sandwich Hybridization Assay 
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   3.    NanoDrop ND-1000 full spectrum UV/visible light spectro-
photometer (NanoDrop, Rockland, DE, USA): Recommended 
for accurate measurement of DNA and protein concentrations 
in small (2 μL) volumes.   

   4.    Saigene 96-well plate processor with Plexiglas dust cover 
(Saigene Biotech, Inc.): A bench-top device (Fig  3b, c ) capable 
of processing up to two 96-well SHA plates simultaneously.   

   5.    VMAX    Kinetic Microplate Reader (Molecular Devices, 
Sunnyvale, CA, USA) or equivalent: A 96-well microplate 
reader (Fig.  3d ) capable of making 650 and 450 nm wave-
length measurements and a computer workstation running 
SOFTmax PRO software (Molecular Devices).       

3     Methods 

      1.    Assemble vacuum manifold by fi rst inserting each 25 mm fi lter 
holder into the center hole of a #8 stopper. It may be necessary 
to slightly lubricate fi lter holder stems with silicon-based lubricant 

3.1  Sample 
Collection and Storage

  Fig. 3    Specifi c equipment required for 96-well SHA plate processing. ( a ) Heating block with cryogenic vial 
sized (12–13 mm outside diameter) wells ( right hand block ). ( b ) Saigene 96-well plate processor ( front view ). 
( c ) Two Saigene plate processors with dust cover lids closed. ( d ) Microplate reader connected to a computer 
workstation running SOFTmax PRO data collection software       
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to facilitate installment. Insert fi lter holder/rubber stopper 
assemblies into manifold ports.   

   2.    Assemble vacuum pump system including pressure gauge and 
regulator. If using a water-jet aspirator, add suffi cient water to 
the reservoir and use tubing to connect the overfl ow drain 
valve to a sink or other drain. Prior to sample fi ltration, turn 
on pump system and adjust pressure regulator so that system 
vacuum pressure is just below 10 in. Hg (0.033 Mpa). Connect 
vacuum manifold to vacuum system with appropriate tubing 
and fi ttings.   

   3.    Place 25 mm fi lters of desired porosity on fi lter holders, insuring 
that plastic fi lter frits are in place below them. Install 200 mL 
fi lter funnels onto fi lter holders, apply vacuum, and open mani-
fold stopcocks. Apply samples to the manifold via fi lter funnels. 
Depending on sample contents, total volume, and fi lter porosity, 
multiple fi lters may be needed for a single sample due to fi lter 
clogging ( see   Note 7 ).   

   4.    Immediately upon completion of sample fi ltration, turn stop-
cocks to cut vacuum pressure and gently remove fi lters with 
forceps, curl fi lter slightly inward, and insert each fi lter into a 
2 mL screw-top cryogenic vial. Immediately immerse in liquid 
nitrogen (use proper protective equipment). Samples must 
remain in liquid nitrogen until analysis. Leave samples in liquid 
nitrogen for 3–5 min minimum before removal for lysis and 
SHA analysis. Typical record keeping includes fi lter porosity 
and sample volume.      

      1.    Resuspend 50 μg lyophilized signal and capture probes in 
150 μL TE (10 mM Tris, 1 mM EDTA) and 200 μL TE, 
respectively. Let resuspended probes sit at room temperature 
for at least 10 min with occasional light vortexing ( see   Note 8 ).   

   2.    Connect NanoDrop spectrophotometer to a computer with 
ND-1000 software installed, open software, and select the 
nucleic acid protocol. Initiate instrument as instructed with 
2 μL Sigma water and make a blank measurement with TE. 
Set the constant fi eld to the constant (number of μg/OD) 
provided on each probe synthesis data sheet. The OD constant 
is specifi c to each probe; therefore the constant fi eld must be 
modifi ed among probe measurements. Measure each probe 
three times, taking the average to arrive at fi nal concentrations 
in ng/μL ( see   Note 9 ).   

   3.    Dilute 2 M signal solution to 0.5 M with signal solution diluent 
(alternatively, make or order 0.5 M stock directly from Saigene). 
Determine how much signal probe must be added to arrive at a 
100 ng/mL fi nal concentration for each probe. Determine 
total volume of all signal probes to be added, and remove that 
volume before adding all signal probes to 0.5 M signal solution. 
Vortex on a high setting for 10 s and invert to mix.   

3.2  96-Well SHA 
Plate Assembly, 
Sample Lysis, and 
Analysis

Sandwich Hybridization Assay 
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   4.       Determine the approximate amount of 1 mg/mL streptavidin 
solution needed to achieve a 1.25 μg/mL fi nal concentration 
for each capture probe solution. Use NanoDrop spectropho-
tometer on protein A280 setting to dilute 10 mg/mL strepta-
vidin stock to 1 mg/mL (A280 reading = 3.44 OD) in a 
suffi cient volume of Sigma water to make capture probe solu-
tions while also allowing for multiple rounds of NanoDrop 
measurement. Continue to measure streptavidin solution, 
adding (with light vortex and spin down) either additional 
Sigma water or 10 mg/mL streptavidin stock (0.5–3 μL incre-
ments) until the average reading reaches 3.44 OD. Once 
diluted, 1 mg/mL streptavidin solution is only viable up to 
24 h (parafi lm sealed at 4 °C) and is best used within hours.   

   5.    Determine volume of resuspended capture probe needed to 
arrive at a fi nal concentration of 400 ng/mL for each capture 
probe solution fi nal volume. Add capture probe to 1/2 fi nal 
volume probe assay wash and mix by gentle swirling and inver-
sion. Add 1 mg/mL streptavidin solution (to reach a fi nal con-
centration of 1.25 μg/mL in 1 volume) to a second 1/2 fi nal 
volume probe assay wash in another container with gentle 
swirling and inversion. Add the streptavidin fraction to the 
probe fraction by careful pouring between containers. Tightly 
cap fi nal volume in a single container and invert and vortex on 
a high setting for 10 s. Capture probe solutions are stable 
under dark conditions at 4 °C for up to 1 year.   

   6.    Assemble SHA plates (Fig.  4 ) by adding reagents in the following 
order (Fig.  4a ) with a 300 μL 12-channel pipette and barrier 
tips (250 μL per well, all reagents): Rows B, C, and E, wash 
buffer E; row D, HRP conjugate; row A, HRP substrate; row 
F, signal solution; row G, capture probes; and row H, sample 
lysate (load just prior to processing). Avoid bubble formation 
when fi lling plate wells by not compressing pipette plunger 
beyond minimum volume setting. If fi lling more than one 
plate, estimate total reagent volumes needed in advance to 
facilitate dispensing (Fig.  4b ). Generally, only two or three 
columns (replicates) contain the same capture probe, so 4–6 
different capture probe (and corresponding signal probe) solu-
tions can be loaded onto a single plate. All other reagents are 
identical across columns within each row. Plates can be sealed 
with a MiniSeal plate sealer (Porvair Sciences, Leatherhead, 
England) and are then stable under dark, 4 °C conditions for 
up to 1 year ( see   Note 8 ).

       7.    Turn on the Saigene plate processor, insuring fi rst that its 
program card is properly installed. Adjust the temperature 
setting for the heated SHA plate stages to 30 °C. Just prior to 
plate analysis, install polystyrene solid support prongs on the 
Saigene plate processor’s prong arm(s). Use forceps and take 
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care not to contact prong tips during installation. One set of 
prongs should be installed for each plate to be processed (up to 
two plates per machine). Discard prongs after a single use. Do 
not leave unused prongs exposed or at room temperature, 
return promptly to dark, 4 °C conditions with desiccation.   

   8.    Remove sample cryogenic vials from liquid nitrogen and allow 
to thaw for 1–3 min at room temperature before adding up to 
2 mL of 1.5 M GuSCN lysis buffer per vial. Tighten vial caps 
and vortex on a high setting for 5 s. Place vials in 85 °C heating 
block for a total of 5 min, briefl y removing at 2.5 min to vortex 
for 5 s. Attach a 0.22 μm Millex Durapore fi lter to a luer lock 
syringe and empty sample lysate into open syringe barrel end. 
Adjust total sample lysate volume to 3.5 mL per plate by add-
ing additional lysis buffer to the syringe barrel, insert syringe 
plunger and push entire sample through fi lter into a 50 mL 
disposable reagent reservoir. Gently mix sample by slightly tilting 
reagent reservoir to move lysate back and forth.   
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  Fig. 4    96-Well SHA plate assembly specifi cs. ( a ) Position of reagents in plate 
wells:  E  wash buffer E,  Con  HRP conjugate,  Sub  HRP substrate,  Sig  signal solu-
tion,  Cap  capture probes, and  Lys  sample lysate. ( b ) Reagent and lysate volumes 
needed for 1–4 SHA plates. When measuring out reagents to multichannel pipet-
ting reservoirs, add 20–100 μL beyond listed volumes to avoid running short or 
introducing bubbles to plate wells       

 

Sandwich Hybridization Assay 



274

   9.    Use 300 μL 12-channel pipette with barrier tips to add 250 μL 
sample lysate per well to row H of the SHA plate. Place each 
SHA plate squarely on one of the Saigene plate processor’s 
heated stages, insuring that the SHA plate is properly centered. 
Press the Run button and insure that the prongs enter all wells 
without contacting the well sides ( see   Note 10 ). Monitor run 
time with the built-in countdown timer. Processing takes 
approximately 1 hour, not including set-up and post-run plate 
analysis. When processing is complete, press the Run button 
when prompted and wait for the prong arms to move to the 
home position.   

   10.    Immediately after processing is completed, move the SHA 
plate(s) to the microplate reader and analyze at 650 nm. 
Immediately add 50 μL of 10 % H 2 SO 4  to plate row A, killing 
the enzymatic signaling reaction. Read plate(s) at 450 nm.   

   11.    In principle, SHA dose-response curves can be generated for 
any organism grown in pure culture or collected from nature 
[ 2 ,  3 ,  5 ,  6 ,  11 ,  15 ]. Examples of SHA dose-response curves 
generated for invertebrate larvae include barnacles, mussels, 
polychaete worms, and the invasive green crab,  C. maenas  [ 2 , 
 11 ]. Dose-response curves can be used to calculate the number 
of individuals present per mL of lysate and subsequently per 
volume of water originally sampled [ 5 ]. Lower limits of detec-
tion can also be determined by comparison of positive control 
samples to 0.22 μm fi ltered seawater (FSW) negative control 
samples. FSW negative controls typically produce an average 
OD reading of 0.05 at both A650 and A450 nm when applied 
to the chemistry described above.       

4     Notes 

     1.    1/4″ male NPT X 1/4″ nipple fi ttings can be used to join two 
or more manifolds together in series. It is best to use “close” 
fi ttings to eliminate additional space between manifolds once 
joined. Correctly apply Tefl on tape to fi tting threads. Prior to 
assembly, remove existing fi ttings if installed. Once fi tting is 
threaded, simply turn adjacent manifolds in opposition (by 
hand) to tighten.   

   2.    It is possible to use vacuum pumps that are not of the water-jet 
aspirator variety. Dry vacuum pumps require the addition of a 
water trap to the system so that manifold fi ltrate does not enter 
the pump. In this case, the water trap must be emptied periodi-
cally, prior to overfl ow.   

   3.    If using the water-jet aspirator pump specifi ed, 1/4″ ID tubing 
connects the manifold(s) to the vacuum system, and 1/2″ ID 
tubing connects the overfl ow hose barb fi tting to a sink or 
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other drain. Other vacuum systems may have different fi ttings 
and therefore different tubing size requirements. Tubing wall 
thickness is important for the portion of the system under vacuum 
and should be suffi cient to withstand vacuum pressure.   

   4.    If ordering directly from the manufacturer, lyophilized probes 
should be resuspended in Sigma water, divided into 50 μg frac-
tions among sterile 0.65 mL microcentrifuge tubes, dehy-
drated under vacuum in a centrifuge concentrator, and stored 
at −80 °C. Always remove gloves when handling lyophilized 
probes because static electrical charge can cause material to 
“jump” out of storage tubes before liquid is added.   

   5.    Capture probes are typically 18–26 base pairs in length with a 
GC content of no more than 40–60 %. Test all probe designs 
prior to purchase using OligoTech analysis software (  http://
www.oligosetc.com/index.htm    ) or equivalent to check probe 
sequence stability, possible stem loop formation, and tendency 
to form homodimers.   

   6.    Standard microcentrifuge tube heating blocks accommodate a 
tube diameter that is too narrow to accept 12–13 mm outside 
diameter cryogenic vials. For most heating units, replacement 
heating blocks that accept cryogenic vial sizes are available for 
purchase.   

   7.    For example, 1.8 L seawater samples from Monterey Bay, 
California, usually require two or three 5 μM fi lters to com-
plete fi ltration in 10–40 min depending on sample contents. 
High turbidity samples tend to slow or clog fi lters more quickly 
and require longer fi ltration times or additional fi lters. In con-
trast, a single 30 μM fi lter typically allows fi ltration of 1.8 L 
seawater in 5–10 min.   

   8.    Alternatively, preformulated signal solution, capture probe 
solutions, or pre-sealed SHA plates containing all necessary 
reagents and custom probes made to user specifi cations can be 
purchased directly—contact Saigene, Inc. for a price quote. 
All reagents produced by Saigene are subjected to rigorous 
quality control testing, work that must otherwise be carried 
out by the end user.   

   9.    Resuspended probes are stable up to 6 months in microcentri-
fuge tubes with parafi lm sealed caps under dark, 4 °C condi-
tions. Stored probes may experience some evaporation, and 
new concentration measurements should be made if more than 
a few days have passed.   

   10.    Saigene plate processor prong arms (and therefore, solid sup-
port prongs, once installed) should be exactly parallel to SHA 
plate surfaces. Additionally, prongs should enter all plate wells 
the same maximum distance (about two thirds of the way from 
the well bottom) without touching the well sides or bottom at 
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any point. If these conditions are not met, the plate processor 
arm needs to be adjusted by a qualifi ed technician before 
proceeding.         

  Acknowledgment 

 This work was supported by and conducted at the Monterey Bay 
Aquarium Research Institute. Sincere thanks to R. Marin III, 
T. Hurford, C. Melançon, C. Preston, N. Alvarado, C. A. Scholin, 
and R. C. Vrijenhoek for their invaluable advice and assistance.  

   References 

      1.    Greenfi eld DI et al (2006) Application of envi-
ronmental sample processor (ESP) methodology 
for quantifying  Pseudo - nitzschia australis  using 
ribosomal RNA-targeted probes in sandwich and 
fl uorescent in situ hybridization formats. Limnol 
Oceanogr Meth 4:426–435  

                 2.    Goffredi SK et al (2006) Molecular detection 
of marine invertebrate larvae. Mar Biotechnol 
8:149–160  

     3.    Haywood AJ et al (2007) Molecular detection 
of the brevetoxin-producing dinofl agellate 
 Karenia brevis  and closely related species using 
rRNA-targeted probes and a semiautomated 
sandwich hybridization assay. J Phycol 43:
1271–1286  

      4.    Scholin CA et al (1999) DNA probes and a 
receptor-binding assay for detection of  Pseudo - 
nitzschia     (Bacillariophyceae) species and 
domoic acid activity in cultured and natural 
samples. J Phycol 35:1356–1367  

      5.    Marin R III, Scholin CA (2010) Toxic algal 
detection using rRNA-target probes in a semi- 
automated sandwich hybridization format. In: 
Karlson B, Cusack C, Bresnan E (eds) 
Microscopic and molecular methods for quanti-
tative phytoplankton analysis. Intergovernmental 
Oceanographic Commission of UNESCO, 
Paris, p 110  

     6.    Ayers K et al (2005) International accredita-
tion of sandwich hybridisation assay format 
DNA probes for micro-algae. N Z J Mar 
Freshwater Res 39:1225–1231  

    7.    Tyrrell JV et al (2001) Detection and enumer-
ation of  Heterosigma akashiwo  and  Fibrocapsa 
japonica  (Raphidophyceae) using rRNA- 
targeted oligonucleotide probes. Phycologia 
40:457–467  

   8.    Mikulski CM et al (2008) Development and 
fi eld application of rRNA-targeted probes for 

the detection of  Cochlodinium polykrikoides  
Margalef in Korean coastal waters using whole 
cell and sandwich hybridization formats. 
Harmful Algae 7:347–359  

    9.    Rhodes LL, Adamson J, Scholin C (2000)  Pseudo -
 nitzschia multistriata  (Bacillariophyceae) in 
New Zealand. N Z J Mar Freshwater Res 34:
463–467  

     10.    Preston CM et al (2009) Near real-time, 
autonomous detection of marine bacterio-
plankton on a coastal mooring in Monterey 
Bay, California, using rRNA-targeted DNA 
probes. Environ Microbiol 11:1168–1180  

            11.    Jones WJ et al (2008) A robotic molecular 
method for in situ detection of marine inverte-
brate larvae. Molecular Ecology Resources 
8:540–550  

   12.    Doucette GJ et al (2009) Remote, subsurface 
detection of the algal toxin domoic acid 
onboard the environmental sample processor: 
assay development and fi eld trials. Harmful 
Algae 8:880–888  

   13.    Scholin C et al (2009) Remote detection of 
marine microbes, small invertebrates, harmful 
algae, and biotoxins using the environmental 
sample processor (ESP). Oceanography 22:
158–167  

   14.   Scholin CA et al. (2001) Aquatic autosampler 
device. US patent 6187530, USA  

      15.    Greenfi eld D et al (2008) Field applications of 
the second-generation environmental sample 
processor (ESP) for remote detection of harm-
ful algae: 2006–2007. Limnol Oceanogr Meth 
6:667–679  

      16.    Scholin CA et al (1996) Identifi cation of 
 Pseudo - nitzschia australis  using rRNA-targeted 
probes in whole cell and sandwich hybridization 
formats. Phycologia 35:190–197    

Julio B.J. Harvey



277

David J. Carroll and Stephen A. Stricker (eds.), Developmental Biology of the Sea Urchin and Other Marine Invertebrates, 
Methods in Molecular Biology, vol. 1128, DOI 10.1007/978-1-62703-974-1_19, © Springer Science+Business Media New York 2014

    Chapter 19   

 Isolation and Assessment of Signaling Proteins 
from Synchronized Cultures During Egg Activation and 
Through the Egg-to-Embryo Transition in Sea Urchins 

           Michelle     M.     Roux-Osovitz     and     Kathy     R.     Foltz    

    Abstract 

   Sea urchins are an excellent model system for investigating fertilization mechanisms and fundamental cell 
biological phenomenon such as release from quiescence, cell division, secretion, and basic signal transduction. 
The ease of gamete collection, fertilization, and culture is complemented by exquisite developmental 
synchronicity and the ability to carry out both large-scale biochemical studies and single-cell experiments. 
In particular, fertilization in echinoderms serves as a paradigm for a digital signaling event—a one-time 
only switch that launches the egg into the developmental pathway. Sperm-induced egg activation is depen-
dent on the release of calcium from internal stores and subsequent effects on a myriad of cellular events 
such as exocytosis, cytoskeletal remodeling, and cell cycle reentry. Here we describe methods to investigate 
individual signaling proteins as well as global proteomic and phosphoproteomic changes involved in the 
initial steps of egg activation through the egg-to-embryo transition.  

  Key words     Sea urchin  ,   Fertilization  ,   2D electrophoresis  ,   Phosphoproteins  ,   Affi nity chromatography  

1       Introduction 

 The transition from a quiescent, unfertilized egg to an actively 
dividing embryo involves a myriad of cellular events collectively 
termed egg activation. A key mediator is calcium, which increases 
transiently in the egg cytosol at fertilization [ 1 ]. Most if not all of 
the proteins involved in egg activation are maternal and thus regu-
lated posttranslationally by modifi cations such as phosphorylation 
or by sequestration or degradation. Therefore, organisms that are 
amenable to biochemical approaches coupled with ease of gamete 
isolation and fertilization are useful models for studying this phe-
nomenon. Sea urchin gametes are easily obtained and in vitro fer-
tilization is straightforward. Because fertilization and subsequent 
cellular changes are synchronous in a given batch, it is possible to 
evaluate signaling events on a rapid (seconds to minutes) time scale 
in a population of cells. A rich history of evaluating single proteins 
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[ 1 ,  2 ] has recently been complemented by the ability to look at 
global changes in the sea urchin egg-to-embryo proteome [ 3 ,  4 ], 
made possible by the completion of the  Strongylocentrotus purpura-
tus  (California purple sea urchin) genome project [ 5 ]. Here we pro-
vide detailed methods for preparing protein fractions from eggs and 
synchronized cultures of fertilized zygotes over a rapid, tight time 
course. These samples can then be analyzed for enzymatic activity, 
protein–protein interactions, or phosphorylation state. These same 
preparative methods can also be used to generate samples for analysis 
by 2-dimensional gel electrophoresis (2DE) and subsequent protein 
identifi cation via tandem mass spectrophotometry. 

 There are a number of concerns to take into account in terms 
of sample size, critical time point capture, buffer conditions to 
enhance a given subcellular fraction or to preserve an interaction, 
and stability of the protein sample, especially with regard to any 
posttranslational modifi cations. We provide detailed methods on 
how to prepare time course samples under non-denaturing condi-
tions for evaluating affi nity interactions with recombinant Src 
Homology 2 (SH2) domain proteins, co-immunoprecipitations, 
and immune complex Src family kinase (SFK) activity assays and 
for phosphoproteome-wide 2DE analyses. 

 An additional important consideration is whether the removal 
of the fertilization envelope (FE) is necessary. At fertilization, the 
calcium release triggers a massive exocytotic event in the egg [ 6 ]. 
The cortical granules fuse with the egg plasma membrane and 
release their contents, causing a permanent change to the egg 
 surface—the slow, mechanical block to polyspermy. This elevated 
FE “hardens” after a few minutes due to cross-linking [ 6 ]. 
However, it is possible to prevent the hardening of the FE and to 
even remove the FE, though this can be a challenge to obtaining 
very tight time courses. In general, we have found it optimal to 
remove the FE and provide detailed methods for this here.  

2     Materials 

 Prepare all solutions using ultrapure water and analytical grade 
reagents and store at 4 °C unless indicated otherwise. For best 
results, use freshly made solutions and do not add sodium azide to 
any buffers. 

  All solutions for use with living  S. purpuratus  eggs and embryos 
are kept and used at 12–15 °C ( see   Note 1 ).

    1.    Natural seawater (NSW): fi lter through a glass fi ber fi lter and 
then a 0.22 μm fi lter and store in designated, detergent- and 
chemical-free carboys. Filter the seawater at least 12 h in 
advance of use and prechill to desired temperature.   

2.1  Reagents 
Needed for 
Fertilization, FE 
Removal, and Culture
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   2.    MBL artifi cial seawater (ASW): 484 mM NaCl, 10 mM KCl, 
11 mM CaCl 2 -H 2 O, 29 mM MgSO 4 -7H 2 O, 27 mM MgCl 2 - 
6H 2 O, NaHCO 3 , pH 8.0 with NaOH at specifi c experimental 
temperature.   

   3.    To induce spawning: 0.55 M KCl and a 5 mL syringe fi tted 
with a 20 G needle.   

   4.    To prevent FE hardening: stock solution of 0.5 M 3-amino- 
1,2,4- triazole (ATAZ) (Sigma Aldrich, Inc; #A8056) dissolved 
in ASW. Just before use, dilute the stock into the desired vol-
ume of ASW to 5 mM.   

   5.    120 μm and 80 μm Nitex mesh (Tetko, Inc; #3-120/52 and 
#3-80/52) for stripping egg jelly coats and FEs, respectively. 
Cut the bottom out of a 50 mL orange cap tube. Secure a 
piece of the mesh across the bottom using a glue gun or a rub-
ber band. Pre wet the mesh in ASW just prior to use.   

   6.    Antibiotics for longer-term cultures: Penicillin–streptomycin 
(5,000 U/mL; Gibco, Inc; #15070).    

     All buffers should be prepared fresh and kept on ice. Protease and 
phosphatase inhibitors should be added just before use ( see   Note 2 ). 
All protein samples should be used immediately; degradation and 
loss of activity occur if sample are frozen and thawed for later use.

    1.    Lysis buffer for protein affi nity interactions and immunopre-
cipitations (HNET): 50 mM HEPES, pH 7.4, 150 mM NaCl, 
5 mM EGTA, 1 mM EDTA, 2 % Triton X-100 (10 μM Protease 
Inhibitor Cocktail III, 50 μM PEFABLOC SC, 0.5 mM 
Na 3 VO 4 , 1 mM NaF).   

   2.    Lysis buffer for 2DE sample preparation (NP40 Buffer): 
50 mM HEPES, pH 7.0, 150 mM NaCl, 15 mM EGTA pH 
8.0, 1 % Nonidet P-40 (0.5 mM Na 3 V0 4 , 10 μM CalBiochem 
Protease Inhibitor Cocktail III, 50 μM PEFABLOC SC, 1 mM 
NaF, 60 mM Na β-glycerophosphate).   

   3.    Protease inhibitors: Protease Inhibitor Cocktail III 
(CalBiochem, Inc; #539134) used at a fi nal concentration of 
10 μM; PEFABLOC SC (Fluka, Inc; #76307) used at a fi nal 
concentration of 50 μM.   

   4.    Phosphatase inhibitors: Sodium orthovanadate (0.5–1 mM 
fi nal); NaF (0.1–1 mM fi nal); Na β-glycerophosphate (60 mM 
fi nal).   

   5.    SDS solubilization buffer: 10 mM Tris, pH 8.0, 1 % SDS 
(passed through a 0.45 μm fi lter).   

   6.    2× kinase buffer (KB): 80 mM HEPES, pH 7.4, 20 mM 
MgCl 2 , 6 mM MnCl 2 , 20 % glycerol, 2 mM DTT.   

   7.    Kinase reaction buffer: For each reaction, dilute 0.7 μL 
γ 32 P[ATP] (10 mCi/mL) in 25 μL of 1× KB.   

2.2  Protein 
Preparation Buffers

Isolation and Assessment of Signaling Proteins from Synchronized Cultures…
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   8.    5× denaturing gel sample buffer: 10 % SDS, 20 % glycerol, 
0.2 M Tris–HCl (pH 6.8), 0.05 % bromophenol blue, 12.5 % 
β-mercaptoethanol (added just before use).    

        1.    Primary antibodies of choice.   
   2.    Protein A-sepharose beads (Sigma, Inc; #P3391) or Protein 

G-sepharose beads (Sigma, Inc; #P3296), Anti-chicken IgY- 
agarose beads (Aves Labs, Inc; #P-1010), or specifi c secondary 
antibody of choice conjugated to beads. Before use, remove an 
aliquot of beads and wash several times with the buffer to be 
used in immunoprecipitation (here, HNET). Note approxi-
mate volume of settled beads. Final resuspension should be a 
50 % slurry of beads in the buffer, kept on ice. Slurry can be 
stored at 4 °C for several weeks.      

      1.    Destreak Rehydration solution: 8 M urea, 0.5 % CHAPS, 
0.01 M DTT, 2 % pH range-specifi c (e.g., pH 4–7) IPG buffer 
(added just prior to use), and 0.002 % bromophenol blue 
(IPG buffer pH 4–7; GE Healthcare, Inc, #17-6000-86).   

   2.    Immobiline DryStrip: pH 4–7, 11 cm (IEF strip), (GE 
Healthcare, Inc; #18-1016-60). This pH range results repro-
ducibly in the optimal resolution of the greatest number of egg 
proteins determined empirically [ 3 ,  4 ] but can be adjusted 
based on parameters for an individual experiment.   

   3.    SDS equilibration buffer 1 (EQ1): 50 mM Tris–HCl pH 8.0, 
6 M Urea, 30 % glycerol, 2 % SDS, and bromophenol blue 
containing 10 mg/mL DTT.   

   4.    SDS equilibration buffer 2 (EQ2): 50 mM Tris–HCl pH 8.0, 
6 M Urea, 30 % glycerol, 2 % SDS, and bromophenol blue 
40 mg/mL iodoacetamide.   

   5.    Criterion Tris–HCl: 8–16 % gradient gels, IPG + 1 well, 11 cm 
(Bio-Rad, Inc; #345-0105).   

   6.    SDS gel running buffer (1× TGS): 25 mM Tris, pH 8.3, 
192 mM glycine, 0.1 % SDS.   

   7.    Agarose for overlaying strips: 0.05 % agarose in 1× TGS, dissolved 
by warming just before use; cool slightly before overlaying.   

   8.    Gel fi x solution: 50 % methanol, 10 % acetic acid.   
   9.    ProQ Diamond stain for phosphorylated proteins (Molecular 

Probes/InVitrogen, Inc; #P-33300).   
   10.    SYPRO Ruby stain for total protein (Molecular Probes/

InVitrogen, Inc; #S-12000).   
   11.    Gel destain for use with ProQ Diamond: 20 % acetonitrile, 

50 mM sodium acetate, pH 4.0.   
   12.    Gel destain for use with SYPRO Ruby stain: 10 % methanol, 

7 % acetic acid.      

2.3  Immunopre-
cipitation Reagents

2.4  2DE Gel 
Components

Michelle M. Roux-Osovitz and Kathy R. Foltz



281

      1.    Trypsin Gold, Mass Spectrometry Grade (Promega, Inc; 
#V5280).   

   2.    Wash buffer 1 for in-gel trypsin digestion: 100 mM NH 4 HCO 3 .   
   3.    Wash buffer 2 for in-gel trypsin digestion: 50 % acetoni-

trile/100 mM NH 4 HCO 3 .   
   4.    Additional components to add to wash buffers: 45 mM DTT, 

100 mM iodoacetamide, acetonitrile.   
   5.    Additional extraction buffer: 60 % acetonitrile/0.1 % formic 

acid.       

3     Methods 

 Carry out gamete collection and fertilization procedures at 
12–15 °C unless otherwise indicated. All other procedures are at 
4 °C unless otherwise indicated. 

         1.    Rinse the adult urchin free of any debris using seawater. Use 
a 5 mL syringe fi tted with a 20 G needle to inject ~1 mL of 
0.55 M KCl directly into the coelomic cavity around the soft 
part of Aristotle’s lantern (the mouth). Set the animal right 
side up until gametes begin to exude. Most species of sea 
urchin are not possible to sex by visual inspection of the adult 
animals. View the gametes as they are released from the gonad-
opores; eggs are yellow–orange and semen is white. The fi ve 
gonadopores are located on the aboral surface (the top of the 
animal).   

   2.    Place male urchin’s aboral side up on a tray of ice. Collect 
sperm “dry” by pipetting it directly from the gonadopores as 
the semen is exuded. Use a pipettor with a yellow tip that has 
had the end cut off to make it wider. Put the semen in micro-
centrifuge tubes and keep on ice. Do not mix sperm from dif-
ferent individuals and do not dilute with seawater.   

   3.    Invert spawning female sea urchin onto a beaker of NSW in a 
cool room (12–16 °C). Ensure that the gonadopores are 
immersed in seawater. Allow the eggs to fall into the beaker 
and settle. Note the approximate volume of settled eggs when 
the female has spawned completely. Transfer the eggs gently 
into a large glass beaker, and add a large (~500×) volume of 
fi ltered NSW. ASW can also be used for the initial collection 
and fi rst wash of the eggs. Allow the eggs to settle again by 
gravity. Decant the NSW (by pouring or pipetting) and gently 
resuspend eggs in a large volume of ASW using a paddle. Allow 
the eggs to settle by gravity and decant.   

   4.    Resuspend the eggs in ASW as a 10 % vol–vol suspension. 
Passage the egg suspension eight times through Nitex mesh 

2.5  Components 
for Protein Sequencing 
by Tandem Mass 
Spectrometry

3.1  Preparation 
of Eggs and 
Synchronized Cultures

3.1.1  Obtaining and 
Washing Gametes
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(120 μm for  S. purpuratus ). Allow eggs to settle by gravity, 
collect the jelly water using a pipette, and save it in a beaker or 
50 mL tube at 12–16 °C.   

   5.    Wash the dejellied eggs twice more by gravity settling in large 
volumes of ASW. Eggs will settle faster once dejellied.      

      1.    Decant the ASW and remove as much ASW as possible using a 
pipette or aspirator.   

   2.    Resuspend the eggs in 500× volume ASW supplemented with 
5 mM ATAZ. Allow the eggs to settle and remove as much 
ASW/ATAZ as possible.   

   3.    Resuspend the eggs in ASW/5 mM ATAZ as a 10 % vol–vol 
suspension.   

   4.    Set aside a sample of eggs as the “unfertilized” sample.   
   5.    For each 100 mL of egg suspension, prepare 50 mL of jelly 

water + 50 mL ASW/10 mM ATAZ in a beaker. Dilute 20 μL 
of dry sperm into this, and mix gently with a paddle to disperse 
the sperm. Immediately pour this into the egg suspension and 
mix gently with a paddle. Set aside a small aliquot to be used 
for viewing FE elevation and early development later.   

   6.    View a drop of the egg suspension under the microscope; 
when >90 % of the eggs appear to have elevated FEs (typically 
less than 1 min), passage them quickly through 80 μm mesh 
4–6 times to strip away the “soft” FE.   

   7.    If a long-term culture is desired, immediately dilute the fertil-
ized eggs in a very large volume of ASW. Wash the fertilized 
eggs twice with large volumes of ASW using gravity settling to 
remove excess sperm.      

      1.    Resuspend the washed, fertilized eggs in a fi nal volume of ASW 
(or NSW) to give a 0.5–1 % (vol–vol) suspension.   

   2.    Add penicillin–streptomycin for a fi nal concentration of 
5 U/mL (usually, a 1:1,000 dilution of the stock antibiotic).   

   3.    Gently transfer the eggs to the culture dish and incubate at 
12–16 °C. Monitor closely. First cell division typically will 
occur within 90 min of insemination and then roughly every 
30 min thereafter until early blastula stage.       

  Follow the fertilization procedure as outlined above 
(Subheading  3.1 ;  see   Note 3 ). Pre-label and prechill all of the tubes 
for sample collection. A small mini centrifuge with pulse spin capa-
bility (such as a Fisher Scientifi c mini centrifuge, #05-090-128) 
is desirable for quickly collecting eggs. Have multiple pipettors 
available (with desired volume preset) and a ready supply of tips. 
For very rapid, tight time course sample preparation (secs to mins 

3.1.2  Fertilization 
Procedure ( See   Note 3 )
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post sperm addition), it is not feasible to strip the softened FEs 
from the fertilized eggs prior to solubilization ( see   Note 4 ).

    1.    For each time point to be collected, prepare 2 microcentrifuge 
tubes and a 1 mL tuberculin syringe fi tted with a 27.5 G needle. 
Preload the syringes with 250 μL of lysis buffer (HNET). Keep 
on ice.   

   2.    Transfer 1.5 mL of unfertilized egg suspension to one tube 
and pulse spin at    250–500 × g to collect eggs. Quickly remove 
the ASW using a pipette or an aspirator, and use the syringe to 
quickly resuspend and lyse the eggs. Triturate the sample to 
lyse the eggs, avoiding air bubbles. Keep on ice.   

   3.    Fertilize the remainder (or a portion of) of the sample, starting 
a timer as soon as sperm are added to eggs ( see   Notes 4  and  5 ).   

   4.    Repeat  step 2  for each time point sample, working as quickly 
as possible. The “time point” is the time of lysis, so collect and 
centrifuge the sample in advance, gauging how long it is taking 
to centrifuge and prepare the sample for lysis.   

   5.    After the last time point is taken and solubilized, allow all samples 
to sit on ice for an additional 10 min.   

   6.    Centrifuge all of the samples at maximum speed in a refrigerated 
microcentrifuge (4 °C) for 30 min.   

   7.    Carefully transfer the supernatant (“total soluble protein 
lysate”) to a new tube, prechilled on ice. The pellets (“insoluble”) 
may be saved and solubilized in SDS buffer.   

   8.    Determine the total protein concentration of each soluble 
lysate sample by desired method ( see   Note 6 ). Using the 
volumes recommended here, each sample should be roughly 
50–200 mg/mL total soluble protein. This lysate can then be 
diluted in the appropriate buffer to the desired protein concen-
tration for further analysis.    

    Follow the fertilization procedure as outlined above 
(Subheading  3.1 ;  see   Note 3 ). Pre-label and prechill all of the tubes 
and syringes for sample collection. A tabletop centrifuge (such as a 
Beckman RC50 or an old-style hand-crank centrifuge) is desirable 
for quickly collecting eggs. Have multiple pipettors available (with 
desired volume preset) and a ready supply of tips. Buffers (HNET 
or NP40 depending on the planned use) should be prechilled on 
ice and all inhibitors added just before starting the time point 
collections.

    1.    For each time point to be collected, prepare a 15 mL polypro-
pylene tube and a 5 mL syringe fi tted with a 27.5 G needle. 
Keep on ice to prechill.   

   2.    Transfer 10 mL of egg suspension to one tube, and centrifuge 
at 250–500 × g for 1 min to collect eggs. Quickly remove the 

3.3  Large-Scale 
Isolation of Protein 
Samples Over a 
Broader Time Course
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ASW using an aspirator. Resuspend the eggs in 2 mL ice- 
cold lysis buffer using a pipette tip ( see   Note 7 ). Passage the 
sample through a 27.5 G needle fi tted on a 5 mL syringe to 
lyse the eggs. Triturate the sample, avoiding air bubbles. Keep 
on ice. This is the “unfertilized sample.”   

   3.    Fertilize the remainder (or a portion) of the sample, starting a 
timer as soon as sperm are added to eggs. If feasible (depending 
on desired time points), remove softened FEs from fertilized 
eggs prior to taking samples ( see   Notes 4  and  5 ).   

   4.    Repeat  step 2  for each sample, working as quickly as possible. 
The “time point” is the time of lysis, so collect and centrifuge 
the sample in advance, gauging how long it is taking to 
centrifuge and prepare the sample for lysis.   

   5.    After the last time point is taken, allow all samples to sit on ice 
for an additional 10 min.   

   6.    Aliquot the samples to pre-labeled and prechilled microfuge 
tubes on ice.   

   7.    Centrifuge the samples at maximum speed in a refrigerated 
microcentrifuge (4 °C) for 30 min.   

   8.    Carefully transfer the supernatants (“total soluble protein 
lysate”) to new tubes, prechilled on ice. The pellets (“insoluble”) 
may be saved and solubilized in SDS buffer.   

   9.    Determine the total protein concentration of each soluble lysate 
sample by desired method ( see   Note 6 ). Each sample should be 
roughly 50–200 mg/mL total soluble protein ( see   Note 7 ). 
This lysate can then be diluted in the appropriate buffer to the 
desired protein concentration for further analysis.    

    Consider controls carefully ( see   Note 8 ). The procedure described 
here has been optimized for recombinant SFK SH2 domain pro-
teins prepared as N-terminal GST fusions but also works well with 
His-tagged SH2 domains [ 7 ].

    1.    Each affi nity interaction (pull down) will use 1 mL of protein 
lysate adjusted to a concentration of 1 mg/mL in HNET buf-
fer. Aliquot the lysate into 1.5 mL microcentrifuge tubes on 
ice. Be sure to save enough lysate for later assessment as “total 
input.”   

   2.    Add the appropriate volume of fusion protein on beads to give 
5 μg of fusion protein to each sample ( see   Note 9 ).   

   3.    Mix well and place on a wheel or rotator at 4 °C for 2–12 h. 
Timing may have to be optimized depending on the bait 
protein and conditions.   

   4.    Centrifuge the samples at 6,000 × g for 1 min in a refrigerated 
microfuge (4 °C).   

3.4  Protein Affi nity 
Interactions Using 
Recombinant SH2 
Proteins as Bait
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   5.    Carefully remove the unbound supernatant and transfer it to 
appropriately labeled tubes on ice (if it is to be analyzed) or 
discard it.   

   6.    Add 1 mL of ice-cold lysis (HNET) buffer to each tube. Mix 
well, so beads are resuspended completely. Place back on the 
wheel or rotator for 10–15 min at 4 °C.   

   7.    Repeat  steps 4 – 6 .   
   8.    Do two additional washes, simply resuspending the beads and 

then centrifuging immediately ( see   Note 10 ).   
   9.    After the fi nal wash and removal of supernatant, pulse spin the 

samples in the microcentrifuge. Using a thin, elongated gel- 
loading pipette tip, remove as much buffer as possible from the 
bead bed.   

   10.    Add 1 bead volume of 2× gel sample buffer and mix gently by 
fl icking. Heat at 95 °C for 5 min. Pulse spin and load on a 
denaturing SDS polyacrylamide gel immediately, leaving 
behind the beads on the bottom of the tube.    

         1.    For each immunoprecipitation (IP), use between 0.25 and 
1 mL of soluble protein lysate adjusted to 1 mg/mL protein 
concentration. Aliquot in microcentrifuge tubes on ice.   

   2.    Add the primary antibody to each sample and mix gently 
( see   Note 11 ).   

   3.    Incubate on a wheel or platform rocker at 4 °C for 4–16 h 
( see   Note 12 ).   

   4.    Pulse spin to remove liquid from cap of tube and place samples 
on ice.   

   5.    Add 10 μL of a 50 % slurry of Protein A-sepharose to each 
sample and mix gently ( see   Note 11 ).   

   6.    Incubate on a wheel or platform rocker at 4 °C for 2–4 h.   
   7.    Centrifuge the samples at 6,000 × g for 1 min in a refrigerated 

microfuge (4 °C) to collect the beads.   
   8.    Carefully remove the unbound supernatant and transfer it to 

appropriately labeled tubes on ice (if it is to be analyzed) or 
discard it.   

   9.    Add 1 mL of lysis (HNET) buffer to each tube. Mix well, so 
beads are resuspended. Place back on the wheel or rotator for 
10–15 min at 4 °C.   

   10.    Repeat  steps 7 – 9 .   
   11.    Do two additional washes, simply resuspending the beads in 

HNET and then centrifuging immediately.   
   12.    After the fi nal wash and removal of supernatant, pulse spin the 

samples in the microcentrifuge. Using a thin bore, elongated 

3.5  Immunopre-
cipitations
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gel-loading pipette tip, remove as much buffer as possible from 
the bead bed.   

   13.    If samples are to be analyzed on gels and by subsequent immu-
noblotting, add 1 bead volume of 2× gel sample buffer and 
mix gently by fl icking. Heat at 95 °C for 5 min. Pulse spin and 
load on gel immediately, leaving the beads in the tube. If sam-
ples are to be subjected to kinase assays, keep washed IPs on ice 
and proceed immediately to Subheading  3.6 , below.      

       1.    Prepare and wash immunoprecipitates (IPs) as in 
Subheading  3.5 . Remove as much buffer as possible from the 
IPs using a thin bore gel-loading tip.   

   2.    Wash each IP in ice-cold 0.5 mL 1× kinase buffer (KB; no 
ATP or substrate). Remove as much buffer as possible with 
gel- loading tip.   

   3.    Resuspend each IP in 25 μL of 1× KB containing 0.7 μCi of 
γ- 32 P[ATP] on ice. If using exogenous substrate, add this last. 
Mix gently and pulse spin ( see   Note 13 ).   

   4.    Incubate at room temperature (or up to 30 °C) for 15 min 
(the temperature and time of incubation may need to be opti-
mized; for echinoderm SFKs, 16–20 °C for 15 min typically is 
optimal).   

   5.    Add 10 μL of 4× Laemmli gel sample buffer, mix, and heat at 
95 °C for 5–10 min. Pulse spin and load on gels immediately 
( see   Note 14 ).      

  The following 2DE protocol was designed to obtain and analyze 
the maximum resolvable components of the entire sea urchin egg 
proteome and phosphoproteome [ 3 ,  4 ]. Special consideration 
should be taken and adjustment made according to specifi cs of 
individual research questions. Many parameters can be altered 
including lysis buffer composition, pH range and profi le of isoelec-
tric focusing, and pH range and resolution of gels. All of these 
parameters can be easily adapted to the protocol outlined here. 
Typically, a minimum of four gels should be run for each sample:

    1.    For each time point sample to be analyzed, denature 100 μg 
NP40-soluble protein in Destreak Rehydration solution 
(including 2 % IPG pH specifi c buffer) to a fi nal volume of 
200 μL. Incubate for 30 min at 25 °C with occasional vortexing 
in order to reduce protein aggregates.   

   2.    Immediately place each sample in a re-swelling tray, and care-
fully overlay with the 11 cm pH 4–7 IEF strip ( see   Note 15 ). 
Allow to rehydrate overnight at 25 °C.   

   3.    Separate proteins in the fi rst dimension by isoelectric point. 
For 11 cm IEF strips pH 4–7, the following program works well: 

3.6  Immune Complex 
Kinase Assays

3.7    2DE
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300 V 0:01 h, 3,500 V 1:30 h, 3,500 V 3:00 h ( see   Note 16 ). 
Samples here were focused using a Multiphor II fl atbed (GE 
Healthcare, Inc) with these additional parameters: set 2 mA 
and 5 W total and run in gradient mode with current check 
turned OFF ( see   Note 17 ).   

   4.    Prepare the EQ1 and EQ2 buffers, allowing enough time for 
the reducing agents to dissolve (do not heat).   

   5.    Immediately after IEF is complete, the strips should be equili-
brated for the second dimension. If absolutely necessary, the 
IEF strips can be stored in plastic conical tubes at −80 °C, but 
this is not recommended. Carefully remove IEF strips from 
focusing tray and place gel side up in a clean re-swelling tray or 
other clean tray of choice. Wash the focused IEF strips for 
15 min at 25 °C with gentle agitation in EQ1 (use enough to 
cover strip in tray).   

   6.    Wash the strips an additional 15 min in the same volume of 
EQ2 ( see   Note 18 ).   

   7.    Separate the focused proteins in the IEF strips based on size in 
the second dimension by SDS PAGE using precast Criterion 
Tris–HCl 8–16 % gradient gels, IPG + 1 well, 11 cm. If using 
the Dodeca Cell from Bio-Rad, prepare 7 L gel running buffer 
(1× TGS) and prechill to 4 °C prior to running the second 
dimension. Remove IEF strips from the re-swelling tray, dip 
them in cold 1× TGS, and place carefully in the Criterion IEF 
well with gel side facing forward. Overlay the strips with warm 
0.05 % agarose in 1× TGS, being sure to avoid introducing 
bubbles. Run until dye front reaches end of gel. Again, all 
samples should be run in quadruplicate, and each dimension 
should be run simultaneously for each set to maximize repro-
ducibility ( see   Note 19 ).   

   8.    Remove gels from cases and place each one directly into 
100 mL gel fi x solution. Cover and incubate for 10–16 h with 
gentle agitation at 25 °C ( see   Note 20 ).   

   9.    If phosphorylated proteins are to be analyzed, stain the gels 
fi rst with ProQ Diamond stain using a volume equivalent to 
10× volume of the gel. Incubate in the dark with gentle agita-
tion for 90 min (do not stain overnight). To destain, carefully 
transfer the gel into a new container and incubate with 100 mL 
ProQ destain for 30 min in the dark with gentle agitation. 
Repeat destain step twice more (90 min total). Wash gels twice 
with ultrapure water for 5 min with gentle agitation. Replace 
water with fi x solution. Image immediately always protecting 
gels from light (see below).   

   10.    To stain for total protein using SYPRO Ruby, either skip 
the ProQ stain ( step 9 , above) or the ProQ gels can be 
subsequently stained with SYPRO Ruby after imaging them. 
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If staining gels directly following the 2D SDS gel run, incubate 
the gels in 100 mL fi x solution in the dark for 30 min with 
gentle agitation. Repeat for a total of 60 min. Fixed gels can be 
stained with 60 mL SYPRO Ruby in the dark overnight. 
Alternatively, imaged ProQ stained gels can be placed directly 
into SYPRO Ruby stain and incubated overnight in the dark 
with gentle agitation at 25 °C.   

   11.    Transfer SYPRO stained gels into a clean container, and destain 
with 100 mL 10 % methanol, 7 % acetic acid for 30 min in the 
dark with gentle agitation.   

   12.    Immediately image the gels ( see   Note 21 ) using a Bio-Rad FX 
scanner with a ~600 nm band pass emission fi lter taking care to 
always protect gels from light. If using other imaging platforms, 
follow instrument specifi c instructions available from the manu-
facturer of the stains (Molecular Probes/InVitrogen, Inc).    

    Image analysis, spot isolation, and protein identifi cation will vary 
greatly depending on availability of platforms and software being 
used. The following provides one example of analysis using 
PDQuest (version 7.4) for spot detection and gel excision using 
the ProteomeWorks station (Bio-Rad, Inc) and quadrupole time-
of- fl ight tandem mass spectrometry (Q-ToF MS/MS). Investigators 
are encouraged to explore all options and utilize a combination 
that is feasible given resources and will most effectively answer the 
research question being posed. 

      1.    Import images into PDQuest (version 7.4, Bio-Rad, Inc). 
Detect spots using the following fi lter parameters within 
PDQuest; noise smoothing fi lter-median 7 × 7, fl oating ball 
background detection fi lter set at default 21–27, vertical streak 
fi lter 43, and horizontal streak fi lter 53. Sensitivity should be 
set at 102.01 with a minimum size scale =5, minimum peak 
=63, and speckle detection =100.   

   2.    Normalize matched spot quantities to total pixel density in 
respective gel images (reported in units = PPM). Organize images 
within PDQuest as “match sets.” Group replicate ( n  = 4) treat-
ments and individually reconcile spots by eye within each group 
(very laborious, but necessary), then analyze for changes between 
treatment groups by establishing analysis sets.   

   3.    Analysis sets should include the following: qualitative presence/
absence and quantitative ≥1.5 increase/decrease. At least three 
of four gels must contain the spot meeting these criteria to be 
included for further analysis. For ProQ Diamond-stained gels, 
all spots must also be detected and matched in SYPRO Ruby 
image replicate groups in order to be successfully excised.   

   4.    Perform quantitative analysis of selected spots as a confi rmation 
of analysis set detection and visual determination of protein 

3.8  Protein Spot 
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dynamics. Measure relative spot intensity in PPM and calculate 
the coeffi cient of variance (CV) within each replicate group. 
Only spots whose replicate group CV is <30 % should be con-
sidered for quantitative differential detection analysis. The CV 
threshold is determined based on the combined amount of 
error induced by experimental variance and PDQuest software 
[ 8 ]. Quantitative differences between replicate groups are then 
calculated using Excel for both SYPRO Ruby and ProQ 
Diamond images. Set a threshold at ≥1.5 fold. Proteins 
reported having differential phosphorylation must not show a 
signifi cant change in total protein detection using SYPRO 
Ruby, ensuring selection based on posttranslational modifi ca-
tion and not protein abundance.      

      1.    Select proteins based on gel analysis (see above) and excise 
them using the ProteomeWorks robotic spot cutter and 
PDQuest Basic Excision Software ( see   Note 22 ).   

   2.    Excised gel pieces will be in the bottom of microfuge tube. 
Wash the gel pieces for 20 min in 500 μL of 100 mM NH 4 HCO 3  
with gentle agitation. Discard the wash.   

   3.    Add 150 μL of 100 mM NH 4 HCO 3  and 10 μL of 45 mM 
DTT. Incubate at 50 °C for 15 min.   

   4.    Cool to room temperature and add 10 μL of 100 mM iodo-
acetamide, and incubate for 15 min in the dark at room 
temperature.   

   5.    Discard the solvent and wash the gel slice in 500 μL of 50 % 
acetonitrile/100 mM NH 4 HCO 3  with gentle agitation for 
20 min. Discard the solvent.   

   6.    Add 50 μL of acetonitrile. After 10–15 min, remove the sol-
vent and dry the gel pieces in a speed vac to remove excess 
acetonitrile.   

   7.    Re-swell the gel pieces in 10 μL of 25 mM NH 4 HCO 3  
 containing Promega Trypsin Gold (mass spectrometry grade) 
following the manufacturer’s protocol to determine the 
amount of enzyme to add (if the amount of protein in the gel 
slices is not known, add 10–20 μL of 0.1–0.2 μg of trypsin in 
10 μL of 25 mM NH 4 HCO 3 ). After 10–15 min, add 10–20 μL 
of 25 mM NH 4 HCO 3  to cover the gel pieces. Incubate over-
night (8 h or more) at 37 °C.   

   8.    Remove the supernatant (containing peptides) and transfer to 
a new microcentrifuge tube. Extract remaining peptides from 
the gel pieces twice with 50 μL of 60 % acetonitrile/0.1 % 
formic acid for 20 min. Add these extracts to appropriate 
tubes containing the initial supernatant of the sample. Speed 
vac to dry.      

3.8.2  Isolation of 
Selected Proteins
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      1.    Subject the trypsin-digested peptides to Q-ToF MS/MS.   
   2.    Analyze peptide spectra using, for example, ProteinLynx 

Global Server (PLGS) software (Waters, Inc).   
   3.    Design PLGS workfl ows to search the sea urchin genome on 

the NCBI database.   
   4.    Assign putative protein identities based on the best hit assessed 

by E-value, and then cross-check by tBLASTn analysis (  www.
ncbi.nlm.nih.gov/BLAST/    ) and by BLASTp against the 
 S. purpuratus  gene predictions on Spbase (  http://www.spbase.
org/SpBase/    ).   

   5.    Gene expression of each protein identifi ed should be evaluated 
by manual inspection of the embryonic tiling array data to con-
fi rm expression [ 9 ]. Proteins selected for quantitative analysis 
reported should have at least two nonoverlapping peptide 
matches.        

4     Notes 

     1.    All glassware for use with gametes and embryos should be 
detergent- and chemical-free and kept separate from other 
glassware. Glassware should be kept clean using water and a 
paper towel to wipe the inside. Periodic treatment of the glass-
ware with mild acid (such as 10 % nitric acid) followed by 
extensive rinsing in deionized and then ultrapure water aids in 
keeping the glassware clean. Finally, precool the glassware and 
then rinse the glassware in seawater of the desired temperature 
just prior to use. Large pyrex glass baking dishes are useful for 
large cultures. For smaller cultures, glass fi nger bowls work 
well. Seawaters and 0.55 M KCl solution can be stored at 
12–15 °C for several weeks.  S. purpuratus  adults are gravid in 
the winter months; the methods described here can be readily 
adapted to other species of sea urchin (such as  Lytechinus 
pictus ) and to Asteroidea sea stars [ 10 ].   

   2.    All buffers are used with the protease inhibitors listed in 
Subheading  2.2 ; phosphatase inhibitors also are included in 
these protocols, which are optimized for preserving phospho- 
epitopes. However, use of particular phosphatase inhibitors 
may be varied. All inhibitors should be added to buffer aliquots 
just before use. We have found it useful to prepare concen-
trated stock solutions (100–1,000×) of inhibitors, aliquoted 
and stored at −20 °C. For commercial stock solutions, aliquot 
after the fi rst use. Avoid freeze thawing. In particular, a stock 
solution of 100 mM sodium orthovanadate should be pre-
pared by dissolving in water and adjusting the pH with NaOH 
to pH 10. The color of the solution will be yellow. Heat in a 
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boiling water bath until solution clears. Cool to room 
temperature and readjust to pH 10. Use immediately or aliquot 
and freeze.   

   3.    Prior to carrying out the fertilization procedure, determine the 
time points that are to be collected. All tubes, buffers, and 
centrifuges should be prepared in advance. This fertilization 
protocol is the basic one, designed to ensure synchronous fer-
tilization. If <98 % fertilization occurs (as assessed by FE eleva-
tion), do not continue; start over with a new batch of eggs.   

   4.    For extremely tight time courses over the fi rst few min after 
sperm addition, it is not feasible to strip the FEs as this requires 
too much time. For short time courses, in fact, it is not even 
necessary to prevent FE hardening as the eggs will be lysed 
before the hardening occurs (we do, however, recommend 
stripping FEs whenever possible). For very tight time courses, 
multiple people are required to manipulate the samples. One 
way that has worked well in our laboratory is to designate an 
individual to collect the time point (place the sample into the 
tube and centrifuge), a second individual to pulse centrifuge 
and remove the overlying seawater, and a third individual to 
deliver the lysis buffer and triturate the sample. Having more 
than one person to carry out this last step can be very helpful. 
As eggs lyse, the color transitions from a milky orange to a 
clear, bright orange.   

   5.    Always retain a small portion of the fertilized eggs so that the 
embryos can be monitored for normal cell division and early 
development. Follow the procedure outlined in the Methods 
section for setting the culture.   

   6.    We typically use the BCA Protein Determination Assay (Pierce; 
#23225), setting a BSA standard curve and blanking with the 
lysis buffer being used (containing the protease and phospha-
tase inhibitors).   

   7.    When preparing large-scale samples for 2DE analyses, samples 
can be resuspended and lysed in a slightly larger volume of lysis 
buffer. Roughly twice the volume of the egg pellet typically 
suffi ces to yield fi nal soluble protein concentrations in the 
range of 10–50 mg/mL.   

   8.    Always include a negative control. GST protein alone is a minimal 
negative control, but a GST fusion protein that is “inactive” or 
related to the experimental protein is better. For example, the 
Src superfamily of kinases includes ABL, which can serve as a 
negative control. The SH2 domain of the Abl kinase has no 
effect on Ca 2+  release in sea urchin eggs, while specifi c SFK 
SH2 domains have strong inhibitory effect; similarly, the 
proteins that associate with the Abl SH2 domain are distinct 
from those that associate with those of the SFKs required for 
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sperm-induced Ca 2+  release [ 7 ]. A further negative control 
that helps ensure specifi city is use of a point- mutated, non-
functional SH2 domain protein [ 11 ,  12 ]. If background is a 
problem, a preclearing step with GST alone or the control 
SH2 domain beads can be helpful.   

   9.    Each affi nity interaction requires 5 μg of fusion protein on 
sepharose or agarose beads. The protein concentration on the 
beads is one of the most critical aspects of the pull down. 
Too much protein per bead, the washes will be diffi cult and the 
interaction will not be effi cient. Typically, adding at least 10 μL 
of beads to the reaction (50 μL is better) is required for pipet-
ting ease. This necessitates optimizing the fusion protein 
expression and capture procedure. This will vary somewhat 
with each specifi c fusion protein. In our experience, most echi-
noderm SFK SH2 domain proteins express well in bacteria; 
adding 1.5 mL of a 50 % GT-bead slurry to the soluble lysate 
prepared from a 50 mL culture of bacteria captures roughly 
1–5 μg of fusion protein per 10 μL of beads. In addition, most 
SH2 fusion protein beads can be stored at 4 °C for up to a 
week before use [ 7 ].   

   10.    If high background is a problem, additional washes or adjust-
ment to the components of the wash buffer (increasing salt or 
detergent concentration) may be required.   

   11.    Follow the manufacturers’ recommendations when using com-
mercially available antibodies, unless it has been empirically 
determined that different amounts will work. It is important to 
avoid adding too much antibodies (generally no greater than 
10 μg/mL) because the antibody can precipitate on its own, 
problems with background can arise, and quantitatively recov-
ering the IgG can be problematic. Be sure to include controls 
(such as no antibody, pre-immune antibody, neutralized anti-
body, or a positive control antibody). The antibody capture 
step method will be dictated by your primary  antibody. For 
most polyclonal antibodies raised in rabbit or mouse, Protein 
A or Protein G conjugated to Sepharose works well. Other 
antibodies, such as those raised in chickens (IgY) will necessi-
tate a different secondary antibody conjugate. Please  see  [ 13 ] 
for excellent considerations of optimizing IPs.   

   12.    The incubation time and temperature may need to be optimized. 
In our experience, we have had the best luck in terms of speci-
fi city with longer incubations at cooler temperatures.   

   13.    We have found that using “driver free” (no unlabeled MgATP 
in the reaction) kinase assays [ 14 ,  15 ] increases the sensitivity 
in immune complex kinase assays for the egg SFKs. However, 
if using recombinant kinases and substrates in vitro, the 2× 
kinase reaction buffer can contain up to 200 μM MgATP.   
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   14.    If labeled proteins or added substrates are to be analyzed 
by autoradiography or phosphorimaging, follow this step. 
However, if exogenously added substrate is to be analyzed by 
other methods, follow the manufacturers’ suggested protocol 
for substrate analysis.   

   15.    Make sure the rehydration tray is cleaned with detergent, 
dried, and leveled. Load samples into the center of the well, 
with care not to introduce bubbles. Lay the strip gel facedown 
into the solution. Do not introduce bubbles, as this will lead to 
uneven rehydration. Gently overlay with mineral oil and leave 
overnight at room temperature to rehydrate. It is very impor-
tant not to heat the sample over 37 °C. The high content of 
urea (6 M) in the rehydration buffer can cause carbamylation 
at elevated temperatures.   

   16.    Be aware that IEF programs are often reported as times or kV 
hours. Optimization of focusing can be achieved by changing 
the last step in the focusing program. This will help to increase 
resolution and decrease smearing or streaking across the gel. 
A clean apparatus, careful technique, and uniform cooling of 
the fl atbed will also ensure good focusing.   

   17.    The dye front will run toward the anode. Always check this 
after 5–10 min into the run to ensure proper electrode connec-
tions. The power supply can be paused at any time during a 
run for any necessary adjustments. When running shorter 
strips, the maximum voltage will not be reached due to limits 
of conductivity.   

   18.    Throughout all 2DE experimental procedures, it is crucial to 
strictly adhere to time of washes and incubations to ensure 
consistency between replicates and experiments.   

   19.    Use of commercially available precast gels is not necessary but 
is recommended to ensure consistent results between gels and 
experiments. We have found the use of precast gels to be 
 cost- effective with respect to both materials and time.   

   20.    Fixed gels can be stored for extended periods of time (6 months +) 
prior to being stained. Use an airtight container and store in 
the dark. Staining containers must be polypropylene or poly-
carbonate; these high-density plastics adsorb minimal amounts 
of the dye (examples include Servinʼ Saver ®  and Stain Shield® 
containers from Rubbermaid). For best results, use containers 
dedicated for SYPRO ®  Ruby dye gel staining to minimize dye 
cross-contamination or other artifacts.   

   21.    Following destaining of either ProQ or SYPRO Ruby stains, 
rinse the gels in ultrapure water for 2–5 min just before 
imaging. This will help prevent corrosion of the imaging 
instrumentation.   

Isolation and Assessment of Signaling Proteins from Synchronized Cultures…



294

   22.    The number of spots excised from gels used to yield peptides 
will depend on relative protein abundance and the specifi c 
mass spectrometry technique used. In our experiments, we 
collected from a minimum of four gels over multiple experi-
ments [ 3 ,  4 ].         
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    Chapter 20   

 Tools for Sea Urchin Genomic Analysis 

           R.     Andrew     Cameron    

    Abstract 

   The Sea Urchin Genome Project Web site, SpBase (  http://SpBase.org    ), in association with a suite of 
 publicly available sequence comparison tools provides a platform from which to analyze genes and genomic 
sequences of sea urchin. This information system is specifi cally designed to support laboratory bench studies 
in cell and molecular biology. In particular these tools and datasets have supported the description of the 
gene regulatory networks of the purple sea urchin  S. purpuratus . This chapter details methods to undertake 
in the fi rst steps to fi nd genes and noncoding regulatory sequences for further analysis.  

  Key words     Sea urchin  ,    Strongylocentrotus purpuratus   ,   Genome  ,   Gene regulatory network  , 
  Cis- regulatory module  

1       Introduction 

 Access to genomic information through a Web-based system has 
become an indispensible tool for laboratory research designed to 
reveal the molecular mechanisms that are the focus of studies in 
cell and developmental biology. Each new high-throughput tech-
nique, whether for genome and transcriptome sequencing or mea-
surement of transcript abundance, adds exponentially to the data 
bits that need to be organized, analyzed, and archived in a manner 
amenable to human observation. A specifi c Web system (  http://
SpBase.org    ) for echinoderm genomics in general and purple 
sea urchin ( Strongylocentrotus purpuratus ) in particular fills this 
role [ 1 ]. 

 Due in part to the ease of gene transfer and the broad base of 
experimental embryology at both the cell and molecular levels, the 
sea urchin system has proven to be an ideal platform to describe 
the gene regulatory networks (GRN) that control developmental 
processes [ 2 ]. Cis-regulatory elements that are hard-wired in the 
genome are the primary building blocks of GRNs and the sites 
through which regulatory genes that make up networks interact. 
A variety of sequence analysis and display tools are needed to 
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accomplish these studies [ 3 ]. Here we will briefl y describe the 
data types available and the tools to use them from the viewpoint 
of SpBase.  

2     Sea Urchin Genome Data Resources (Materials) 

     1.    The California purple sea urchin,  Strongylocentrotus purpuratus  
(Sp), was the first echinoderm selected for sequencing in 
the early 2000s and the genome was completed in 2006 [ 4 ]. 
The genome of  S. purpuratus  is fairly well characterized for a 
non- chordate deuterostome. There are 42 chromosomes [ 5 ] 
and the mass of the diploid genome is 1.8 pg [ 6 ]. This corre-
sponds to about 800 Mb of sequence. A complement of about 
23,300 protein-coding genes was estimated from gene predic-
tions and EST comparisons [ 4 ].   

   2.    At the time of this writing, the newest sequences of echino-
derm genomes and transcriptomes are derived from next-gen-
eration sequencing protocols and they continue to increase 
exponentially. Several additional sequencing rounds have pro-
vided additional information to signifi cantly improve the 
assembly of the reference species,  S. purpuratus . NIH has 
approved the genome sequencing of three additional species of 
echinoderms by the Human Genome Sequencing Center, 
Baylor College of Medicine (BCM-HGSC), in order to perfect 
new short read methods for the highly polymorphic genomes 
such as those possessed by these animals. The HGSC contin-
ues to sequence echinoderm genomes and transcriptomes for 
the following species:  Strongylocentrotus purpuratus ,  S. francis-
canus ,  Allocentrotus fragilis ,  Lytechinus variegatus ,  Eucidaris 
tribuloides , and  Patiria miniata  ( see  Table  1 ). These genome 
sequence resources are be added to SpBase as they come 
available.

       3.    There are a number of Web sites that present sea urchin data 
publicly ( see  Table  2 ). The archival site at NIH, the National 
Library of Medicine, National Center for Biotechnology 
Information (NCBI) is the fi rst public repository for all feder-
ally funded sequencing project results. They also maintain 
information on the extent of various genome projects and link 
to many other kinds of information including their own inde-
pendent gene annotation of the  S. purpuratus  genome assem-
bly. As the short read sequencing, especially of transcriptomes, 
becomes more prevalent, additional sites will probably appear. 
It is likely that these will be represented by links at the SpBase 
and NCBI sites.

       4.    SpBase posts an extensive set of annotations along with 
genome browsers for different versions of the genome sequence. 
A  variety of sequence objects are available as tracks on the 
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genome browser. These include three versions of predicted 
gene  models: the eBACS assembled by BCM-HGSC; ESTs 
mapped to the genome sequence by two methods; and 
assembly contigs and a number of computed features such as 
translations, restriction sites, and GC-content. In addition to 
the newest assembly version, the site retains the original ver-
sion 0.5 genome assembly because this is the one from which 
the gene models were predicted for the presentation of the 
genome assembly in 2006 [ 4 ].   

   Table 1  
  The sequence resources currently available for echinoderms. All of the sequence sets 
from BCM- HGSC are in Genbank and available at SpBase   

 Species  Sequence type  Source  Assembled objects 

  S. purpuratus   Genome assembly  BCM-HGSC  32,0008 scaffolds 

  S. purpuratus   Transcriptome (20 samples)  Caltech  >30,000 transcripts 

  S. purpuratus   Transcriptome (2 samples)  University of Miami  ND 

  S. purpuratus   Transcriptome (2 samples)  MPIMG  ND 

  S. franciscanus   Genome sequence  BCM-HGSC  ~12 million reads 

  A. fragilis   Genome sequence  BCM-HGSC  ~12 million reads 

  L. variegatus   Genome sequence  BCM-HGSC  330,000 Scaffolds 

  L. variegatus   Transcriptome  BCM-HGSC  31,357 isotigs 

  L. variegatus   Transcriptome  Boston University  ND 

  E. tribuloides   Transcriptome  BCM-HGSC  39,802 isotigs 

  P. miniata   Transcriptome  BCM-HGSC  58,528 isotigs 

   Table 2  
  Web sites that display the sea urchin genome sequence and, in some cases, the associated 
annotations   

 Name  Contents  URL 

 SpBase  Genomic sequences, 
gene annotation 
(29,144), Genome 
browser, Biomart 

   http://www.spbase.org/SpBase/     

 HGSC  Genomic sequences, 
gene annotation 
(9,941 genes), 
Genome browser 

   http://www.hgsc.bcm.tmc.edu/     

 NCBI  Genomic sequences    http://www.ncbi.nlm.nih.gov/projects/genome/guide/sea_urchin     

 UCSC  Genome browser    http://genome.ucsc.edu/     

Sea Urchin Genome Analysis
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   5.    An original set of annotations for about 10,000 genes was 
produced by the sea urchin research community (various 
reports in Developmental Biology 300, 2006) and collected by 
BCM- HGSC. This database was moved to SpBase when it 
became active in 2008 and since extended. Nucleotide and 
peptide sequences for the 28,944 gene predictions constitute 
the original set of genes [ 7 ]. Community-supplied sequences 
not found in this set have also been added. A variety of infor-
mation complements the sequence data ( see  Fig.  1 ). For example, 
the evidence for gene name assignment such as homologous 
gene identity is collected here.

  Fig. 1    The SpBase home page located at   http://www.spbase.org/SpBase/           
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       6.    One data type of great interest to the research community is 
the temporal and spatial distribution of gene expression for 
characterized genes in the purple sea urchin which can be used 
to design experiments for the study of  cis -regulatory modules 
and the gene regulatory modules into which they are assem-
bled. In addition to data from research papers on gene func-
tion, there have been a series of high-throughput analyses of 
gene expression. In the embryo, these include a whole genome 
tiling array, a Genscan gene prediction array, a quantitative 
PCR and WMIS study of transcription factors and zinc fi ngers, 
and studies on individual gene families [ 8 – 18 ]. A medium-
throughput procedure that counts individual RNA molecules, 
the NanoString nCounter [ 19 ] has been used to produce a 
high-density time course of the expression of 172 regulatory 
genes from 0 to 48 h of the embryonic stage [ 20 ]. The amount 
of information on expression for each gene in the set varies 
depending on the depth of study. The different classes of 
expression information are linked to an expression page for 
each gene (Fig.  2 ).

3            Methods 

      1.    Annotated genes are those which have been assigned a name. 
The naming convention adopted by the sea urchin community 
specifi es the use of the mouse version of the gene name 
 wherever possible ( see   Note 1 ). The Gene Search page at 
SpBase (  http://www.spbase.org/SpBase/search/index.php    ) 
serves as an entry into the database of information on anno-
tated genes. Each search returns a list of matches that are linked 
to the gene information page as indicated. The query can take 
the form of a text fragment and wild card symbols, asterisk “*,” 
to denote any alphanumeric text (bra* returns Sp-Bra or brachy-
ury or Sp-Cobra). The question mark “?” denotes one alphanu-
meric character (br?=Sp-Bra or Sp-Fibropellin). The search page 
offers several fi elds to search (Fig.  3 ) and fi eld entries can be 
combined in a Boolean search term.

       2.    The search categories ( see   Note 2 ) on the query page are Gene 
Offi cial ID (SPU_######), Scaffold, Offi cial gene name, 
Synonym, and PubMed ID.      

      1.    Matching sequences to known items in a sequence database is 
a useful way to fi nd out more about a gene of interest. At the 
SpBase BLAST page, we have installed a local version of NCBI 
Basic Local Alignment Search Tool (BLAST; [ 21 ]). This group 
of programs fi nds regions of local similarity between sequences. 
It compares nucleotide or protein sequences to sequence 
databases and calculates the statistical signifi cance of matches. 

3.1  Finding Genes 
by Name

3.2  Finding Genes by 
Sequence Comparison

Sea Urchin Genome Analysis
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  Fig. 2    An example of a gene expression page at SpBase. A variety of expression 
data is posted here and some is available through links to other Web sites       
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BLAST can be used to infer functional and evolutionary 
relationships between sequences as well as help identify members 
of gene families.   

   2.    There are several different BLAST databases available to search 
at SpBase. The genome assembly versions 0.5, 2.6, and 3.1 are 
available as well as three more specifi c ones:  SP genes  are nucle-
otide sequences of the entire gene set;  SP peptides  are the pro-
tein sequence of the gene set; and  clones  are the sequences in 
Genbank that correspond to the individual clones in the cDNA 
and BAC libraries maintained in the Center for Computational 
Regulatory Genomics. Many clones in these libraries were 
sequenced as part of the genome project [ 4 ].   

   3.    The capacity to fi nd clones by sequence allows “cloning by 
computer” for those situations where one has a sequence and 
wishes to fi nd a biochemical reagent. This might be useful to, 
for example, construct a gene sequence in a plasmid for in vitro 
translation to obtain the protein. Please  see   Note 3  for a 
description of the clone name conventions.   

  Fig. 3    The Gene Search screen at SpBase. A number of different fi elds in the annotation database are available 
to search       
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   4.    There are a number of search possibilities to use. Homologous 
gene searches are best conducted using protein sequences. If 
one has a protein sequence, blastp can be used with the Sp pep-
tide database. Tblastn uses a protein sequence to search a trans-
lated nucleotide database. This strategy works well if the genome 
is suspected of containing an unannotated gene sequence. Lastly, 
blastx translates a nucleotide query to search a protein database. 
If you expect the sequence to be found in the genome, then 
blastn matches a nucleotide query to a nucleotide sequence 
database. A more complete discussion of BLAST program usage 
can be found in the NCBI Blast Handbook (  http://www.ncbi.
nlm.nih.gov/books/NBK21097/    ). Links from the BLAST 
result pages can be followed to gene annotation of Gbrowse 
genome viewer pages as needed.      

      1.    Gene searches by available query term and sequence searches by 
BLAST are linked, directly or indirectly, to the Gbrowse genome 
viewer. Here one can display a number of genome feature tracks 
aligned with the genome assembly (Fig.  4 ). The Gbrowse dis-
play page has the usual controls for navigating along the 
sequence and zooming in or out to display the features on inter-
est. There are also two ways to download sequence elements 
from the sequence in view. This is valuable if one wants to design 
PCR primers within one exon of a gene of interest or use PCR 
to obtain genomic sequence near a gene under study.

       2.    The fi rst way is by region: Choose the region to be down-
loaded in the “Region” subpanel. It is the second subpanel 
from the top of the sequence track panel. Choose the region 
by dragging the cursor along the track.   

   3.    In the search panel, a variety of data forms can be specifi ed. 
The one we are discussing here is “Download Decorated 
FASTA File.” Under the “Confi gure” button, a number of 
formatting selections are available. The “Go” button produces 
a text fi le to be downloaded and saved.   

   4.    The    second way is by feature: Clicking on an individual feature 
in the sequence subpanel will transfer the view to the informa-
tion from the database for that feature, including the sequence. 
The sequence portion and FASTA-formatted header are easily 
copied to the clipboard from that window. Please note that the 
sequence displayed is the portion of the assembled genome 
sequence that is mapped to that feature.   

   5.    If the feature has a slightly different sequence (e.g., due to the 
extreme polymorphism of this species), it can only be obtained 
by going to another site using the sequence reference.   

   6.    If one clicks on an EST track feature, the resultant window 
includes an NCBI linkout to the EST sequence in Genbank. 
Most of the EST sequences are identical to the assembled 

3.3  Obtaining Gene 
Sequences with the 
Gbrowse Genome 
Viewer
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genome, but if there are one or a few changes, the resultant 
PCR primer would not work.      

  Although rules and methods for identifying sequences that serve as 
protein-coding templates are reasonably well established, the ones 
for identifying other functional features like gene regulatory 
regions are not. Transcription factor core binding sites are often 
degenerate and of such small size (6–8 bp) as to be present in 
seemingly random sequence. The strongest method to fi nd regions 
that are functional outside of protein-coding gene sequences relies 
on the conservation of base order at an evolutionary distance 
wherein genetic drift can alter all but the functionally conserved 
patch of sequence ([ 22 ];  see  [ 23 ] for review). Additional rules can 
be formulated once conserved regions are identifi ed. 

 In the case of the purple sea urchin, empirical results have 
shown that a divergence time between genomes of 50 million 
years reveals functionally conserved regions. The comparison 

3.4  Finding 
Noncoding Regulatory 
Regions

  Fig. 4    A typical Gbrowse display showing the sequence features around the chyury gene. In this case, the 
contig from the genome assembly, the coding exons of two different transcript sets, matching ESTs and BACs 
used in the assembly are each displayed as separate tracks       
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species that has been used most successfully is  L. variegatus . The 
fi rst proof of concept described the modules controlling expres-
sion of Sp-Otx [ 24 ]. Over 100 of these comparisons with  S. pur-
puratus  have been made using  L. variegatus  sequences from BAC 
clones [ 2 ,  25 ].

    1.    Cartwheel and FamilyRelations are tools to support the analy-
sis, annotation, and comparison of BAC-sized genomic 
sequences (50–150 kb). They were developed in the Davidson 
laboratory to support studies of cis-regulation of transcription 
and the creation of the endomesoderm gene regulatory net-
work [ 25 ]. It is the core of an automatic annotation system for 
regulatory sequences [ 3 ].   

   2.    Cartwheel is a Web-based system with a user-friendly interface 
that allows users to upload sequences and analyze them with a 
variety of tools, including BLAST and several gene fi nders. This 
system is currently maintained by Dr. Titus Brown, Michigan 
State University (  http://woodward.ged.msu.edu/canal/    ).   

   3.    The unique feature of the system is an un-gapped sequence 
comparison tool, Paircomp [ 26 ]. It uses a window of 10–50 bp 
to scan one sequence against the other, recording matches at a 
user-defi ned percent similarity. The XML output is stored on 
the Web site for future download and viewing using the 
FamilyRelations software.   

   4.    FamilyRelations is a graphical user interface written in Java that 
lets users explore the results of analyses done with Cartwheel. 
FamilyRelations can display analyses of a single sequence as 
well as pairwise comparisons and allows interactive viewing of 
the analyses as well as sequence extraction and motif search.   

   5.    FamilyRelations is available through the Cartwheel site or at 
  http://family.caltech.edu/    . There is also an online tutorial to 
help users get started at   http://family.caltech.edu/tutorial/    .   

   6.    The FamilyRelations graphical interface displays the sequence 
similarity between two sequences as either a dot plot or a linear 
display (Pair View; Fig.  5 ). In addition to managing the dis-
play, the interface also provides the capability to choose and 
copy sequence elements to the clipboard and search the 
sequence chosen for motifs specifi ed by the user.

       7.    Multiple analyses can be associated with a sequence by the 
Cartwheel program and displayed. An example of this capability 
is seen in the SUGAR analyses (“Sea Urchin Genome 
Annotation Resource”) produced for many pairs of BAC 
sequences and posted on the SpBase (  http://www.spbase.org/
SpBase/resources/bac_sequences.php    ).    

        1.    SpBase also provides a tool to create lists of genomic informa-
tion. Called BioMart (  http://www.biomart.org/index.html    ), 
it is a fast genome information search and retrieval program 

3.5   Data Mining
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  Fig. 5    A typical linear plot of the paircomp sequence comparison in the vicinity of 
the brachyury gene. The  S. purpuratus  sequence is to the  right  and the  L. varie-
gatus  sequence to the  left . The  arrows  on the  right  indicate the position of exons 
and similarly, the brackets mark putative control regions conserved between the 
two species near the exons       
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whose query-building operations allow one to select data by 
diverse categories, fl exibly fi lter the results, and output data 
in a tabulated form. This package, a component of GMOD, 
was developed jointly by the Ontario Institute for Cancer 
Research (OICR) and the European Bioinformatics Institute 
(EBI). It is used at SpBase as a fairly simple way to generate 
large lists of search results. An example of an output page is 
shown in Fig.  6 .

       2.    The entire contents of SpBase are available for download if one 
wishes to conduct large-scale data manipulation locally. Various 
portions of sequence and even the programming code that 
generates the Web system can be obtained (  http://www.
spbase.org/SpBase/downloads.php    ).       

4     Notes 

     1.     Gene naming conventions . This note describes the scheme for 
gene names and gene symbols that were used in the annotation 
of the purple sea urchin genome. The gene symbol uses the 
specifi cation of the mouse nomenclature whenever possible 
and adds a sea urchin identifi er, e.g.,  Sp - Otx . The specifi cation 
is described on the mouse Mouse Genome Informatics 
Web site, The Jackson Laboratory, Bar Harbor, Maine [ 27 ]. 
The salient information is on the nomenclature page “Quick 
Guide to Nomenclature for Genes” (  http://www.informatics.
jax.org/mgihome/nomen/short_gene.shtml    ).   

  Fig. 6    BioMart. A screen capture of the results’ page from a BioMart search for “dismutase” showing the user-
specifi ed attribute fi elds       
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   2.     Search Category Defi nitions . The search categories are as 
follows:
   (a)     Gene Offi cial ID  (e.g., SPU_000001). This query uses the 

SpBase form of the offi cial gene identifi er unique in the 
database. The form of the identifi er is three letters “SPU” 
followed by an underscore and six numbers. The SpBase 
identifi er is derived from and continues on the Offi cial 
Gene Set identifi ers generated at Baylor, the GLEAN 
numbers. The relationship between SPU numbers and 
GLEAN number is as follows: 

 GLEAN3_#####=SPU_0##### 

 SPU numbers higher than the original 28,944 
GLEAN3 numbers denote annotated genes for which no 
GLEAN prediction existed. These additional genes came 
from individually sequenced cDNAs or other evidence.   

  (b)     Scaffold  (e.g., Scaffold100, Scaffold3148). The scaffold 
identifi er refers to the assembly scaffold from the indicated 
version of the genome assembly. This query uses the num-
ber of the scaffold after the identifi er “Scaffold” with no 
space between as in “Scaffold343.” It will return a list of 
the annotated genes predicted from the scaffold sequence. 
To see all the genes predicted from that scaffold, view the 
scaffold in Gbrowse with the GLEAN:Prediction track 
displayed.   

  (c)     Offi cial gene name  (e.g., Sp-SFK1, Sp-Exotose, 
Sp-chordin). The offi cial gene names of the annotated sea 
urchin genes start with the Sp-gene symbol (“Sp-”). 
Extensions are usually three to fi ve characters, but addi-
tional characters may be added as necessary up to ten in 
order to distinguish similar symbols. Symbols should begin 
with an uppercase letter followed by all lowercase letters, 
unless extensive previous usage dictates otherwise. 
Punctuation is only used to separate two adjacent numbers 
(e.g., Lamb1-2) or for designating related (e.g., Es10-rs1) 
sequences and pseudogenes (e.g., Adh5-ps1). The query 
can be a text fragment and does not need to include the 
general prefi x (Sp-). A list of the genes whose names match 
the text fragment will be returned.   

  (d)     Synonym  (e.g., Src,EXT,chrd). In order to account for 
variable usage of gene names, we have tried to collect any 
synonyms known for annotated genes. For example, 
Sp-Bra has been called brachyury in many publications. 
A mouse name that has been for brachyury is “T” or small 
T locus. Our synonym category can be searched with text 
fragments as above. A list of genes whose synonyms match 
the query will be returned.   

Sea Urchin Genome Analysis
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  (e)     PubMed ID  PubMed is the bibliographic component of 
the NCBI’s Entrez retrieval system. It accesses a database 
designed to provide access to citations from biomedical 
journals. It resides at the National Center for Biotechnology 
Information (NCBI) at the National Library of Medicine 
(NLM), one of the institutes of the National Institutes of 
Health (NIH). PubMed links also lead to full-text journal 
articles at Web sites of participating publishers as well as to 
other related Web resources. The PubMed ID (PMID) 
takes the form of an 8-digit number (e.g., 9628328). Wild 
card characters cannot be used here. The search returns a 
list of the genes referred to in the publication.    

      3.     Clone naming conventions . The EST sequences derived from 
purple sea urchin cDNa and deposited in Genbank are from 
several sources [ 4 ,  28 – 32 ]. These high-throughput datasets 
are each derived from one or more cDNA libraries (Table  3 ). 
Some of the libraries are still available for clone requests if one 
should need the actual cDNA.   
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   Table 3  
  The source and NCBI reference numbers for the EST datasets at Genbank. The clone location and 
library can be derived from the information on the NCBI page for that clone   

 Source  Reference  Accession numbers 

 Coelomocyte cDNAs  [ 28 ]  CK828301.1–CK829214.1 
 CV652690.1–CV652795.1 
 R61894.1–R62134.1 

 7 h EST (1000)  [ 29 ]  AF122056–AF122818 

 PMC EST (8293)  [ 30 ]  BG780044–BG789442 

 Clustered ESTs  [ 32 ]  CD289359–CD297607 
 CD303636–CD324638 
 CD330178–CD342180 

 Full-length cDNAs (36522)  Coffman, unpub 

 HGSC-BCM ESTs 
(111,497 items) 

 NCBI: 
(txid7668[orgn] AND gbdiv_est[prop]) 

 SMC (H. pulcherrimus)  [ 31 ]  AU272543–AU275011 
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    Chapter 21   

 Antibody Inhibition of Protein Activity in Starfi sh Oocytes 

           Eiichi     Okumura    ,     Masatoshi     Hara    , and     Takeo     Kishimoto    

    Abstract 

   Antibodies are widely utilized in cell and molecule biology for immunoblots, immunostaining, 
 immunoprecipitation, immunoaffi nity purifi cation, and immunoassay. Some antibodies can be used for in 
vivo inhibition experiments. These antibodies bind to their target molecules and neutralize their functions, 
providing functional information in the study of their biological role. Here, we describe our methods for 
obtaining inhibitory antibodies against desired proteins. We then describe in the starfi sh oocyte system 
how to inhibit a target protein, even in the nucleus, by injection of antibody into the cytoplasm, and how 
to evaluate antibody inhibition of cell cycle regulators in small numbers of oocytes.  

  Key words     Antibody inhibition  ,   Neutralizing antibody  ,   Starfi sh oocyte  ,   Microinjection  ,   Nuclear 
targeting  ,   H1 kinase  ,   Immunoblot  

1       Introduction 

 Inhibitory antibodies provide valuable tools for studying the 
 biological role of a protein of interest in vivo [ 1 ]. These antibodies 
block the biological function of a target protein through binding 
to various functional domains such as the catalytic domain, regula-
tory domain, or binding domain of the target. It is by chance 
whether an inhibitory antibody is available. Most antibodies are 
not suitable for in vivo inhibition studies. In order to improve the 
probability of producing an inhibitory antibody, the immunizing 
peptide antigen sequence is selected from the functional domain of 
the desired protein. Mouse or rabbit is typically used for antibody 
production [ 2 ]. 

 The method of antibody inhibition has advantages and disad-
vantages. Antibody inhibition is highly specifi c to the antigen pro-
tein. The timing of inhibition is controllable, because inhibitory 
antibodies are usually introduced directly into cells by microinjec-
tion. However, the number of cells to be examined is limited. 
Production of high-titer antibody is required, because the injec-
tion volume is limited. Furthermore, injected immunoglobulins 
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may interfere further analysis by immunoblots with the primary 
antibody raised in the same species of animals. If available, another 
experimental method for inhibition such as chemical inhibitor or 
dominant-negative competitor should be used in order to comple-
ment the results obtained by antibody inhibition. 

 Here, we describe our methods to prepare and utilize inhibi-
tory antibodies against cell cycle regulators in starfi sh oocytes: (1) 
designing the antigen domain of the desired protein and produc-
tion of its recombinant protein, (2) immunization against rabbit, 
(3) affi nity purifi cation of antibodies from serum, (4) immunopre-
cipitation to confi rm recognition of native protein, (5) microinjec-
tion of antibody into starfi sh oocytes, and (6) evaluation of 
inhibitory effect in the antibody-injected oocyte. In antibody 
injection, we especially describe our most recent method to inhibit 
nuclear protein activity. IgG is too large to pass through nuclear 
pores and the volume which can be injected directly into the 
nucleus (called the germinal vesicle (GV) in oocyte) is limited. 
To overcome these problems, we have developed a method that 
allows nuclear accumulation of the antibody which was injected 
into the cytoplasm. For evaluation of the inhibitory effect of the 
antibody, we usually measure histone H1 kinase activity as a cell 
cycle marker that represents Cdk1 activity [ 3 ] and examine the 
behavior of cell cycle regulators with immunoblots, in addition to 
microscopic inspection of the oocyte and nucleus. Because the num-
bers of the antibody-injected oocytes are very limited, we describe a 
high sensitive method for histone H1 kinase assay and immunoblots 
in a small number of oocytes. 

 Regular methods are based on some books of laboratory 
manuals [ 2 ,  4 ] and this series of Method in Molecular Biology. 
Here, we describe in detail some modifi cations of these methods.  

2     Materials 

      1.    Maleimide-activated KLH (PIERCE; 77605).   
   2.    SulfoLink coupling gel (PIERCE; 20401) for preparation of 

affi nity beads which are used for purifi cation of anti-peptide 
antibody.      

      1.    cDNA of the desired protein.   
   2.    Vectors: pET-21 (Novagen) or pTrcHis (Invitrogen) for 

His- tagged protein expression and pGEX-4T vector (GE 
Healthcare) for GST-tagged protein expression.   

   3.    Thermal cycler, restriction enzymes, DNA ligation kit ver. 2.1 
(Takara; 6021), and other materials for molecular work [ 4 ].   

   4.     E. coli : DH5α competent cells (Invitrogen), stored at −80 °C.   

2.1  Peptide Antigen 
and Peptide Beads 
Preparation

2.2  Vector 
Construction for 
Antigen Protein 
Expression

Eiichi Okumura et al.
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   5.    LB medium: 10 g/L NaCl, 10 g/L Bacto Tryptone (BD), 
5 g/L yeast extract (BD), pH 7.5 in deionized water at 3 MΩ.   

   6.    Antibiotics: Carbenicillin.      

      1.     E. coli : BL21 (DE3) competent cells (Invitrogen), stored 
at −80 °C.   

   2.    LB medium: 10 g/L NaCl, 10 g/L Bacto Tryptone (BD), 
5 g/L yeast extract (BD), pH 7.5 in deionized water at 3 MΩ.   

   3.    IPTG (isopropyl β- D -1-thiogalactopyranoside).   
   4.    Antibiotics: Carbenicillin.   
   5.    Extraction buffer A: 50 mM Tris–HCl pH 7.9, 0.5 M NaCl, 

1 mM DTT, complete EDTA-free protease inhibitor cocktail 
(Roche; 11873580001).   

   6.    Ni-NTA Agarose (Qiagen; 30210) and 10 mL Poly-Prep 
Chromatography column (Bio-Rad).   

   7.    Washing buffer A: 20 mM Tris–HCl pH 7.9, 0.5 M NaCl, 
20 mM imidazole.   

   8.    Elution buffer A: 20 mM Tris–HCl pH 7.9, 0.5 M NaCl, 
250 mM imidazole.   

   9.    Vivaspin column (Sartorius) for concentration of antigen 
protein.   

   10.    Phosphate buffered saline (PBS): 137 mM NaCl, 2.7 mM 
KCl, 7.5 mM Na 2 HPO 4 , 1.5 mM KH 2 PO 4 , pH 7.4.   

   11.    Coomassie Protein Assay Reagent Kit (PIERCE).      

      1.    Adjuvant: AbISCO-300 adjuvant (ISCONOVA), TiterMax 
Gold (CytRx Corp. GA).   

   2.    1 mL tuberculin syringes (NORM-JECT 1 mL, HENKE SASS 
WOLF) and needles of 23 G (TERUMO).   

   3.    70 % ethanol cotton for disinfection.   
   4.    Electric animal hair clipper (Model 9000, THRIVE) and razors 

(FEATHER).   
   5.    Two healthy rabbits, New Zealand white (~1.5 kg), per antigen.      

      1.    Glutathione-Sepharose CL4B (GE Healthcare) and reduced 
glutathione.   

   2.    Lysis buffer A: PBS containing complete protease inhibitor cock-
tail (Roche; 11697498001).   

   3.    Elution buffer B: 50 mM Tris–HCl pH 8.0, 10 mM reduced 
glutathione.   

   4.    2×-sample buffer: 0.125 M Tris–HCl, pH 6.8, 20 % glycerol, 
10 % β-mercaptoethanol, 4 % SDS, and 0.002 % Bromophenol 
blue.   

2.3  His-Tagged 
Antigen Protein 
Preparation

2.4   Immunization

2.5  Purifi cation of 
GST-Tagged Antigen 
and Preparation of 
Antigen- Transferred 
Membrane Pieces

Neutralizing Antibodies
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   5.    SDS-PAGE and Western blot equipment.   
   6.    PVDF membrane: Immobilon-P Transfer Membrane 

(Millipore; IPVH00010).   
   7.    Ponceau-S staining solution: 0.1 % ponceau-S, 0.05 % acetic 

acid.   
   8.    Ponceau-S destaining solution: 0.05 % acetic acid.   
   9.    Blocking solution: 5 % skim milk in TBS, freshly prepared.      

      1.    TBS: 50 mM Tris–HCl, pH 7.5, 150 mM NaCl.   
   2.    TBS-T: TBS with 0.1 % Tween-20.   
   3.    Wash buffer: 50 mM Tris–HCl, pH 7.5, 500 mM NaCl.   
   4.    0.15 M NaCl.   
   5.    Elution buffer: 0.2 M glycine-HCl pH 2.0.   
   6.    1 M Tris-base for neutralization.   
   7.    pH testing paper or drop pH meter.   
   8.    Vivaspin column (Sartorius) for concentration of purifi ed 

antibodies.   
   9.    Coomassie Protein Assay Reagent Kit (PIERCE, 23200).      

      1.    Starfi sh,  Asterina pectinifera  (renamed  Patiria pectinifera ), are 
collected during the breeding season and kept in laboratory 
aquaria supplied with circulating commercial artifi cial seawater 
at 14 °C.   

   2.    Commercial artifi cial seawater: Sealife (Marine-tech), Marin 
art (   Osaka Yakken).   

   3.    Artifi cial seawater (ASW): 462 mM NaCl, 10 mM KCl, 
9.2 mM CaCl 2 , 36 mM MgCl 2 , 18 mM MgSO 4 , 20 mM 
H 3 BO 3 , pH 8.2 [ 5 ] ( see   Note 1 ).   

   4.    Ca-free ASW: 476 mM NaCl, 10 mM KCl, 36 mM MgCl 2 , 
18 mM MgSO 4 , 20 mM H 3 BO 3 , pH 8.2 [ 5 ].   

   5.    Tweezers and 35-mm dishes.   
   6.    Microscope and stereomicroscope.   
   7.    Extraction buffer B: 160 mM Na-β-glycerophosphate, 40 mM 

EGTA, 30 mM MgCl 2 , 200 mM KCl, 200 mM sucrose, pH 
7.3 for stock solution stored at 4 °C and for working solution, 
add fi nal conc. 2 mM DTT, 1 mM Na-orthovanadate, 0.1 % 
Nonidet P-40, 50 μM benzamidine, 50 μM PMSF, 50 μg/mL 
leupeptin, 50 μg/mL soybean trypsin inhibitor [ 6 ].      

      1.    Protein A-Sepharose 4B (Sigma; P9424-5ML) or Protein G 
Sepharose 4B (Sigma; P3296-5ML).   

   2.    Immunoprecipitation buffer: 50 mM Tris–HCl, pH 7.5, 
150 mM NaCl, 0.5 % Triton X-100, 0.1 % SDS, 50 mM NaF, 

2.6  Antibody 
Purifi cation with 
Peptide Beads or 
Antigen- Transferred 
Membrane Pieces

2.7  Starfi sh and 
Oocyte Extracts

2.8  Immunopre-
cipitation

Eiichi Okumura et al.



315

10 mM Na pyrophosphate, 0.1 mM Na-orthovanadate, 
0.1 mM Na  p -nitrophenyl phosphate, and 0.1 mM ZnCl 2 , 
stored at 4 °C for a few months.      

      1.    Glass injection needles formed from 50 μL microcap 
(Drummond Scientifi c; 1-000-0500) using a glass needle 
puller (NARISHIGE).   

   2.    1 mL syringe (TERUMO; SS-01T) with long needle 
(Hamilton; 90122).   

   3.    Silicone oil (Shin-Etsu Chemical; KF-96-500CS).   
   4.    Glass chamber for holding oocytes [ 7 ].   
   5.    Microscope with injector and micromanipulator (Leitz) [ 8 ].      

      1.    pET21-ZZ-IBB: ZZ-domain [ 9 ] was amplifi ed by PCR from 
pEZZ18 (GE Healthcare; 27-4810-01) and cloned into 
pET21a (Novagen; 69740-3) along with the coding region of 
IBB [ 10 ] (for ZZ-IBB,  see  Subheading  3.12 ).   

   2.    Rosetta 2 (DE3) Competent Cells (Novagen; 71397-3).   
   3.    Plusgrow II (Nacalai Tesque; 08202-75).   
   4.    Antibiotics: Carbenicillin and chloramphenicol.   
   5.    IPTG (isopropyl-β- D -thiogalactopyranoside).   
   6.    Binding buffer: 20 mM Tris–HCl, pH 7.5, 0.5 M NaCl, 5 mM 

imidazole and complete EDTA-free protease inhibitor cocktail 
(Roche; 11873580001).   

   7.    Nonidet P-40 (NP-40).   
   8.    Ni-NTA Agarose (Qiagen; 30210).   
   9.    Wash buffer B: 20 mM Tris–HCl, pH 7.5, 0.5 M NaCl and 

20 mM imidazole.   
   10.    Elute buffer C: 20 mM Tris–HCl, pH 7.5, 0.5 M NaCl and 

200 mM imidazole.   
   11.    Coomassie Brilliant Blue (CBB) staining solution: 0.05 % 

CBB, 25 % methanol, and 7 % acetic acid.   
   12.    CBB destaining solution: 25 % methanol and 7 % acetic acid.   
   13.    PBS.   
   14.    Dialysis tube: Spectra/Por2 (Spectrum Labs; 132678).   
   15.    Vivaspin 500 10,000 MWCO PES (Sartorius; VS0102).      

      1.    Lysis buffer B: 80 mM β-glycerophosphate, 20 mM EGTA, 
15 mM MgCl 2 , 100 mM KCl, 100 mM Sucrose, 1 mM DTT, 
0.5 mM Na-orthovanadate, 25 mM NaF, 0.5 % NP-40, and 
complete EDTA-free protease inhibitor cocktail (Roche; 
11873580001), pH 7.3.      

2.9   Microinjection

2.10  Expression and 
Purifi cation of ZZ-IBB

2.11  Small-Scale 
Oocyte Extracts for 
High Sensitive Histone 
H1 Kinase Assay and 
Immunoblots

Neutralizing Antibodies
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      1.    Kinase buffer: 80 mM β-glycerophosphate, 20 mM EGTA, 
15 mM MgCl 2 , 1 mM DTT, and complete EDTA-free prote-
ase inhibitor cocktail (Roche; 11873580001), pH 7.3.   

   2.    H1 reaction mixture: 0.6 mg/mL histone H1 and 14.8 MBq/mL 
[γ- 32 P]-ATP in kinase buffer.   

   3.    4×-sample buffer: 0.25 M Tris–HCl, pH 6.8, 40 % glycerol, 
20 % β-mercaptoethanol, 8 % SDS, and 0.004 % Bromophenol 
blue.   

   4.    Coomassie Brilliant Blue (CBB) staining solution: 0.05 % 
CBB, 25 % methanol, and 7 % acetic acid.   

   5.    CBB destaining solution: 25 % methanol and 7 % acetic acid.   
   6.    Bio-imaging analyzer: BAS 2000 (Fuji Film).      

      1.    Transfer buffer: 100 mM    Tris–HCl, 192 mM glycine, 0.05 % 
SDS, and 20 % methanol.   

   2.    Semidry blotter: HorizBlot (ATTO; AE-6677).   
   3.    PVDF membrane: Immobilon-P Transfer Membrane 

(Millipore; IPVH00010).   
   4.    Filter paper (Advantec; 526).   
   5.    TBS-T: 0.05 % Tween 20 in TBS.   
   6.    Can Get Signal Immunoreact Enhancer (Can Get Signal) 

Solution 1 and 2 (Nacalai Tesque; NKB-101).   
   7.    Secondary antibody: Anti-rabbit IgG HRP-linked F(ab′) 2  

fragment donkey HRP-conjugated anti-rabbit IgG (GE 
Healthcare; NA9340-1ML) or polyclonal rabbit anti-mouse 
immunoglobulins- HRP (Dako; P0260).   

   8.    ECL Plus Western Blotting Detection System (GE Healthcare; 
RPN2132).   

   9.    Imaging system: Image Quant LAS 4000 (GE Healthcare).       

3     Methods 

      1.    Search databases for homologous sequences to the desired 
protein.   

   2.    Generate sequence alignments on a program such as DNASIS 
(Hitachi Solutions. Ltd.).   

   3.    Search a homologous domain of the desired protein to the 
conserved catalytic domain such as a kinase or a phosphatase 
domain. Design antigen including a catalytic domain. If there 
is some information about motifs such as the binding domain 
to the target and the regulatory domain of the activity, these 
domains are also available for antigen (Fig.  1 ) ( see   Note 2 ).

2.12  High Sensitive 
Histone H1 Kinase 
Assay

2.13  High Sensitive 
Immunoblots

3.1  Designing the 
Antigen for Inhibitory 
Antibodies

Eiichi Okumura et al.
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       4.    Full-length recombinant protein and N- and C-terminal 10–20 
peptides are designed as control antigens for non-inhibitory 
antibodies, which can be utilized in activity assay in immuno-
precipitates,  immunostaining, and immunoblots.   

   5.    In case of short peptide antigens, cysteine is added at the 
end for chemical coupling with maleimide-activated carrier 
proteins such as KLH (keyhole limpet hemocyanin).      

  Fig. 1    Flow chart of antibody preparation       

 

Neutralizing Antibodies
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      1.    Order synthesis of the designed peptide at 10 mg scale (from a 
supplier such as Sigma-Aldrich Co. or Operon Biotechnologies). 
Or synthesize antigen peptide by solid-phase peptide synthesis 
utilizing Fmoc amino-protecting group and further purify 
them by reverse phase chromatography with FPLC, if 
available.   

   2.    Conjugate synthesized peptide with maleimide-activated KLH 
following the instruction manual of Imject Maleimide-
Activated mcKLH (PIERCE; 0838w). Use 4 mg of the peptide 
and 4 mg of the carrier protein.   

   3.    Dialyze the conjugated mixture against over 100× volume of 
PBS for 5 h, with buffer exchange at 1 and 3 h.   

   4.    Recover the antigen conjugate and divide the solution into 
eight aliquots of 1 mg protein in each tube. Freeze and stock 
them at −80 °C for further use.      

   His-tagged protein is used for immunization and GST-tagged 
protein is used for affi nity purifi cation of antibody to eliminate the 
antibody against the His-tagged domain.

    1.    cDNA of the desired protein was amplifi ed by PCR with for-
ward and reverse primers which contain restriction enzyme 
sequences to insert multiple cloning sites of vectors.   

   2.    Cut 5′ and 3′ end of the PCR product with restriction enzymes.   
   3.    Cut vectors with same restriction enzymes. Use pET21 or 

pTrcHis for His-tagged protein expression. Use pGEX-4T 
vector for GST-tagged protein expression.   

   4.    Ligate DNA fragments of  steps 2  and  3  with Takara DNA 
ligation kit.   

   5.    Transform DH5α  E. coli  cells with the ligated DNA, plate cells 
on the LB plate containing carbenicillin, and incubate over-
night at 37 °C.   

   6.    Pick six single colonies and incubate them overnight at 37 °C 
in 1.6 mL LB medium containing 100 μL/mL carbenicillin.   

   7.    Purify plasmid DNA with plasmid mini prep kit.   
   8.    Confi rm DNA sequences of insert DNA by sequencer.      

      1.    Transform BL21 (DE3)  E. coli  cells with the His-tagged pro-
tein expression vector according to the manufacturer’s instruc-
tions, plate cells on the LB plate containing carbenicillin, and 
incubate overnight at 37 °C.   

   2.    Pick a single colony and incubate it overnight at 37 °C in 
10 mL LB medium containing 100 μL/mL carbenicillin.   

   3.    Inoculate 1,000 mL LB medium containing 100 μL/mL 
carbenicillin with the 10 mL overnight culture and incubate 
for 3 h at 37 °C.   

3.2  Preparation of 
Short Peptide Antigen

3.3  Vector 
Construction for 
His-Tagged and 
GST-Tagged Antigen 
Protein Expression

3.4  Preparation of 
His-Tagged Antigen 
Protein
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   4.    Add IPTG at fi nal conc. of 1 mM and incubate for 4 h at 37 °C 
to induce the protein expression ( see   Note 3 ).   

   5.    Harvest the cells by centrifugation at 4,000 ×  g  for 15 min 
at 4 °C.   

   6.    Add PBS to the cell pellet and resuspend cells with a pipette 
until the pellet is completely dissociated.   

   7.    Pellet the cells again and freeze in liquid nitrogen.   
   8.    Thaw the cells expressing His-tagged protein and suspend 

them in 10 mL extraction buffer A.   
   9.    Sonicate the cell suspension on ice with a microtip for an interval 

of 15 s sonication and 30 s cooling. Repeat this for several 
rounds until the sample becomes no longer viscous.   

   10.    Centrifuge lysate at 12,000 ×  g  for 20 min at 4 °C.   
   11.    Recover clear supernatant ( see   Note 4 ).   
   12.    Add 2 mL of 50 % of Ni-NTA slurry to 10 mL cleared lysate 

and mix gently with rotator in a cold room at 4 °C for 1 h.   
   13.    Load the mixture into a Bio-Rad 10 mL column and collect 

fl ow-through.   
   14.    Wash the column twice with 5 mL of extraction buffer A.   
   15.    Wash the column with 6 mL of wash buffer A.   
   16.    Elute the His-tagged protein with 6 mL elution buffer A and 

collect 1 mL aliquots of the eluate.   
   17.    Analyze by SDS-PAGE and CBB staining and then pool the 

eluted protein fractions.   
   18.    Concentrate the fraction pool with Vivaspin ( see   Note 5 ).   
   19.    For buffer exchange, repeat several rounds of dilution with 

PBS and reconcentration with Vivaspin.   
   20.    Assay the protein concentration with Coomassie Protein Assay 

Reagent Kit (PIERCE). The protein concentration at 2 mg/mL 
is preferable.   

   21.    Freeze and stock at −80 °C in the aliquots of 1 mg protein in 
each tube.      

  At immunization, we handle rabbits following the guideline of the 
center for experimental animals in our Institute.

    1.    For initial immunization, mix 1 mg of antigen protein solu-
tion (2 mg/mL, 0.5 mL) with 45 μg of AbISCO-300 adju-
vant (3 mg/mL, 15 μL) per rabbit by a vortex mixer shortly 
( see   Note 6 ).   

   2.    Before initial injection, collect 5–10 mL pre-immune blood by 
insertion of needle into the ear vein of a rabbit. Prepare pre- 
immune serum by leaving the blood overnight in cold room 
and collect the supernatant after centrifugation at 2,000 ×  g  

3.5  Immunization 
and Serum 
Preparation
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for 15 min at 4 °C. Add sodium azide at fi nal conc. 0.05 %. 
Store the serum at 4 °C (or at −30 °C for over several months 
storage) for use as the negative control.   

   3.    Cut the hair on the back of rabbit with an electric animal hair 
clipper.   

   4.    Disinfect the back skin with 70 % ethanol cotton.   
   5.    Inject the antigen mixture into about fi ve subcutaneous 

administration sites on a rabbit back.   
   6.    For boost 4 weeks after the initial injection, inject the same 

amount of AbISCO-300 adjuvant (3 mg/mL, 15 μL) and a 
half amount of antigen protein solution (2 mg/mL, 0.25 mL) 
per rabbit into about fi ve subcutaneous administration sites on 
a rabbit back.   

   7.    Test bleed 5–10 mL per rabbit 1 week after the fi rst boost 
injection and prepare serum. Test serum whether they can be 
used for immunoblots with antigen and endogenous protein 
from starfi sh oocytes. Pre-immune serum is used as a negative 
control ( see   Note 7 ).   

   8.    Repeat boost injection and test bleeding in a 4-week cycle until 
fi nal bleeding.      

      1.    Cross-link synthesized antigen peptides to SulfoLink coupling 
gel according to its instruction (PIERCE; 0527). Use 1 mg 
peptides per 1 mL gel.   

   2.    Pour 2 mL of 50 % slurry of gel suspension into 10 mL Poly- 
Prep Chromatography column.   

   3.    Wash the column with 6 mL of 0.2 M glycine-HCl (pH 2.0).   
   4.    Wash the column with 10 mL of TBS.   
   5.    Add 1 mL of TBS and 1 mL of serum.   
   6.    Incubate the column for overnight in cold room with gentle 

mixing by a rotator.   
   7.    Recover fl ow-through fraction and further test its immunore-

activity by immunoblots for confi rmation of antibody absorption 
to the column.   

   8.    Wash the column with 10 mL TBST.   
   9.    Wash the column with 3 mL of 0.15 M NaCl.   
   10.    Elute the antibodies with 1 mL of 0.2 M glycine-HCl 

(pH 2.0) for six times.   
   11.    Neutralize the eluted fractions immediately by Tris-base, along 

with pH monitoring by the pH test paper or a drop pH meter.   
   12.    Confi rm by protein assay reagent whether each of the eluted 

fractions contains antibody.   
   13.    Pool fractions containing antibodies and concentrate them to 

approx. 50 μl with Vivaspin.   

3.6  Purifi cation 
of Antibody Using 
Peptide 
Affi nity Column
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   14.    For buffer exchange, repeat several rounds of dilution with 
PBS and reconcentration with Vivaspin.   

   15.    Measure protein concentrations of purifi ed antibodies 
( see   Note 8 ).      

      1.    Thaw the cells expressing GST-tagged protein (prepared in 
Subheading  3.3 ) and suspend them in 10 mL of lysis buffer A.   

   2.    Sonicate the cell suspension on ice with a microtip for an interval 
of 15 s sonication and 30 s cooling. Repeat this for several 
rounds until the sample becomes no longer viscous.   

   3.    Centrifuge lysate at 12,000 ×  g  for 20 min at 4 °C.   
   4.    Recover clear supernatant ( see   Note 9 ).   
   5.    Add 2 mL of 50 % of Glutathione-Sepharose slurry to 10 mL 

of cleared lysate and mix them gently with rotator in a cold 
room at 4 °C for 1 h.   

   6.    Load the mixture into a Bio-Rad 10 mL column and recover 
fl ow-through.   

   7.    Wash the column twice with 5 mL of lysis buffer A.   
   8.    Wash the column with 5 mL of PBS.   
   9.    Elute the GST-tagged protein with 6 mL elution buffer B and 

collect 1 mL aliquots of the eluate.   
   10.    Analyze by SDS-PAGE and pool the eluted protein fractions.   
   11.    Concentrate the pooled fraction with Vivaspin ( see   Note 5 ).   
   12.    Add SDS-PAGE sample buffer to a part of concentrated 

GST-tagged protein solution. Another part is used for the 
immunoprecipitation test.      

      1.    Cast the gel for SDS-PAGE without comb. The concentration 
of acrylamide is selected so that the GST-tagged protein runs 
around middle of the gel.   

   2.    Load about 200 μg of GST-tagged protein per mini slab gel on 
the fl at stacking gel ( see   Note 10 ).   

   3.    After gel electrophoresis, transfer to PVDF membrane and 
stain it with ponceau-S. Cut out the stained band of the GST- 
tagged protein. Collect the stained band from 4 to 5 mini gels.   

   4.    Destain the membranes with 0.05 % acetic acid solution, then 
cut them into small pieces (3 × 10 mm), and put them into 
2-mL tube.   

   5.    Block membrane pieces with 1.5 mL of 5 % skim milk in TBS 
for 30 min at RT with gentle mixing by rotator.   

   6.    Wash membrane pieces fi ve times with TBS.   
   7.    Wash membrane pieces fi ve times with 1.5 mL of 0.2 M 

 glycine-HCl pH 2.0.   

3.7  Purifi cation of 
GST-Tagged Antigen 
Protein for Antibody 
Purifi cation
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   8.    Wash membrane pieces fi ve times with 1.5 mL of TBS.   
   9.    Add 1 mL of 2× diluted serum with TBS.   
   10.    Incubate overnight in cold room with gentle mixing by 

rotator.   
   11.    Wash membrane pieces fi ve times with 1.5 mL of TBS-T.   
   12.    Wash membrane pieces two times with 1.5 mL of 0.15 M 

NaCl.   
   13.    Elute antibody by adding 0.5 mL of 0.2 M glycine-HCl 

pH 2.0 to membrane pieces and incubating for 3 min. The 
eluate is recovered to a new tube. Repeat this fi ve rounds.   

   14.    Neutralize the eluted fractions by Tris-base immediately, 
along with pH monitoring by the pH test paper or a drop pH 
meter.   

   15.    Confi rm by protein assay reagent whether each of the eluted 
fractions contains antibody.   

   16.    Pool fractions containing antibodies and concentrate them to 
approx. 50 μL with Vivaspin.   

   17.    Measure protein concentrations of purifi ed antibodies 
( see   Note 8 ).      

      1.    Dissect a piece of ovary from female starfi sh with a tweezers 
and put it into Ca-free ASW in 35-mm dishes.   

   2.    Hold a closed end of ovary with a tweezers and squeeze out 
oocytes gently from open end with another tweezers under a 
stereomicroscope.   

   3.    Wash oocytes several times with Ca-free ASW until follicles are 
removed.   

   4.    Wash isolated oocytes three times with ASW. These are used 
for microinjection or preparation of oocyte extracts.   

   5.    To prepare oocyte extracts, put isolated oocytes into a microtube 
and centrifuge at 5,000 ×  g  for 10 s at 4 °C.   

   6.    Remove the supernatant seawater by aspiration.   
   7.    Add the oocytes pellet with 5 volumes of ice-cold extraction 

buffer B and freeze the mixture in liquid nitrogen.   
   8.    Thaw the oocyte suspension, followed by homogenization 

with a microtip sonicator for 3 s on ice.   
   9.    Centrifuge at 12,000 ×  g  for 20 min at 2 °C.   
   10.    Recover the supernatant to a fresh tube as an oocyte extract.      

  It is essential for the inhibitory antibody to bind to its target pro-
tein. Immunoprecipitation is performed to confi rm whether the 
prepared antibody can recognize and bind to the native form of 
desired endogenous protein.

3.9  Oocyte Isolation 
and Preparation of 
Oocyte Extracts

3.10  Immunopre-
cipitation and In Vitro 
Activity Assay of the 
Protein
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    1.    Add 0.2 μL of purifi ed antibody to 10 μL of oocyte extracts 
and briefly mix them by a vortex mixer ( see   Note 11 ). 
His-tagged or GST-tagged protein solution is also used for 
precipitation in a control experiment.   

   2.    Incubate the mixture on ice for 1 h.   
   3.    Add 10 μL of 50 % slurry of protein A-Sepharose 4B suspended 

in immunoprecipitation buffer.   
   4.    Incubate the mixture on ice for 1 h with gentle and brief mixing 

by a vortex mixer in 10–15 min intervals.   
   5.    Wash the beads three times with 1 mL of the immunoprecipi-

tation buffer.   
   6.    Recover beads, add 2× SDS-PAGE sample buffer to them, and 

analyze by immunoblots to confi rm that the antibody binds to 
the endogenous antigen protein ( see   Note 12 ).   

   7.    For in vitro enzyme assay to test whether the antibody directly 
inhibits the activity of the protein of interest, wash the beads of 
 step 5  three times with an assay buffer appropriate for measur-
ing enzyme activity. Then, use beads for enzyme assay of the 
protein of interest. For a positive control of the activity assay, 
prepare immunoprecipitates using other non-inhibitory anti-
bodies such as    anti-N-terminal or anti-C-terminal peptide 
antibodies ( see   Note 13 ).      

  Microinjection is performed according to the methods previously 
described by Kishimoto [ 8 ]. Only the holding chamber of oocytes 
is modifi ed [ 7 ]. If the target protein localizes in the nucleus, anti-
bodies are injected into the cytoplasm along with the ZZ-IBB pro-
tein described in Subheadings  3.12  and  3.13  [ 11 ] (Figs.  2  and  3 ).

      1.    Inject the purified and concentrated antibodies into the 
cytoplasm of an isolated oocyte. The injection volumes are less 
than 1/10 volume of an oocyte.   

3.11  Microinjection 
of Purifi ed Antibodies 
into Starfi sh Oocytes

  Fig. 2    Antibody targeting to cytoplasm or nucleus. ( a ) For cytoplasmic target 
protein, antibody (Ig, indicated by  bold Y ) is microinjected into the cytoplasm of a 
starfi sh oocyte. ( b ) For nuclear target protein, Ig is co-injected with recombinant 
ZZ-IBB protein which has both binding domain with Ig and nuclear localization 
activity derived from importin α       
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   2.    Incubate the injected oocyte for 30 min at 20–21 °C. Then, 
evaluate the effect as Subheadings  3.14  and  3.15 .   

   3.    If the antibodies show inhibitory effect, prepare a series of 
serial dilution of the purifi ed and concentrated antibodies.   

   4.    Inject a series of purifi ed antibodies into the cytoplasm of an 
isolated oocyte. The control IgG is also injected at the highest 
concentration as a control.    

      ZZ-IBB consists of two synthetic “Z” domains derived from IgG- 
binding domain of protein A [ 9 ] and IBB (importin β-binding 
domain of importin α), a nuclear localization signal [ 10 ]. ZZ-IBB 
allows the antibody which is injected into the cytoplasm to accu-
mulate into the nucleus, resulting in inhibition of the activity of the 
nuclear protein [ 11 ].

    1.    Transform Rosetta 2 (DE3)  E. coli  cells with pET21-ZZ-IBB 
according to the manufacturer’s instructions, plate cells on the 
LB plate containing carbenicillin and chloramphenicol, and 
incubate overnight at 37 °C.   

3.12  Expression and 
Purifi cation of ZZ-IBB

  Fig. 3    Microinjection, incubation, and sampling. Antibody is injected under micro-
scope by a glass needle into a starfi sh oocyte held by the glass chamber which 
is fi lled with artifi cial seawater (ASW) (refs. [ 7 ,  8 ]). Injected oocytes are taken out 
by the injection needle and transferred into a 35-mm dish fi lled with ASW. 
After treatment with 1-methyladenine (maturation-inducing hormone), oocytes 
are transferred into tube for the H1 kinase assay or immunoblots       
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   2.    Pick a single colony and incubate it overnight at 37 °C in 
10 mL Plusgrow II medium containing 100 μL/mL carbeni-
cillin and 20 μL/mL chloramphenicol.   

   3.    Inoculate 100 mL Plusgrow II medium containing 100  µL/
mL carbenicillin and 20 μL/mL chloramphenicol with the 
10 mL overnight culture and incubate for 1 h at 37 °C.   

   4.    Add IPTG at a fi nal concentration of 1 mM and incubate for 
3 h at 37 °C to induce the protein expression.   

   5.    Harvest the cells by centrifugation at 4,000 ×  g  for 15 min at 
4 °C.   

   6.    Resuspend the cells in 10 mL binding buffer and lyse the cells 
by sonication.   

   7.    Centrifuge the lysate at 26,000 ×  g  for 15 min at 4 °C.   
   8.    Recover the supernatant, mix it with 1 mL (bed volume) 

Ni-NTA Agarose resin, and incubate and rotate the mixture 
for 30 min at room temperature.   

   9.    After removing the supernatant, wash the resin three times 
with 10 mL binding buffer and wash buffer B.   

   10.    Elute the ZZ-IBB protein from the resin four times with 1 mL 
elution buffer C and check the purity by SDS-PAGE and CBB 
staining.   

   11.    Dialysis against PBS using dialysis tube.   
   12.    Concentrate using Vivaspin.   
   13.    Divide into aliquot, freeze in liquid nitrogen, and store at −80 °C.    

          1.    Thaw the neutralizing antibody and ZZ-IBB on ice ( see   Note 14 ).   
   2.    Mix the neutralizing antibody with ZZ-IBB and add NP-40 

into the mixture to a fi nal concentration of 0.05 % (Fig.  2 ) 
( see   Note 15 ).   

   3.    After incubation for 30 min on ice, centrifuge the mixture at 
12,000 ×  g  for 15 min at 4 °C.   

   4.    Inject supernatant into the cytoplasm of immature starfi sh 
oocytes ( see   Note 16 ).   

   5.    Incubate the injected oocytes for 30 min and proceed to fur-
ther experimental process.      

         1.    Recover fi ve starfi sh oocytes with 3 μL sea water into a 0.5 mL 
micro test tube and freeze in liquid nitrogen ( see   Note 17 ).   

   2.    Stand the tube on ice, add 7 μL lysis buffer B, and incubate for 
30 min on ice.   

   3.    Lyse the oocytes by vortexing at 4 °C and then centrifuge the 
lysate at 12,000 ×  g  for 15 min at 4 °C.   

   4.    Recover 0.5 μL supernatant and transfer into 4.5 μL ice-cold 
kinase buffer in a new 0.5-mL micro test tube. The following 

3.13  Transport the 
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procedures are performed in a room for radioisotope 
experiments.   

   5.    Add 5 μL H1 reaction mixture and incubate for 15 min at 
25 °C.   

   6.    Add 10 μL 2× sample buffer and heat for 5 min at 96 °C to 
terminate the kinase reaction.   

   7.    Run samples on 12.5 % SDS-PAGE and stain the gel with CBB 
staining solution.   

   8.    After destaining the gel with CBB destaining solution, detect 
the radioactivity incorporated into histone H1 using BAS 2000 
image analyzer (Fuji Film). Alternatively, excise the histone H1 
bands from the gel and quantify the radioactivity incorporated 
into histone H1 using a liquid scintillation counter.      

   Unless otherwise indicated, the procedure below is performed at 
room temperature.

    1.    Add 4 μL 4× sample buffer into the tube from  step 3  in 
Subheading  3.14  after recovering sample for histone H1 kinase 
assay at  step 1  in Subheading  3.14  and heat for 5 min at 96 °C.   

   2.    Separate proteins by appropriate percentage of SDS-PAGE.   
   3.    Equilibrate fi lter paper and PVDF membrane in transfer buffer 

with gentle rocking.   
   4.    After electrophoresis, equilibrate the gel in transfer buffer with 

gentle rocking for 10 min.   
   5.    Transfer the proteins from the gel to the membrane using 

semidry blotter. Briefl y, place on the anode plate of the blotter in 
following order: three sheets of the fi lter paper, the membrane, 
the gel, and three sheets of the fi lter paper. Set the cathode 
of the blotter and transfer the protein to the membrane at 
2 mA/cm 2  constant current for 1 h.   

   6.    Recover and wash the membrane three times with TBS-T for 
5 min. It should be noted that skipping a blocking step here is 
the essence of high sensitive immunoblotting ( see   Note 18 ).   

   7.    Incubate the membrane with primary antibody at appropriate 
dilution with Can Get Signal Solution 1 for overnight at 4 °C 
( see   Note 19 ).   

   8.    Wash the membrane three times with TBS-T for 5 min.   
   9.    Incubate the membrane with HRP-conjugated secondary 

antibody diluted 1:10,000 in TBS-T for 1 h ( see   Note 20 ).   
   10.    Wash the membrane three times with TBS-T for 5 min.   
   11.    For detection of the protein, incubate the membrane with 

ECL Plus Western Blotting Detection System and visualize 
with LAS 4000.       

3.15  Small-Scale 
Evaluation of Antibody 
Inhibition by 
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4     Notes 

     1.    The salinity of seawater is not the same among various oceans 
in the world. The artifi cial seawater used in our lab is the modi-
fi ed version of van’t Hoff’s artifi cial seawater which is buffered 
by 20 mM boric acid at pH 8.2.   

   2.    In our previous studies, we obtained four types of neutralizing 
antibodies. One is anticatalytic domain of Cdc25 phosphatase 
antibody [ 12 ], which inhibits its phosphatase activity directly. 
Second is the anti-C-terminal domain of Myt1 antibody [ 13 ], 
which inhibits Myt1 kinase activity toward Cdc2 but not auto-
phosphorylation, consistent with a report [ 14 ] that the C-terminal 
domain binds to Cdc2. Third is anti-Plk1 antibody [ 6 ], which 
inhibits activation of Plk1 through  blocking T-loop phosphoryla-
tion but not the activity itself of Plk1. Fourth is anti-C-terminal 
catalytic domain of Greatwall kinase antibody [ 11 ], which inhib-
its its kinase activity in immunoprecipitates and presumably also 
suppresses its kinase activation when the antibody is injected 
together with ZZ-IBB into the cytoplasm of immature oocytes.    

   3.    To increase the yield of soluble His-tagged proteins, the condi-
tion of IPTG induction is sometimes changed: decrease the 
ITPG concentration to 0.1 mM and/or lower the culture 
temperature to 18 °C.   

   4.    If the His-tagged proteins are mostly insoluble, one may try to 
purify them under denaturing conditions. AbISCO adjuvant is 
applicable to soluble antigen and can be used with solution con-
taining 3 M Urea. When most of protein becomes precipitated 
during dialysis against 3 M Urea/PBS, suspension of the precipi-
tated protein in PBS is injected into rabbit along with another 
adjuvant TiterMax Gold, which is applicable to insoluble antigen.   

   5.    Various kinds of proteins are concentrated well by Vivaspin 
with low rate of protein absorption, but some proteins cannot be 
concentrated because of their limited solubility. If so, addition 
of 8 M Urea/PBS to the pellet can solubilize the precipitated 
proteins. Then, the concentration of Urea should be diluted 
lower than 3 M for immunization.   

   6.    High specifi city and high titer are required for inhibitory anti-
body. Immunization of large amount of antigen (0.5–1 mg per 
rabbit) increases the likelihood of obtaining high-titer antibodies.   

   7.    Titer and specifi city of the antibody are tested by immunoblots. 
The method is similar to that described in Subheading  3.15 , 
except for addition of blocking with 5 % skim milk to reduce 
the nonspecifi c signals. Oocyte samples are usually loaded 
alongside of His-tagged and GST-tagged proteins as controls.   

   8.    The fi nal concentration for inhibition of protein activity varies 
from 10 μg/mL to 5 mg/mL in our experiments. The inhibitory 
antibody against synthetic peptide usually exhibits its effect 
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at lower concentration than that against bacterially expressed 
protein, although the yield after antibody purifi cation is relatively 
low in the case of synthetic peptide antigen.   

   9.    Glutathione beads are applicable to soluble proteins in native 
condition. If the protein amount is insuffi cient, alternative culture 
conditions described in  Note 3  are suggested. If the protein is 
still insoluble and forms inclusion bodies, their pellet may be 
washed with lysis buffer A, followed by several rounds of soni-
cation. The suspension added with sample buffer mainly con-
tains GST-tagged protein and can be used for purifi cation.   

   10.    200 μg of loading proteins is usually moderate. If more amount 
of proteins are loaded and transferred on a membrane, the 
proteins are sometimes eluted from the membrane together 
with antibodies. Pretreatment of the membrane pieces with 
0.2 M glycine-HCl (pH 2.0) reduces the coelution. Purifi ed 
antibodies should be checked whether they contain the GST-
tagged protein.   

   11.    If the signal of the desired protein is detected in control beads, 
oocyte extracts are preincubated with protein A beads to 
reduce nonspecifi c binding.   

   12.    In some cases, endogenous proteins cannot be precipitated, 
while control recombinant proteins can be precipitated. A possi-
ble reason would be that endogenous proteins may form com-
plexes with some partner that masks the epitope.   

   13.    One way to confi rm neutralizing activity is to assay the activity 
of purifi ed desired protein in the presence or absence of the 
antibody. The desired protein can be purifi ed by peptide elution 
from immunoprecipitates with peptide antibodies.   

   14.    Once ZZ-IBB is thawed, it can be stored on ice for a few days.   
   15.    Because injection of an excess amount of ZZ-IBB causes delay 

in meiotic progression in starfi sh oocytes, the injection amount 
of ZZ-IBB as well as that of the antibody should be optimized. 
A high-concentration protein solution is viscous and clogs the 
glass micropipette. To avoid this, NP-40 is added into the 
injection material at a fi nal concentration of 0.05 %. It should 
be noted that an injection material which contains more than 
0.1 % NP-40 is toxic to starfi sh oocytes.   

   16.    To check whether ZZ-IBB can transport IgG into the GV, 
ZZ-IBB is fi rst mixed with a fl uorescently labeled IgG (e.g., 
Alexa488-IgG) and then injected into cytoplasm of an immature 
oocyte [ 11 ]. Thereafter, accumulation of the fl uorescent signal 
into the GV can be examined by fl uorescence microscopy.   

   17.    Because histone H1 kinase activity can be measured with oocyte 
extracts equivalent to less than 0.25 oocytes, it is possible to 
carry out this procedure with less than fi ve oocytes, if you have 
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a high-titer antibody against the protein of interest. The frozen 
oocytes can be stored at −80 °C at least a few weeks.   

   18.    In general, the blocking is believed to be an essential step in 
immunoblotting to reduce background noise by preventing 
nonspecifi c interaction between the antibodies and the blot-
ting membrane or nonspecifi c proteins. However, the blocking 
reduces the signal of the target protein as well as the back-
ground. In our immunoblotting procedure, we found that 
omission of the blocking step does not so increase the back-
ground noise. Instead, this enhances the signal of the  target 
protein, resulting in increase of signal/noise ratio. It is recom-
mended that an optimal condition is determined in each anti-
body (i.e., dilution factor of antibody). It should be noted 
that immunoblotting without the blocking step may not be 
successful for some antibodies, because of their titer and 
specifi city.   

   19.    Can Get Signal Solution 1 increases the sensitivity and specifi c-
ity of antibody and reduces the background signal, resulting in 
a high signal/background ratio. Can Get Signal Solution 1 is 
optimized for dilution of primary antibody. It is recommended 
that an optimal dilution factor is determined for each antibody. 
In most cases, the antibody dilution factor can be increased by 
using Can Get Signal Solution 1, compared to conventional 
diluents such as PBS or TBS.   

   20.    To enhance the signal of the target protein, the secondary 
antibody may be diluted with Can Get Signal Solution 2 which 
is optimized for the secondary antibody dilution.         
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     Appendix on Starfi sh Genomes 

 Sequencing of the genome and EST of the starfi sh  Asterina pec-
tinifera  (renamed  Patiria pectinifera  in the 2007 NCBI Taxonomy 
Browser) is now ongoing in the Japanese team. For details, contact 
Takeo Kishimoto at kishimoto.takeo@ocha.ac.jp. Some  A. pectinifera  
EST sequences are already available in    DDBJ/EMBL/GenBank. 
EST data from another species of the starfi sh,  Patiria miniata , are 
also available on the website of Baylor College of Medicine,   http://
blast.hgsc.bcm.tmc.edu/blast.hgsc?organism=Pminiata    .   
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    Chapter 22   

 Immunophotoaffi nity Labeling of the Binding Proteins 
for 1-Methyladenine, an Oocyte Maturation-Inducing 
Hormone of Starfi sh 

           Tetsuo     Kida    ,     Shinjiro     Matsuda    ,     Atsushi     Kuyama    , and     Tetsuo     Toraya    

    Abstract 

   Starfi sh oocytes are naturally arrested at the prophase stage of the fi rst meiotic division and resume meiosis 
in response to 1-methyladenine (1-MeAde), the oocyte maturation-inducing hormone of starfi sh. Putative 
receptors for 1-MeAde have not yet been characterized biochemically, although the specifi c binding of 
1-MeAde to the isolated cortices of starfi sh oocytes was reported so far. Based on the structure-activity 
relationship of 1-MeAde analogs, we have designed a photoaffi nity labeling reagent. The photoaffi nity 
labeling of oocyte membrane fractions, followed by immunoblotting analysis with anti-1-MeAde antibody, 
results in the detection of an almost single protein band. This 1-MeAde-binding protein might be a 
possible candidate of the maturation-inducing hormone receptor of starfi sh.  

  Key words     Immunophotoaffi nity label  ,   Photoaffi nity label  ,   Immunoblot  ,   Oocyte maturation  , 
  Maturation-inducing hormone  ,   Starfi sh  ,    Asterina pectinifera   ,   1-Methyladenine  ,   1-Methyladenine- 
binding proteins  ,   Receptor  

1       Introduction 

 Fully grown oocytes of starfi sh are arrested at the prophase stage of 
the fi rst meiotic division. Reinitiation of meiosis is triggered by 
1-methyladenine (1-MeAde), the oocyte maturation-inducing 
hormone (MIH) of starfi sh [ 1 ], which is produced and released by 
the ovarian follicle cells in response to the gonad-stimulating 
substance (GSS), a peptide hormone from the radial nerve [ 1 ]. 
Recently, it has been reported that GSS is closely related to the 
vertebrate relaxin [ 2 ]. 

 Upon exposure of oocytes to 1-MeAde, the maturation- 
promoting factor (MPF) becomes activated in the cytoplasm [ 3 ] and 
induces oocyte maturation. A MPF has been identifi ed as a complex 
of  cdc2  kinase ( cdk1 ) with cyclin B [ 4 ,  5 ], but the hormonal 
signal transduction pathway has not yet been fully elucidated. 
Putative receptors for 1-MeAde have also not yet been 
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characterized biochemically, although the specifi c binding of 
1-MeAde to the isolated cortices of starfi sh oocytes was reported 
independently by Yoshikuni et al. [ 6 ,  7 ], by Tadenuma et al. [ 8 ], 
and by ourselves [ 9 ]. 1-MeAde-induced maturation of oocytes was 
inhibited by microinjection of pertussis toxin, suggesting the 
involvement of pertussis toxin-sensitive G-protein in the signal 
transduction pathway [ 10 ]. A starfi sh G-protein serving as pertus-
sis toxin substrate was purifi ed from the plasma membranes of 
oocytes [ 11 ]. The cDNA encoding its α subunit was cloned, and 
the deduced amino acid sequence was reported [ 12 ]. The βγ sub-
units of starfi sh G-protein were shown by Chiba et al. to induce 
oocyte maturation when injected into cytoplasm [ 13 ] and to coex-
ist with cytokeratin fi laments in starfi sh oocytes [ 14 ]. 

 Isolation and characterization of 1-MeAde receptors would 
help us to understand the entire signal transduction pathway from 
the receptors to MPF. Many analogs of 1-MeAde were synthe-
sized and tested for oocyte maturation-inducing activity [ 15 – 18 ]. 
Relationship between biological activities as 1-MeAde agonists 
and antagonists and their competitive binding for 1-MeAde recep-
tors was also investigated with several analogs of 1-MeAde [ 6 ,  9 ]. 
Based on these structure-binding studies of 1-MeAde analogs, we 
have designed a photoaffi nity labeling reagent for 1-MeAde recep-
tors [ 19 ]. 

 In this chapter, we report the methods of photoaffi nity label-
ing of 1-MeAde-binding proteins of starfi sh oocytes and of detec-
tion of the labeled proteins by immunoblotting analysis with rabbit 
anti-1-MeAde antibody. Figure  1  outlines the principle of immu-
nophotoaffi nity labeling method described here.

  Fig. 1    Principle of immunophotoaffi nity labeling.    MA—N 3 , photoaffi nity labeling reagent such as Reagent I 
( N  6 -ANB-AH-CM-1-MeAde); MA, 1-methyladenine; P, 1-methyladenine-binding proteins including receptors; 
-XH, generic functional group reactive to a nitrene; AP, alkaline phosphatase       
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2        Materials 

 Prepare all solutions using pure water and reagent-grade commercial 
products. Store all reagents in a refrigerator (unless otherwise 
indicated). Prepare and stock the photoaffi nity labeling reagents in 
the dark ( see   Note 1 ). 

      1.    Adenosine.   
   2.    Iodoacetic acid.   
   3.    DOWEX-50 (H +  form) column (bed volume, 300 mL).      

      1.     N -5-azido-2-nitrobenzoyloxysuccinimide.   
   2.     N , N -dimethylacetamide.      

      1.    1-MeAde analog I (Fig.  2a ):  N  6 -(6-aminohexyl)carbox-
amidomethyl- 1-methyladenine ( N  6 -AH-CM-1-MeAde) synthe-
sized as described below.

       2.    Dimethyladipimidate · 2HCl in ice-cold water (50 mg/mL).   
   3.    50 mM sodium phosphate buffer, pH 8.2.   
   4.    Saline: 0.9 % (w/v) NaCl.   
   5.    Tris-buffered saline (TBS): 0.15 M NaCl, 0.01 M Tris–HCl 

buffer; pH 7.4.   

2.1  Synthesis of 
1-MeAde Analog I

2.2  Synthesis 
of Reagent I

2.3  Preparation and 
Affi nity Purifi cation of 
Antibody Against 
1-MeAde

  Fig. 2    1-MeAde analog and photoaffi nity labeling reagent used in this study. ( a ) 1-MeAde Analog I ( N   6 -AH- CM -
1-MeAde). ( b ) Photoaffi nity labeling Reagent I ( N  6 -ANB-AH-CM-1-MeAde)       
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   6.    1 % (w/v) Triton X-100, 1 M NaCl, 20 mM Tris–HCl; 
pH 7.5.   

   7.    0.1 M glycine · HCl buffer, pH 2.5.      

      1.    Modifi ed van’t Hoff’s artifi cial seawater (ASW): 460 mM 
NaCl, 10.1 mM KCl, 9.2 mM CaCl 2 , 35.9 mM MgCl 2 , 
17.5 mM MgSO 4 , 20 mM H 3 BO 3 . Adjust pH to 8.2 with 
NaOH.   

   2.    2 Ca 2+ -free artifi cial seawater (CaFASW): The same as ASW, 
except that 9.2 mM CaCl 2  and 460 mM NaCl are replaced by 
476 mM NaCl.   

   3.    CaFASW, 2 mM EGTA; pH 6.5.   
   4.    Homogenizing buffer (HB)/1 mM PMSF: 20 mM HEPES 

buffer (pH 7.4) containing 5 mM EGTA and 5 mM MgCl 2 . 
Add 1 % volume of 100 mM phenylmethanesulfonyl fl uoride 
(PMSF) in dimethyl sulfoxide (DMSO).      

      1.    WSB: Water-saturated 2-butanol.   
   2.    Reagent I (Fig.  2b ): 208 mM  N  6 -(6-(5-azido-2- nitrobenzoyl)

aminohexyl)carboxamidomethyl-1- methyladenine ( N  6 -ANB-
AH-CM-1-MeAde). Keep this reagent in the dark.      

      1.    Solution A: Weigh 29.2 g of acrylamide monomer and 0.8 g of 
 N,N -methylenebisacrylamide and make up to 100 mL with 
water. Store at 4 °C.   

   2.    Solution B: Dissolve 18.2 g of    Tris and 0.4 g of sodium dodecyl 
sulfate (SDS) in 80 mL of water. After adjusting pH to 8.8 
with HCl, make up to 100 mL with water. Store at 4 °C.   

   3.    Solution C: Dissolve 6.06 g of Tris and 0.4 g of SDS in 80 mL 
of water. After adjusting pH to 6.8 with HCl, make up to 
100 mL with water. Store at 4 °C.   

   4.    Solution D: Weigh 0.1 g of ammonium persulfate and make 
up to 1 mL with water. Prepare this solution fresh each time.   

   5.     N,N,N,N -Tetramethylethylenediamine (TEMED): Store at 
4 °C.   

   6.    2× Sample buffer: 125 mM Tris–HCl buffer (pH 6.8), 4 % 
SDS, 20 % glycerol, 10 mM 2-mercaptoethanol, 0.02 % 
bromophenol blue (BPB).   

   7.    SDS-PAGE running buffer: 0.3 % Tris, 1.44 % glycine, 0.1 % 
SDS.   

   8.    Marker proteins: Sigma MW-SDS-70L and MW-SDS-6H.   
   9.    Blotting buffer: 25 mM Tris, 192 mM glycine, 0.1 %(w/v) 

SDS, 10 %(v/v) methanol; pH 8.3.   
   10.    PVDF membrane (ProBlott; Applied Biosystems).      

2.4  Crude Membrane 
Preparation

2.5  Photoaffi nity 
Labeling

2.6  SDS-PAGE and 
Transfer to a PVDF 
Membrane
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      1.    Blocking solution: Bovine serum albumin (BSA) in TBS 
(20 mg/mL).   

   2.    Affi nity-purifi ed anti-1-MeAde antibody: Dilute appropriately 
in the blocking solution.   

   3.    TBS-tween (TBST): TBS containing 0.05 % Tween-20.   
   4.    Affi nity-purifi ed goat anti-rabbit IgG antiserum conjugated 

with alkaline phosphatase (AAF-012-1; EY LABORATORIES, 
INC): Dilute to 1/5,000 in the blocking buffer.   

   5.    NBT solution: Dissolve 15.0 mg of nitroblue tetrazolium 
(NBT) in 200 mL of 70 % dimethylformamide (DMF).   

   6.    BCIP (x-phosphate) solution: Dissolve 10.0 mg of 5-bromo-
4- chloro-3′-indolylphosphate (BCIP) (x-phosphate) in 200 mL 
of 100 % dimethylformamide (DMF).   

   7.    Buffer A: 100 mM Tris–HCl buffer (pH 9.5), 10 mM NaCl, 
50 mM MgCl 2 .   

   8.    10 mM Tris–HCl buffer (pH 8.0), 1 mM EDTA.       

3     Methods 

 Carry out all the procedures at 4 °C unless otherwise indicated. 
Perform the photoaffi nity labeling experiments in the dark or 
under a safety light. 

      1.    Dissolve 2.5 g of adenosine and 8.0 g of iodoacetic acid in 
200 mL of water. The pH of the solution was adjusted to and 
maintained at pH 6.5 with 2 M LiOH. After 22 days at 30 °C, 
adjust pH to 3.0 with 1 N HCl and make up to 2 L with water. 
Load this solution on a DOWEX-50 (H +  form) column (bed 
volume, 300 mL). Wash the column with 5 bed volumes of 
water and then with 3 bed volumes of 30 %(v/v) ethanol. Elute 
1-carboxymethyladenosine (1-CM-Ado) from the column with 
30 % ethanol containing 1 N NH 3 .   

   2.    Pool the 1-CM-Ado-containing fractions (about 670 mL), 
concentrate, and make up to 200 mL with water. Adjust pH to 
11.0 with 2 N LiOH and heat the solution at 70 °C for 2 h to 
convert 1-CM-Ado to  N  6 -carboxymethyladenosine ( N  6 -CM- 
Ado ) (Dimroth rearrangement). Neutralize the solution to pH 
7.0 and make up to 4 L with water. Load this solution on a 
diethylaminoethyl (DEAE)-cellulose column (acetate form) 
(bed volume, 300 mL). Wash the column with 5 bed volumes 
of water and elute  N  6 -carboxymethyladenosine ( N  6 -CM-Ado) 
from the column with 1 % acetic acid. Pool the fractions that 
show UV quenching and evaporate it to dryness under reduced 
pressure.   

2.7   Immunoblotting

3.1  Synthesis of 
1-MeAde Analog I

Immunophotoaffi nity Labeling of 1-Methyladenine-Binding Proteins
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   3.    Dissolve 0.55 g of  N  6 -CM-Ado and 2.5 g of hexamethylenedi-
amine (HMDA) in 40 mL of water and adjust pH to 4–5. Add 
0.4 g of 1-(3-dimethyaminopropyl)-3-ethylcarbodiimide 
(water-soluble carbodiimide, WSC) and allow to react at room 
temperature for 2 h. Then, add WSC six times, 0.1 g each 
time, with gentle stirring. Add 80 mL of water to terminate 
the reaction and centrifuge to collect supernatant. Load the 
supernatant onto the fl orisil (100–200 mesh) column (bed 
volume, 103 mL) and wash the column with 5.7 L of water. 
Elute the  N  6 -(6-aminohexyl)carboxamidoadenosine ( N  6 -AH-
CM-Ado) with 80 %(v/v) acetone containing 1 %(v/v) acetic 
acid and evaporate it to dryness under reduced pressure.   

   4.    To  N  6 -AH-CM-Ado in 4 mL of 50 %(v/v) 1,4-dioxane, add 
0.75 g of 2-( tert -butoxycarbonyloxyimino)-2-phenylacetni-
trile (Boc-on) and 531 μL of triethylamine (Et 3 N) in 33 mL of 
50 %(v/v) 1,4-dioxane three times, 0.25 g of Boc-on and 
177 μL of Et 3 N each time. Evaporate the reaction mixture to 
dryness under reduced pressure. After washing with ether, add 
2.5 L of water and 300 mL of ether to extract  N  6 -Boc-AH-
CM-Ado. Evaporate the water layer to dryness under reduced 
pressure. Take up the residue into 20 mL of 10 % 2-butanol in 
water-saturated 2-butanol (WSB) and load the sample on a 
silica gel column (bed volume, 120 mL) which has been equili-
brated with the same solvent. Evaporate the  N  6 -Boc-AH-CM-
Ado-containing fractions to dryness under reduced pressure.   

   5.    Dissolve  N  6 -Boc-AH-CM-Ado in 5.5 mL of  N,N - 
dimethylacetamide . Add 400 μL, 200 μL, and 100 μL of 
methyl iodide on days 1, 4, and 5, respectively. On day 6, 
terminate the reaction by evaporating the mixture to dryness 
under reduced pressure. After washing with ether,  N  6 -Boc-
AH- CM-1-MeAdo was evaporated to dryness under reduced 
pressure.   

   6.    Dissolve  N  6 -Boc-AH-CM-1-MeAdo in 10 mL of 0.5 N HCl 
and seal the solution in a glass tube. After heating at 95 °C for 
45 min, neutralize the reaction mixture with 2 N NaOH and 
evaporate the hydrolyzate to dryness under reduced pressure to 
obtain  N  6 -(6-aminohexyl)carboxamidomethyl-1- methyladenine 
( N  6 -AH-CM-1-MeAde) (1-MeAde analog I in Fig.  2a ).      

      1.    Add 19.4 mg of  N -5-azido-2-nitrobenzoyloxysuccinimide 
(ANB-NOS) in 0.5 mL of  N , N -dimethylacetamide to  N  6 -
AH- CM -Ado in 4.5 mL of  N , N -dimethylacetamide and allow 
to react at room temperature in the dark for 50 h with gentle 
stirring.   

   2.    Add 400 μL of methyl iodide to this reaction mixture and 
allow to react at room temperature in the dark for 47 h. 

3.2  Synthesis 
of Reagent I

Tetsuo Kida et al.
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After washing three times with 90 mL of ether, 30 mL each 
time, evaporate the mixture to dryness under reduced pressure.   

   3.    Dissolve  N  6 -(6-(5-azido-2-nitrobenzoyl)aminohexyl)carbox-
amidomethyl- 1-methyladenosine ( N  6 -ANB-AH-CM-1- MeAdo) 
in 1.5 mL of 0.5 N HCl and seal the solution in a glass tube. 
After heating at 95 °C for 30 min, neutralize the sample to pH 
6–7 by passing through a DEAE-cellulose column (bed vol-
ume, 10 mL) twice. Evaporate the effl uent under reduced 
pressure to obtain crude  N  6 -(6-(5-azido-2-nitrobenzoyl)ami-
nohexyl)carboxamidomethyl- 1-methyladenine ( N  6 -ANB-AH-
CM-1- MeAde) (Reagent I in Fig.  2b ).   

   4.       Dissolve crude  N  6 -ANB-AH-CM-1-MeAde in 100 mL of 
70 %(v/v) ethanol and purify the desired product by fi rst thin- 
layer chromatography (TLC) on silica gel 60 F 254  (20 × 20 cm) 
using water-saturated 2-butanol (WSB), second TLC on the 
same adsorbent using WSB containing 1 % acetic acid, and 
third TLC on 20 mM borate buffer-impregnated silica gel 60 
F 254  (20 × 20 cm) using WSB. Photosensitive and oocyte 
maturation- inducing bands were collected and extracted from 
silica gel.  λ  max  for  N  6 -ANB-AH-CM-1-MeAde (Reagent I) in 
water: 317 nm (peak) and ~270 nm (shoulder).      

      1.    Dissolve 7.7 mg of keyhole limpet hemocyanin (KLH) into 
1.6 mL of 0.1 M NaHCO 3  with gentle shaking and then mix 
with 5 mg of the 1-MeAde analog I (Fig.  2a ) in 0.25 mL of 
0.1 M NaHCO 3 . Add 55 μL of dimethyladipimidate · 2HCl in 
ice-cold water (50 mg/mL) and allow to react at room tem-
perature for 3.5 h. Add 200 μL of 50 mM sodium phosphate 
buffer (pH 8.2), centrifuge, and store the supernatant solution 
at −80 °C.   

   2.    Add 0.5 mL of saline to 0.4 mL of the above 1-MeAde-KLH 
solution and then mix with 1.1 mL of Freund complete adju-
vant (FCA). Inject 0.1–0.15 mL aliquots to the back of female 
adult rabbits. Inject the mixture of 0.2 mL of the above 
1-MeAde-KLH solution, 0.7 mL of saline, and 1.1 mL of 
Freund incomplete adjuvant (FIA) for the booster injections 
on days 21 and 32 after the fi rst immunization.   

   3.    Sacrifi ce the rabbit 7 days later to collect the whole blood from 
carotid. After 1 h at room temperature, collect sera by centri-
fuge and store at −80 °C.   

   4.    Add 1.5 mL of KLH (12 mg/mL in TBS) to 3 mL of the 
 antiserum. After 2 h at room temperature, shake at 4 °C 
for 2.5 days. Centrifuge at    15,000 ×  g  to collect the 
supernatant.   

   5.    Apply the supernatant (4.4 mL) onto a 1-MeAde-Sepharose 
4B column (bed volume, 3 mL) and wash the column 

3.3  Preparation and 
Affi nity Purifi cation of 
Antibody Against 
1-MeAde

Immunophotoaffi nity Labeling of 1-Methyladenine-Binding Proteins
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 successively with 4 bed volumes of TBS, 10 bed volumes of 
1 %(w/v) Triton X-100/1 M NaCl/20 mM Tris–HCl (pH 
7.5), 10 bed volumes of TBS, and 4 bed volumes of 0.15 M 
NaCl. Elute the antiserum with 4 mL of 0.1 M glycine · 
HCl buffer (pH 2.5), pH of the eluate being immediately 
adjusted to 7.5.   

   6.    Pass the affi nity-purifi ed antibody three times through 3 mL 
of a KLH-Sepharose 4B column, which was preliminarily 
equilibrated with 5 bed volumes of TBS.      

      1.    Obtain  Asterina pectinifera  immature oocytes without follicle 
cells from dissected ovaries by the transfer from Ca 2+ -free arti-
fi cial seawater (CaFASW) [ 6 ] to modifi ed van’t Hoff’s artifi cial 
seawater (ASW) [ 20 ]. Wash three times with CaFASW.   

   2.    Prepare dejellied oocytes from immature oocytes by washing 
three times with CaFASW/2 mM EGTA (pH 6.5). After wash-
ing with ASW, pack the dejellied oocytes by centrifuge at 
120 ×  g  for 30 s.   

   3.    Add 2 packed volumes of HB/1 mM PMSF and homogenize 
using Tefl on homogenizer (5 strokes). Centrifuge at 17,000 ×  g  
for 15 min to remove the supernatant. Add 2 precipitant 
 volumes of HB/1 mM PMSF, resuspend, and centrifuge to 
remove the supernatant. This operation was repeated twice. 
Store the oocyte membrane fractions at −80 °C.      

      1.    Add 2 μL of 208 mM Reagent I to 10 μL of a crude membrane 
suspension or its 1 % Triton X-100/1 mM EDTA extract in 
the dark. After 30 min at room temperature, photo-irradiate 
the mixture at 0 °C for 2 min with a 250-W tungsten light 
bulb from the distance of 20 cm.   

   2.    Add 12 μL of 2× Laemmli’s sample buffer. After mixing, heat 
the mixture at 100 °C for 5 min.      

      1.    For preparing a 7.5 % running gel, mix 2.25 mL of Solution A, 
2.25 mL of Solution B, and 4.5 mL of water. Degas with an 
aspirator. Add 0.01 mL of TEMED and 0.04 mL of Solution 
D and cast gel in gel cassette. Overlay gently with 50 μL of 
water.   

   2.    For preparing a stacking gel, mix 0.90 mL of Solution A, 
1.5 mL of Solution C, and 3.0 mL of water. Degas with an 
aspirator. Add 0.01 mL of TEMED and 0.02 mL of Solution 
D and cast gel in gel cassette. Insert a gel comb immediately 
 without introducing air bubbles.   

   3.    After centrifugation, load supernatants of the heated samples 
in the sample buffer and marker proteins (MW-SDS-200 kit) 
on a 7.5 % gel. Electrophorese at 10 mA till the sample has 

3.4  Oocyte 
Membrane Fractions 
of the Starfi sh 
 Asterina Pectinifera 

3.5  Photoaffi nity 
Labeling of 1-MeAde- 
Binding Proteins

3.6  SDS-PAGE and 
Transfer to a PVDF 
Membrane
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entered the running gel and then continue at 15 mA till the 
dye front has reached the bottom of the gel.   

   4.    After electrophoresis, pry the gel plates open, rinse the gel with 
water, and transfer into a blotting buffer (25 mM Tris/192 mM 
glycine/0.1 %(w/v) SDS/10 %(v/v) methanol; pH 8.3). Place 
the gel on a fi lter paper.   

   5.    Cut a PVDF membrane (ProBlot; Applied Biosystem) to the 
size of the gel and immerse the membrane in methanol and 
then in the blotting buffer. Lay a PVDF membrane on the gel 
and then a fi lter paper. Place the PVDF membrane-gel-fi lter 
paper sandwich to a trans-western blotting apparatus (ATTO 
AE-3280). Fill up with the blotting buffer and transfer at 10 V 
for 6 h. Remove the PVDF membrane for immunoblotting.      

      1.    Block the PVDF membrane with the blocking solution 
(20 mg/mL BSA in TBS) at 4 °C overnight.   

   2.    Add 10 mL of diluted anti-1-MeAde antibody to the PVDF 
membrane in a hybridization bag and incubate at room tem-
perature for 12 h.   

   3.    Wash the membrane with TBS-tween three times, 15 min each 
time, and then with TBS for 60 min with gentle shaking.   

   4.    Add affi nity-purifi ed goat anti-rabbit IgG antiserum conju-
gated with alkaline phosphatase (AAF-012-1; EY 
LABORATORIES, INC) (1/5,000-diluted with 20 mg/mL 
BSA in TBS) to the membrane in a hybridization bag and incu-
bate at room temperature for 2 h.   

   5.    Wash the membrane with TBS-tween three times, 15 min each 
time, and then with TBS for 60 min with gentle shaking.   

   6.    Add 1 mL of the mixture of 4.5 μL of NBT (nitroblue tetrazo-
lium) solution, 3.5 μL of BCIP (5-bromo-4-chloro-3′-
indolylphosphate, x-phosphate) solution, and 1 mL of buffer 
A and let bands develop.   

   7.    Add 10 mM Tris–HCl buffer (pH 8.0)/1 mM EDTA to stop 
the reaction.   

   8.    Wash with pure water and scan the membrane for bands after 
being air-dried (Fig.  3 ).

4             Note 

     1.    To avoid undesired photolysis of a photoaffi nity labeling 
reagent, carry out all the procedures in the dark. Use a safety 
light in the dark room if necessary.         

3.7  Detection of 
Labeled Proteins by 
Immunoblotting

Immunophotoaffi nity Labeling of 1-Methyladenine-Binding Proteins
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